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Introduction

Overview

This manual describes how to configure and monitor the SMxTAT2SA via the web via its RJ-45 serial
interface and Ethernet ports.

The SMXTAT2SA Smart Managed GbE PoE+ switch is the next-generation Ethernet switch offering
powerful L2 features with better functionality and usability. It delivers cost-effective business and
transport Ethernet services via fiber or copper connections.

The SMxTAT2SA delivers 8/16/24 (10M/100M/1G) RJ45 ports with 8 PoE+ ports (supports 802.3 at/af
and total up to 130W on the SM8TAT2SA) and 2 GbE SFP ports. SMXTAT2SA provides high hardware
performance and environment flexibility for SMBs and Enterprises. The embedded Device Managed
System (DMS) feature makes the switch easy to use, configure, install, and troubleshoot in video
surveillance, wireless access, and other SMB and Enterprise applications.

SMxXTAT2SA features include:

e Compliant with IEEE 802.3at PoE+ and e RMON groups 1,2,3,9
802.3af PoE e IGMP v1/v2/v3 and MLD v1/v2 Snooping

e PoE configuration, Power delay, and e RADIUS and TACACS+ authentication
Scheduling e [P Source Guard

e PoE Auto Power Reset e DHCP Snooping, DHCP Relay (Option 82),

¢ Device Management System (Graphical DHCP statistics, DHCP per Port
Monitoring, Traffic Monitoring, and e 802.1d (STP), 802.1w (RSTP) and 802.1s
Troubleshooting) (MSTP)

e L2+ features for better manageability, e LACP and static link aggregation
security, QoS, and performance e Q-in-Q double tag VLAN

e |IPv4/IPv6 dual stack management e GVRP dynamic VLAN

e SSH/SSL secured management e LLDP (Link Layer Discovery Protocol)

e SNMPv1/v2c/v3 e |EEE 802.3az Energy Efficiency

33717 Rev. ) https://www.transition.com Page 7 of 304
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Ordering Information

This manual documents four similar models as described below. The models differ mainly in port count.
Model differences are noted where applicable in this manual.

SKU Description

PoE+ layer 2 Smart Managed Switch with Web GUI, SNMP management;
SMSTAT2SA PoE scheduling, APR, and DMS feature support. Port support description:
(8) 10/100/1000Base-T PoE+ ports with 2 SFP ports; AC version.

PoE+ layer 2 Smart Managed Switch with Web GUI, SNMP management;
SMS8TAT2SA-DC PoE scheduling, APR, and DMS feature support. Port support description:
(8) 10/100/1000Base-T PoE+ ports with 2 SFP ports; DC version.

PoE+ layer 2 Smart Managed Switch with Web GUI, SNMP management;
SM16TAT2SA PoE scheduling, APR, and DMS feature support. Port support description:
(16) 10/100/1000Base-T PoE+ ports with 2 SFP ports

PoE+ layer 2 Smart Managed Switch with Web GUI, SNMP management;
SM24TAT2SA PoE scheduling, APR, and DMS feature support. Port support description:
(24) 10/100/1000Base-T PoE+ ports with 2 SFP ports

Purpose

This manual gives specific information on how to operate and use the SMxTAT2SA management
functions with an HTTP/HTTPs web browser.

Audience
This manual is intended for use by network administrators who are responsible for operating and

maintaining network equipment; it assumes a basic working knowledge of general switch functions,
the Internet Protocol (IP), and Hypertext Transfer Protocol (HTTP).

Cautions and Warnings: See the Install Guide for important Cautions and Warnings.

Related Manuals

Other related manuals are listed below.
. SMxTAT2SA Quick Start Guide, 33715
. SMXTAT2SA Install Guide, 33716
. SMXTATS2A CLI Reference, 33718
. SM8TAT2SA-DC Quick Start Guide, 33813
. SM8TAT2SA-DC Install Guide, 33814
e  SMXTAT2SA Unified APl User Guide, 33825
e Release Notes (version specific)

For Transition Networks Drivers, Firmware, etc. go to the Product Support webpage (logon required).

For Manuals, Brochures, Data Sheets, etc. go to the Support Library (no logon required).

Note that this manual provides links to third party websites for which Transition Networks is not
responsible. These external third party links are provided as a convenience and are for informational
purposes only; they do not constitute an endorsement or an approval by Transition Networks of any of
the products, services, or opinions of the corporation or organization or individual. Transition Networks
bears no responsibility for the accuracy, legality, or content of these external sites or for subsequent
links. Contact the external site for answers to questions regarding its content.

33717 Rev. G https://www.transition.com Page 8 of 304
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Chapter 1 - Web-based Management

Initial Configuration

This chapter describes how to configure and manage the SMxTAT2SA via the web user interface. With
this facility, you can easily access and monitor through any one port of the switch all the status of the
switch, including each port activity, Spanning tree status, port aggregation status, multicast traffic, VLAN
and priority status, even illegal access. SMXTAT2SA default values are:

IP Address 192.168.1.77
Subnet Mask 255.255.255.0
Default Gateway 192.168.1.254
Username admin
Password admin

After the SMXTAT2SA interface has been configured, you can browse it. For instance, type
http://192.168.1.77 in the address row in a browser; it will show the Login screen and ask you for a
username and password in order to login and access authentication.

The default Username is admin and default Password is admin. For first time use, enter the default
username and password, and then click the Login button. The login process now is complete. In the login
menu, you must enter the complete username and password respectively. The SMxTAT2SA allows two or
more users using administrator’s identity to manage this switch; the administrator to do the last setting
will be the configuration to affect the system.

@ Note: When you login to the switch Web page to manage, type the Username admin and press the
<tab> key. Then type the Password admin and press Enter. When you login to the switch Web Ul, you can
use IPv4 or IPv6 login to manage.

To optimize the display effect, we recommend Microsoft IE 6.0 above, Netscape V7.1 above or Firefox
V1.00 above with 1024x768 resolution. See the SMxTAT2SA Install Guide for Web browser support.

@ Note: The SMXTAT2SA has the DHCP function disabled by default, so if you do not have a DHCP
server to provide an IP addresses to the switch, enter the default IP address (192.168.1.77).

Figure 1: The Login page

33717 Rev.J https://www.transition.com Page 9 of 304



https://www.transition.com/

Transition Networks SMXTAT2SA Web User Guide

Chapter 2 - First Time Wizard

The first time you use this device you must configure some basic settings such as password, IP address,
date and time, and system information. Use the following procedure:

Step 1: Change default password

Enter a new password and then enter it again. Starting at FW v1.02.1471: the Password must contain at
least 8 characters, at least 1 upper case, 1 lower case and one numeric. The new password cannot be
blank or the default value. Click the Next button.

4\
TRANSITION
\/ NETWORKS
_-“ ]
TRANSITION
\-—" NETWORKS
e Change default password
T New password
= \
Change default password Repeat new password
New password
Password must contain
1. Minimum of 8 characters
Repeat new password 2. At least 1 upper case, 1 lower case and 1 numeric
New password should not be blank or default value.
Figure 2-1: Change default password
Step 2: Set IP address

Select “Obtain IP address via DHCP” or “Set IP address manually” to set the IP address.
[J If setting manually, enter IP address, Subnet mask, and Default router.
[]  If obtaining via DNS, enter a DNS server IP address. See “Messages” below.
[] If obtaining via DHCP, enter a DHCP server IP address.
Click the Next button.

TRANSITION
N NETWORKS
—a
esznom P anoRsse
Set IP address TRANSITION
\—’ NETWORKS
Interface VLAN ID
1
b—a
Obtain IP address via DHCP [ = rooREss oare s Twe weommATION
@ Set IP address manually
P address Set IP address
192.168.1.77
Interface VLAN ID
Subnet mask
255.255.255.0 !
@® Obtain IP address via DHCP
Default router
152 185 1 950 Set IP address manually
NS DNS

Figure 2-2a: Set IP address
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an
JRANSITION

Set IP address

Interface VLAN ID
1

Obtain |P address via DHCP

@ Set IP address manually

IP address

182.168.1.77

Subnet mask

255.255.255.0

Default router

182.168.1.254

DNS

The value of 'DNS' must be a valid IP address in dotted
decimal notation ('x.y.z.w'). The fellowing restrictions
apply: 1) X, y. z. and w must be decimal numbers
between 0 and 255, 2) x must not be 0 unless also y, z,
and w are 0, 3) x must not be 127, and 4) x must not be
greater than 223,

Figure 2-2b: Set IP address

SMXTAT2SA Web User Guide

The value of 'DNS' must be a valid IP address in dotted decimal notation ('x.y.z.w'). The following
restrictions apply: 1) x, y, z, and w must be decimal numbers between 0 and 255, 2) x must not be 0
unless alsoy, z, and w are 0, 3) x must not be 127, and 4) x must not be greater than 223.

Step 3: Set date and time

Enable “Automatic data and time” or select “Manually” to set or select the desired date and time.
If you enable “Automatic data and time” then you must enter a “Server Address” and select a “Time
zone”. Click the Next button when done.

33717 Rev. )
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FA32WORD

F ADDRESE DATE ETIME

Set date and time

Automatic date and time

Manually

2021-03-20 10:56:18

Figure 2-3: Set date and time

https://www.transition.com

INFORMATION

Page 11 of 304


https://www.transition.com/

Transition Networks SMXTAT2SA Web User Guide

Step 4: Set system information

You can set some system information to this device, such as “System contact”, “System name”, and
“System location”. Click the Apply button when done.

=
JRANSITION.

2 2 0

FAZENORD IP ADDREEE DATE & TIME MFDRMATION

Set system information

System contact

System name

SMIBTATZSA

System location

Figure 2-4: Set system information

Message: Password format error.

Message: The value of 'DNS' must be a valid IP address in dotted decimal notation ('x.y.z.w).
The following restrictions apply: 1) x, y, z, and w must be decimal numbers between 0 and 255, 2) x must not
be 0 unless also y, z, and w are 0, 3) x must not be 127, and 4) x must not be greater than 223.
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Webpage Controls

Webpage controls and icons are shown and described below.

TRANSITIDN = T — Auto-logout [OFF H o C‘
N\ NETWORKS.
SME8TAT2SA System Information @Homs - System - System Information

Click the Transition Networks logo to return to the Switch > System > System Information page.

Click the = icon to alternately display / hide the left hand menu bar.

ol LT
Hover the cursor over any port to see its current status: or .

Click on any port to display its current Detailed Port Statistics page.

Auto-logout |10 min ¥ H 9 Cﬁ

Top right corner icons:

- ]
H Save Configuration: Click to save parameter changes to the running-config file. Click OK
when the message “Please confirm to save current running-config file as startup-config file?” displays.
Do not reset or power off the switch until the save completes.

Click Save Button: displays when a Save to startup-config can be performed. At the “Are you Click Save Button

sure ...” prompt click the OK button. The Click Save Button then disappears until you make
another webpage change.

9 Help: Displays the Help page for the current webpage.
L | . |
Logout: Logs you out and displays the Login prompt.

. [ A .
dHome System =2 m ] L ) : Displays the current webpage path.
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Auto-logout [10min ¥ Auto-logout dropdown lets you set the amount of time after Ate-logout
a successful login before an automatic log out occurs. The selections are OFF, 1, 2, 3, 4, 1 min
5, 10, 20, 30, 40, and 60 minutes (added at FW v1.02.1463). The default is 10 minutes. i,
When set to OFF, no Auto-logout occurs. 4min
After you change the Auto-Logout timeout and then log out and log back in, the
Auto-Logout timeout setting will be the setting saved to the start-up config file. 20 min
40 min
When the Auto-Logout timeout setting is changed, it directly writes to running-config. 50 min

60 min

To save the timeout change to start-up config, you must execute a save to startup-config.

To examine the running-config, you can run the CLI command “showing running-config” or in the Web
Ul just log out and log back in again.

To save the timeout change into startup-config, you must do a save to startup-config and then reboot
the switch.

In summary:

o  When you power on the switch, it will get the settings from startup-config.

e When you logout and login (without switch reboot), the switch will get the timeout settings from
startup-config.

e When you reload defaults, the switch will get the timeout settings default-config.

For the “Save to start-up config” behavior, if you don’t save the config, when you change the timeout
setting but logout, at the next login the timeout setting remains unchanged as the setting in start-up
config.

If you save timeout setting to start-up config: If you don’t save timeout setting to start-up config:

When you change the timeout setting and save
to startup-config (click the disc icon), the
changed timeout setting will be applied to
running-config and start-up config immediately.

When the you change the timeout setting (without
save to startup-config), the timeout change will be
applied to running-config immediately.

After Logout and login, the timeout setting will | After Logout and login, the timeout setting will be
be the setting saved in start-up config. the setting saved in start-up configure.

After a switch reboot, the timeout setting will After you reboot the switch, the timeout setting will
be the setting saved in start-up config. be the setting saved in start-up config.

Webpage Messages

Message: Wrong username or password!
Recovery: Re-try the login with the correct username and password credentials.

Message: There are too many users in the system.
Recovery: Try to log in later.
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Chapter 3 - System

This chapter describes the basic configuration tasks including System Information and certain System
parameters (e.g., IP Address, System Time, LLDP, UPnP).

3-1 System Information

You can enter a system name, location, and contact information here. Additional switch-related
information is also provided here (e.g., Model Name, HW version, FW version, Serial Number, etc.).
Web interface

To configure System Information in the web UL

1. Click System and System Information.

2. View the read-only parameters.

3. Enter System Name, Location, and Contact information (optional).
4. Click the Apply button.

‘ﬂ TRANSITION * (R p .
TRANSITION * =| = suss _ SN
N\ NETWORKS
SM8TAT2SA System Information @Home - System - SyswmInformation
Switch DMS
Model Name SMETATZSA
» System Y

System Description Smart Managed Switch, 8-port Gigabit PoE+, 2-port 100/1000 SFP

» System Information

< Hardware Version v1.01
Mechanical Version v1.01
» LLDP <
- Firmware Version v1.04.0020
» UFnF
PoE Firmware Version 208-211
» Port Management &

-

PoE Management

-

VLAN Management

-

Quality of Service

-

Spanning Tree

MAC Address
Serial Number

System Name

00-C0-F2-4C-22-C3

C020319AR2400167

SMETATZSA

Location Experience Center
» MAC Address Table
b Multicast contact Erpenencs CenirAdmin
» DHCP System Date 2017-01-01 00:01:27 +0000
¥ Security System Uptime 0 days, 0:01:41
» Access Control <
» SNMP ¢ | 2eply ]| Reset |

Figure 3-1: System Information (SM16TAT2SA shown)
Parameter descriptions:

Model Name: the specific switch model number (i.e.,, SM8TAT2SA, SM8TAT2SA-DC, SM16TAT2SA, or
SM24TAT2SA).

System Description: e.g., Smart Managed Switch, 16-port Gigabit PoE+, 2-port 100/1000 SFP.
Hardware Version: the current version of hardware (e.g., v1.02).

Mechanical Version: the current mechanical version (e.g., v1.01).

Firmware Version: the current running version of switch firmware (e.g., v1.04.0020).

33717 Rev.J
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PoE Firmware Version: the current PoE MCU FW version (e.g., 208-211 or 208-188).
MAC Address: the switch MAC Address in the format 11-22-33-44-55-66.
Serial Number: the switch S/N (e.g., C020316AR5100024).

System Name: An administratively assigned name for this managed node. By convention, this is the
node's fully-qualified domain name. A domain name is a text string drawn from the alphabet (A-Z, a-z),
digits (0-9), minus sign (-). No space characters are permitted as part of a name. The first or last character
must not be a minus sign. The allowed string length is 0 - 128 characters (e.g., SM8TAT2SA).

Location: The physical location of this node (e.g., telephone closet, 3rd floor). The allowed string length is
0 - 128 character, and the allowed content is an ASCII character 32-126.

Contact: The textual identification of the contact person for this managed node, with information on how
to contact this person. The allowed string length is 0-128 characters, and the allowed content is ASCII
characters 32-126.

System Date: the current date and time (e.g., 2021-02-25 13:26:58 +0000).
System Uptime: the time the switch has been running since the last power cycle (e.g., 6 days, 23:28:42).

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.

TRANSITION ® = === . i [onn] H @ G
N NETWORKS.
SM8TAT2SA-DC System Information BHome  System  System Information
Switc DMS
Model Name SMB8TAT2SA-DC
»
System Description Managed Switch, 8-port Gigabit PoE+, 2-port 100/1000 SFP
d Hardware Version v1.02
' Mechanical Version v1.02
Firmware Version v1.02.1474
» Port Management < PoE Firmware Version 208-211
» PoE Management < MAC Address 00-40-10-15-10-01
» VLAN Management ¢ Serial Number XYZ01234567898

Quality of Service < System Name

Spanning Tree <

” Location

MAC Address Table

» Multicast < Contact
»
l23td5 System Date 2017-01-01 00:01:46 +0000
» Security
: System Uptime 0 days, 0:02:00
» Access Control
» SNMP

Figure 3-2: System Information (SM8TAT2SA-DC shown)
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3-2 IP Address
3-2.1 IP Settings

At System > IP Address > IP Settings you can configure the IPv4 address and related parameters.

The IPv4 address for the switch could be obtained via DHCP Server for VLAN 1. To manually configure an
address, you need to change the switch's default settings to values that are compatible with your network.
You may also need to establish a default gateway between the switch and management stations that exist
on another network segment.

Web Interface

To configure IP settings in the web interface:

1. Click System, IP Address, IP Settings.

2. Check the "IPv4 DHCP Client Enable” box.

3. Enter the IPv4 Address, Subnet Mask, Gateway, and DNS Server parameters.
4

Click Apply.
TRANSITION® = @*F . = e
NETWORKS.
SM8TAT2SA IP Settings @orome - System - P Address - 19 Settings
Switch DMS
IPv4 DHCP Client Enable [
> System Information IPv4 Address 10.0.4.3
» IP Address
Subnet Mask 755.255.255.0
> |P Settings
» Advanced IP Settings Gateway 10.0.4.1
> Status
> System Time DNS Server o DS server v
» LLDP
> UPNP | Apply |

Figure 3-2.1: IP Settings page
Parameter descriptions:

IPv4 DHCP Client Enable: Check the box to enable DHCP Client support globally. Enable the DHCP client
by checking this box. If this option is enabled, the system will configure the IPv4 address and mask of the
interface using the DHCP protocol. The DHCP client will announce the configured System Name as
hostname to provide DNS lookup.

IPv4 Address: e.g., 192.168.1.77. The IPv4 address of the interface in dotted decimal notation. If DHCP is
enabled, this field is not used. The field may also be left blank if IPv4 operation on the interface is not
desired.

Subnet Mask: The IP address of the IP gateway. Valid format is dotted decimal notation or a valid IPv6
notation. Gateway and Network must be of the same type. User IP subnet mask of the entry (e.g.,
255.255.255.0).

Gateway: The IP address of the IP gateway. Valid format is dotted decimal notation or a valid IPv6
notation (e.g., 192.168.1.254). Gateway and Network must be of the same type.
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DNS Server: Select either No DNS server, Configured, From this DHCP interface, or
From any DHCP interfaces. If you select “Configured”, enter an IP address.
If you select “From this DHCP interface”, enter a DNS Server number (configured in Configured

the following section “Advanced IP Settings”. From this DHCP interface
From any DHCP interfaces

Mo DNS server ¥

This setting controls the DNS name resolution done by the switch. The following
modes are supported:

No DNS server: No DNS server will be used.
Configured: Explicitly provide the IP address of the DNS Server in dotted decimal notation.

From this DHCP interface: Specify from which DHCP-enabled interface a provided DNS server
should be preferred.

From any DHCP interfaces: The first DNS server offered from a DHCP lease to a DHCP-enabled
interface will be used.

Buttons

Apply: Click to save changes.
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3-2.1 Advanced IP Settings

The IPv4 address for the switch can be obtained via DHCP Server for VLAN 1. To manually configure an
address, you must change the switch's default settings to values that are compatible with your network.
You may also need to establish a default gateway between the switch and management stations that exist
on another network segment.

Configure the switch-managed IP information on this page and configure IP basic settings, control IP
interfaces and IP routes. You can configure up to 8 interfaces and 8 routes.

Web Interface
To configure an IP configuration in the web interface:

1. Click System, IP Address, Advanced IP Settings.

2. Click Add Interface and configure the new Interface for the switch.
3. Click Add Route and configure the new route for the switch.
4

. Click Apply.
‘ﬂ —_ Ln{nuw_\ﬁ Auto-logout v -
TRANSITIDN = C ] Auto-logout H o C’
N NETWORKS
SMETAT2SA Advanced IP Settings @Home ~ System =~ IP Address ~ Advanced IF Settings
Switch DMS
DNS Server No DNS server v
» System A
> System Information
IP Interfaces

DHCP Per Port ]

Mode Disabled

IP
» LLDP <
> UPnP

DHCPv4 IPv4 IPv6
» Port Management «
5 (T Current Mask Mask
y g
DE L EAgEITE Delete  VLAN Enable Fallback Lease Address Length  Address Length

» VLAN Management & - -

[ 1 [ 0 10.0.4.3 24
» Quality of Service &
» ing Tre < N

Spanning Tree Add Interface

» MAC Address Table <
T < Link-Local Address binding interface VLANT
» DHCP <

IP Routes
» Security &
» Access Control & Delete Network Mask Length Gateway Next Hop VLAN

]

» SNMP < 0 0.0.0.0 0 10.0.4.1 0 '
» Event Notification &
» Diagnostics < | Add Route
» Maintenance < | Apply H Reset |

Figure 3-2.1: Advanced IP Settings
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Parameter descriptions:

Advanced IP Settings

DNS Server: Controls the DNS name resolution done by the switch. These modes are supported:
No DNS server: No DNS server will be used.

Configured: Explicitly provide the IP address of the DNS Server in No DNS server v
o th G ot NoDNSzener
From this DHCP interface: Specify from which DHCP-enabled AL 4
. . Configured
interface a provided DNS server should be preferred. = S

. ] From thiz DHCP interface
From any DHCP interfaces: The first DNS server offered from a From any DHCP interfaces

DHCP lease to a DHCP-enabled interface will be used.

IP Interfaces
Delete: Select this option to delete an existing IP interface.

DHCP Per Port Mode: At the dropdown select Enable or Disable DHCP per Port operation. The default is
Disabled.

DHCP Per Port IP: Define the IP range for DHCP Per Port. The range must be equal to the number of
switch RJ45/TP ports (e.g., 16 for the SM16TAT2SA).

VLAN: The VLAN associated with the IP interface. Only ports in this VLAN will be able to access the IP
interface. This field is only available for input when creating a new interface.

DHCPv4 Enabled: Enable the IPv4 DHCP client by checking this box. If this option is enabled, the system
will configure the IPv4 address and mask of the interface using the DHCP protocol. The DHCP client will
announce the configured System Name as hostname to provide DNS lookup.

DHCPv4 Fallback: The number of seconds for trying to obtain a DHCP lease. After this Timeout period
expires, a configured IPv4 address will be used as IPv4 interface address. A value of zero disables the
fallback mechanism, such that DHCP will keep retrying until a valid lease is obtained. Legal values are 0 to
4294967295 seconds.

DHCPv4 Current Lease: For IPv4 DHCP interfaces with an active lease, this column shows the current
interface address, as provided by the DHCP server.

IPv4 Address: The IPv4 address of the interface in dotted decimal notation.
If DHCP is enabled, this field is not used. The field may also be left blank if IPv4 operation on the interface
is not desired.

IPv4 Mask: The IPv4 network mask, in number of bits (prefix length). Valid values are 0 - 30 bits for an
IPv4 address. If DHCP is enabled, this field is not used. The field may also be left blank if IPv4 operation on
the interface is not desired.

IPv6 Address: The IPv6 address of the interface. An IPv6 address is in 128-bit records represented as eight
fields of up to four hexadecimal digits with a colon separating each field (:). For example,
fe80::215:¢5ff:fe03:4dc7. The symbol :: is a special syntax that can be used as a shorthand way of
representing multiple 16-bit groups of contiguous zeros; but it can appear only once. It can also represent
a legally valid IPv4 address. For example, :192.1.2.34.

The field may be left blank if IPv6 operation on the interface is not desired.

IPv6 Mask: The IPv6 network mask, in number of bits (prefix length). Valid values are 1 - 128 bits for an
IPv6 address. The field may be left blank if IPv6 operation on the interface is not desired.
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Link-Local Address binding interface: Configure Link-Local IP address to a different VLAN interface.

The first IP interface entry is for the default value. A link-local address is a network address that is valid
only for communication within the network segment or the broadcast domain that the host is
connected to. Link-local addresses are not guaranteed to be unique beyond their network segment. IPv4
link-local addresses are assigned from address block 169.254.0.0/16 (169.254.0.0 - 169.254.255.255). In
IPv6, they are assigned from the block fe80::/10.

IP Routes
Delete: Select this option to delete an existing IP route.

Network: The destination IP network or host address of this route. Valid format is dotted decimal
notation or a valid IPv6 notation. A default route can use the value 0.0.0.0or IPv6 :: notation.

Mask Length: The destination IP network or host mask, in number of bits (prefix length). It defines how
much of a network address that must match, in order to qualify for this route. Valid values are 0 - 32 bits
for IPv4 routes and128 bits for IPv6 routes. Only a default route will have a mask length of 0 (as it will
match anything).

Gateway: The IP address of the IP gateway. Valid format is dotted decimal notation or a valid IPv6
notation. Gateway and Network must be of the same type.

Next Hop VLAN (Only for IPv6): The VLAN ID (VID) of the specific IPv6 interface associated with the
gateway. The valid VID range is 1 - 4094 and will be effective only when the corresponding IPv6 interface
is valid.

If the IPv6 gateway address is link-local, it must specify the next hop VLAN for the gateway.

If the IPv6 gateway address is not link-local, system ignores the next hop VLAN for the gateway.

Buttons

Add Interface: Click to add a new IP interface. A maximum of 8 interfaces is supported.
Add Route: Click to add a new IP route. A maximum of 8 routes is supported.

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.

Messages:

Message: ERROR: DHCP Per Port IP range (192.168.1.1 - 192.168.1.10) is not equal to switch RJ45/TP port
number (16)

Message: Subnet overlaps with VLAN 1

Message: VLAN 1 used for more than one interface

Message: This field is required.

Message: Subnet of VLAN 2 overlaps VLAN 1

Message: ‘Address mask length’ must be an integer value between 1 and 30.
Message: IP address must not be a broadcast address

Message: ipv4 — 1.2.3.4 — Address conflict
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Message: The value of ‘Interface IP address’ must be a valid IP address in dotted decimal notation
(z.y.zw’).

The following restrictions apply:

1) z, y, z, and w must be decimal numbers between 0 and 255,

2) x must not be 0,

3) x must not be 127, and
4) x must not be greater than 223.

Message: A static address is only used if the fall-back timeout is non-zero.
Message: Invalid route - address bits outside mask: 0.0.1.77

Message: Default route mask length must be zero.

Message: ERROR: Already exists

Message: IP address will be modify in management interface, and then use the new IP address to
reconnect.
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This page displays the status of the IP protocol layer. The status is defined by the IP interfaces, the IP

routes and the neighbor cache (ARP cache) status.

Web Interface
To display the log configuration in the web interface:
1. Click System, IP Address, Status.

2. View the IP Configuration information.

e I - R

SMETATZSA |P Status Setome - Gween - Maddma - Suea
Switch DMS
IP Interfaces
Interface | Type Address Status
03la Link 00-00-00-00-00-00 UP LOOPBACK RUNNING MTL: 16436 Metric:1
05:la el 1/B
03la I#vE =1f12E
| WLAML Link 0Q-C0-F2-49-AB-14 UP BROADCAST RUMNING MULTICAST MTU:1500 Metric:L
| WLANL I5d 10.0.43/24 Manual
WLAML PvE Fel0:2cluf2fifed5ab 14,64 Link Local Address
IP Routes
Metwork & Gatmway Status Interface
» DHCP £ 0.00.0/0 10.041 UP GATEWAY WLAML
¥ Security & £U0.0.0/0 0.0.0.0 ur WLANL
 femesz Cantrl 10.0.4.0/24 000 up VLANL
» SNMP
o000 up 05la
b Event Notification
) ) 0.0.0.0 up VLANL
b Disgnastics
N 17228 [ OStla
[ ]
FeB0:/54 up WLAML
feB:-2clcf2fi-fed Boab 14 /126 up 05la
up WLAML
A2 WP CACHE WLARNL
Neighbour Cache
IP Addrass * | Link Address
10041 WLANIAOC-00-5e-00-01-04
10044 WLAN1AO0-c0-f2-8c-34-T2
165.354.55.108 WLANIAO0-c0-F2-Sa-8-fb
[ 168.234.3.207 WLAN1AO0-c0-f2-8c-34-T2
|
I DNE Server
| Type IF Address Interface
Mane 0.0.0.0
| b
— - — — - -

Figure 3-2.2: IP Status page
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Parameter descriptions:

IP Interfaces
Interface: Shows the name of the interface (e.g., OS:lo or VLAN1).
Type: Shows the address type of the entry. This may be LINK or IPv4 or IPv6.

Address: Shows the current address of the interface (of the given type; e.g., 192.168.1.77/24 or ::1/128 or
00-40-C7-1C-CB-6E).

Status: Shows the status flags of the interface (and/or address). For example: UP LOOPBACK RUNNING
MTU:16436 Metric:1 or UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1, or Manual, or Link
Local Address, or DHCP Fallback.

IP Routes
Network: Shows the destination IP network or host address of this route (e.g., 192.168.1.0/24).
Gateway: Shows the gateway address of this route (e.g., 192.168.1.254 or :).

Status: Shows the status flags of the route (e.g., UP or UP GATEWAY).
Interface: Shows the name of the interface (e.g., OS:lo or VLAN1).

Neighbor Cache
IP Address: Show the IP address of the entry (e.g., 192.168.1.99).

Link Address: Show the Link (MAC) address for which a binding to the given IP address exists (e.g.,
VLAN1:00-1b-11-b2-6d-4b).

DNS Server
Type: Show the address type of the entry. This may be LINK or IPv4 or DHCP any.
IP Address: Show the current address of the interface (of the given type).

Interface: Show the name of the interface.

Auto-refresh Refresh
Buttons ;J

Auto-refresh: Check to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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The switch provides manual and automatic ways to set the system time via NTP. For manual setting, enter
the "Year”, "Month”, “Day”, "Hour" and “Minute” within the valid value range indicated for each item.

Web Interface

To configure Time in the web interface:

1. Click System and System Time.

2. Specify the Time parameters.

3. Click Apply.

e
| JRANSITION

SMETAT2SA

Switch DMS
b System

» System Information

» IP Address

> System Time

» LLDP

> UPnP
» Port Management

| » PoEManagement

-

VLAN Management

Quality of Service

Spanning Tree

MAC Address Table

Multicast

» DHCP

Security

-

Access Control

» SNMP

Event Notification

Diagnostics

Maintenance
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Figure 3-3: Time Configuration page
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Time Configuration

Clock Source: There are two modes for configuring how the Clock Source from. Select "Local Settings" :
Clock Source from Local Time. Select "NTP Server" : Clock Source from NTP Server.

System Date: Show the current time of the system. The year of system date must be 2000 - 2037.

Time Zone Configuration

Time Zone: Lists various Time Zones worldwide. Select appropriate Time Zone from the drop down and
click Apply to set.

Acronym: You can set the acronym of the time zone. This is a user configurable acronym to identify the
time zone (range: up to 16 characters).

Daylight Saving Time Configuration

Daylight Saving Time: This is used to set the clock forward or backward according to the configurations
set below for a defined Daylight Saving Time duration. Select 'Disable’ to disable the Daylight Saving Time
configuration. Select 'Recurring’ and configure the Daylight Saving Time duration to repeat the
configuration every year. Select 'Non-Recurring' and configure the Daylight Saving Time duration for
single time configuration. (Default: Disabled).

Recurring Configuration

Start time settings:
Month - Select the starting month (Jan — Dec).
Week - Select the starting week number (1-5).
Day - Select the starting day (Mon — Sun).
Hours - Select the starting hour (0-23).

End time settings:
Month - Select the starting month (Jan — Dec).
Week - Select the starting week number (1-5).
Day - Select the starting day (Mon — Sun).
Hours - Select the starting hour (0-23).

Offset settings: Offset - Enter the number of minutes to add during Daylight Saving Time. The valid range
is 1 to 1440 minutes. The default is 60 minutes.

@ Note: The information under “"Start Time Settings” and "End Time Settings” displays what you set
on the “Start Time Settings” and “End Time Settings” field information.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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Configure NTP Server: At "Clock Source” select NTP Server. This enables the Configure NTP Server
button.

TRANSITIO N — JRANSITEN F T Auto-logout H 9 C’
N NETWORKS.
SMETAT2SA Time Configuration @Home - System - System Time
Switch DMS
Time Configuration
» System M
» System Information Clock Source Confizure NTP Server
# IP Address <
System Date 2020-12-04 16:00:33 (yyyy-mm-dd hh:mm:ss)
» LLDP <
3 1PnE Timea 7ana Canfiouratinn

Click the Configure NTP Server button to configure NTP server.

TRANSITION = Lt = -'-\L:D-.-:g:-l_lt o C"
N\ NETWORKS
SMBTAT2SA NTP Configuration @Home - System - System Time
Switch DMS
Server 1
n Information Server2
<
. . Server 3
» System Time
» LLDP < Server 4
> UPnP
Server5
» Port Management &
» PoE Management < Server 6
» VLAN Management Interval Omin v
¥ Quality of Service <
» Spanning Tree & | Apply || Rese |

Figure 3-3: NTP Configuration page

NTP (Network Time Protocol) is used to sync the network time based Greenwich Mean Time (GMT). If use
the NTP mode and select a built-in NTP time server or manually specify a user-defined NTP server as well
as Time Zone, the switch will sync the time in a short after pressing Apply button. Though it synchronizes
the time automatically, NTP does not update the time periodically without user’s processing.

Time Zone is an offset time off GMT. You have to select the time zone first and then perform time sync via
NTP because the switch will combine this time zone offset and updated NTP time to come out the local
time, otherwise, you will not able to get the correct time. The switch supports configurable time zone
from =12 to +13 step 1 hour. The default Time zone is +8 Hrs.

Parameter descriptions:

Server 1 to 6: Provide the NTP IPv4 or IPv6 address of this switch. IPv6 address is in 128-bit records
represented as eight fields of up to four hexadecimal digits with a colon separating each field ().

For example, 'fe80::215:c5ff:fe03:4dc7'. The symbol "' can be used as a shorthand way of representing
multiple 16-bit groups of contiguous zeros; but it can only appear once. It can also represent a valid IPv4
address. For example, ':192.1.2.34".
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Interval: You can specify the time interval in seconds after which a time check Interval |:|
and, in case of deviation, a resynchronization of the internal device clock against —
i . . . 2 min
the specified timeserver via Network Time Protocol (NTP) should be performed. 10 min
The selections are 5 min, 10 min, 15 min, 30 min, 60 min, and 120 min. f; :::
| 60min

120 min
Buttons: These buttons are displayed on the NTP page: '

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.

Message:

The input value ‘Server 2 Address’ (::)

is not a valid IPv6 address.

The Unspecified Address must never be assigned to any node.

Message:

The value of ‘Server 2 Address’ (:: ::)
must be a valid IPv6 address.

The symbol ‘::’ can appear once.

Message:

The value of ‘Server 2 Address’ (::)

must be a valid IPv6 address in 128-bit record represented as

eight fields of up to four hexadecimal digits with a colon (:) separating
each field.

Message:
The format of ‘Server 3 Address’ is invalid.

It must either be a valid IP address in dotted decimal notation

(x.y.z.w’) or a valid hostname.

A valid hostname is a string drawn from the alphabet (A-Za-z), digits

(0-9), dot (.), hyphen (-).

Spaces are not allowed, the first character must be an alphanumeric character,
and the first and last characters must not be a dot or hyphen.
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3-4 LLDP » LLDP

> LLDP Configuration

The switch supports the Link Layer Discovery Protocol (LLDP) which provides a
standards-based method to enable switches to advertise themselves to adjacent

> LLDP-MED Configuration

> LLDP Neighbar
devices and to learn about adjacent LLDP devices. » LLDP PoE
LLDP is a vendor-neutral Link Layer protocol in the Internet Protocol Suite used by > A TR e
network devices for advertising their identity, capabilities, and neighbors on a IEEE ANDEStattics

802 local area network, principally wired Ethernet. The protocol is formally referred to by the IEEE as
Station and Media Access Control Connectivity Discovery specified in standards document IEEE 802.1AB.

LLDP can be used as a component in network management and network monitoring applications.
LLDP is also used to advertise power over Ethernet capabilities and requirements and negotiate power
delivery.

LLDP-MED provides extended and automated power management of Power over Ethernet (PoE) end
points. Media Endpoint Discovery is an enhancement of LLDP, known as LLDP-MED.

3-5.1 LLDP Configuration

This page lets you view and set LLDP detail parameters on a per-port basis; the settings take effect
immediately.

LLDP uses System Capability Codes: B = Bridge (Switch), C = DOCSIS Cable Device, O = Other,
P = Repeater, R = Router, S = Station, T = Telephone, and W = WLAN Access Point.

LLDP information is sent by devices from each of their interfaces at a fixed interval, in the form of an
Ethernet frame. Each frame contains one LLDP Data Unit (LLDPDU). Each LLDPDU is a sequence of type-
length-value (TLV) structures.

The Ethernet frame used in LLDP typically has its destination MAC address set to a special multicast
address that 802.1D-compliant bridges do not forward. Other multicast and unicast destination addresses
are permitted. The EtherType field is set to 0x88cc.

Each LLDP frame starts with the mandatory TLVs Chassis ID, Port ID, and Time-to-Live.

Web Interface

To configure LLDP:

1. Click System, LLDP, and LLDP Configuration.

2 Modify LLDP Parameters and LLDP Port Parameters.

3. Specify the information to include in the TLV field of advertised messages.
4.  Click Apply.
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TRANSITION ® = === : = H oG
N NETWORKS
SMBTAT2SA LLDP Configuration @itoms - System - LLOP - LLDP Configuration
Switch DMS
LLDP Parameters
b System -
> System Information Tx Interval 20 seconds
# |P Address <
Tx Hold 4 i
> System Time times
i (i ) Tx Delay 2 seconds
> LLDP Configuration
> LLDP-MED Configuration Tx Reinit 2 seconds
> LLDP MNeighbor
> LLDP PoE LLDP Port Configuration
> LLDP-MED Neighbor
Optional TLVs
> LLDP Statistics
5> UPnP CDP Part System System System Management
Port Mode Aware Description  MName Description Capabilities Address
» Port Management <
1 Disabled w  [|
» PoE Management <
» VLAN Management < 2 Disabled v [_|
» Quality of Service < )
3 Dizabled W D
» Spanning Tree <
4 Disabled W v v v v v
» MAC Address Table < s O
» Multicast ¢ 5 Disabled v | [J
» DHCP 3
5 Disabled v [
P Security <
7 Disabled W v v v v =
b Access Control < 1=able OJ
» SNMP 3 E Dizsbled | [
» Event Notification <
[ ] Disabled % [|
» Diagnostics <
» Maintenance < 10 pissbled v []

Figure 3-5.1: LLDP Configuration page
LLDP Parameters:

Tx Interval: The switch periodically transmits LLDP frames to its neighbors for having the network
discovery information up-to-date. The interval between each LLDP frame is determined by the Tx Interval
value. Valid values are 5 - 32768 seconds. The default is 30 seconds.

Tx Hold: Each LLDP frame contains information about how long the information in the LLDP frame will be
considered valid. The LLDP information valid period is set to Tx Hold multiplied by Tx Interval seconds.
Valid values are 2 - 10 times. The default is 4 times.

Tx Delay: If some configuration is changed (e.g. the IP address) a new LLDP frame is transmitted, but the
time between the LLDP frames will always be at least the value of Tx Delay seconds. Tx Delay cannot be
larger than 1/4 of the Tx Interval value. Valid values are 1 - 8192 seconds. The default is 2 seconds.

Tx Reinit: When a port is disabled, LLDP is disabled or the switch is rebooted, an LLDP shutdown frame is
transmitted to the neighboring units, signaling that the LLDP information isn't valid anymore. Tx Reinit
controls the number of seconds between the shutdown frame and a new LLDP initialization. Valid values
are 1 - 10 seconds. The default is 2 seconds.
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LLDP Port Configuration: The LLDP port settings relate to the currently selected, as reflected by the
page header.

Port: The switch port number of the logical LLDP port.

Mode: Select LLDP mode:
Rx only The switch will not send out LLDP information, but LLDP information from neighbor units is
analyzed.

Tx only The switch will drop LLDP information received from neighbors but will send out LLDP
information.

Disabled The switch will not send out LLDP information and will drop LLDP information received
from neighbors.

Enabled the switch will send out LLDP information and will analyze LLDP information received from
neighbors.
CDP Aware: Select CDP awareness.
The CDP operation is restricted to decoding incoming CDP frames (The switch doesn't transmit CDP
frames). CDP frames are only decoded if LLDP on the port is enabled.

Only CDP TLVs that can be mapped to a corresponding field in the LLDP neighbors’ table are decoded. All
other TLVs are discarded (Unrecognized CDP TLVs and discarded CDP frames are not shown in the LLDP
statistics.). CDP TLVs are mapped onto LLDP neighbors’ table as shown below.

CDP TLV "Device ID" is mapped to the LLDP "Chassis ID" field.

CDP TLV "Address" is mapped to the LLDP "Management Address" field. The CDP address TLV can contain
multiple addresses, but only the first address is shown in the LLDP neighbors’ table.

CDP TLV "Port ID" is mapped to the LLDP "Port ID" field.
CDP TLV "Version and Platform" is mapped to the LLDP "System Description” field.

Both the CDP and LLDP support "system capabilities”, but the CDP capabilities cover capabilities that are
not part of the LLDP. These capabilities are shown as "others" in the LLDP neighbors’ table.

If all ports have CDP awareness disabled, the switch forwards CDP frames received from neighbor devices.
If at least one port has CDP awareness enabled all CDP frames are terminated by the switch.

@ Note: When CDP awareness on a port is disabled the CDP information isn't removed immediately
but gets disabled when the hold time is exceeded.

Port Descr: Optional TLV: When checked the "port description” is included in LLDP information transmitted.
Sys Name: Optional TLV: When checked the "system name" is included in LLDP information transmitted.

Sys Descr: Optional TLV: When checked the "system description" is included in LLDP information
transmitted.

Sys Capa: Optional TLV: When checked the "system capability" is included in LLDP information transmitted.

Mgmt Addr: Optional TLV: When checked the "management address” is included in LLDP information
transmitted.
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Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.

Messages:

Tx Delay must not be larger than 1/4 of the Tx Interval value (IEEE 802.1AB-clause 10.5.4.2)
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This page lets you configure LLDP-MED. This function applies to devices which support LLDP-MED.
Media Endpoint Discovery is an LLDP enhancement, called LLDP-MED, that provides these facilities:

Auto-discovery of LAN policies (such as VLAN, Layer 2 Priority and Differentiated services (Diffserv)

settings) enabling plug and play networking.

Device location discovery allows creation of location databases and, in the case of Voice over Internet

Protocol (VolP), Enhanced 911 services.

Extended and automated power management of Power over Ethernet (PoE) end points is provided.
Inventory management, allowing network administrators to track their network devices, and
determine their characteristics (manufacturer, software and hardware versions, and serial or asset

number).

To configure LLDP-MED:

Select a Policy ID for each port.
Click Apply.

©®No AW

Click System, LLDP, and LLDP-MED Configuration.

Modify Fast Start Repeat Count parameter; the default is 4.
Modify Coordinates Location parameters.

Enter Civic Address Location parameters.

Enter Emergency Call Service parameter.

Click the Add New Policy button and configure a new policy.

JRANSITION™ = e T

LLDP-MED Configuration

Fast Start Repest Count

Fast start repest count

Coordinatss Location

Civic Address Location

Country Code

Dlete Folicy ID Application Type

Folicy Port Configuration

Fort Fobicy 1D

1

o0& &

&

& 00 -

&

County

Black (Heighbarhood)

VLAN ID L2 Priority DsCR

ooooao-*-

Figure 3-5.2: LLDP-MED Configuration page
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Parameter descriptions:

Fast start repeat count

Rapid startup and Emergency Call Service Location Identification Discovery of endpoints is a critically
important aspect of VoIP systems in general. In addition, it is best to advertise only those pieces of
information which are specifically relevant to particular endpoint types (for example only advertise the
voice network policy to permitted voice-capable devices), both in order to conserve the limited LLDPU
space and to reduce security and system integrity issues that can come with inappropriate knowledge of
the network policy.

With this in mind LLDP-MED defines an LLDP-MED Fast Start interaction between the protocol and the
application layers on top of the protocol, in order to achieve these related properties. Initially, a Network
Connectivity Device will only transmit LLDP TLVs in an LLDPDU. Only after an LLDP-MED Endpoint Device
is detected, will an LLDP-MED capable Network Connectivity Device start to advertise LLDP-MED TLVs in
outgoing LLDPDUs on the associated port. The LLDP-MED application will temporarily speed up the
transmission of the LLDPDU to start within a second, when a new LLDP-MED neighbor has been detected
in order share LLDP-MED information as fast as possible to new neighbors.

Because there is a risk of an LLDP frame being lost during transmission between neighbors, it is
recommended to repeat the fast start transmission multiple times to increase the possibility of the
neighbors receiving the LLDP frame. With Fast start repeat count it is possible to specify the number of
times the fast start transmission would be repeated. The recommended value is 4 times, given that 4 LLDP
frames with a 1 second interval will be transmitted, when an LLDP frame with new information is received.

It should be noted that LLDP-MED and the LLDP-MED Fast Start mechanism is only intended to run on
links between LLDP-MED Network Connectivity Devices and Endpoint Devices, and as such does not apply
to links between LAN infrastructure elements, including Network Connectivity Devices, or other types of
links.

Coordinates Location

Latitude: Latitude normalized to within 0-90 degrees with a maximum of 4 digits. It is possible to specify
the direction to either North of the equator or South of the equator.

Longitude: Longitude normalized to within 0-180 degrees with a maximum of 4 digits. It is possible to
specify the direction to either East of the prime meridian or West of the prime meridian.

Altitude: Altitude normalized to within -32767 to 32767 with a maximum of 4 digits.
It is possible to select between two altitude types (floors or meters).
Meters: Representing meters of Altitude defined by the vertical datum specified.

Floors: Representing altitude in a form more relevant in buildings which have different floor-to-floor
dimensions. An altitude = 0.0 is meaningful even outside a building and represents ground level at the
given latitude and longitude. Inside a building, 0.0 represents the floor level associated with ground level
at the main entrance.

Map Datum: The Map Datum is used for the coordinates given in these options:

WGS84: (Geographical 3D) - World Geodesic System 1984, CRS Code 4327, and Prime Meridian
Name: Greenwich.

NADS83/NAVD88: North American Datum 1983, CRS Code 4269, Prime Meridian Name: Greenwich;
the associated vertical datum is the North American Vertical Datum of 1988 (NAVD88). This datum
pair is to be used when referencing locations on land, not near tidal water (which would use Datum
= NAD83/MLLW).
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NADS83/MLLW: North American Datum 1983, CRS Code 4269, Prime Meridian Name: Greenwich;
the associated vertical datum is Mean Lower Low Water (MLLW). This datum pair is to be used when
referencing locations on water/sea/ocean.

Civic Address Location: IETF Geopriv Civic Address based Location Configuration Information (Civic
Address LCI).

Country code: The two-letter ISO 3166 country code in capital ASCII letters - Example: DK, DE or US.
State: National subdivisions (state, canton, region, province, prefecture).
County: County, parish, gun (Japan), district.

City: City, township, shi (Japan) - Example: Copenhagen.

City district: City division, borough, city district, ward, chou (Japan).
Block (Neighborhood): Neighborhood, block.

Street: Street - Example: Poppelve;.

Leading street direction: Leading street direction - Example: N.

Trailing street suffix: Trailing street suffix - Example: SW.

Street suffix: Street suffix - Example: Ave, Platz.

House no.: House number - Example: 21.

House no. suffix: House number suffix - Example: A, 1/2.

Landmark: Landmark or vanity address - Example: Columbia University.
Additional location info: Additional location info - Example: South Wing.
Name: Name (residence and office occupant) - Example: Flemming Jahn.
Zip code: Postal/zip code - Example: 2791.

Building: Building (structure) - Example: Low Library.

Apartment: Unit (Apartment, suite) - Example: Apt 42.

Floor: Floor - Example: 4.

Room no. : Room number - Example: 450F.

Place type: Place type - Example: Office.

Postal community name: Postal community name - Example: Leonia.
P.O. Box: Post office box (P.O. BOX) - Example: 12345,

Additional code: Additional code - Example: 1320300003.

Emergency Call Service: Emergency Call Service (e.g. E911 and others), such as defined by TIA or NENA.

Emergency Call Service: Emergency Call Service ELIN identifier data format is defined to carry the ELIN
identifier as used during emergency call setup to a traditional CAMA or ISDN trunk-based PSAP. This
format consists of a numerical digit string, corresponding to the ELIN to be used for emergency calling.

Policies: Network Policy Discovery enables the efficient discovery and diagnosis of mismatch issues with
the VLAN configuration, along with the associated Layer 2 and Layer 3 attributes, which apply for a set of
specific protocol applications on that port. Improper network policy configurations are a very significant
issue in VoIP environments that frequently result in voice quality degradation or loss of service.
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Policies are only intended for use with applications that have specific 'real-time' network policy
requirements, such as interactive voice and/or video services.

The network policy attributes advertised are:

1. Layer 2 VLAN ID (IEEE 802.1Q-2003)
2. Layer 2 priority value (IEEE 802.1D-2004)
3. Layer 3 Diffserv code point (DSCP) value (IETF RFC 2474)

This network policy is potentially advertised and associated with multiple sets of application types
supported on a given port. The application types specifically addressed are:

1. Voice

2. Guest Voice

3. Softphone Voice

4. Video Conferencing

5. Streaming Video

6. Control / Signaling (conditionally support a separate network policy for the media types above)

A large network may support multiple VoIP policies across the entire organization, and different policies
per application type. LLDP-MED allows multiple policies to be advertised per port, each corresponding to
a different application type. Different ports on the same Network Connectivity Device may advertise
different sets of policies, based on the authenticated user identity or port configuration.

It should be noted that LLDP-MED is not intended to run on links other than between Network
Connectivity Devices and Endpoints, and therefore does not need to advertise the multitude of network
policies that frequently run on an aggregated link interior to the LAN.

Delete: Check to delete the policy. It will be deleted during the next save.

Policy ID: ID for the policy. This is auto generated and is used when selecting the polices that will be
mapped to the specific ports.

Application Type: Intended use of the application; types include:

Voice - for use by dedicated IP Telephony handsets and other similar appliances supporting interactive
voice services. These devices are typically deployed on a separate VLAN for ease of deployment and
enhanced security by isolation from data applications.

Voice Signaling (conditional) - for use in network topologies that require a different policy for the
voice signaling than for the voice media. This application type should not be advertised if all the same
network policies apply as those advertised in the Voice application policy.

Guest Voice - support a separate 'limited feature-set' voice service for guest users and visitors with their
own IP Telephony handsets and other similar appliances supporting interactive voice services.

Guest Voice Signaling (conditional) - for use in network topologies that require a different policy for
the guest voice signaling than for the guest voice media. This application type should not be advertised
if all the same network policies apply as those advertised in the Guest Voice application policy.

Softphone Voice - for use by softphone applications on typical data centric devices, such as PCs or
laptops. This class of endpoints frequently does not support multiple VLANS, if at all, and are typically
configured to use an 'untagged' VLAN or a single 'tagged' data specific VLAN. When a network policy is
defined for use with an 'untagged' VLAN (see Tagged flag below), then the L2 priority field is ignored
and only the DSCP value has relevance.

Video Conferencing - for use by dedicated Video Conferencing equipment and other similar appliances
supporting real-time interactive video/audio services.
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Streaming Video - for use by broadcast or multicast based video content distribution and other similar
applications supporting streaming video services that require specific network policy treatment. Video
applications relying on TCP with buffering would not be an intended use of this application type.

Video Signaling (conditional) - for use in network topologies that require a separate policy for the
video signaling than for the video media. This application type should not be advertised if all the same
network policies apply as those advertised in the Video Conferencing application policy.

Tag : Tag indicating whether the specified application type is using a 'tagged' or an 'untagged' VLAN.

Untagged indicates that the device is using an untagged frame format and as such does not include a tag
header as defined by IEEE 802.1Q-2003. In this case, both the VLAN ID and the Layer 2 priority fields are
ignored and only the DSCP value has relevance.

Tagged indicates that the device is using the IEEE 802.1Q tagged frame format, and that both the VLAN
ID and the Layer 2 priority values are being used, as well as the DSCP value. The tagged format includes
an additional field, known as the tag header. The tagged frame format also includes priority tagged
frames as defined by IEEE 802.1Q-2003.

VLAN ID : VLAN identifier (VID) for the port as defined in IEEE 802.1Q-2003.

L2 Priority: L2 Priority is the Layer 2 priority to be used for the specified application type. L2 Priority may
specify one of eight priority levels (0 through 7), as defined by IEEE 802.1D-2004. A value of O represents
use of the default priority as defined in IEEE 802.1D-2004.

DSCP: DSCP value to be used to provide Diffserv node behavior for the specified application type as
defined in IETF RFC 2474. DSCP may contain one of 64 code point values (0 through 63). A value of 0
represents use of the default DSCP value as defined in RFC 2475.

Port Policies Configuration: Every port may advertise a unique set of network policies or different
attributes for the same network policies, based on the authenticated user identity or port configuration.

Port: The port number to which the configuration applies.

Policy Id: The set of policies that will apply to a given port. The set of policies is selected by check
marking the checkboxes that corresponds to the policies.

Buttons

Add New Policy: Click to add a new policy. Specify the Application type, Tag, VLAN ID, L2 Priority and
DSCP for the new policy. Click "Apply".

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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This page provides a status overview for all LLDP neighbors. The displayed table contains a row for each
port on which an LLDP neighbor is detected. If your network device doesn't support LLDP or if LLDP is not
enabled, the table displays “No LLDP neighbor information found".

Web Interface

To show LLDP neighbors:
1. Click System, LLDP, and LLDP Neighbor.
2. Click Refresh to manually update the web page.

3. Click Auto-refresh to automatically update web page every 3 seconds.

Switch
» System

> System Information

#* IP Address

> System Time

» LLDP

> LLDP Neighbor
* LLDP PoE

> LLDP Statistics

> UPnP

‘ﬂ — || rawsmaEr
TS [ s

SM8TAT2SA-DC
DMS

> LLDP Configuration

> LLDP-MED Configuration

> LLDP-MED Neighbor

LLDP Neighbor Information

Auto-refresh

| Refresh ‘

Local Port
Port Chassis ID Port ID Description
00-Co- §
Port 3 Port #9
F2-7C-5T-B1
AC-CC-BE-AD- AC-CC-BE-
Port 6 etho
Fa-2A AD-F8-2A
00-Co-
Port9 Port #3
F2-7C-5T-B1

System Name

SMBTAT2SA-
DC

axis-
acccBeadfsza

SMBTAT2SA-
DC

System Capabilities

Bridge(+)

Bridge(-), WLAN Access
Point(-), Router(-},
Station Only(+)

Bridge(+)

Figure 3-5.3: LLDP Neighbor Information

Parameter descriptions:

Local Port: The port on which the LLDP frame was received.

Auto-logout 60 min -

@Home - System - LLDP - LLDP Neighbor

System Description

Managed Switch,
8-port Gigabit PoE+,
2-port 100/1000 SFP

AXIS M3106-LVE Mk II
Network Camera
8.30.1.1

Managed Switch,
8-port Gigabit PoE+,
2-pert 100/1000 SFP

Chassis ID: The Chassis ID is the identification of the neighbor's LLDP frames.

Port ID: The Remote Port ID is the identification of the neighbor port.

H 0 ¢

m

Management
Address

192.168.1.77
(IPv4)

192.168.0.90
(IPv4)

192.168.1.77
(IPv4)

Port Description: Port Description is the port description advertised by the neighbor unit.

System Name: System Name is the name advertised by the neighbor unit.

System Capabilities: System Capabilities describes the neighbor unit's capabilities. The possible system
capabilities are: 1. Other, 2. Repeater, 3. Bridge, 4. WLAN Access Point, 5. Router, 6. Telephone, 7. DOCSIS
cable device, 8. Station only, 9. Reserved.

When a capability is enabled, the capability is followed by (+). If the capability is disabled, the capability is

followed by a (-).

System Description: Displays the system description.
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Management Address: The neighbor unit's IP address that is used for higher layer entities to assist

discovery by the network management. This could for instance hold the neighbor’s IP address. You can
click the linked text to display the device webpage. See the example below.

Buttons Auto-refresh

Auto-refresh: Check to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.

Example

e
(=4
®

AXISA AXIS M3106-LVE MK Il Network Camera

i Native view 4

Image = Stream Overlay PTZ Privacy mask Viewarea Apps System v
Appearance Wide dynamic range
?ﬂmaﬁon 10| 50 wor @D
Contrast Local contrast
0 100| 50 0 100| 50 >
Dogbincss e White balance
?harpness 100! 50 Light environment | Automatic v

L
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3-4.4 LLDP PoE

This page provides a status overview for all LLDP PoE neighbors. The displayed table contains a row for
each port on which an LLDP PoE neighbor is detected.
To show LLDP neighbors’ PoE information:

Click System, LLDP, and LLDP PoE.

2. Observe the parameters displayed.
3. Click Refresh to manually update the web page immediately.
4. Click Auto-refresh to automatically update web page every 3 seconds.
=] - s . g G
LLDP Neighbor Power Over Ethernet Information BFome  Sptem - LLDP - LLDP ROl
Auto-refresh
Local Port Power Type Power Sowrce Powver Prioedty M mwem Possser
Port 10 FSE Device Primary Power Supply L 0.0 ['W)

Figure 3-4.3: LLDP Neighbor Power Over Ethernet Information
Parameter descriptions:
Local Port: The port for this switch on which the LLDP frame was received.

Power Type: The Power Type represents whether the device is a Power Sourcing Entity (PSE) or Power
Device (PD). If the Power Type is unknown it is represented as "Reserved".

Power Source: Represents the power source being utilized by a PSE or PD device.

If the device is a PSE device it can either run on its Primary Power Source or its Backup Power Source.

If it is unknown whether the PSE device is using its Primary Power Source or its Backup Power Source it is
indicated as "Unknown".

If the device is a PD, it can either run on its local power supply or it can use the PSE as power source.

It can also use both its local power supply and the PSE.

If it is unknown what power supply the PD device is using it is indicated as "Unknown".

Power Priority: Represents the priority of the PD device, or the power priority associated with the PSE
type device's port that is sourcing the power. The three levels of power priority are Critical, High and
Low. If the power priority is unknown it is indicated as " Unknown'".

Maximum Power: The Maximum Power Value contains a numerical value that indicates the maximum
power in watts required by a PD device from a PSE device, or the minimum power a PSE device is
capable of sourcing over a maximum length cable based on its current configuration.

The maximum allowed value is 102.3 W. If the device value is higher than 102.3 W, it is represented as
"reserved".

Buttons
Auto-refresh: Check this box to refresh the page automatically every 3 seconds.
Refresh: Click to manually refresh the page immediately.
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3-4.4 LLDP-MED Neighbor

This page provides a status overview of all LLDP-MED neighbors. The displayed table contains a row for
each port on which an LLDP neighbor is detected. This function applies to VoIP devices which support
LLDP-MED. If your network has no devices that support LLDP-MED then the table will show “No LLDP-
MED neighbor information found".

Web Interface

To show LLDP-MED neighbor:

1. Click System, LLDP, and LLDP-MED Neighbor.

2. Click Refresh to manually update web page.

3. Click Auto-refresh for auto-update web page.

LLDP-MED Neighbor Information @Home - System - LLDP - LLDP-MED Neighbor
Auto-refresh Refres
Port5
Device Capabilities
Type
Endpoint s : ; 7
Classill LLDP-MED Capabilities, Network Policy, Extended Power via MDI - PD, Inventory
ass
Application Policy Tag VLANID Priority DSCP
Type
Voice
i . Unknown Untagged
Signaling -
Auto- Auto- Auto-negotiation Capabilities MAU Type

negotiation negotiation
status

1000BASE-T half duplex mode, 1000BASE-X, -LX, -SX, -CX full duplex mode , 100BaseTXFD - 2 pair
Supported Enabled Asymmetric and Symmetric PAUSE for full-duplex inks, Symmetric PAUSE for full- category 5 UTP, full duplex
duplex links mode

Figure 3-4.4: LLDP-MED Neighbor Iformation page
Parameter descriptions:
Port: The port on which the LLDP frame was received.

Device Type: LLDP-MED Devices are comprised of two primary Device Types: Network Connectivity
Devices and Endpoint Devices.

LLDP-MED Network Connectivity Device Definition: LLDP-MED Network Connectivity Devices, as
defined in TIA-1057, provide access to the IEEE 802 based LAN infrastructure for LLDP-MED Endpoint
Devices. An LLDP-MED Network Connectivity Device is a LAN access device based on any of these
technologies:

1. LAN Switch/Router

2.IEEE 802.1 Bridge

3. IEEE 802.3 Repeater (included for historical reasons)

4. IEEE 802.11 Wireless Access Point

5. Any device that supports the IEEE 802.1AB and MED extensions defined by TIA-1057 and can relay
IEEE 802 frames via any method.
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LLDP-MED Endpoint Device Definition: LLDP-MED Endpoint Devices, as defined in TIA-1057, are located
at the IEEE 802 LAN network edge, and participate in IP communication service using the LLDP-MED
framework.

Within the LLDP-MED Endpoint Device category, the LLDP-MED scheme is broken into further Endpoint
Device Classes, as defined in the following.

Each LLDP-MED Endpoint Device Class is defined to build on the capabilities defined for the previous
Endpoint Device Class. For-example will any LLDP-MED Endpoint Device claiming compliance as a Media
Endpoint (Class II) also support all aspects of TIA-1057 applicable to Generic Endpoints (Class I), and any
LLDP-MED Endpoint Device claiming compliance as a Communication Device (Class III) will also support
all aspects of TIA-1057 applicable to both Media Endpoints (Class II) and Generic Endpoints (Class I).

LLDP-MED Generic Endpoint (Class I): The LLDP-MED Generic Endpoint (Class I) definition is applicable
to all endpoint products that require the base LLDP discovery services defined in TIA-1057, however do
not support IP media or act as an end-user communication appliance. Such devices may include (but are
not limited to) IP Communication Controllers, other communication related servers, or any device
requiring basic services as defined in TIA-1057.

Discovery services defined in this class include LAN configuration, device location, network policy, power
management, and inventory management.

LLDP-MED Media Endpoint (Class II): The LLDP-MED Media Endpoint (Class II) definition is applicable to
all endpoint products that have IP media capabilities however may or may not be associated with a
particular end user. Capabilities include all of the capabilities defined for the previous Generic Endpoint
Class (Class I) and are extended to include aspects related to media streaming. Example product
categories expected to adhere to this class include (but are not limited to) Voice / Media Gateways,
Conference Bridges, Media Servers, and similar.

Discovery services defined in this class include media-type-specific network layer policy discovery.

LLDP-MED Communication Endpoint (Class III): The LLDP-MED Communication Endpoint (Class III)
definition is applicable to all endpoint products that act as end user communication appliances
supporting IP media. Capabilities include all of the capabilities defined for the previous Generic Endpoint
(Class I) and Media Endpoint (Class II) classes and are extended to include aspects related to end user
devices. Example product categories expected to adhere to this class include (but are not limited to) end
user communication appliances, such as IP Phones, PC-based softphones, or other communication
appliances that directly support the end user.

Discovery services defined in this class include provision of location identifier (including ECS / E911
information), embedded L2 switch support, inventory management.

LLDP-MED Capabilities: LLDP-MED Capabilities describes the neighborhood unit's LLDP-MED capabilities.
The possible capabilities are:

1. LLDP-MED capabilities

2. Network Policy

3. Location Identification

4. Extended Power via MDI - PSE
5. Extended Power via MDI - PD
6. Inventory

7. Reserved
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Application Type: Indicates the primary function of the application(s) defined for this network policy,
advertised by an Endpoint or Network Connectivity Device. The possible application types are:

1. Voice - for use by dedicated IP Telephony handsets and other similar appliances supporting
interactive voice services. These devices are typically deployed on a separate VLAN for ease of
deployment and enhanced security by isolation from data applications.

2. Voice Signalling - for use in network topologies that require a different policy for the voice
signalling than for the voice media.

3. Guest Voice - to support a separate limited feature-set voice service for guest users and visitors
with their own IP Telephony handsets and other similar appliances supporting interactive voice
services.

4. Guest Voice Signalling - for use in network topologies that require a different policy for the guest
voice signalling than for the guest voice media.

5. Softphone Voice - for use by softphone applications on typical data centric devices, such as PCs or
laptops.

6. Video Conferencing - for use by dedicated Video Conferencing equipment and other similar
appliances supporting real-time interactive video/audio services.

7. Streaming Video - for use by broadcast or multicast based video content distribution and other
similar applications supporting streaming video services that require specific network policy
treatment. Video applications relying on TCP with buffering would not be an intended use of this
application type.

8. Video Signalling - for use in network topologies that require a separate policy for the video
signalling than for the video media.

Policy: Indicates that an Endpoint Device wants to explicitly advertise that the policy is required by the
device. Can be either Defined or Unknown

Unknown: The network policy for the specified application type is currently unknown.

Defined: The network policy is defined.

TAG: Indicates whether the specified application type is using a tagged or an untagged VLAN. Can be
Tagged or Untagged.

Untagged: The device is using an untagged frame format and as such does not include a tag
header as defined by IEEE 802.1Q-2003.

Tagged: The device is using the IEEE 802.1Q tagged frame format.

VLAN ID: The VLAN identifier (VID) for the port as defined in IEEE 802.1Q-2003. A value of 1 through 4094
is used to define a valid VLAN ID. A value of O (Priority Tagged) is used if the device is using priority tagged
frames as defined by IEEE 802.1Q-2003, meaning that only the IEEE 802.1D priority level is significant and
the default PVID of the ingress port is used instead.

Priority: The Layer 2 priority to be used for the specified application type. One of the eight priority levels
(0 through 7).

DSCP: The DSCP value to be used to provide Diffserv node behavior for the specified application type as
defined in IETF RFC 2474. Contain one of 64 code point values (0 through 63).

Auto-negotiation: Identifies if MAC/PHY auto-negotiation is supported by the link partner.

Auto-negotiation status: identifies if auto-negotiation is currently enabled at the link partner.
If Auto-negotiation is supported and Auto-negotiation status is disabled, the 802.3 PMD operating mode
will be determined the operational MAU type field value rather than by auto-negotiation.

Auto-negotiation Capabilities: shows the link partners MAC/PHY capabilities.
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Buttons

Auto-refresh: Check to refresh the page automatically every 3 Auto-refresh | S J
seconds.

Refresh: Click to manually refresh the page immediately.
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3-4.5 LLDP Statistics

Two types of counters are shown. Global counters are counters that refer to the whole switch, while Local
counters refer to per port counters for the switch.

Web Interface

To show LLDP Statistics:

1. Click System, LLDP, and LLDP Statistics.

2. Click Refresh to manually update the web screen.

3. Click Auto-refresh to auto-update the web screen.
4

Click Clear to clear all counters.

TRANSITION = L = Auto-logout o C"
N NETWORKS
SMBTATZ2SA LLDP Statistics @bHome - Sysem - LLDP - LLDP Statstics
Switch DMS
Auto-refresh | R Clear |
P System -
m Information LLDP Global Counters
Address ¢
= Neighbor entries were last changed 0 days, 0:06:17 (377 sec. ago)
wEem lime
» LLDP N Total Meighbors Entries Added 1
Total Neighbors Entries Deleted 0
Total Neighbors Entries Dropped 0
DP Neighb
TP Total Neighbors Entries Aged Out 0

> LLDP-MED Neighbor
LLDP Statistics Local Counters

» LLDP Statistics
> UPnP Local Port Tx Frames RxFrames RxErrors Frames Discarded TLVsDiscarded TLVsUnrecognized Org. Discarded Age-Outs
» Port Management < 1 12 49 0 0 0 0 0 0
=} a {
» PoE Management 2 0 0 0 o o o 0 o
» WLAN Management <
3 0 0 0 0 0 0 0 0
» Quality of Service <
4 ] 0 ] Q 0 0 ] 0
» Spanning Tree <
5 0 0 0 ] ] ] ] ]
» MAC Address Table <
b DS < [ 0 ] 0 0 0 0 0 0
» DHCP < 7 0 0 0 4] 4] 4] 0 4]
» Security < g 0 0 0 0 0 0 0 0
» Access Control . 9 0 0 0 0 0 0 0 0
» SNMP & 10 0 0 0 0 0 0 0 0
[ Y S ¢

Figure 3-4.5: LLDP Statistics information
Parameter descriptions:

Global Counters

Neighbor entries were last changed: Shows the time when the last entry was last deleted or added. It
also shows the time elapsed since the last change was detected.

Total Neighbors Entries Added: Shows the number of new entries added since switch reboot.

Total Neighbors Entries Deleted: Shows the number of new entries deleted since switch reboot.
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Total Neighbors Entries Dropped: Shows the number of LLDP frames dropped due to the entry table
being full.
Total Neighbors Entries Aged Out: Shows the number of entries deleted due to Time-To-Live expiring. ]

Local Counters: The displayed table contains a row for each port. The columns display the following
information:

Local Port: The port on which LLDP frames are received or transmitted.

Tx Frames: The number of LLDP frames transmitted on the port.

Rx Frames: The number of LLDP frames received on the port.

Rx Errors: The number of received LLDP frames containing some kind of error.

Frames Discarded: If an LLDP frame is received on a port, and the switch's internal table has run full, the
LLDP frame is counted and discarded. This situation is known as "Too Many Neighbors" in the LLDP
standard. LLDP frames require a new entry in the table when the Chassis ID or Remote Port ID is not
already contained within the table. Entries are removed from the table when a given port's link is down, an
LLDP shutdown frame is received, or when the entry ages out.

TLVs Discarded: Each LLDP frame can contain multiple pieces of information, known as TLVs (TLV is short
for "Type Length Value"). If a TLV is malformed, it is counted and discarded.

TLVs Unrecognized: The number of well-formed TLVs, but with an unknown type value.
Org. Discarded: The number of organizationally received TLVs.

Age-Outs: Each LLDP frame contains information about how long time the LLDP information is valid (age-
out time). If no new LLDP frame is received within the age out time, the LLDP information is removed, and
the Age-Out counter is incremented.

Buttons Auto-refresh

Auto-refresh: Check to refresh the page automatically every 3
seconds.

Refresh: Click to manually refresh the page immediately.

Clear: Clears the counters for the selected port.
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3-5 UPnP

The goals of UPnP (Universal Plug and Play) are to allow devices to connect seamlessly and to simplify the
implementation of networks in the home (data sharing, communications, and entertainment) and in
corporate environments for simplified installation of computer components.

Web Interface

To configure the UPnP Configuration in the web interface:
Click System and UPnP.

2. Scroll to select the mode to enable or disable.
3. Specify the parameters in each field.
4. Click the Apply button to save the settings.
5. To cancel the setting click the Reset button to revert to previously saved values.
ﬁ — wr{snﬁi‘ Auto-logout w
TRANSITION ' = = Auto-logout 2 I
N\ NETWORKS. )
SM8TAT2SA UPnP Configuration rome - System - UPne
Switch DMS
Mode ﬂ:.:'
» System M ’
» System Information Interface VLAN 1
# IP Address
> System Time TTL 4
» LLDP
Advertising Duration 100
> UPnP
» Port Management <

Figure 3-5: UPnP Configuration page
Parameter descriptions:
Mode: Indicates the UPnP operation mode. Possible modes are:

Enabled: Enable UPnP mode operation.
Disabled: Disable UPnP mode operation.

When Mode is enabled, two ACEs are added automatically to trap UPNP related packets to the CPU. The
ACEs are automatically removed when the mode is disabled.

Interface VLAN: The Interface VLAN value is used by UPnP to send SSDP advertisement messages for the
Interface VLAN. Valid values are VIDs 1 - 4095.

TTL: The Time To Live (TTL) value is used by UPnP to send SSDP advertisement messages. Valid values are
1 - 255 seconds.

Advertising Duration: The duration, carried in SSDP packets, is used to inform a control point or control
points how often it or they should receive an SSDP advertisement message from this switch. If a control
point does not receive any message within the duration, it will think that the switch no longer exists. Due
to the unreliable nature of UDP, in the standard it is recommended that such refreshing of advertisements
to be done at less than one-half of the advertising duration. In the implementation, the switch sends SSDP
messages periodically at the interval one-half of the advertising duration minus 30 seconds. Valid values
are 100 - 86400 seconds.

33717 Rev.J https://www.transition.com Page 47 of 304



https://www.transition.com/

Transition Networks SMXTAT2SA Web User Guide

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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This page lets you configure switch Port parameters and enable or disable a switch Port. You can also
monitor the ports’ speed and flow control status here.

4-1 Port Configuration

This page lets you view and configure current port parameters.

Web Interface

To set Port Configuration parameters in the web UL

1. Click Port Management and Port Configuration.

2. Specify the Maximum Frame Size, Speed Mode, Flow Control, and Description parameters.

3. Click the Apply button.

LT — | TRANSTION®
TS <[

SM16TAT2SA Port Configuration
Switch DMS
| Refresh |
b System < —
Maximum Frame Size
» Port Management v

> SFP Port Information Port Link

t Ethernet

1 o

<
ction < 2 .

» PoE Management <
i 3 [

» VLAN Management <
» Quality of Service < 4 .

» Spanning Tree <
P 2 5 .

» MAC Address Table <
» Multicast & g .

Parameter descriptions:

Speed

Status

1Gfdx

1Gfdx

down

down

down

down

Mode

Auto

Auto

Auto

Auto

Auto

Auto

Flow Control

Rx Status

On

Tx Status

On

On

Figure 4-1: Port Configuration page

Auto-logout

Mode

O
(]
O
O
O

O

2 I

Port Managsment - Port Configurstion

Description

Maximum Frame Size : Maximum packet length filtering is examined on both receiving and transmitting
ports. Enter the maximum frame size allowed for the switch port, including FCS. The valid range is 1518-
10000 bytes. The default value is 10,000 bytes. FW v1.04.0009 added Maximum Frame Size setting per

system in the Port Configuration.

Port: This is the logical port number for this row.

Link: The current link state is displayed graphically. Green means the link is up and red means it is down.

Status: Provides the current link speed of the port if the port is up, otherwise displays ‘down".
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Mode: (Configured Link Speed) Select any available link speed for the given switch port.
Only speeds supported by the specific port are shown. Possible speeds are:

Mode

Disabled - Disables the switch port operation.

Auto - Port auto negotiating speed with the link partner and selects the highest speed
that is compatible with the link partner.
10Mbps FDX

10Mbps HDX - Forces the cu port in 10Mbps half-duplex mode. 100MEpa HDK
10Mbps FDX - Forces the cu port in 10Mbps full duplex mode. i;b'F'EFF:E“
100Mbps HDX - Forces the cu port in 100Mbps half-duplex mode.

100Mbps FDX - Forces the cu port in 100Mbps full duplex mode.
1Gbps FDX - Forces the port in 1Gbps full duplex mode.

10Mbps HDX

Dizabled

100Mbps FOX
1Gbps FDX

Flow Control: When Auto Speed is selected on a port, this section indicates the flow control
capability that is advertised to the link partner. When a fixed-speed setting is selected, that is
what is used.

The Rx Status column indicates whether pause frames on the port are obeyed, and the Tx Status column
indicates whether pause frames on the port are transmitted. The Rx and Tx Status settings are determined
by the result of the last Auto-Negotiation.

Check the Flow Control Mode checkbox to use flow control. This setting is related to the setting for
Configured Link Speed.

Description: Enter up to 63 characters to be descriptive name for identifies this port. Specify the detail
Port alias or description; an alphanumeric string describing the full name and version identification for the
system'’s hardware type, software version, and networking application.

Buttons
Refresh: Click to refresh the Port link Status manually.
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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This page displays Port statistics information and provides an overview of general traffic statistics for all

switch ports.

Web Interface

To display the Port Statistics Overview in the web UL

1. Click Port Management and Port Statistics.

To automatically refresh the page select "Auto-refresh”.

2
3. Click " Refresh” to refresh the port statistics or clear all information when you click “Clear”.
4

To view detailed port statistics, click that port.

R 2 IR > W

TRANSITION © =| mwsnan .
N NETWORKS. -
SM24TAT2SA Port Statistics Overview
Switch DMS T,
Auto-refresh | Refresh || Clear |
P System < -
S Eerl ey v Packets Bytes Errors
t Manageme
» Port Configuration Port Received Transmitted Received Transmitted Received Transmitted
Port S
1 23656 28223 5124166 11706707 0 a
» SFP Port Information
» Emergy Efficient Ethernet - 0 g g 0 0 o
< 3 0 0 0 Q Q 0
otection <
4 0 15821 0 26756048 1] 0
» PoE Management % ~ ~
5 1382 14549 4§3372 2357369 4] a
» VLAN Management <
6 2956 126873 1407236 1268524 4] a
» Quality of Service <
- ) ¢ 7 0 0 0 4] 4] a
» Spanning Tree
» MAC Address Table < E 0 g g 0 o o
¥ Multicast < 9 0 0 0 0 0 0
» DHCP ¢ lw o 0 0 0 0 0

Parameter descriptions:

Port: The logical port for the settings contained in the same row.

Figure 4-2: Port Statistics Overview page

Packets: The number of received and transmitted packets per port.

Bytes: The number of received and transmitted bytes per port.

Drops
Received
0

0

Transmitted

0

Errors: The number of frames received in error and the number of incomplete transmissions per port.

Drops: The number of frames discarded due to ingress or egress congestion.
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Buttons Auto-refresh Refresh || Clear

Auto-refresh: Click to refresh the page automatically every 3
seconds.

Refresh: Click to manually refresh the page immediately.
Clear: Clears the counters for all ports.

Click a linked port to see its Detailed Port Statistics. The displayed counters are the totals for receive and
transmit, the size counters for receive and transmit, and the error counters for receive and transmit.

TRANSITION \ =| »=* = puto-logout M @ G
N NETWORKS.
SM8TAT2SA Detailed Port 1 Statistics @Homs - Port Managsment - Port Statistics
Switch DMS ———
Auto-refresh | Refresh || Clear | Portl v
P System <
» Port Management » Receive Total Transmit Total
> Port Configuration Rx Packets 284959 Tx Packets 12593
> Port Statistics
Rx Octets 178705128 Tx Octets 4035256
> SFP Port Information
> i T Rx Unicast 7584 Tx Unicast 11682
= a8y
» Link Aggregation < Rx Multicast 208616 Tx Multicast a5
Loop Pratecti
» Loop Protection ¢ Rx Broadcast 68759 Tx Broadcast 826
» PoE Management <
o= Rx Pause 0 Tx Pause 0
» VLAN Management E
» Quality of Service ¢ Receive Size Counters Transmit Size Counters
i g <
» Spanning Tree Rx 64 Bytes 57660 T 64 Bytes 3861
» MAC Address Table <
Rx 65-127 Bytes T447 Tx 65-127 Bytes 1099
» Multicast N
Rx 128-255 Bytes 2001 Tx 128-255 Bytes 3591
» DHCP <
Rx 256-511 Bytes 117894 Tx 256-511 Bytes 1437
» Security E
» Access Control ¢ Rx 512-1023 Bytes 3350 Tx 512-1023 Bytes 2104
» SNMP < Rx 1024-1518 Bytes 86607 Tx 1024-1518 Bytes 501
» Event Notification < Rx 1519-max Bytes 0 Tx 1519-max Bytes 0
» Diagnostics <
» Maintenance < Receive Error Counters Transmit Error Counters
Rx Drops 207947 Tx Drops 0
Rx CRC/Alignment 0 Tx Late Collision 0
Rx Undersize 0 Tx Excessive Collision 0
Rx Oversize 0 Tx Oversize 0

Figure 4-2: Detailed Port Statistics page
Parameter descriptions:

Receive Total and Transmit Total

Rx and Tx Packets: The number of received and transmitted (good and bad) packets.

Rx and Tx Octets: The number of received and transmitted (good and bad) bytes. Includes FCS but excludes
framing bits.
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Rx and Tx Unicast: The number of received and transmitted (good and bad) unicast packets.
Rx and Tx Multicast: The number of received and transmitted (good and bad) multicast packets.
Rx and Tx Broadcast: The number of received and transmitted (good and bad) broadcast packets.

Rx and Tx Pause: A count of the MAC Control frames received or transmitted on this port that have an
opcode indicating a PAUSE operation.

Receive and Transmit Size Counters: The number of received and transmitted (good and bad) packets
split into categories based on their respective frame sizes.

Receive Error Counters

Rx Drops: The number of frames dropped due to lack of receive buffers or egress congestion.
Rx CRC/Alignment: The number of frames received with CRC or alignment errors.

Rx Undersize: The number of short 1 frames received with valid CRC.

Rx Oversize: The number of long 2 frames received with valid CRC.

Rx Fragments: The number of short 1 frames received with invalid CRC.

Rx Jabber: The number of long 2 frames received with invalid CRC.

Rx Filtered: The number of received frames filtered by the forwarding process.
Short frames are frames that are smaller than 64 bytes.
Long frames are frames that are longer than the configured maximum frame length for this port.

Transmit Error Counters

Tx Drops: The number of frames dropped due to output buffer congestion.

Tx Late/Exc. Coll.: The number of frames dropped due to excessive or late collisions.

Auto-refresh

Buttons
Auto-refresh: Click to refresh the page automatically every 3 seconds.
Refresh: Click to manually refresh the page immediately.

Clear: Clears the counters for the selected port.
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4-3 SFP Port Info

This page displays detailed SFP module information when an SFP is connected to the switch.
The information includes Connector type, Fiber type, wavelength, bit rate, Vendor OU], etc.

Web Interface

To display the SFP information in the web interface:
1. Click Port Management and SFP Port Info.
2. Use the port select dropdown to select the desired port.
3. View the displayed SFP Information.

TRANSITION — JRANSITIE N Auto-logout -m 0 c’
N NETWORKS -
SMETAT2SA SFP Port Information @8Home - Port Menagement » SFP Fort Infarmetion
Switch DMS
Auto-refresh | Refresh ots W
» System <
g
¥ Port Management h port -
> Port Configuration Connector Type SFP ar 5FP Plus - LC
Fiber Type Multi-mode (MM)
Tx Central Wavelength 250
< Bit Rate 1000 Mbps
7 oo Fretction ¢ vendorou 00-c0-12
» PoE Management < -
Vendor Name Transition
» VLAN Management <
Vendor P/N TN-S5FP-5X
» Quality of Service %
) Vendor Revision 0000
» Spanning Tres J
b MAC Address Table < Vendor Serial Number 8772662
¥ Multicast < Date Code 101022
» DHCP < Temperature none
P Security < Ve nane
b Access Control < .
Monl (Bias) none
» SNMP .
Mon2 (TX PWR) none
» Event Motification <
) ) Mon3 (RX PWR) nane
» Diagnostics <

Figure 4-3: SFP Port Information page
Port select scroll bar: Use the dropdown to select the port to display its Port statistics (e.g., Port 9).
Connector Type: Display the connector type (e.g., SFP, SFP Plus, Reserved - LC, SC, ST, LC, etc.).
Fiber Type: Display the fiber mode, for instance, Multi-Mode (MM) or Single-Mode (SM).

Tx Central Wavelength: Display the fiber optical transmitting central wavelength, for instance, 850nm,
1310nm, 1550nm, etc.

Bit Rate: Displays the nominal bit rate of the transceiver.

Vendor OUI: Displays the Manufacturer's OUI (Organizationally Unique Identifier) code which is assigned
by IEEE.
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Vendor Name: Displays the company name of the module manufacturer.
Vendor P/N: Displays the product name of the naming by module manufacturer.
Vendor Revision: Displays the module revision.

Vendor Serial Number: Shows the serial number assigned by the manufacturer.
Date Code: Shows the date this SFP module was made.

Temperature: Shows the current temperature of SFP module.

Vcc: Shows the working DC voltage of SFP module.

Mon1(Bias) mA: Shows the Bias current of SFP module in milliamps.

Mon2(TX PWR): Shows the transmit power of SFP module in dBm.

Mon3(RX PWR): Shows the receiver power of SFP module in dBm.

Auto-refresh

Buttons
Auto-refresh: Check to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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4-4 Energy Efficient Ethernet

This page lets you view and configure the current EEE port settings.

EEE (Energy Efficient Ethernet) is defined in IEEE 802.3az as a power saving option that reduces the power

usage when there is very low traffic utilization (or no traffic).

EEE works by powering down circuits when there is no traffic. When a port gets data to be transmitted all
circuits are powered up. The time it takes to power up the circuits is named wakeup time. The default
wakeup time is 17 us for 1Gbit links and 30 us for other link speeds. EEE devices must agree upon the
value of the wakeup time in order to make sure that both the receiving and transmitting device has all
circuits powered up when traffic is transmitted. The devices can exchange information about the devices

wakeup time using the LLDP protocol.

Web Interface

To configure Energy Efficient Ethernet in the web interface:
1. Click Port Management and Energy Efficient Ethernet.
2. For each port select enable or disable Energy Efficient Ethernet.
3. Click the Apply button to save the settings.
4. To cancel the setting click the Reset button to revert to previously saved values.

TRANSITIDN = Ll il Auto-logout
N\ NETWORKS«
SM8TAT2SA Energy Efficient Ethernet Configuration = @reme - Fortiansgement

Switch DMS

Port Energy Efficient Ethernet Configuration
» System <
» Port Management 2 Port Configure
» Port Configuration 1 Disabled
> Port Statistics
> SFP Port Information 2 Enabled ¥
» Energy Efficient Ethernet

3 Enabled v
» Link A ation <
» Loop Protection < 4 Enabled w
» PoE Management <

5 Enabled W
» VLAN Management <
» Quality of Service : 6 Frabled ¥
» Spanning Tree < 7 Dissbled v
» MAC Address Table :

23 Disabled
» Multicast §
» DHCP ¢ 9 Disabled W
» Security 4 10 Disabled v
» Access Control <
» SNMP <

Figure 4-4: Port Energy Efficient Ethernet Configuration
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Parameter descriptions:
Port: The switch port number of the logical EEE port.

Configure: Controls whether EEE is Enabled or Disabled for each switch port.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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4-5 Link Aggregation » Li
4_5.1 Port » Configuration
» Aggregation Status
This section describes Port setting/status used to configure the trunk properties of > Aggregator View
each port. > Aggregation Hash Made
» LACP System Priority
Web Interface ’

To configure the trunk property of each and every port in the web interface:
1. Click Port Management > Link Aggregation > Port Configuration.
2. Specify the Method, Group, LACP Role and LACP Timeout.
3. Click the Apply button to save the settings.
4. To cancel the setting click the Reset button to revert to previously saved values.

‘\ ANSITION . TR :
TRANSITION | - Auto-logout H 0 C.
\-’ NETWORKS - T
SM8TAT2SA Trunk Port Configuration/Status @Home - FortMansgement - LinkAggregation - Configuration
Switch DMS
Trunk Port Configuration/Status
» System <
» Port Management w Trunk Port Configuration Trunk Port Status
> Port Configuration Port  Method Group LACP Role LACP Timeout Aggr Status
> Port Statistics
) 1 Mone % 0w Active v Fast W 1 Ready
> SFP Port Information
> Energy Efficient Ethernet 2 None 0 v Active W Fast W 2 -
» Link A v
> Configuration 3 Mone % 0w Active v Fast W 3 -—
> Aggregation Status .
4 None v 0 v Active v Fast ¥ 4 -
> Aggregator View
> Aggregation Hash Mode 5 None v 0 v Active v Fast v 5 -
> LACP System Priority
6 MNone W 0 v Active W Fast W 6 --=
» Loop Protection <
» PoE Management < 7 MNone v 0w Active W Fast W T --=
\ <
» VLAN Management a None D Active v Fast v a .
» Quality of Service <
i g MNone v 0w Active W Fast W+ 9 -
» Spanning Tree <
» MAC Address Table E 10 Mone 0 v Active W Fast 10 -
» Multicast 5 —
» DHCP ¢ | Apply || Reset |

Figure 4-5.1: Trunk Port Configuration/Status page
Parameter descriptions:

Port Trunk Configuration:

Port: The logical port number for the settings contained in the row.
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Method: This determines the method a port uses to aggregate with other ports.
None: A port does not want to aggregate with any other port should choose this default setting.
LACP: A port use LACP as its trunk method to get aggregated with other ports also using LACP.
Static: A port use Static Trunk as its trunk method to get aggregated with other ports also using
Static Trunk.

Group: Ports choosing the same trunking method other than “None” must be assigned a unique Group
number (i.e., Group ID; valid value is 1 - 8) in order to declare that they wish to aggregate with each other.
LACP Role: This field is only referenced when a port's trunking method is LACP.

Active: An Active LACP port begins to send LACPDU to its link partner right after the LACP protocol
entity started to take control of this port.

Passive: A Passive LACP port will not actively send LACPDU out before it receives an LACPDU from
its link partner.
LACP Timeout: The Timeout controls the period between BPDU transmissions.
Fast: It will transmit LACP packets each second,
Slow: It will wait for 30 seconds before sending a LACP packet.

Port Trunk Status:

Aggr: Abbreviation of "aggregator”. Every port is also an aggregator, and its own aggregator ID is the
same as its own Port number. We can regard an aggregator as a representative of a trunking group. Ports
with the same Group ID and using same trunking method will have the opportunity to aggregate to a
particular aggregator port. This aggregator port is usually the port with the smallest Port No. within the
trunking Group.

Status: This field represents the trunking status of a port which uses a trunking method other than
“None”. It also represents the management link status of a port which uses the “None” trunking method.
"---"'means "not ready”

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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4-5.2 Aggregation Status

This page displays the current port trunking information from the aggregator point of status (added at FW
v 1.02.1463).

Web Interface

To see the LACP detail in the web interface:

1. Click Port Management, Link Aggregation, and Aggregation Status.
2. View the displayed status.
3. Click the Auto-refresh and Refresh buttons as needed.

‘ﬂ TRANSITION *
TRANSITION = = Auto-logout OFF = o C.
N NETWORKS. -
SMETAT2SA Aggregation Status @Home - Port t- Link ion - Aggresation Status
Switch DMS PR =
Auto-refresh | Refresh |
» System < —

" Aggregation Status

> Port Configuration . .
AggrID Name Type  Speed  Configured Ports Aggregated Ports Aggregated Bandwidth

> Port Statistics

> SFP Port Information ° LLAGS LACP 16 ° ° 16

> Energy Efficient Ethernet 10 LLAG10 LACP  1G 10 10 1G

Figure 4-5.2: Port Management > Link Aggregation > Aggregation Status

Parameter descriptions:

Aggr ID: Shows the aggregator ID of aggregator ports.

Name: Show the aggregator Name of aggregator ports.

Type: Show the type a port uses to aggregate with other ports.

Speed: Show the port link speed of aggregator ports.

Configured Ports: Show all config ports of aggregator ports.

Aggregated Ports: Show all aggregated ports of aggregator ports.

Aggregated Bandwidth: Show the ports aggregated link speed bandwidth of aggregator ports.

Buttons
Auto-refresh: Check this box to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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This page displays the current port trunking information from the aggregator point of view.

Web Interface

To see the LACP detail in the web interface:

1. Click Port Management, Link Aggregation, and Aggregator View.
2. Click the LACP Detail radio button.
3. Click the LACP Detail button.

=
JRANSITION

SM8TAT2SA
Switch DMS
b System

» Port Management

> Port Configuration

v

Aggregation Status

w

Aggregator View

e

Aggregation Hash Mode

w

LACP System Priority
» Loop Protection

» PoE Management

» VLAN Management

» Quality of Service

» Spanning Tree

~

— JRANSITAR i} Auto-logout o C.
Aggregator View @hHome - Forti t - LinkAzgregstion ~ AzgragstorView
Aggregator \liew
Aggregator Method Member Ports Ready Ports LACP Detail
1 None 1 1 @
2 None 2 O
3 None 3 O
4 None 4 O
5 None 5 O
6 None 6 O
7 None 7 O
8 None 8 O
9 None 9 O
10 None 10 O

| LACP Detail |

Figure 4-5.3: Aggregator View page

Parameter descriptions:

Aggregator: Shows the aggregator ID of every port. In fact, every port is also an aggregator, and its own

aggregator ID is the same as its own Port number.

Method: Show the method a port uses to aggregate with other ports.

Member Ports: Show all member ports of an aggregator (port).

Ready Ports: Show only the ready member ports within an aggregator (port).

LACP Detail: Lets you select the port that you want to see the LACP Detail.
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Buttons

LACP Detail: Click this radio button to display the Aggregator Information for the selected Aggregator as
described below.

TRANSITION \ | T il Auto-logout = o C*
N NETWORKS.
SMSTATQ SA Aggl‘egator l |I’|f0rm at'on @@Home - PortManagement - Link Aggregation - Aggregator View
Switch DMS
Aggregator Information
» System <
» Port Management v Actor Partner
» Port Configuration
System Priority Mac Address System Priority Mac Address
> Port Statistics
N P ——— 32768 00-C0-F2-48-AB-14 32768 00-00-00-00-00-00
> Energy Efficient Ethernet
v Actor Port Actor Key Trunk Status Partner Port Partner Key
1 259 Ready 1 0
| Back|

> Aggregation Hash Mode
Figure 4-5.4: LACP Detail page

Parameter descriptions:

Actor

System Priority: Show the System Priority part of the aggregation Actor. (1-65535).

Mac Address: The system ID of the aggregation Actor.

Actor Port: The actor's port number connected to this port.

Actor Key: The Key that the actor has assigned to this aggregation ID.

Partner

System Priority: Show the System Priority part of the aggregation partner. (1-65535)
Mac Address: The system ID of the aggregation partner.

Partner Port: The partner's port number connected to this port.

Partner Key: The Key that the partner has assigned to this aggregation ID.

Trunk Status: This field represents the trunking status of a port which uses a trunking method other than
“None”. It also represents the management link status of a port which uses the “None” trunking method.
"---" means "not ready".

Button

Back: Click to undo any changes made locally and return to the Aggregator View page.

Messages: Method must be LACP and Member Ports must have a port at least.
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4-5.4 Aggregation Hash Mode

Aggregation Mode lets you select one of several Hash code contributors to calculate the destination port
for the frame.

Web Interface

To configure the Aggregation hash mode in the web interface:
1. Click Port Management, Link Aggregation, and Aggregation Hash Mode.
2. Click Hash Code Contributors to select the mode.
3. Click the Apply button to save the settings.
4. To cancel the setting, click the Reset button to revert to previously saved values.

TRANSITION \ || e : Auto-logout [OFF _ v| [} o G

— : =
=" NETWORKS. ks
SM8TAT2SA Aggregation Mode Configuratiome-ome - rortuanagement - Link azgregation - azsregation Hash ode
Switch DMS
Aggregation Mode Configuration
» System
» Port Management v Hash Code Contributors
> Port Configuration .
dst-ip v
> Port Statistics src-mac
> SFP Port Information |_ dst-mac
src-gst-mac
> Energy Efficient Ethernet 1 srcip

» Link Aggregation . _
src-gst-ip

» Configuration

> Aggregation Status
> Aggregator View
» Aggregation Hash Mode
Figure 4-5.5: Aggregation Hash Mode
Parameter descriptions:

Hash Code Contributors

src-mac: The Source MAC address can be used to calculate the destination port for the frame. Check to
enable the use of the Source MAC address or uncheck to disable. By default, Source MAC Address is
enabled.

dst-mac: The Destination MAC Address can be used to calculate the destination port for the frame. Check
to enable the use of the Destination MAC Address or uncheck to disable. By default, Destination MAC
Address is disabled.

ip: The IP address can be used to calculate the destination port for the frame. Check to enable the use of
the IP Address, or uncheck to disable. By default, IP Address is enabled.

src-dst-mac: Use Source MAC Address + Destination MAC Address.

src-ip: Use Source MAC Address + IP Address.

dst-ip: Use Destination MAC Address + IP Address.

src-dst-ip: Use Source MAC Address + Destination MAC Address + IP Address.
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Buttons
Apply : Click to save changes.

Reset : Click to undo any changes made locally and revert to previously saved values.
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4-5.5 LACP System Priority

This page lets you set the priority part of the LACP system ID. LACP will only aggregate together the ports
whose peer link partners are all on a single system. Each system that supports LACP will be assigned a
globally unique System Identifier for this purpose. A system ID is a 64-bit field comprising a 48-bit MAC
Address and 16-bit priority value. The System Priority is configurable; its range is 1 - 65535. The default is
32768.

Web Interface
To configure the LACP System Priority in the web interface:

1. Click Port Management, Link Aggregation, and LACP System Priority.

2. Specify the LACP System Priority.

3. Click the Apply button to save the settings.

4. To cancel the setting click the Reset button to revert to previously saved values.

‘ﬂ TRERSITION * A FF
TRANSITION © =| == o
— N .
N NETWORKS
Sr\ﬂ BTATESA I_ACP System Prio ﬁty @Home - PortManagement - Link Aggregation - LACP Systemn Priority
Switch DMS
LACP System Priority
P System 5
» Port Management v System Priority 32768

Figure 4-5.6: The LACP System Priority page

Parameter descriptions:

System Priority: Show the System Priority part of a system ID (1-65535).

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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4-6 Loop Protection
4-6.1 Configuration

Loop Protection is used to detect the presence of traffic. When the switch receives packet’s (looping
detection frame) MAC address the same as oneself from port, Loop Protection is shown. The port will be
locked when it receives the looping Protection frames. If you want to resume the locked port, find and
remove the looping path, then select the locked port and click on “Resume” to turn on the locked ports.

Web Interface

To configure the Loop Protection parameters in the web interface:

1. Click Port Management, Loop Protection, and Configuration.
2. Select "on" to enable port Loop Protection globally.
3. Click the Apply button to save the settings.
4. To cancel the setting, click the Reset button to revert to previously saved values
TRANSITION \ — TR T Auto-logout H o C»
N\ NETWORKS.
SM8TAT2SA Loop Protection Configuration @+ome - PortManagement - Loop Protection -~ Configurstion
Switch DMS
Global Configuration
b System <
» Port Management e Enable Loop
R Protection
> Port Configuration
> Port Statistics Transmission Time 5 seconds
> SFP Port Information
i Shutdown Time 180 seconds
> Energy Efficient Ethernet
% Link Aggregation <
» Loop Protection v Port Configuration
> Configuration
Port Enable Action Tx Mode
> Status
* | ] = ~ = v
» PoE Management < —
» VLAN Management < 1 (v Shutdown Port v Enable v
» Quality of Service K _
2 [v] Shutdown Port ~ Enable W
» Spanning Tree <
» MAC Address Table ¢ 3 |Z| Shutdown Port v Enable w
» Multicast ¥ 4 v Shutdown Port v Enable
» DHCP < -
5 [w] Shutdown Port b Enable W
¥ Security <
» Access Control < 5} |z| Shutdown Port ~ Enable
s STIF ¢ T |z| Shutdown Port A Enable w
» Event Notification R -
8 %} Shutdown Port hd Enable W
» Diagnostics <
» Maintenance < 9 |2| Shutdown Port ~ Enable ~
10 |2| Shutdown Port v Enable w

| Apply || Reset |

Figure 4-6.1: The Loop Protection Configuration page
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Global Configuration

Enable Loop Protection: Controls whether loop protections is enabled (as a whole).

Transmission Time: The interval between each loop protection PDU sent on each port. Valid values are 1
to 10 seconds.

Shutdown Time: The period (in seconds) for which a port will be kept disabled in the event of a loop is
detected (and the port action shuts down the port). Valid values are 0 - 604800 seconds (7 days).
A value of zero will keep a port disabled (until next device restart).

Port Configuration

Port: The switch port number of the port.

Action
Enable: Controls whether loop protection is enabled on this switch port.
Action: Configures the action performed when a loop is detected on a port. Shutg@-'-l-'" Portand Log
Valid values are Shutdown Port, Shutdown Port and Log, or Log Only. e

Tx Mode: Controls whether the port is actively generating loop protection PDUs, or whether it is just
passively looking for looped PDUs.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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4-6.2 Status

This section displays the loop protection port status.

Web Interface

To display the Loop Protection status in the web interface:

1. Click Port Management, Loop Protection, and Status.

2. To automatically refresh the information, select “Auto refresh”.

3. Click "Refresh” to refresh the Loop Protection Status.

ﬁ _
JBANSITION ™ =

SM8TAT25A

Switch

>

» Port Management

» Port Configuration

>

>

>

»

»

»

>

»

>

Parameter descriptions:

Port: The switch port number of the logical port.

System

Port Statistics

SFP Port Information
Energy Efficient Ethernet
Link Aggregation

Loop Protection

» Configuration

> Status

PoE Management
VLAN Management

Quality of Service

Spanning Tree

o

=,
‘T_IEHISI'_[_ICIN F 1

Loop Protection Status

Auto-refresh

Port

1

10

Action

Log

Log

Shutdown and Log
Shutdown and Log
Shutdown and Log
Shutdown
Shutdown
Shutdown
Shutdown

Shutdown

| Refresh |

Transmit

Enabled

Enabled

Disabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Loops

SMXTAT2SA Web User Guide

Auto-logout o C*

#eHoms

Status
Up
Down
Down
Down
Down
Down
Down
Down
Down

Down

Figure 4-6.2: Loop Protection Status

Loop

Port Management ~ Loop Protection = Status

Time of Last Loop

Action: The currently configured port action (Shutdown Port, Shutdown Port and Log, Log Only).

Transmit: The currently configured port transmit mode.

Loops: The number of loops detected on this port.

Status: The current loop protection status of the port.

Loop: Whether a loop is currently detected on the port.

Time of Last Loop: The time of the last loop event detected.
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Buttons

Auto-refresh: Check to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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Chapter 5 - POE Management

PoE (Power over Ethernet) is used to transmit electrical power to remote devices over
standard Ethernet cable. PoE can be used for powering IP cameras, wireless LAN access
points and other equipment, where it would be difficult or expensive to connect

equipment to the main power supply.

5-1 PoE Configuration

SMXTAT2SA Web User Guide

» PoE Management

> PoE Configuration

> PoE Status

> PoE Power Delay

> PoE Auto Power Reset

» PoE Scheduling Profile

This page lets you view and configure current PoE port settings and show PoE Supply power.

Web Interface

To configure Power over Ethernet in the web interface:
1. Click PoE Management and PoE Configuration.

2. Specify Reserved Power, Capacitor Detection, POE Mode, PoE Schedule, Priority, and Maximum

Power.

3. Click Apply to save the configuration.

Maintenance

TRANSITION ® =| =% : ====
= H . -
'\-"" NETWORKS 310
SM8TAT2SA Power Over Ethernet Configuration
Switch DMS
Primary Power Supply [W] 130
» System .
< Reserved Power @a ) Allocati
» PortM t . (@) Class () Allocation
ort Managemen determined by
» PoE Management e
Capacitor Detection
> PoE Configuration P O
> PoE Status
> PoE Power Delay PoE Port Configuration
» [ReEi i = Port PoE Mode PoE Schedule
> PoE Scheduling Profile
1 Enabled IZI Disabled
» VLAN Management .
» Quality of Service < 2 Enabled IZI Disabled
i <
D SIS 3 Ensbled B Disabled
» MAC Address Table .
4 Enabled IZI Disabled
» Multicast .
» DHCP < 5 Enabled IZI Disabled
» i <
SEEI 6 Enabled IZI Disabled
» Access Control <
T Enabled IZI Disabled
» SNMP <
» Event Notification < 8 Enabled |Z| Disabled
» Diagnostics < . B i
N < | Apply || Reset |

(O LLDP-Med

| »

Auto-logout  OFF -

2 B

@Home - PoE Mansgement - PoE Configurstion

m

Priority Maximum Power [W]

Critical IZI 30

E E E EEEEE
KN

Figure 5-1: PoE Configuration

Parameter descriptions:

Primary Power Supply [W]: Displays the primary power supply power in watts (e.g., 130 Watts).
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Reserved Power determined by: Radio button to select one of two modes for configuring how the
ports/PDs may reserve power:

Class: The PD will negotiate PD class then feed power if the PD request power complies with the
standard. If Maximum Power at the port is configured different then factory default value 30W, the
PD connects the port again; the PD cannot draw more power than the new configured Maximum
Power for the port. Class mode is the factory default mode. Note: Starting at FW v1.01.1195, when
the Maximum Power per port value is changed, it will change the mode to Allocation mode. When
Class mode is set, PoE allocated value will display after PoE negotiation.

Allocation: The switch will only examine power in the Maximum Power field. So once the switch
receives PD request power, the switch will check Maximum Power configuration, and if the
configured value is smaller than PD request power, the switch will not feed power.

LLDP-Med: This mode is similar to the Class mode except that each port determines the amount
power it reserves by exchanging PoE information using the LLDP protocol and reserves power
accordingly. If no LLDP information is available for a port, the port will reserve power using the Class
mode. In Class mode the Maximum Power fields have no effect for all modes: If a port uses more
power than the reserved power for the port, the port is shut down.

Capacitor Detection: Check to enable or uncheck to disable the capacitor configuration. The default is
disabled. Check to enable legacy IP phones support.

PoE Port Configuration

Port: This is the logical port number for this row.

PoE Mode: The PoE operating mode for the port (Enabled, Disabled, or Force), where: PoE Mode
Disabled: PoE disabled for the port (default).
Enabled: Enables PoE IEEE 802.3at (Class 4 PDs limited to 30W) (default). Disabled
Force: The switch port powers up the linked PD without any detect/negotiate " Force _

mechanism (PD limited to 30W). Note: Only connect PDs which support a power input

of 48~56V to prevent damage to PDs. When the port changes to Force mode, the port’s PoE LED will
light immediately. Select Force mode for devices that do not do PoE negotiation (e.g., for a PoE
DSRC RSU). Note for first time use: PoE Force mode is disabled by default, so you must execute the
enable CLI command first. Once it's executed, Force mode displays in the Web UL

The PoE Force mode enable CLI command is shown below:

# configure terminal
(config)# Special ip-cam poe-force-mode on

Note: Execute the CLI command to enable Force mode; the switch reboots automatically, then Force
mode can start working. If you execute this command, the PoE Force mode will always be available.
See the CLI Reference for more information.

PoE Schedule: Disable PoE Scheduling or select a PoE Schedule profile for each port.

Priority: The Priority represents the ports priority. The three levels of power priority are Low, Priority
High and Critical. The priority is used in the case where the remote devices require more
power than the power supply can deliver. In this case the port with the lowest priority will be
turned off first starting from the port with the highest port number. If both power supplies High

are in use and are required to provide enough power for the PoE connections that are in use, crtice

if one of the power supplies fails and there is not enough power to support all of the PoE ports that are in
use, then PoE power will be fed to PoE ports with higher priority. If the ports have the same priority, the
lower port number will be fed PoE power.
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Maximum Power [W]: Indicates the maximum power in watts that can be delivered to a remote device.
The valid range is 1-30 Watts. The default is 30 Watts.

Buttons

Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.

Messages

Message: PoE Mode(Force): The switch port will power up the linked PD without any detect/negotiate
mechanism(PD limited to 30W). Do you want to change this setting?

Meaning: Confirmation message ensuring that you want to make this config change.

Action: Click the OK button only if you are sure you want to change this setting. See the "PoE Mode”
parameter description above. If you are not sure you want to change this setting, click the Cancel button.
Added at FW v 1.01.1209.
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5-2 PoE Status

This page displays the current status of all PoE ports.
Web Interface

To display PoE Status in the web interface:
1. Click PoE Management and PoE Status.
2. Set Auto-refresh to on or off.
3. Click the Refresh button to refresh the page.

TRANSITION ® =[ > ; = o ogo IS
N NETWORKS
SM8TAT2SA Power Over Ethernet Status Home - FoEMansgement - FoE Status
Switch DMS -
Auto-refresh ‘ Refresh |
» System <
» Port Management < Local Port PDClass PowerAllocated PowerOverride PowerUsed CurrentUsed Priority Port Status
» PoE Management ~ 1 = 0[w] 0 a[w] 0 [mA] Critical ~ No PD detected
b [FfE Eemiip e 2 - 0[W] 0 0[W] 0[mA] High No PD detected
> PoE Sta
o 3 = 0[W] 0 0 [W] 0 [mA] Low No PD detected
> PoE Pov Yy
> PoE Auto Power Reset 4 - [l 0 0w 0 [mA] Low No PD detected
» PoE Scheduling Profile 5 5 0 W] 0 0 W] 0[mA] Low No PD detected
» VLAN Management < s - 0[W] 0 0[W] 0[mA] Low No PD detected
» ity i <
Quality of Service 7 - 0w 0 0[W] 0 [mA] low  NoPDdetected
» Spanning Tree <
8 - 0[W] 0 0 [W] 0 [mA] Low No PD detected
» MAC Address Table <
Total 0 W] 0 W] 0[mA]
» Multicast &
» DHCP < Balance PoE Power Available 130 [W]

Figure 5-2: PoE Status
Parameter descriptions:

Local Port: The logical port number for this row.

PD Class: Each PD is classified according to a class that defines the maximum power the PD will use.

PD Class will show by learning from the link partner no matter which “Reserved Power determined by”
mode is set. If Maximum Power at the port is configured different than the factory default value of 30W,
PD class still stays at the previous learned Class.

The PD Class field shows the PDs classes 0-4 where:

Class 0: Max. power 154 W
Class 1: Max. power 4.0 W
Class 2: Max. power 7.0 W
Class 3: Max. power 154 W
Class 4: Max. power 30.0 W

Power Allocated: Shows the amount of power the switch has allocated for the PD. Power gets updated to
power negotiation by Class, the value assigned and displayed is forced. When Power override =1, the
value is the same as the value of “"Maximum Power (W)". The Switch provides power to the PD if the power
required by the PD is less than this value.
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Power Override: Displays 0 (override disabled) or 1 (override the default power requirement specified
by the IEEE classification). The difference between the power requirement mandated by the IEEE
classification and what is actually needed by the PD is returned into the global power budget for use by
additional PDs. This lets you extend the switch power budget and use it more effectively. So, if you have
devices that use less power than the default that will be assigned based on class, by overriding a lower
value you avoid maxing out the calculated total allocation for the switch. Added at FW v 1.01.1171.
When "Power Allocated" configuration value is different from the default value, displays 1. Otherwise
displays 0.

Power Override Indicates whether the maximum power at the port has ever changed. If Maximum
Power at the port is configured different than the factory default value of 30W, it displays “1”.

Power Used: The Power Used shows how much power the PD currently is using.
Current Used: The Current Used shows how much current the PD currently is using.
Priority: The Priority shows the port's priority currently configured (e.g., Critical, High, or Low).

Port Status: The Port Status shows the port's status. The status can be one of the following values:

Voltage injection: current was returned; that would affect one device at an adjacent port and cannot
completely power on.

PoE turned ON : PoE power is turned on and available.
PoE not available - No PoE chip found: PoE not supported for the port.
PoE turned OFF - PoE disabled: PoE is disabled by user.

PoE turned OFF - Power budget exceeded: The total requested or used power by the PDs exceeds
the maximum power the Power Supply can deliver, and port(s) with the lowest priority is/are
powered down. A port's PoE can be revoked for one of two reasons: 1) Port power budget exceeded,
or 2) Total power budget exceeded.

No PD detected: No Powered Device detected for the port.

PoE turned OFF - PD overload: The PD has requested or used more power than the port can deliver
and is powered down.

PoE turned OFF: PD is off.

Invalid PD: PD detected but is not working correctly.

PD overloaded: The PD consumed more power than the maximum limit configured for the port,
based on the default, user, or CDP configuration.

Total: A combined total is displayed for each column.

Balance PoE Power Available: Displays the remaining power that can be used (Total power of switch) —
(Sum of power allocated of all ports) in Watts. Added at FW v1.01.1195.

o[ il o [ O [ma] Low

—- = Mo PD
15 oW 0 QW 0 (A Lo

detected

detertedd
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Buttons Auto-refresh ‘ Refresh ‘
Auto-refresh: Check to refresh the page automatically every 3
seconds.
Refresh: Click to manually refresh the page immediately.
Five PD Classes are defined by the IEEE standards:
Class Usage Classification Power Range Class
9 Current [mA] [W] Description
0 Default 0-4 0.44-12.94 Classification
unimplemented
Optional 9-12 0.44-3.84 Very Low power
Optional 17-20 3.84-6.49 Low power
Optional 26-30 6.49-12.95 Mid power
Valid for 802.3at (Type 2)
4 devices, not allowed for 802.3af 36-44 12.95-25.50 High power
devices
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5-3 PoE Power Delay

This page lets you specify the delay time before power is provided to a port after device rebooted.

Web Interface

To configure Power over Ethernet Power Delay in the web interface:

1. Click PoE Management and PoE Power Delay.

Enable or Disable Delay Mode.

2
3. Specify the Delay Time.
4

Click Apply to apply the change.

TRANSITION ® =| ===

N\ NETWORKS.

SMBTAT2SA
Switch DMS
P System
» Port Management

» PoE Management

> PoE Configuration

> PoE Scheduling Profile
» VLAN Management
» Quality of Service
» Spanning Tree
» MAC Address Table
» Multicast
» DHCP

» Security

Parameter descriptions:

<

<

~

PoE Power Delay

Port PoE Power Delay

Port

1

[#5]

Delay Mode

Disabled
Disabled
Disabled
Disabled
Disabled
Disabled
Disabled

Disabled

Figure 5-3: PoE Power Delay

SMXTAT2SA Web User Guide

Auto-logout o C.

@ Home - PoE Management ~ PoE Power Delay

Delay Time(0~300 sec)

]

Port: The port being configured; each port instance is represented by a line in the table.

Delay Mode: At the dropdown, select Enabled. The default is Disabled.

Delay Time(0~300 sec): Enter the amount of delay time (0~300 seconds). The default is 0 seconds.

If Port 1 PoE Power Delay time setting is 30 seconds, it means the switch will wait 30 seconds to provide
power to port 1 after the switch reboots.

Buttons

Apply : Click to save changes.

Reset : Click to undo any changes made locally and revert to previously saved values.
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5-4 PoE Auto Power Reset

This page lets you specify the auto detection parameters to check the link status between PoE ports and
PDs. When the switch detects a failed connection, it can reboot the remote PD automatically and log the
failure action.

Web Interface

To configure Power over Ethernet Auto Power Reset in the web interface:
1.
2.
4.

»

»

-

-

-

-

-

-

-

-

-

»

Click PoE Management and PoE Auto Power Reset.

Enable the Ping Check function.

SMXTAT2SA Web User Guide

Specify the PD’s IP address, startup time, interval time, retry time, failure action, reboot time, and max

reboot times.

Click Apply to apply the change.

TTR
JRANSITION

SMETAT2SA
Switch DMS
System

Port Management

PoE Management
> PoE Configuration
> PoE Status
> PoE Power Delay

> PoE Auto Power Reset
> PoE Scheduling Profile
VLAN Management
Quality of Service
Spanning Tree
MAC Address Table
Multicast
DHCP
Security
Access Control
SNMP
Event Notification
Diagnostics

Maintenance

=
TRANSITION

PoE Auto Power Reset Configuration

Ping Check

PoE Port Configuration

Port PinglIP
Address
1 0.0.0.0
2 0.0.0.0
3 0.0.0.0
4 0.0.0.0
5 0.0.0.0
6 0.0.0.0
T 0.0.0.0
a 0.0.0.0
| Apply || Reset |

Figure 5-4: PoE Auto Power Reset Configuration

Parameter descriptions:

Lon @)
Startup Interval Retry Time
Time Time(sec)
60 30 3
60 30 3
60 30 3
60 30 3
60 30 3
60 30 3
60 30 3
60 30 3

Failure
Log

error:0,

total:0

error:0,

total:0

error:0,

total:0

error:0,

total:0

error:0,

total:0

error:0,

total:0

error:0,

total:0

error:0,

total:0

Auto-logout H 9 c»

FeHome

Failure
Action

PoE Management

Reboot

Time(sec)

15

15

15

15

15

15

15

15

PoE Auto Power Reset

Max. Reboot
Times

0

Ping Check: Turn the Ping Check function on to detect the connection between PoE port and powered
devices (PDs). The default is off (Ping Check disabled).

Port: The logical port number for this row.

Ping IP Address: The PD's IP Address the system should ping.
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Startup Time: After startup time, device will enable auto checking. Default: 30; range: 30-60 seconds.

Interval Time(sec): Device will send checking message to PD each interval time. Default: 30; range: 10-
120 seconds.

Retry Time: When PoE port can't ping the PD, it will try to send detection again. When ping fails the third
time, it will trigger the configured Failure Action. Default: 3; range: 1-5.

Failure Log: Failure loggings counter.
Failure Action: The action when the third fail detection.

Nothing: Keep Pinging the remote PD but do nothing further.
Reboot: Cut off the power of the PoE port, make PD reboot.

Reboot time(sec): When PD has been rebooted, the PoE port restores power after the specified time.
Default: 15 seconds, range: 3-120 seconds.

Max. Reboot Times: When the number of reboots exceeds this setting, auto checking will stop on this
port until you change PoE mode without disabling in PoE configuration. The switch will issue an SNMP
Trap and Log to notify this remote PD no response. If Max Reboot Times is 0, auto checking will not stop.
The default is 0 reboots; the valid range is 0-10 reboots.

Buttons
Apply : Click to save changes.

Reset : Click to undo any changes made locally and revert to previously saved values.

PoE Auto Checking “AutoFill” Feature

When you enable Auto Power Reset (PoE Auto Checking) in DMS) the IP addresses of the connected devices
are automatically filled in the Auto Power Reset configuration page.

1. Configure the “PoE Auto Checking” parameter at Switch > PoE Management > PoE Auto Power Reset.
The default value of the "Failure Action” parameter is "Nothing".

2. Configure PoE parameters at DMS > Graphical Monitoring > Topology View. Left click on the switch icon

to display its device configuration popup. Click the PoE Config (7°E 272 ) jcon to display the PoE Auto
Checking pane.
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5-5 PoE Scheduling Profile

This page lets you define profiles for PoE scheduling.

TRANSITIDN \ = TRANSITIEN " Auto-logout e C’
N NETWORKS.
SM8TAT2SA PokE SChed Ull ng Proﬂ le @ Home - Pof Management - PoE Scheduling Profile
Switch DMS
Profile 1 v
» System <
» Port Management < Name profilel

» PoE Management

> PoE Configuration Start Time End Time
> PoE Status
Week Day HH MM HH MM
> PoE Power Delay
to Power Reset . = v - v - v - M
oF Scheduling Profile Monday o - 0 - 0 v 0 v
» VLAN Management <
Tuesday 0 v 0 v 0 v 0 v
» Quality of Service <
» Spanning Tree < Wednesday 0 v 0 v 0 v 0 v
» MAC Address Table E Thursday 0 v o v o v 0 v
» Multicast <
Friday ] w ] w ] w o w
» DHCP <
» Security < Saturday o v 0 v 0 v 0 v
|
» <
Access Control sunday . - o v 0 v 0 v
I » SNMP g
» Event Notification < | Apply |
Figure 5-5: PoE Scheduling Profile
Parameters:

Profile: The index of profile. You can configure up to 16 profiles.

Name: The name of profile. The default name is "profile 1". You can define the name for identifying the
profile.

Week Day: The day to schedule PoE.

Start Time: The hour (HH) and minute (MM) to start PoE. The time 00:00 means the first second of this
day.

End Time: The hour (HH) and minute (MM) to stop PoE. The time 00:00 means the last second of this
day.

Buttons

Apply: Click to save changes.

Messages: End time should not be earlier than start time
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Chapter 6 - VLAN Management
» VLAN Management

6-1 VLAN Configuration > VLAN Configuration

This page lets you assign a specific VLAN for management purpose. The management VLAN > VLAN Membership
is used to establish an IP connection to the switch from a workstation connected to a port in > VLAN Port Status
the VLAN. This connection supports a VSM, SNMP, and Telnet session. By default, the active > VLAN Selective QinQ

management VLAN is VLAN 1, but you can designate any VLAN as the management VLAN
using the Management VLAN window. Only one management VLAN can be active at a time.

» MAC sed VLAN

hased VLAN

When you specify a new management VLAN, your HTTP connection to the old management > P Subnet-based VLAN
VLAN is lost. For this reason, you should have a connection between your management > Private VLAN
station and a port in the new management VLAN or connect to the new management VLAN A -
through a multi-VLAN route. . Ve
Web Interface
To configure VLAN membership configuration in the web interface:
1. Click VLAN Management and VLAN Configuration.
2. Configure for existing VLANSs, Ethertype, port types, ingress/egress, and allowed VLANSs.
3. Click the Apply button.
TRANSITION ® = =" : = - oG
N NETWORKS
SMBTAT2SA VLAN Configuration @Home - VLAN Msnagement - VLAN Configuration
Switch DMS
Global VLAN Configuration
» System <
» Port Management 3 Allowed Access VLANs 1,2,19,20,100,200
» PoE Management ¢ Ethertype for Custom S-ports a3a8
» VLAN Management v
> VLAN Configuration
- Port VLAN Configuration
Port Mode Port VLAN Port Type Ingress Filtering  Ingress Acceptance Egress Tagging Allowed VLANs
1 Access ¥ 1 C-Port v v Tegged and Untagged ¥ Untag Port VLAN ~ + 1
2 Access || 1 C-Fort v |v Tagged and Untagged v UntagPort AN v || 1
> Port Isolation 3 Trunk v 1 C-Port v v Tagzed and Untagged v UntagPort VAN ~ | 1,20
» Voice VLAN
4 Access ¥ 1 C-Port v | Tegged and Untagged ¥ Untag Port VLAN & 1
» Quality of Service «
> Spanning Tree ¢ 5 Access w ||| 1 C-Port v |v Tegged and Untagged ¥ UntagPort AN v 1
» MAC Address Table <
» Multicast S 6 Access v 1 C-Port v |l Tagzed and Untagzed Untag Port VLAN v 1
» DHCP ¢
» Security < T Access ¥ 1 C-Port v v Tegged and Untagged v Untag Port VLAN v 1
» Access Control g
8 Access ¥ 1 C-Port v v Tagged and Untagged v Untag Port VLAN v 1
» SNMP <
» Event Notification < -
9 Access 1 C-Part v v Tagged and Untagged v Untag Port VLAN 1
» Diagnostics <
* Maintenance ¢ 10 Access v 1 C-Port v e Tagzed and Untagged ¥ UntagPortVLAN % | 1

Figure 6-1: VLAN Configuration page
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Parameter descriptions:

Global VLAN Configuration

Allowed Access VLANSs: This field shows the VLANSs that are created on the switch. By default, only VLAN
1 exists. More VLANs may be created by using a list syntax where the individual elements are separated by
commas. Ranges are specified with a dash separating the lower and upper bound. The following example
will create VLANs 1, 10, 11, 12, 13, 200, and 300: 1,10-13,200,300. Spaces are allowed between delimiters.

Ethertype for Custom S-ports: This field specifies the Ethertype/TPID (specified in hexadecimal) used for
Custom S-ports. The setting is in force for all ports whose Port Type is set to S-Custom-Port.

Port VLAN Configuration
Port: This is the logical port number of this row.

Mode: The port mode (default is Access) determines the fundamental behavior of the port in question.
A port can be in one of three modes as described below. Whenever a particular mode is selected, the
remaining fields in that row will be either grayed out or made changeable depending on the mode in
question. Grayed out fields show the value that the port will get when the mode is applied.

Access: Access ports are normally used to connect to end stations. Dynamic features like Voice VLAN
may add the port to more VLANs behind the scenes. Access ports have these characteristics:

« Member of exactly one VLAN, the Port VLAN (a.k.a. Access VLAN), which by default is 1,

- accepts untagged frames and C-tagged frames,

« discards all frames that are not classified to the Access VLAN,

- on egress all frames are transmitted untagged.

Trunk: Trunk ports can carry traffic on multiple VLANs simultaneously and are normally used to connect
to other switches. Trunk ports have these characteristics:

« By default, a trunk port is member of all existing VLANs. This may be limited by the use of Allowed
VLANS,

« unless VLAN Trunking is enabled on the port, frames classified to a VLAN that the portis not a
member of will be discarded,

« by default, all frames but frames classified to the Port VLAN (a.k.a. Native VLAN) get tagged on
egress. Frames classified to the Port VLAN do not get C-tagged on egress,

« egress tagging can be changed to tag all frames, in which case only tagged frames are accepted on
ingress,

« VLAN trunking may be enabled.
Hybrid: Hybrid ports resemble trunk ports in many ways but adds additional port configuration
features. In addition to the characteristics described for trunk ports, hybrid ports have these abilities:

« Can be configured to be VLAN tag unaware, C-tag aware, S-tag aware, or S-custom-tag aware,

« ingress filtering can be controlled,

- ingress acceptance of frames and configuration of egress tagging can be configured independently.

Port VLAN: Determines the port's VLAN ID (a.k.a. PVID). Allowed VLANSs are in the range 1 through 4095;
the default is 1.

On ingress, frames get classified to the Port VLAN if the port is configured as VLAN unaware, the frame is
untagged, or VLAN awareness is enabled on the port, but the frame is priority tagged (VLAN ID = 0).

On egress, frames classified to the Port VLAN do not get tagged if Egress Tagging configuration is set to
untag Port VLAN.

The Port VLAN is called an "Access VLAN" for ports in Access mode and “Native VLAN" for ports in Trunk
or Hybrid mode.

Port Type : Ports in hybrid mode allow for changing the port type, that is, whether a frame's VLAN tag is
used to classify the frame on ingress to a particular VLAN, and if so, which TPID it reacts on. Likewise, on
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egress, the Port Type determines the TPID of the tag, if a tag is required.

Unaware: On ingress, all frames, whether carrying a VLAN tag or not, get classified to the Port VLAN,
and possible tags are not removed on egress.

C-Port: On ingress, frames with a VLAN tag with TPID = 0x8100 get classified to the VLAN ID
embedded in the tag. If a frame is untagged or priority tagged, the frame gets classified to the Port
VLAN. If frames must be tagged on egress, they will be tagged with a C-tag.

S-Port: On ingress, frames with a VLAN tag with TPID = 0x8100 or 0x88A8 get classified to the VLAN ID
embedded in the tag. If a frame is untagged or priority tagged, the frame gets classified to the Port
VLAN. If frames must be tagged on egress, they will be tagged with an S-tag.

S-Custom-Port: On ingress, frames with a VLAN tag with a TPID = 0x8100 or equal to the Ethertype
configured for Custom-S ports get classified to the VLAN ID embedded in the tag. If a frame is untagged
or priority tagged, the frame gets classified to the Port VLAN. If frames must be tagged on egress, they
will be tagged with the custom S-tag.

Ingress Filtering: Hybrid ports allow for changing ingress filtering. Access and Trunk ports always have
ingress filtering enabled.
If ingress filtering is enabled (checkbox is checked), frames classified to a VLAN that the port is not a
member of get discarded.
If ingress filtering is disabled, frames classified to a VLAN that the port is not a member of are accepted
and forwarded to the switch engine. However, the port will never transmit frames classified to VLANs
that it is not a member of.

VLAN Trunking: Trunk and Hybrid ports allow for enabling VLAN trunking. When VLAN trunking is
enabled, frames classified to unknown VLANs are accepted on the port whether ingress filtering is
enabled. This is useful in scenarios where a cloud of intermediary switches must bridge VLANs that haven't
been created. By configuring the ports that connect the cloud of switches as trunking ports, they can
seamlessly carry those VLANs from one end to the other.

Ingress Acceptance: Hybrid ports allow for changing the type of frames that are accepted on ingress.
Tagged and untagged: both tagged and untagged frames are accepted.
Tagged Only: Only tagged frames are accepted on ingress. Untagged frames are discarded.
Untagged Only: Only untagged frames are accepted on ingress. Tagged frames are discarded.

Egress Tagging: Ports in Trunk and Hybrid mode may control the tagging of frames on egress.

Untag Port VLAN: Frames classified to the Port VLAN are transmitted untagged. Other frames are
transmitted with the relevant tag.

Tag All: All frames, whether classified to the Port VLAN or not, are transmitted with a tag.

Untag All: All frames, whether classified to the Port VLAN or not, are transmitted without a tag. This
option is only available for ports in Hybrid mode.

Allowed VLANSs: Ports in Trunk and Hybrid mode may control which VLANs they are allowed to become
members of. Access ports can only be member of one VLAN, the Access VLAN. The field's syntax is
identical to the syntax used in the Existing VLANSs field. By default, a port may become member of all
possible VLANSs, and is therefore set to 1-4095. The field may be left empty, which means that the port will
not be member of any of the existing VLANSs, but if it is configured for VLAN Trunking it will still be able to
carry all unknown VLANs.

Buttons
Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.
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6-2 VLAN Membership

This page provides an overview of membership status of VLAN users.

Various internal software modules may use VLAN services to configure VLAN memberships on the fly.
The drop-down list on the right allows for selecting between showing VLAN memberships as configured
by an administrator (Admin) or as configured by one of these internal software modules.

The "Combined" entry will show a combination of the administrator and internal software modules
configuration, and basically reflects what is actually configured in hardware.

The VLAN User module uses services of the VLAN management functionality to configure VLAN
memberships and VLAN port configurations such as PVID and UVID.

Web Interface

To configure VLAN membership configuration in the web interface:
1. Click VLAN Management and VLAN Membership.
2. Scroll the bar to choose which VLANs to be displayed.
3. Click Refresh to update the state.

TRANSITION — JRANSITIEN — Auto-logout H 0 C’
e NETWORKS =
SMBTAT2SA VLAN Membership Status #iHome - VLN Management - VLAN Membership
Switch DMS
Auto-refresh | Refresh
» System <
» Port Management < Show| 1~ Admin v Search:
entries |
» PoE Management <
» VLAN Management R Port Members
o VLAN ID
> VLAN Configuration 1 2 3 4 5 e 7 2 9 10
LA ership
1 v v 1] v T 1] U ]
LAN Port Statu
12 ] T T
< 60

Figure 6-2: VLAN Membership Status
Parameter descriptions:
Show entries: At the dropdown you can choose how many items you want to show up (10, 25, 60, or All).

VLAN USER: VLAN User module uses services of the VLAN management functionality to configure VLAN
memberships and VLAN port configurations such as PVID and UVID. These VLAN user types are currently
supported: Combined, Admin, 802.1x, MVR, Voice VLAN, MSTP and DMS.

Combined: A combination of VLAN User types. Admin M
Admin: Shows VLAN memberships configured by an administrator. Combined
802.1x: Provides port-based authentication, which involves communications between P
a Supplicant, Authenticator, and an Authentication Server. MVR

MVR: Multicast VLAN Registration (MVR) is used to eliminate the need to duplicate Veice VLAN

. . . . . . : MSTR
multicast traffic for subscribers in each VLAN. Multicast traffic for all channels is sent :3 5

only on a single (multicast) VLAN.
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Voice VLAN: Voice VLAN is a VLAN configured specially for voice traffic typically originating from IP
phones.

MSTP: The 802.1s Multiple Spanning Tree protocol (MSTP) uses VLANSs to create multiple spanning trees
in a network, which significantly improves network resource utilization while maintaining a loop-free
environment.

DMS: Shows DMS VLAN membership status.
VLAN ID: VLAN ID for which the Port members are displayed.
Port Members: A row of check boxes for each port is displayed for each VLAN ID.
If a port is included in a VLAN, an image U will be displayed.

If a port is included in a Forbidden port list, an image < will be displayed.
If a port is included in a Forbidden port list and dynamic VLAN user register VLAN on same Forbidden

port, then conflict port will be displayed as >

VLAN Membership: The VLAN Membership Status Page shows the current VLAN port members for all
VLANSs configured by a selected VLAN User by using the combo box.

When ALL VLAN Users are selected, it shows this information for all the VLAN Users, and this is by default.
VLAN membership allows the frames classified to the VLAN ID to be forwarded on the respective VLAN
member ports.

Show entries: You can choose how many items you want to view.

Search: You can search for the information that you want to view.

Buttons

Auto-refresh: Check to refresh the page automatically every 3 seconds.
Refresh: Click to manually refresh the page immediately.

Next: Updates the system log entries, turn to the next page.

Previous: Updates the system log entries, turn to the previous page.

Messages:
ERROR: Invalid allowed VLAN list (1.30)
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The Port Status function gathers the information of all VLAN status and reports it by the order of

Combined, Admin, NAS, GVRP, MVR, Voice VLAN, MSTP, DMS, and VCL.

Web Interface

To display VLAN Port Status in the web interface:

1. Click VLAN Management and VLAN Port Status.
2. At the dropdown, specify the user type.

3. Click Refresh to display the current Port Status information.

TRANSITIDN V= s & Auto-logout [OFF v | o C’
N NETWORKS.
SM8TAT2SA VLAN Port Status @Home ~ VLAN Management - VLAN Port Status
Switch DMS ——
Auto-refresh Refresh H Clear ‘ Combined
» System <
» Port Management ¢ Port Port Type Ingress Filter Frame Type Port VLAN ID Tx Tag
» PoE Management < 1 C-Port true All 1 None
» VLAN Management h 2 C-Port true All 1 None
3 VLAN Configuration X
3 C-Port true All 1 All except-native
4 C-Port true All 1 None
5 C-Port true All 1 None
6 C-Port true All 1 None
7 C-Port true All 1 None
8 C-Port true All 1 None
» Portlsolation 9 C-Port true All 1 None
» Voice VLAN
10 C-Port true All 1 Naone

» OQualitv of Service <

Figure 6-3: VLAN Port Status page

VLAN USER: Various internal software modules may use VLAN services to configure

VLAN memberships on the fly. The drop-down list on the right allows for selecting

between showing VLAN memberships as configured by an administrator (Admin) or as

configured by one of these internal software modules. These VLAN User types are

currently supported:

Combined: A combination of the administrator and internal software modules

configuration, and basically reflects what is actually configured in hardware.

Admin: VLAN memberships as configured by an administrator.

Combined v
Combined

| Admin
202 1x
Vaoice VLAN
MSTE

DMS

NAS: NAS provides port-based authentication, which involves communications between a Supplicant,

Authenticator, and an Authentication Server.

GVRP: GVRP (GARP VLAN Registration Protocol or Generic VLAN Registration Protocol) facilitates
control of VLANSs within a larger network. GVRP conforms to the IEEE 802.1Q specification, which

defines a method of tagging frames with VLAN configuration data.

MVR: Multicast VLAN Registration (MVR) is used to eliminate the need to duplicate multicast traffic for
subscribers in each VLAN. Multicast traffic for all channels is sent only on a single (multicast) VLAN.

Voice VLAN: Voice VLAN is a VLAN configured specially for voice traffic typically originating from IP

phones.
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MSTP: The 802.1s Multiple Spanning Tree protocol (MSTP) uses VLANSs to create multiple spanning trees
in a network, which significantly improves network resource utilization while maintaining a loop-free
environment.

DMS: Transition Networks’ DMS (Device Management System) is an intelligent management tool
embedded in the switch to intuitively help reduce support time, cost, and effort.

Port: The logical port for the settings contained in the same row.

Port Type: Shows the Port Type, which can be Unaware, C-port, S-port, or Custom S-port. If Port Type is
Unaware, all frames are classified to the Port VLAN ID and tags are not removed. C-port is Customer Port.
S-port is Service port. Custom S-port is S-port with Custom TPID.

Ingress Filter: Shows the ingress filtering on a port. This parameter affects VLAN ingress processing.
If ingress filtering is true (enabled) and the ingress port is not a member of the classified VLAN, then the
frame is discarded.

Frame Type: Shows whether the port accepts all frames or only tagged frames. This parameter affects
VLAN ingress processing. If the port only accepts tagged frames, then untagged frames received on that
port are discarded.

Port VLAN ID: Shows the Port VLAN ID (PVID) that a given user wants the port to have. The field is empty
if not overridden by the selected user.

Tx Tag: Shows egress filtering frame status whether None, All, or All except-native.

Buttons Auto-refresh [ Refresh H Clear ‘

Auto-refresh: Check to refresh the page automatically every 3 seconds.
Refresh: Click to manually refresh the page immediately.

Clear: Click to clear the page.
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6-4 VLAN Selective QinQ

A Q-in-Q VLAN tunnel enables a service provider to segregate the traffic of different customers in their
infrastructure, while still giving the customer a full range of VLANSs for their internal use by adding a
second 802.1Q tag to an already tagged frame.

Navigate to Switch > VLAN Management > VLAN Selective QinQ to create new and edit existing entries.

TRANSITION \ =| =% a o ogou -
N NETWORKS.
SMBTAT2SA VLAN Selective QinQ Configuration dBHome -+ VLAN Management - VLAN Selsctive Qing
Switch DMS
Port Members
» System <
Delete  CVID SPID 1 2 3 4 5 6 7 8 9 10
» Port Management
» PoE Management < (] L 1 O =] (v (v 2] O OJ O O OJ
2 HvETEEmEnE 7 ) 0O 0 ® ¥ 0O & 8 & 0O @
VLAN Configuration
O 3 3 O O O (vl [w) (v (v O O O

Parameter descriptions:

Delete: To delete a private VLAN entry, check this box. The entry will be deleted during the next apply.
CVID: 1-4095; the Customer VLAN ID List to which the tagged packets will be added.

SPID: 1-4095; this configures the VLAN to join the Service Providers VLAN as a tagged member.

Port Members: Checkmarks indicate which ports are members of the entry. Check or uncheck as needed
to modify the entry.

Buttons

Add New Entry: Click the button to add a new instance. An empty row is added to the table, and the new
member can be configured as needed. Initially displays “Table is Empty".

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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6-5 MAC-based VLAN

This page lets you view and configure MAC-based VLAN Memberships. Navigate to Switch > VLAN
Management > MAC-based VLAN > Configuration to configure new entries and view the status of
existing entries.

MAC address-based VLAN decides the VLAN for forwarding an untagged frame based on the source MAC
address of the frame. A most common way of grouping VLAN members is by port, hence the name port-
based VLAN. Typically, the device adds the same VLAN tag to untagged packets that are received through
the same port. Later, these packets can be forwarded in the same VLAN. Port-based VLAN is easy to
configure and applies to networks where the locations of terminal devices are relatively fixed. As mobile
office and wireless network access gain more popularity, the ports that terminal devices use to access the
networks are very often non-fixed. A device may access a network through Port A this time, but through
Port B the next time. If Port A and Port B belong to different VLANSs, the device will be assigned to a
different VLAN the next time it accesses the network. As a result, it will not be able to use the resources in
the old VLAN. On the other hand, if Port A and Port B belong to the same VLAN, after terminal devices
access the network through Port B, they will have access to the same resources as those accessing the
network through Port A do, which brings security issues. To provide user access and ensure data security
in the meantime, the MAC-based VLAN technology is developed. MAC-based VLANs group VLAN
members by MAC address. With MAC-based VLAN configured, the device adds a VLAN tag to an
untagged frame according to its source MAC address. MAC-based VLANs are mostly used in conjunction
with security technologies such as 802.1X to provide secure, flexible network access for terminal devices.

6-5.1 Configuration

TRANSITION * =| =% : = Aologo MO C
N NETWORKS.
SM8TAT2SA MAC-based VLAN Membership Configuration = @sems - vintansgsment - Machassd vian - Configuration
Switch DMS
Delete MAC Address VLAN ID
b System <
J 0C-22-33-44-55-66 1
» Port Management < —
» PoE Management ¢ 0 1C-22-44-66-88-12 1
» VLAN Management e
l App l| Resel || Add New En

> WLAN Configuration

Parameter descriptions:

Delete: To delete a private VLAN entry, check this box. The entry will be deleted during the next apply.
MAC Address: Enter the MAC address for the entry. Must be a valid unicast MAC address.

VLAN ID: Enter the VLAN ID (VID) for the entry (1-4095).

Buttons
Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.

Add New Entry: Click the button to add a new MAC-based VLAN member. An empty row is added to the
table, and the new member can be configured as needed. Any unicast MAC address can be configured for
the MAC-based VLAN entry. No broadcast or multicast MAC addresses are allowed. Valid VLAN ID values
are 1-4095.
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6-5.2 Status
Navigate to Switch > VLAN Management > MAC-based VLAN > Status to view existing members’ status.

TRANSITION \ =| == 2 MO G
N\ NETWORKS.
SM8TAT2SA MAC-based VLAN Membership Status @eHome - VLAN Vanagement - MACbssed VLAN - Status
Switch DMS
Auto-refresh | Refresh |

» System <
» Port Management ¢ MAC Address VLAN ID User
» POE Management < 0C-22-33-44-55-66 1 Static

» VLAN Management - 1C-22-44-66-838-12 1 Static

N

Parameter descriptions:
MAC Address: Displays the MAC address for the entry.
VLAN ID: Displays the VLAN ID (VID) for the entry.

User: Displays User Type for the entry (Combined, Admin, NAS, GVRP, MVR, Voice, VLAN, MSTP, DMS, or
VCL).

Buttons
Auto-refresh: Check to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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6-6 Protocol-based VLAN
6-6.1 Protocol to Group Mapping Table

This page lets you add new protocols to Group Name (unique for each Group) mapping entries as well as
allow you to see and delete already mapped entries for the switch.

Navigate to Switch > VLAN Management > Protocol-based VLAN > Protocol to Group to display the
Protocol to Group Mapping Table. Here you can add new entries and view or edit existing table entries.

TR —
TR SIT[ON = \Tﬂ_’ANS\TIOH >
\-—’M_ WORKS - L J 9 c
SM16TAT2SA PrOtOCOl to Group Mapplng Table @&Home - VLAN Management - Protocol-based VLAN - Protocol to Group
Switch DMS
Delete Frame Type Value Group Name
» System
» Port Management < | Delete ‘ Ethernet[v| Etype: 0x o000
r < —
b el et | Delete ‘ Ethernet[V| Etype: 0x 0800
» VLAN Management e
> VLAN Configuration | Delete ‘ Ethernet[V| Etype: 0x| o0z00
> VLAN Membership

Apply H Reset

> VLAN Port Status

> VLAN Selective QinQ

» MAC-based VLAN

» Protocol-based VLAN v

> Protocol to Group

> Groun toVIAN

Parameter descriptions:
Delete: To delete an entry, check this box. The entry will be deleted during the next apply.
Frame Type: At the dropdown, select the Ethernet frame type (Ethernet, SNAP, or LLC). Frame Type

Value: Displays a value for the frame type. Valid value that can be entered in this text field
depends on the option selected from the preceding Frame Type selection menu. Below are SNAP
the criteria for the three different Frame Types: e

Ethernet: Values in the text field when Ethernet is selected as a Frame Type is called etype.

Valid etype values are 0x0600-0xffff

SNAP: Valid value in this case also is comprised of two different sub-values.
a. OUL OUI (Organizationally Unique Identifier) is value in format of xx-xx-xx where each pair
(xx) in string is a hexadecimal value 0x00-0xff.
b. PID: If the OUI is hexadecimal 000000, the protocol ID is the Ethernet type (EtherType) field
value for the protocol running on top of SNAP; if the OUI is an OUI for a particular

organization, the protocol ID is a value assigned by that organization to the protocol running
on top of SNAP.

LLC: Valid value in this case is comprised of two different sub-values.

a. DSAP: 1-byte long string (0x00-0xff)
b. SSAP: 1-byte long string (0x00-0xff)

Group Name: Displays the assigned group name for each entry.
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Reset: Click to undo any changes made locally and revert to previously saved values.

Add New Entry: Click the button to add a new entry. An empty row is added to the table, and the new
member can be configured as needed.

Example

A saved Protocol to Group Mapping Table is shown below:

\.-' NETWORKS

SM16TAT2SA

» System
» Port Management
» PoE Management
» VLAN Management
> VLAN Configuration
> VLAN Membership

> VLAN Port Status

> VLAN Selective QinQ
» MAC-based VLAN

» Protocol-based VLAN

> Protocol to Group

> Group to VLAN

33717 Rev. )
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Switch DMS

— | masmow T T T W LT »
= ey veww "= = e C
Protocol to G roup Mappmg Table @Home ~ VLAM Management - Protocol-based VLAN - Protocol to Group f
Delete Frame Type Value Group Name
O Ethernet 0800 EthFT1
0 SNAP 000000-0001 SnapType2
O LLC fi-ff LlcType3
[ Apply J Reset || Add New Entry
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6-6.2 Group Name to VLAN mapping Table
This page lets you map an already configured Group Name to a VLAN for the switch.

Navigate to Switch > VLAN Management > Protocol-based VLAN > Group to VLAN to display the Group
Name to VLAN mapping Table. Add new entries and view or edit existing table entries.

SM16TAT2SA Group Name to VLAN mapping Tablesrome  vuanvanseement - protocotoased il - cf@beo (8

Switch DMS
Port Members
» System <
Group VLAN
» Port Management ¢ Delete Name ID 1 2 3 4 5 5 7 8 9 10
» POE Management <
O 61100 U » ¥ @M ¥ » O 0O 0O O

» VLAN Management e
> VLAN Configuration
A Mo O egp2 200 J O O O 0O

VLAN Membership
> VLAN Port Status

_ O ep3 300 O O O O C O O O 0O ™
> VLAN Selective QinQ
» MAC-based VLAN ’ < >
» Protocol-based VLAN v

| Add New Entry

| Apply || Reset

> Protocol te Group

> Group to VLAN

Parameter descriptions:

Delete: To delete a private VLAN entry, check this box. The entry will be deleted during the next apply.
Group Name: A valid Group Name is a string of almost 16 characters.

VLAN ID: Indicates the ID to which Group Name will be mapped. A valid VLAN ID ranges from 1-4095.

Port Members: A row of check boxes for each port is displayed for each Group Name to VLAN ID
mapping. To include a port in a mapping, check the box. To remove or exclude the port from the
mapping, make sure the box is unchecked. By default, no ports are members, and all boxes are unchecked.

Buttons
Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.

Add New Entry: Click to add a new entry in the mapping table. An empty row is added to the table; the
Group Name, VLAN ID and port members can be configured as needed. Valid values for a VLAN ID are 1 -
4095. The Reset button can be used to undo the addition of a new entry.
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6-7 IP Subnet-based VLAN

Navigate to Switch > VLAN Management > Protocol-based VLAN > IP Subnet-based VLAN to display the
IP Subnet-based VLAN Membership Configuration table. Here you can add new entries and view or edit
existing table entries.

TRANSITION * =| =" - Auto-logout H 0 &
N\ NETWORKS.
SM8TAT2SA IP Subnet-based VLAN Membership Configuration @=oms - veanissnsgement - 1= subnst-bssed vian
Switch DMS
Delete IP Address Mask Length VLAN ID
» System <
» Port Management < | el * .

» PoE Management

| Apply H Reset |l Add New Entry

» VLAN Management h

Parameter descriptions:

Delete: To delete an entry, check this box. The entry will be deleted during the next apply.
IP Address: Enter an IP address for each entry.

Mask Length: Enter the mask length for each entry.

VLAN ID: Enter the VID for this new entry (1-4095).

Buttons
Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.

Add New Entry: Click the button to add a new entry. An empty row is added to the table, and the new
member can be configured as needed.
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6-8 Private VLAN

Private VLAN membership configurations for the switch can be monitored and modified here.
Private VLANs can be added or deleted here, and Port members of each Private VLAN can be added or
removed here.

Private VLANSs are based on the source port mask, and there are no connections to VLANs. This means
that VLAN IDs and Private VLAN IDs can be identical.

A port must be a member of both a VLAN and a Private VLAN to be able to forward packets.
By default, all ports are VLAN unaware and members of VLAN 1 and Private VLAN 1.

A VLAN unaware port can only be a member of one VLAN, but it can be a member of multiple Private
VLANSs.

Web Interface

To configure Private VLAN membership via the web Ul

1. Click VLAN Management and Private VLAN.

2. Configure the Private VLAN port members for the switch.
3. Click the Apply button.

TRANSITION \ =| =% a Autotogout e c [
NETWORKS. )
SMB8TAT2SA Private VLAN Membership Configuration @rome - VLAN Hansgament - Privats VLAN
Switch DMS
Port Members
» System <
Delete PVLANID 1 2 3 4 5 6 7 8 9 10
» Port Management
» PoE Management ¢ || Delete 0O 0O 0O 0O 0O o0 o o oo

» VLAN Management
> VLA

Configuration

> VLAN Membership

> VLAN Part Status
Figure 6-4: Private VLAN Membership Configuration

Parameter descriptions:

Delete: To delete a private VLAN entry, check this box. The entry will be deleted during the next apply.

PVLAN ID: Indicates the ID of this particular private VLAN.

Port Members: A row of check boxes for each port is displayed for each private VLAN ID. To include a
port in a Private VLAN, check the box. To remove or exclude the port from the Private VLAN, make sure
the box is unchecked. By default, no ports are members, and all boxes are unchecked.

Adding New Private VLAN: Click the Add New Entry button to add a new private VLAN ID. An empty
row is added to the table, and the private VLAN can be configured as needed.

The Private VLAN is enabled when you click "Apply". The Reset button can be used to undo the addition
of new Private VLANSs.

Buttons
Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.
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6-9 Port Isolation

Port Isolation provides for an apparatus and method to isolate ports on layer 2 switches on the same
VLAN to restrict traffic flow. The apparatus comprises a switch having said plurality of ports, each port
configured as a protected port or a non-protected port. An address table memory stores an address
table having a destination address / port number pair.

A forwarding map generator generates a forwarding map which is responsive to a destination address of
a data packet. The method for isolating ports on a layer 2 switch comprises configuring each of the ports
on the layer 2 switch as a protected port or a non-protected port. A destination address on a data packet
is matched with a physical address on said layer 2 switch and a forwarding map is generated for the data
packet based upon the destination address on the data packet. The data packet is then sent to the
plurality of ports pursuant to the forwarding map generated based on whether the ingress port was
configured as a protected or non-protected port.

This page is used for enabling or disabling port isolation on ports in a Private VLAN.A port member of a
VLAN can be isolated to other isolated ports on the same VLAN and Private VLAN.

Web Interface

To configure Port Isolation configuration in the web interface:

1. Click VLAN Management and Port Isolation.
2. Select which port(s) on which you want to enable Port Isolation.
3. Click the Apply button.

TRANSITION * =| 2F : = oo
N NETWORKS. J
SM8TAT2SA Port Isolation Configuration @Home - VLAN anagement - Port slation
Switch DMS
Port Number
» System <
1 2 3 4 5 6 T 8 9 10
» Port Management <
S TRE [ EaE T ¢ O] L] [v] (v OJ O] O] O] O] ]
» N Management - —
| App || E€.€_|

\ Configuration

Figure 6-5: Port Isolation Configuration page

Parameter descriptions:

Port Number: A check box is provided for each port of a private VLAN. When checked, port isolation is
enabled on that port. When unchecked, port isolation is disabled on that port. By default, port isolation is
disabled (unchecked) on all ports.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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6-10 Voice VLAN

The Voice VLAN feature enables voice traffic forwarding on the Voice VLAN; the switch can then classify
and schedule network traffic. It is recommended that there be two VLANSs on a port - one for voice, one
for data. Before connecting the IP device to the switch, the IP phone should configure the voice VLAN ID
correctly. It should be configured through its own GUL

6-6.1 Voice VLAN Configuration Table

This page lets you configure the Voice VLAN feature parameters.

Web Interface
To configure Port Isolation configuration in the web interface:

Click Voice VLAN and Configuration.

Click the Add New Entry button.

Select which port(s) on which you want to configure Voice VLAN.
Enter VLAN ID and Aging Time and select Traffic.

For each Port select Mode, Security, and Discovery Protocol.
Click the Apply button.

o vk W

TRANSITION © =| =% - wiciogon 0] H @ (G

NETWORKS

SM8TAT2SA Voice VLAN Configuration hHome * VLAN Mansgement - Voica VLAN - Corfiguration
Switch DMS

Port Members
b System <
Delete VLAN ID Aging Time Traffic 1 2 3 4 5 6 7 8 9 10
» Port Management <

» PoE Management < ‘ jflftf‘ 000 86400 otew) | [ O OdJ O ] J 0 O ] 0

» VLAN Management

Port Configuration

Port Mode Security Discovery Protocol
1 Forced Dissbled oul v
> IP Subnet-based VLAN 2 Forced Disabled v oul v
3 Forced W Disabled oul v
- 4 Forced + Disabled v our v
> oU 5 Forced Disabled oul v
ity i <
7 Qe erEamics 6 Foreed v Disabled v oul v
» Spanning Tree <
7 Forced Dissbled oul v
» MAC Address Table £
» Multicast < 8 Forced Disabled oul v
» <
Tegr 9 Forced W Disabled oul v
» Security <
10 Forced v Disabled oul v
» Access Control &
» SNMP C (o
‘ Apply H Reset |

S B R s Rt <

Figure 6-5: Voice VLAN Configuration page
Parameter descriptions:

Voice VLAN Configuration

VLAN ID: Indicates the Voice VLAN ID. It should be a unique VLAN ID in the system and cannot equal
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each port PVID. It is a conflict in configuration if the value equals management VID, MVR VID, PVID etc.
The allowed range is 1 - 4095.

Aging Time: Indicates the Voice VLAN secure learning aging time. The allowed range is 10 to 10000000
seconds. It is used when security mode or auto detect mode is enabled. In other cases, it will be based on
hardware aging time. The actual aging time will be situated between the [age_time; 2 * age_time] interval.

Traffic: Indicates the Voice VLAN traffic class. All traffic on the Voice VLAN will apply this class.

The range is 0 (Low priority) to 7 (High priority). Traffic

Port Members: Indicates the Voice VLAN port mode operation. You must disable the MSTP
feature before you enable Voice VLAN. It can avoid the conflict of ingress filtering. Select '
which port that you want to enable the Voice VLAN mode operation.

Port Configuration 5

Port: The switch port number of the Voice VLAN port.

Mode: Indicates the Voice VLAN port mode. When the port mode isn't equal disabled, we
must disable MSTP feature before we enable Voice VLAN. It can avoid the conflict of ingress
filtering. Possible port modes are:

Auto: Enable auto detect mode. It detects whether there is VoIP phone attached to the specific port

and configures the Voice VLAN members automatically.

Forced: Force join to Voice VLAN.

Security: Indicates the Voice VLAN port security mode. When the function is enabled, all non-telephonic
MAC addresses in the Voice VLAN will be blocked for 10 seconds. Possible security modes are:

Enabled: Enable Voice VLAN security mode operation.

Disabled: Disable Voice VLAN security mode operation.

Discovery Protocol: Indicates the Voice VLAN port discovery protocol. It will only work when auto detect
mode is enabled. We should enable LLDP feature before configuring discovery protocol to "LLDP" or
"Both". Changing the discovery protocol to "OUI" or "LLDP" will restart the auto detect process. Possible
discovery protocols are:

OUI: Detect telephony device by OUI address.
LLDP: Detect telephony device by LLDP.
Both: Both OUI and LLDP.

Buttons

Save: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
Delete: Click to do delete an existing Voice VLAN entry.

Add New Entry: Click to add a new entry in Voice VLAN configuration table.

Apply: Click to save changes.
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6-6.1 Voice VLAN OUI Configuration Table

This page lets you configure the Voice VLAN OUI table. The maximum entry number is 16. Modifying the
OUI table will restart auto detection of the OUI process. An Organizationally Unique Identifier (OUI) is a
24-bit number that uniquely identifies a vendor, manufacturer, or other organization. The IEEE Public OUI
list is at http://standards-oui.ieee.org/oui/oui.txt.

Web Interface

To configure Port Isolation configuration in the web interface:

1. Click Voice VLAN and OUL
2. Click the Add New Entry button.
3. Enter a Telephony OUI and Description for each instance.
4.  Click the Apply button.
TRANSITION ® =| = : = G
N NETWORKS:
SM8TAT2SA Voice VLAN OUI Table gHome - VLAN Management - Voice VLAN ~ OUI
Switch DMS
Delete Telephony QUI Description
» System
» Port Management ¢ | Delete ‘ 00-01-E3 Siemens AG phone
» PoE Management | Delete ‘ 00-03-6B Cisco phone
¥ VLAN Management v : -
> VLAN Configuration Add New Entry |
> VLAN Membership §
> VILAN Port Status . Apply H Reset |

Figure 6-6: Voice VLAN OUI Table

Parameter descriptions:

Telephony OULI: A telephony OUI address is a globally unique identifier assigned to a vendor by IEEE.

It must be 6 characters long and the input format is "xx-xx-xx" (where x is a hexadecimal digit).

Voice VLAN OUI Table Telephony OUI examples include: 00-01-E3 (Siemens AG phones), 00-03-6B (Cisco
phones), 00-0F-E2 (H3C phones), 00-60-B9 (Philips and NEC AG phones), 00-DO0-1E (Pingtel phones), 00-
EO-75 (Polycom phones), and 00-E0-BB (3Com phones).

Description: The description of OUI address. Normally, it describes which vendor telephony device it
belongs to. The allowed string length is 0 to 32 characters.

Delete: Click to delete an existing Voice VLAN OUI entry.

Add New Entry: Click to add a new entry in Voice VLAN OUI table. An empty row is added to the table to
configure the Telephony OUI and Description.

Buttons
Save: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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Chapter 7 - Quality of Service TR
> Port Settings

7-1 Global Settings > Port Policing

Use the QoS Global Settings page to set the trust behavior for QoS basic mode. S TR

This configuration is active when the switch is in QoS basic mode. Packets entering 7 Storm Contrel
> Port Scheduler

a QoS domain are classified at the edge of the QoS domain.

> CoS p Mapping

Web Interface 2.1p Remarking

nce Mapping

To configure the Global Settings in the web interface: > IP Precedence Remarking

1. Click Quality of Service and Global Settings.

2. Select the trust mode when the switch is in QoS basic mode. If a packet CoS
level and DSCP tag are mapped to separate queues, the trust mode determines the queue to which
the packet is assigned.

3. Click Apply to save the configuration.
4. To cancel the setting, click the Reset button to revert to previously saved values.

TRANSITION ® = == : = pobse T Y] M @ G
N NETWORKS

SMBTATZSA QOS GlObalsettingS @ Home - Quality of Service - Global Settings

Switch DMS |
Trust Mode (@ cos/ana.ip

» System ¢ O pscp

» Port Management < ) IP Precedence

() cos/202.1p-DSCP
» PoE Management ¢ - Losisledp

» VLAN Management 4

) . Apply || Reset |
» Quality of Service I

> Global Settings

Figure 7-1: QoS Global Settings page
Parameter descriptions:
Trust Mode

CoS/802.1p: Traffic is mapped to queues based on the VPT field in the VLAN tag, or based on the per-
port default CoS/802.1p value (if there is no VLAN tag on the incoming packet), the actual mapping of the
VPT to queue can be configured on the CoS/802.1p to Queue page.

DSCP: All IP traffic is mapped to queues based on the DSCP field in the IP header. The actual mapping of
the DSCP to queue can be configured on the DSCP to Queue page. If traffic is not IP traffic, it is mapped
to the best effort queue.

IP Precedence: Traffic is mapped to queues based on the IP precedence. The actual mapping of the IP
precedence to queue can be configured on the IP Precedence to Queue page.

Co0S/802.1p-DSCP: Uses the trust CoS mode for non-IP traffic and trust DSCP mode for IP traffic.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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7-2 Port Settings

Web Interface
To configure the QoS Port Setting in the web interface:

1. Click Quality of Service and Port Settings.
2. Select Mode, Default CoS, and Source CoS, for each port.

3. Check which port(s) on which you want to enable the Remark Cos, Remark DSCP, and Remark IP
Precedence.

4. Click Apply to save the configuration.
5. To cancel the setting, click the Reset button to revert to previously saved values.

TRANSITION ' =| =% - Auto-logout H e c
N\ NETWORKS | )
SMSTATZSA QOS POI’t Settings @ Home - Quality of Service - Port Settings
Switch DMS '
Default Source Remark Remark Remark IP
{
» System Port Mode CoS CoSs CoSs DSCP Precedence
» Port Management <
D 1 Untrust v 0 v CTAG v D [:] D
» PoE Management < |
» VLAN Management < 2 untrust o cme v [ O O
» Quality of Service M 3 Untrust v 0 v et v [ M 0
> Global Settings
> Port Settings 4 Untrust v 0w CTAG v C] [:] C]
> Port Policing
5 Untrust  « 0w crac v [ O O
> Port Shaper
> Storm Control 6 Untrust  w 0w CTAG W C] [:] C]
> Port Scheduler
> CoS/802.1p Mapping 7 Untrust ¥ o cme v O O
> Co5/802.1p Remarking g Untrust v 0 CTAG v D D D |
> IP Precedence Mapping |
> IP Precedence Remarking 9 Untrust v L crae v [ [ [l
| |
> DSCP Mapping
10 Untrust  « 0w crae v [ O O
> DSCP Remarking
» Spanning Tree | Apply | Reset|

Figure 7-2: QoS Port Settings page
Parameter descriptions:
Port: The logical port for the settings contained in the same row.

Mode: Select Trust or Untrust, where:

Untrust: All ingress traffic on the port is mapped to the best effort queue and no
classification/prioritization takes place (default).

Trust: Port prioritize ingress traffic is based on the system wide configured trusted mode, which is
either CoS/802.1p trusted mode, IP Precedence trusted mode, or DSCP trusted mode.
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Default CoS: Select the default CoS value to be assigned to incoming untagged packets (0 - 7).
Source CoS: The CoS value is determined based on C-Tag or S-Tag for incoming tagged packets
Remark CoS: Click the checkbox to remark the CoS/802.1p priority for egress traffic on this port.
Remark DSCP: Click the checkbox to remark the DSCP value for egress traffic on this port.

Remark IP Precedence: Click the checkbox to remark the IP precedence for egress traffic on this port.

Note: The CoS/802.1p priority and IP Precedence, or the CoS/802.1p priority and DSCP value can be
remarked simultaneously for egress traffic on a port, but the DSCP value and IP Precedence cannot be
remarked simultaneously.

Buttons
Apply : Click to save changes.

Reset : Click to undo any changes made locally and revert to previously saved values.
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7-3 Port Policing

This section provides an overview of QoS Ingress Port Policers for all switch ports. Port Policing is useful in
constraining traffic flows and marking frames above specific rates. Policing is primarily useful for data
flows and voice or video flows because voice and video usually maintains a steady rate of traffic.

Web Interface
To configure QoS Port Policers in the web UL

1. Click Quality of Service and Port Policing.

2. Click which port need to enable the QoS Ingress Port Policers, and configure the Rate limit condition.
3. Click Apply to save the configuration.
4. To cancel the setting, click the Reset button to revert to previously saved values.
TRANSITION \ = =% 2 oG
N NETWORKS: | .
SMBTATZSA QOS |ngI’ESS POl’t PO“CEI’S @& Home - Quality of Service - Port Policing
Switch DMS
Port Enable Rate (kbps)
b System «
» Port Management E ! U 1000000
» PoE Management E 2 ) 1000000
» VLAN Management & -
3 ] 1000000
» Quality of Service h
> Global Settings 4 O 1000000
> Port Settings
» Port Policing 5 |—| 1000000
> Port Shaper 6 M 1000000

Storm Control

> Port Scheduler T L] 1000000
> CoS/802.1p Mapping -

8 [ 1000000
> CoS/802.1p Remarking
> |P Precedence Mapping ] |:| 1000000
> IP Precedence Remarking

P 10 O 1000000

> DSCP Mapping U
> DSCP Remarking R

Apply H Reset |

» Spanning Tree s B

Figure 7-3: QoS Ingress Port Policers page
Parameter descriptions:

Port: The logical port for the settings contained in the same row. Click on the port number to configure
its schedulers.

Enable: Check to enable for each Port you on which you want to enable the QoS Ingress Port Policers
function.

Rate (kbps): Set the Rate limit value for this port; the default is 1000000 kbps.

Buttons
Apply : Click to save changes.

Reset : Click to undo any changes made locally and revert to previously saved values.
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7-4 Port Shaper

This section provides an overview of QoS Egress Port Shapers for all switch ports.

Web Interface
To configure QoS Port Shapers in the web UL
Click Quality of Service and Port Shaper.

2. Select the port to configure QoS Egress Port Shaper.
3. Click the port to enable, and configure the Rate limit condition.
4. Click Apply to save the configuration.
5. To cancel the setting, click the Reset button to revert to previously saved values.
TRANSITION = Twsn® : [ T T Auto-logout H 9 c»
" NETWORKS L J
SMBTATZSA QOS Egress Port Shaper @@ Home - Quality of Service - Port Shaper
Switch DMS
Port Port1 w
» System <
» Port Management <
Queue Shaper
» PoE Management <
» VLAN Management < Queue Enable Rate (kbps)
» Quality of Service V 0 O 1000000
> Global Settings
> Port Settings 1 O 1000000
> Port Policing
2 O] 1000000
> Port Shaper
> Storm Control 3 O 1000000
> Port Scheduler
> CoS/802.1p Mapping 4 C] i
> CoS5/802.1p Remarking 5 C] 1000000
> IP Precedence Mapping
> 1P Precedence Remarking 6 () 1000000
> DSCP Mappin
| e 7 O 1000000
| > DSCP Remarking
» Spanning T 4
: panning Tree Port Shaper
| » MACAddress Table <
[ » Multicast < Enable Rate (kbps)
» DHCP < OJ 1000000
» Security < y ‘
» Access Control < | Apply | e |

Figure 7-4: The QoS Egress Port Shaper page
Parameter descriptions:

Port : The logical port for the settings contained in the same row. Click on the port number to configure
the shapers.
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Queue Shaper
Queue : The queue number of the queue shaper on this switch port.
Enable : Controls whether the queue shaper is enabled for this queue on this switch port.

Rate(kbps) : Controls the rate for the queue shaper. The default value is 1000000.

Port Shaper
Enable : Controls whether the port shaper is enabled for this switch port.

Rate(kbps) : Controls the rate for the port shaper. The default value is 1000000.

Buttons
Apply : Click to save changes.

Reset : Click to undo any changes made locally and revert to previously saved values.
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7-5 Storm Control

This page lets you configure Storm control for the switch. There is a destination lookup failure storm rate
control, multicast storm rate control, and a broadcast storm rate control. These only affect flooded frames,
i.e. frames with a (VLAN ID / DMAC) pair not present on the MAC Address table.

The configuration indicates the permitted packet rate for unicast, multicast or broadcast traffic across the
switch.

Web Interface
To configure Storm Control Configuration parameters in the web UL

1. Click Quality of Service and Storm Control.

2. Click the port to be enabled, and configure the Rate limit condition.

4. Click the Apply button to save the settings.

5. To cancel the setting, click the Reset button to revert to previously saved values.

TRANSITION ® =| =™ : = IS
N\ NETWORKS - )
SMSTAT2SA Storm Conﬂguration @ Home - Quality of Service - Storm Control
Switch DMS
Broadcast Unknown Multicast Unknown Unicast
b System <
Port Enable Rate (pps Enable Rate (pps Enable Rate (pps
» Port Management < (pps) (Pps) (Pp)
» PoE Management < 1 O 500 O 500 O 500
» \ <
VLAN Management 2 <00 00 0 <00
» Quality of Service M
> Global Settings 3 500 500 O 500
> Port Settings
4 500 500 500
> Port Policing
> Port Shaper 5 [:] 500 C] 500 D 500
> Storm Control
> Port Scheduler 6 D =00 C] w0 D w0
> CoS/802.1p Mapping 7 D 200 D s00 D 200
> CoS5/802.1p Remarking
> IP Precedence Mapping 8 OJ 500 OJ 500 O 500
> IP Precedence Remarkin
- 9 ] 500 O 500 0 500
> DSCP Mapping
> DSCP Remarking o 500 O 500 O 500

» Spanning Tree <

» MAC Address Table < ‘ ReseE |

Figure 7-5: Storm Configuration page

Parameter descriptions:

Port : The logical port for the settings contained in the same row. Click on the port number to configure
storm control.

Frame Type : The settings in a particular row apply to the frame type listed here: Broadcast, Multicast or
Unknown Unicast.

Enable : Enable or disable the storm control status for the given frame type.
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Rate : The rate unit is packets per second (pps). Valid values are: 1, 2, 4, 8, 16, 32, 64, 128, 256, 512, 1K, 2K,
4K, 8K, 16K, 32K, 64K, 128K, 256K, 512K or 1024K, 1024K, 2048K, 4096K, 8192K, 16384K or 32768K.

The 1 kpps is actually 1002.1 pps.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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7-6 Port Scheduler

This section provides an overview of QoS Egress Port Scheduler for all switch ports.

To configure the QoS Port Schedulers in the web interface:

Click Quality of Service > Port Scheduler.

i Ac wnN

TTR)
TRANSITION

NETWORKS

SMETAT2SA
Switch DMS

» System
» Port Management
» PoE Management
» VLAN Management
» Quality of Service
> Global Settings
> Port Settings
> Port Policing
> Port Shape!
> Storm Control
> Port Scheduler
> CoS5/802.1p Mapping
> CoS5/802.1p Remarking
> IP Precedence Mapping
> IP Precedence Remarking
> DSCP Mapping

> DSCP Remarking
» Spanning Tree

» MAC Address Table

Select Scheduler Mode for each port.

Click the Apply button to save the settings.

TRANSITION
A

QoS Egress Port Scheduler

Weight
Port SchedulerMode Qo0 Q1 Q2 Q3
1 WRR ~ 20 20 20 20
2 WFQ hd 17 17 17 17
3 Strict Priority v ] 0 0 0
4 Strict Priority  + ] 0 0 0
5 Strict Priority  + ] 0 0 0
51 Strict Priority v 0 0 0 0
7 Strict Priority v 0 0 0 0
8 Strict Priority v 0 0 0 0
9 Strict Priority  ~ 0 0 0 0
10 Strict Priority v ] 0 0 0
| Reset ‘

Parameter descriptions:

Figure 7-6: QoS Egress Port Scheduler

Port: The logical port for the settings contained in the same row.

To cancel the setting, click the Reset button to revert to previously saved values.

Auto-logout

Q4

20

17

SMXTAT2SA Web User Guide

If you select WRR (Weighted round robin) or WFQ (Weighted fair queueing), configure Weight.

2 B

@k Home - Quality of Service - Port Scheduler

Qs

17

Scheduler Mode: Controls whether the scheduler mode is "Strict Priority", "WRR" or
"WFQ" on this switch port.

WFQ allows specifying, for each flow, what fraction of the capacity will be given.

WRR serves a number of packets for each nonempty queue.

Q6

Q7

Scheduler Mode

WRR

WFQ

In a Strict Priority queue, an element with high priority is served before an element with low
priority. If two elements have the same priority, they are served according to their order in the

queue.

Weight: Controls the weight for this queue. The default value is "0". This value is restricted to 0-127. This
parameter is only shown if "Scheduler Mode" is set to "Weighted" (WRR or WFQ).
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Buttons
Apply : Click to save changes.

Reset : Click to undo any changes made locally and revert to previously saved values.
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7-7 CoS/802.1p Mapping

Use the CoS/802.1p to Queue page to map 802.1p priorities to egress queues. The CoS/802.1p to Queue
table determines the egress queues of the incoming packets based on the 802.1p priority in their VLAN
tags. For incoming untagged packets, the 802.1p priority will be the default CoS/802.1p priority assigned
to the ingress ports.

Web Interface

To configure the Cos/802.1p Mapping in the web interface:
1. Click Quality of Service > Cos/802.1p Mapping.

2. Select a Queue ID.

3. Click the Apply button to save the settings.
4. To cancel the setting, click the Reset button to revert to previously saved values.

TRANSITION ' = =" - Auto-logout o I 2
N\ NETWORKS. | .
SM8TAT2SA QoS Ingress CoS/802.1p to Queue Mapping  @rome - qualityor sevics - Cos/an2.Lo Mapping
Switch DMS
CoS/802.1p Queue ID
» System E
0 1 v
» Port Management E
» PoE Management E 1 0 v
» VLAN Management E |
2 2w
» Quality of Service h
> Global Settings 3 3 v
> Port Settings
> Port Policing 4 4 v
> Port Shaper 5 s
> Storm Control
> Port Scheduler 6 6
> CoS/802.1p Mapping
7 T v
> Co5/802.1p Remarking
> |IP Precedence Mapping |—||—|
Apply || Reset
> IP Precedence Remarking |2PPY J e

Figure 7-7: QoS Ingress CoS/802.1p to Queue Mapping
Parameter descriptions:

CoS/802.1p: Displays the 802.1p priority tag values to be assigned to an egress queue, where 0 is the
lowest and 7 is the highest priority.

Queue ID: Select the egress queue to which the 802.1p priority is mapped. Eight egress queues are
supported, where Queue 8 is the highest priority egress queue and Queue 1 is the lowest priority egress
queue.

Buttons

Apply : Click to save changes.

Reset : Click to undo any changes made locally and revert to previously saved values.
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7-8 CoS/802.1p Remarking

Use the Queues to CoS/802.1p page to remark the CoS/802.1p priority for egress traffic from each queue.

Web Interface

To configure the Cos/802.1p Remarking in the web interface:
1. Click Quality of Service > Cos/802.1p Remarking.

2. Select CoS/802.1p.

3. Click the Apply button to save the settings.

4

To cancel the setting, click the Reset button to revert to previously saved values.

TRANSITION ' =| =™ - Auto-logout M ¢
N\ NETWORKS -
SM8TATZSA QOS EgI’E‘SS Queue tO COS/SOZ‘lp RemarkingﬁHome Quality of Service - CoS/802.1p Remarking

Switch DMS
Queue D CoS/802.1p

P System

» Port Management < 0 o

» PoE Management < 1 v

» VLAN Management < |
2 2w

» Quality of Service M

» Global Settings 3 3 v

> Port Settings

> Port Policing 4 4

> Port Shaper 5 s v

> Storm Control

> Port Scheduler 6 5w

> CoS/802.1p Mapping
T T v

> CoS5/802.1p Remarking

> |P Precedence Mapping S T —
| Apply || Reset |

> |IP Precedence Remarking

Figure 7-8: QoS Egress Queue to CoS/802.1p Remarking

Parameter descriptions:

Queue ID: Displays the Queue ID, where Queue 8 is the highest priority egress queue and Queue 1 is the
lowest priority egress queue.

Co0S/802.1p: For each output queue, select the CoS/802.1p priority to which egress traffic from the queue
is remarked.

Buttons

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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7-9 IP Precedence Mapping

This page lets you map an IP precedence to an egress queue.

Web Interface

To configure IP Precedence Mapping in the web UL

1. Click Quality of Service > IP Precedence Mapping.
2. Select Queue ID.

3. Click the Apply button to save the settings.

4

To cancel the setting, click the Reset button to revert to previously saved values.

TRANSITION © =| &% g >
N\ NETWORKS: |, )
SMSTATZSA QOS |ngI’ESS IP Precedence tO Queue Mapping geHome - Quality of Service - IP Precedence Mapping
Switch DMS
IP Precedence QueueID
b System
£ 0 [
» Port Management
» PoE Management < 1 v
» VLAN Management <
2 2 v
» Quality of Service M
> Global Settings 3 3 v
> Port Settings |
> Port Policing 4 -
> Port Shaper 5 .
> Storm Control
> Port Scheduler 6 6 v
> CoS/802.1p Mapping
T T W~
> Co5/802.1p Remarking
> IP Precedence Mapping —
Apply H Reset |

> |IP Precedence Remarking .

Figure 7-9: QoS Ingress IP Precedence to Queue Mapping

Parameter descriptions:

IP Precedence: Displays the IP Precedence priority tag values to be assigned to an egress queue, where 0
is the lowest and 7 is the highest priority.

Queue ID: Select the egress queue to which the IP precedence priority is mapped. Eight egress queues
are supported, where Queue 8 is the highest priority egress queue and Queue 1 is the lowest priority
egress queue.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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7-10 IP Precedence Remarking

This page lets you map egress queue to IP precedence.

Web Interface

To configure IP Precedence Remarking in the web UL

1.

2
3.
4

»

»

»

»

>

Click Quality of Service and IP Precedence Remarking.

Select IP Precedence.

Click the Apply button to save the settings.

To cancel the setting, click the Reset button to revert to previously saved values.

TRANSITION =

N\ NETWORKS

SMETAT2SA
Switch DMS
System
Port Management <
PoE Management <
VLAN Management <

Quality of Service
> Global Settings

> Port Settings

W

Port Policing

W

Port Shaper

W

Storm Control

W

Port Scheduler

TRANSITION
il

ol Auto-logout

(2 B

QoS Egress Queue to IP Precedence Remarking  aiome - qualityofsenvice - 1P Precedence Remarking

Queue ID

0

IP Precedence

D v

Figure 7-10: QoS Egress Queue to IP Precedence Remarking

Parameter descriptions:

Queue ID: Displays the Queue ID, where Queue 8 is the highest priority egress queue and Queue 1 is the
lowest priority egress queue.

IP Precedence: For each output queue, select the IP Precedence priority to which egress traffic from the
queue is remarked.

Buttons

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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Use the DSCP to Queue page to map IP DSCP to egress queues. The DSCP to Queue table determines the
egress queues of the incoming IP packets based on their DSCP values. The original VLAN Priority Tag
(VPT) of the packet is unchanged. It is possible to achieve the desired QoS in a network by simply
changing the DSCP to Queue mapping, the queue schedule method, and bandwidth allocation.

Web Interface

To configure DSCP Mapping in the web UL
1.

2
3.
4

Parameter descriptions:

»

»

»

»

»

Click Quality of Service and DSCP Mapping.

Click the Apply button to save the settings.

To cancel the setting, click the Reset button to revert to previously saved values.

QoS Ingress DSCP to Queue Mapping

Select Queue ID.
TRANSITION * =| =%
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System
. 0 (BE)
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Figure 7-11: QoS Ingress DSCP to Queue Mapping

DSCP: Displays the DSCP value in the incoming packet and its associated class.

8 v

5 v

8 v

Queue ID

Queue ID: Select the traffic forwarding queue from the Output Queue drop-down menu to which the
DSCP value is mapped.

Buttons

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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7-12 DSCP Remarking
Use the Queues to DSCP page to remark DSCP value for egress traffic from each queue.
Web Interface
To configure DSCP Remarking in the web UL
Click Quality of Service and DSCP Remarking.

2. Select DSCP.
3. Click the Apply button to save the settings.
4. To cancel the setting, click the Reset button to revert to previously saved values.
TRANSITION ® =| === : = RGN
N NETWORKS
SMEBTAT2SA QoS Egress Queue to DSCP Remarking @Home - Quality of Service - DSCP Remarking
Switch DMS
Queue ID DSCP
» System %
» Port Management < 0 o Y 1
» PoE Management < 1 2(cs1 v
» VLAN Management % ~
£ 16 (C52) d
, v
3 24(c53) W
Port Settings
4 37({C54) W
Port Policing
Port Shape 5 40(Ccss) W
Storm Control
5] 4z(cs8) W
Port Scheduler
» CoS5/802.1p Mapping 7 56 [CST) W
» Co5/202.1p Remarking
P Precedence Mapping Anoly || Rese

Figure 7-12: QoS Egress Queue to DSCP Remarking
Parameter descriptions:

Queue ID: Displays the Queue ID, where Queue 8 is the highest priority egress queue and Queue 1 is the
lowest priority egress queue.

DSCP: For each output queue, select the DSCP priority to which egress traffic from the queue is remarked.
For example Expedited Forwarding (EF) for low-loss, low-latency traffic or Assured Forwarding (AF) which
assures delivery under prescribed conditions.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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Chapter 8 - Spanning Tree

The Spanning Tree Protocol (STP) can be used to detect and disable network loops, and to provide
backup links between switches, bridges or routers. This allows the switch to interact with other bridging
devices (that is, an STP-compliant switch, bridge or router) in your network to ensure that only one route
exists between any two stations on the network and provide backup links which automatically take over
when a primary link goes down.

STP uses a distributed algorithm to select a bridging device (STP- compliant switch, bridge or router) that
serves as the root of the spanning tree network. It selects a root port on each bridging device (except for
the root device) which incurs the lowest path cost when forwarding a packet from that device to the
root device. Then it selects a designated bridging device from each LAN which incurs the lowest path
cost when forwarding a packet from that LAN to the root device. All ports connected to designated
bridging devices are assigned as designated ports. After determining the lowest cost spanning tree, it
enables all root ports and designated ports, and disables all other ports. Network packets are therefore
only forwarded between root ports and designated ports, eliminating any possible network loops.

~. Designated .,
/ Root

Designated Root .

et Designated ., Fort, Part..
X . Bridge 0ood

Figure 8: Spanning Tree Protocol

Once a stable network topology has been established, all bridges listen for Hello BPDUs (Bridge Protocol
Data Units) transmitted from the Root Bridge. If a bridge does not get a Hello BPDU after a predefined
interval (Maximum Age), the bridge assumes that the link to the Root Bridge is down. This bridge will
then initiate negotiations with other bridges to reconfigure the network to reestablish a valid network
topology.

STP network protocol builds a loop-free logical topology for Ethernet networks. The basic function of
STP is to prevent bridge loops and the broadcast radiation that results from them. Spanning tree also
allows a network design to include backup links providing fault tolerance if an active link fails.

STP was originally standardized as IEEE 802.1D but the functionality of spanning tree (802.1D), Rapid
Spanning tree (802.1w), and Multiple Spanning tree (802.1s) has since been incorporated into IEEE
802.1Q-2014.

RSTP (Rapid Spanning Tree Protocol) was introduced as 802.1w in 2001 by the IEEE. RSTP provides
significantly faster recovery in response to network changes or failures, introducing new convergence
behaviors and bridge port roles to do this. RSTP was designed to be backwards-compatible with
standard STP.

MSTP (Multiple Spanning Tree Protocol) was originally defined in IEEE 802.1s-2002 and later merged

into IEEE 802.1Q-2005. MSTP defines an extension to RSTP to further develop the usefulness of virtual
LANs (VLANSs). In the standard a spanning tree that maps one or more VLANSs is called “multiple spanning
tree” (MST). If MSTP is implemented a spanning tree can be defined for individual VLANs or for groups

of VLANs. The administrator can also define alternate paths within a spanning tree. VLANs must be
assigned to a so-called multiple spanning tree instance (MSTI). Switches are first assigned to an MST
region, then VLANs are mapped against or assigned to this MST. A Common Spanning Tree (CST) is an

MST to which several VLANs are mapped; this group of VLANSs is called MST Instance (MSTI).
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8-1 State

This page lets you enable or disable MSTP; you can also select what protocol version you want.
The default is Spanning Tree enabled.

Web Interface
To 3nable and configure Spanning Tree Protocol version in the web UL

1. Click Spanning Tree and state.

2. Select “on” to enable Spanning Tree Protocol.

3. Select the Spanning Tree Protocol version.

4. Click the Apply button to save the settings.

5. To cancel the setting, click the Reset button to revert to previously saved values.

TRANSITIUN = T 4 Auto-logout o C-
N NETWORKS
SMETAT2SA MSTP State #Home - SpanningTres - Stats
Switch DMS
Multiple Spanning Tree
L S ¢ Protocol
P ¥l aoa {
» Port Management T
» PoE Management &
» VLAN Management < | el || Reset |
b Quality of Service <
» Spanning Tres v

Figure 8-1: MSTP State page

Parameter descriptions:
Multiple Spanning Tree Protocol: You can select on to enable MSTP or off to disable MSTP.

Force Version: The STP protocol version setting. Valid values are STP, RSTP and MSTP (see. previous
page for descriptions).

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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8-2 Region Config

This page lets you configure the basic identification of a MSTP bridge. Bridges participating in a common
MST region must have the same Region Name and Revision Level.

Web Interface

To configure MSTP Region Config in the web UL

1. Click Spanning Tree and Region Config.

2. Specify the Region Name and Revision Level.

3. Click the Apply button to save the settings.

4. To cancel the setting, click the Reset button to revert to previously saved values.

THANSITION \ — TRANSTIGN i Auto-logout 9 C’
N NETWORKS: )
SMgTATZSA MSTP Region Canig @Home - Spanning Tree - Region Config
Switch DMS
Region Name (0~32 characters) 00-CO-F2-49-AB-14
b System
» Port Management < Revision Level (0-65535) 0
» PoE Management 4 ) )
» VLAN Management S Apply ” HESEE |

Figure 8-2: MSTP Region Config
Parameter descriptions:

Region Name (0~32 characters): The name identifying the VLAN to MSTI mapping. Bridges must share
the name and revision (see below), as well as the VLAN-to-MSTI mapping configuration in order to share
spanning trees for MSTI's (Intra-region). Enter up to 32 characters.

Revision Level (0-65535): The revision of the MSTI configuration named above. This must be an integer
between 0 and 65535.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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8-3 Instance View

This page provides an MST instance table which includes information (VLAN membership of a MSTI ) of all
spanning tree instances provisioned in the particular MST region which the bridge belongs to. Through
this table, additional MSTP configuration data can be applied and MSTP status can be retrieved.

Web Interface
To configure MSTP Instance in the web UL
1. Click Spanning Tree and Instance View.
2. Click the Add VLAN button.
3. Specify the Instance and Port.
4. Click Instance Status and Port Status to see the detail.
5. To cancel the settings click the Delete button.

TRANSITION * =| *** - e (o I 2
N NETWORKS: | )
SM8TAT2SA MSTP |nStanCE Config @ Home - Spanning Tree - Instance View
Switch DMS
Instance Corresponding Vlans
» System < D
» Port Management e -
L] 0 1-4094
» PoE Management <
» VLAN Management « | Add VLAN H Delete ‘
» Quality of Service E

| Instance Config || Port Confi Instance Status || Port Status

&

B Cnannina Traa

Figure 8-3: MSTP Instance Config

Parameter descriptions:

Instance ID: Every spanning tree instance must have a unique instance ID within 0~4095. Instance 0
(CIST) always exists and cannot be deleted. Additional spanning instances (MSTIs) can be added or
deleted. At least one VLAN must be provisioned for an MSTI to declare the need for the MSTI to exist.

Corresponding Vlans: 1-4095. Multiple VLANs can belong to an MSTIL. All VLANSs that are not provisioned
through this will be automatically assigned to Instance 0 (CIST).

Buttons

Add Vlan: Click to add an MSTI and provide its VLAN members or modify VLAN members for a specific
MSTL you can add up to 63 for a total of 64.

Delete: Click to delete a selected MSTL

Instance Config: Click to provision spanning tree performance parameters per instance.
Port Config: Click to provision spanning tree performance parameters per instance per port.
Instance Status: Click to show the status report of a particular spanning tree instance.

Port Status: Click to show the status report of all ports regarding a specific spanning tree instance.
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MSTP Create MSTI/Add Vlan Mapping:

ﬁ [ rmansman . L

TRANSITION ® =| =% : asss MO G

N\ NETWORKS: | o LLLLle ]
SMETAT2SA MSTP Create MSTI/Add Vlan Mapping
Switch DMS
Instance ID 1

b System
» Port Management < Vlan Mapping ‘ 2,5,20-40)
» PoE Management < y . ;
» VLAN Management & | fonbiywRcssl H Gancs

Parameter descriptions:
Instance ID: The valid range is 1-4094.

Vlan Mapping: The list of VLANs mapped to the MSTL The VLANSs can be given as a single (xx, xx being
between 1 and 4094) VLAN, or a range (xx-yy), each of which must be separated with comma and/or
space. A VLAN can only be mapped to one MSTL An unused MSTI should just be left empty (i.e., not have
any VLANs mapped to it). For example: 2,5,20-40.

Buttons

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
Cancel: Click to undo any changes made locally and return to the Users.

Instance Config of Instance 0 :

TRANSITION \ — JRausman : [T T Auto-logout H 9 C*
N = oy = =
NETWORKS . J
SMSTATZSA Instance Caniguration (lD:0) @Home - Spanning Tree - Instance View
Switch DMS
Priority 29768 v
» System <
» Port Management < Max. Age 20 seconds
Y <
» PoE Management Forward Delay 5 |seconds
» VLAN Management <
) . Max. Hops seconds
» Quality of Service < P “
» Spanning Tree ) . o ¢ " N
T | Apply I Reset || Back |

Figure 8-3: Instance Config of Instance 0
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Parameter descriptions:

Priority: The priority parameter used in the CIST (Common and Internal Spanning Tree) connection:

0/4096 /8192 /12288 /16384 / 20480 / 24576 / 28672 / 32768 / 36864 / 40960 / 45056 / 49152 /
53248 / 57344 / 61440

MAX. Age: 6-40sec. The same definition as in the RSTP protocol.
Forward Delay: 4-30sec. The same definition as in the RSTP protocol.

MAX. Hops: 6-40sec. It's a new parameter for the multiple spanning tree protocol. It is used in the
internal spanning tree instances. “CIST Remaining Hops"” or “"MSTI Remaining Hops” in the Spanning tree
protocol message would decrease by one when the message is propagated to the neighboring bridge.

If the Remaining Hops in a message is zero, the message (BPDU) would be regarded as invalid. Max Hops
is used to specify the initial value of the Remaining Hops for Regional Root Bridge (Either CIST Regional
Root or MSTI Regional Root).

Buttons
Apply : Click to save changes.
Reset : Click to undo any changes made locally and revert to previously saved values.

Back : Click to undo any changes made locally and return to the Users.

Port Config of Instance 0:
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» Multicast & -
6 (v Auto v 128 v Yes v Auto v No No v
» DHCP <
» Security < 7 [w) Auto v 128 v Yes v Aute v No No v
» Access Control < —
8 (v Auto v 128 v Yes v Auto v No No v
» SNMP <
T — q 9 [« Auto v 128 v Yes v Auto v No v No v v
vent Notification
» Diagnostics N 0 @ Auto v 128 v Yes v Auto v No No v
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| Apply H Back ‘

Figure 8-3: Port Config of Instance 0
Parameter descriptions:

Port: The logical port for the settings contained in the same row.
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Path Cost: 1 — 200,000,000 or Auto. The same definition as in the RSTP specification. But in MSTP, this
parameter can be respectively applied to ports of CIST and ports of any MSTL

Priority: 0/16/32/48/64/80/96/112/128 /144 /160 /176 /192 /208 /224 /240 . The same
definition as in the RSTP specification. But in MSTP, this parameter can be respectively applied to ports of
CIST and ports of any MSTL

Admin Edge: Yes / No. The same definition as in the RSTP specification for the CIST ports. The factory
default setting is No (Non-Edge).

Admin P2P: Auto / True / False. The same definition as in the RSTP specification for the CIST ports.

Restricted Role: Yes / No. If “Yes” causes the Port not to be selected as Root Port for the CIST or any
MSTI, even it has the best spanning tree priority vector. Such a Port will be selected as an Alternate Port
after the Root Port has been selected. This parameter is “No” by default. If set, it can cause lack of
spanning tree connectivity. It is set by a network administrator to prevent bridges external to a core region
of the network influencing the spanning tree active topology, possibly because those bridges are not
under the full control of the administrator.

Restricted TCN: Yes / No. If “Yes” causes the Port not to propagate received topology change
notifications and topology changes to other Ports. This parameter is “No” by default. If set it can cause
temporary loss of connectivity after changes in a spanning trees active topology as a result of persistent
incorrectly learned station location information. It is set by a network administrator to prevent bridges
external to a core region of the network, causing address flushing in that region, possibly because those
bridges are not under the full control of the administrator, or the status of MAC operation for the attached
LANs transitions frequently.

Migration Check: The same definition as in the RSTP specification for the CIST ports. The STP Migration
Check (mCheck) variable. Automatically migrate from RSTP or MSTP to STP-compatible mode.

Buttons
Apply : Click to save changes.

Back : Click to undo any changes made locally and return to the MSTP Instance Config table.
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Instance Status of Instance 0 :

..ﬁ . = ~
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| Back | Refresh |
b System < - -
» Port Management < MSTP State Enabled
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» VLAN Management < Bridge Max Age 20
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L ing T h .
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DT Instance Priority 32768
» Instance View Bridge Mac Address 00-40-CT-1C-CB-6E
» MAC Address Table < CIST ROOT PRIORITY 32768
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> (e CIST ROOT MAC 00-40-C7-1C-CB-6E
» DHCP <
CIST EXTERMAL ROOT PATH COST 0
¥ Security .
CIST ROOT PORTID ]
¥ Access Control <
CIST REGIONAL ROOT PRIORITY 32768
» SNMP <
» Evenit Notification < CIST REGIONAL ROOT MAC 00-40-CT-1C-CB-6E
b Diagnostics < CISTINTERNAL ROOT PATH COST 0
» Maintenance < CIST CURRENT MAX AGE 20
CIST CURRENT FORWARD DELAY 15
TIME SINCE LAST TOPOLOGY CHANGE
247057
(SECs)
W
TOPOLOGY CHANGE COUNT (SECs) 0

Figure 8-3: Instance Status of Instance 0
Parameter descriptions:
MSTP State : MSTP protocol is Enable or Disable.
Force Version : Shows the current spanning tree protocol version configured.
Bridge Max Age : Shows the Max Age setting of the bridge itself.
Bridge Forward Delay : Shows the Forward Delay setting of the bridge itself.
Bridge Max Hops : Shows the Max Hops setting of the bridge itself.
Instance Priority : Spanning tree priority value for a specific tree instance (CIST or MSTI)
Bridge Mac Address : The Mac Address of the bridge itself.
CIST ROOT PRIORITY : Spanning tree priority value of the CIST root bridge
CIST ROOT MAC : Mac Address of the CIST root bridge

CIST EXTERNAL ROOT PATH COST : Root path cost value from the point of view of the bridge’s MST
region.

CIST ROOT PORT ID : The port ID of the bridge's root port. In MSTP, peer port of a root port may reside
in different MST region or in the same MST region. The first case indicates that the root port's owner is the
CIST regional root bridge.
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CIST REGIONAL ROOT PRIORITY: Spanning tree priority value of the CIST regional root bridge. Note that
CIST Regional Root bridge is different from CIST Root bridge. One exception is that when a bridge
belonging to an MST region happens to be the root bridge of the CST (Common Spanning Tree). An MST
Region in the CST can be regarded as a common RSTP bridge. The IST (Internal Spanning Tree) and MSTIs
are transparent to bridges outside this region.

CIST REGIONAL ROOT MAC : Mac Address of the CIST regional root bridge.

CIST INTERNAL ROOT PATH COST : Root path cost value from the point of view of the bridges inside the
IST.

CIST CURRENT MAX AGE : Max Age of the CIST Root bridge.
CIST CURRENT FORWARD DELAY : Forward Delay of the CIST Root bridge.

TIME SINCE LAST TOPOLOGY CHANGE (SECs) : Time Since Last Topology Change is the elapsed time in
unit of seconds for a bunch of “Topology Change and(or) Topology Change Notification receiving” to
occur. When new series of Topology Changes occur again, this counter will be reset to 0.

TOPOLOGY CHANGE COUNT (SECs) : The per spanning tree instance Topology Change Count expresses
the time spent in unit of seconds since the beginning of the Spanning Tree Topology Change to the end of
the STP convergence. Once there is no topology change occurring and no more topology change
notification received, the Topology Change count will be reset to 0.

Buttons
Back : Click to undo any changes made locally and return to the Users page.

Refresh : Click to manually refresh the page immediately.
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Port Status of Instance 0 :

TRANSITION ® =| =< ; = 0 c
N NETWORKS:
SMSTATZSA Port Status Of |nSta nce l @@ Home - Spanning Tree - Instance View
Switch DMS ——
‘ Back H Refresh |
» System < - i
b B D e ¢ Port  Status Role Path Priority Hello Oper. Oper. Restricted Restricted
- No Cost Edge P2P Role Ten
» PoE Management E
1 DISCARDING  disable 20000 128 2 Vv
» VLAN Management E
» Quality of Service < 2 DISCARDING disable 500000 144 2 \
b Spanning Tree v 3 DISCARDING disable 20000000 128 2 v
> Bt 4 DISCARDING disable 20000000 128 2 v
> Region Config
5 DISCARDING  disable 20000000 128 2 vV
> Instance View
b MAC Address Table ¢ 5} DISCARDING  disable 20000000 128 2 v
vl
» Multicast < 7 DISCARDING  disable 20000000 128 2 v
» DHCP < & DISCARDING  disable 20000000 128 2 v
» Security ¢ 9 DISCARDING disable 20000000 128 2 i
: <
» Access Control 10 DISCARDING disable 20000000 128 2 v
» SAIMDP <

Figure 8-3: Port Status of Instance 0
Parameter descriptions:
Port No: The port number to which the configuration applies.

Status: The forwarding status. Same definition as of the RSTP specification. Possible values are
"FORWARDING", “LEARNING", “DISCARDING".

Role: The role that a port plays in the spanning tree topology. Possible values are “disable”(disable
port) , "alternate” (alternate port) , "backup” (backup port) , “ROOT" (root port) , "DSGN" (designated
port) , and “"MSTR" (master port). The last 3 are possible port roles for a port to transit to FORWARDING
state

Path Cost: Displays currently resolved port path cost value for each port in a particular spanning tree
instance.

Priority: Displays port priority value for each port in a particular spanning tree instance.

Hello: Per port Hello Time display. It takes the following form: Current Hello Time/Hello Time Setting
Oper. Edge: Whether or not a port is actually an Edge Port.

Oper. P2P: Whether or not a port is actually a Point-to-Point port.

Restricted Role: Yes / No. If “Yes” causes the Port not to be selected as Root Port for the CIST or any
MSTI even it has the best spanning tree priority vector. Such a Port will be selected as an Alternate Port
after the Root Port has been selected. This parameter is “No” by default. If set, it can cause lack of
spanning tree connectivity. It is set by a network administrator to prevent bridges external to a core region
of the network influencing the spanning tree active topology, possibly because those bridges are not
under the full control of the administrator.
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Restricted TCN: Yes / No. If “Yes" causes the Port not to propagate received topology change
notifications and topology changes to other Ports. This parameter is “No” by default. If set it can cause
temporary loss of connectivity after changes in a spanning trees active topology as a result of persistent
incorrectly learned station location information. It is set by a network administrator to prevent bridges
external to a core region of the network, causing address flushing in that region, possibly because those
bridges are not under the full control of the administrator, or the status of MAC operation for the attached
LANs transitions frequently.

Buttons
Back : Click to undo any changes made locally and return to the Users.

Refresh : Click to manually refresh the page immediately.

Messages
Message: MSTP disabled or force version is not MSTP
Recovery: Click OK to clear, change the Instance Status parameter, and continue.

X

192.168.1.77 says:

I MSTP disabled or force version is not MSTP ‘
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Chapter 9 - MAC Address Tables

9-1 Configuration

Switching of frames is based on the DMAC address contained in the frame. The switch builds a table that
maps MAC addresses to switch ports for knowing which ports the frames should go to (based upon the
DMAC address in the frame). This table contains both static and dynamic entries. The static entries are
configured by the network administrator if the administrator wants to do a fixed mapping between the
DMAC address and switch ports.

The frames also contain a MAC address (SMAC address), which shows the MAC address of the equipment
sending the frame. The SMAC address is used by the switch to automatically update the MAC table with
these dynamic MAC addresses. Dynamic entries are removed from the MAC table if no frame with the
corresponding SMAC address is been seen after a configurable age time.

Web Interface

To configure MAC Address Table in the web interface:

1. Click MAC Address Table and Configuration.
2. Specify the Disable Automatic Aging and Aging Time.
3. Configure the Port Members (Auto, Disable, Secure).
4. Click the Add New Static Entry button, and specify the VLAN ID, Mac address, Block, and Port
Member parameters.
5. Click Apply.
= — . = .
TRANSITION = o - Auto-logout H e
NETWORKS
SMETAT2SA MAC Table Configuration #BHome - MAC Address Teble - Configuretion
Switch DMS
Aging Configuration
¥ System
» Port Management < Disable Automatic Aging O
» PoE Management . Aging Time 300 seconds
» VLAN Management <
b Quality of Service < MAC Table Learning
» Spanning Tree <

Port Member

MAC Address Table h

P 1 2 3 a 5 6 7 8 g 10
> Information Learning [C] IC] IC] @ IC] IC] IC] IC] IC] [C]
: <
b Multicast Disable
» DHCP <
Secure
» Security <
Ao < . . .
> AccessControl Static MAC Table Configuration
b SNMP &
i Delete VLAN ID MAC Address Block Port Member
» Event Notification &
» Diagnostics & | Iele:—;| i 00-00-00-00-00-00 O Portl W

Maintenance

Figure 9-1: MAC Table Configuration
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Parameter descriptions:

Aging Configuration: By default, dynamic entries are removed from the MAC table after 300 seconds.
This removal is also called aging. Configure aging time by entering a value here in seconds. The valid
range is 10 - 1000000 seconds. Disable the automatic aging of dynamic entries by checking the Disable
Automatic Aging checkbox.

MAC Table Learning

If the learning mode for a given port is greyed out, another module is in control of the mode, so that it
cannot be changed by the user. An example of such a module is the MAC-Based Authentication under
802.1X. Each port can do learning based upon the following settings:

Learning: Learning is done automatically as soon as a frame with unknown SMAC is received.

Disable: No learning is done.

Secure: Only static MAC entries are learned; all other frames are dropped.

@ NoTe: Make sure that the link used for managing the switch is added to the Static
MAC Table before changing to Secure learning mode, otherwise the management link
is lost and can only be restored by using another non-secure port or by connecting to
the switch via the Telnet interface.

Static MAC Table Configuration

The static entries in the MAC table are shown in this table. The static MAC table can contain 64 entries.
The MAC table is sorted first by VLAN ID and then by MAC address.

Delete: Check to delete the entry. It will be deleted during the next save.

VLAN ID: The VLAN ID of the entry.

MAC Address: The MAC address of the entry.

Block: Click it, if you want to block this mac address.

Port Member: Check radio buttons to set which ports are members of the entry. Check or uncheck as
needed to modify the entry.

Buttons

Add New Static Entry: Click to add a new entry to the static MAC table. Specify the VLAN ID, MAC
address, and port members for the new entry. Click "Apply".

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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9-2 Information

Entries in the MAC Table are shown on this page. The MAC Table contains up to 8192 entries, and is
sorted first by VLAN ID, then by MAC address.

Web Interface

To display the Dynamic MAC Table in the web interface:
1. Click MAC Address Table and Information.
2. View the displayed MAC Address Table.

TRANSITION = | T [ ] Auto-logout OFF = 0
N NETWORKS:
SMBTAT2SA MAC Table Information @Home - MACAddressTable  Information
Switch DMS —
Auto-refresh | Refresh | Clear |
» System <
» Port Management ¢ Show| 10 E|entr‘\es Search:
» PoE Management 3 Port Members
<
» VLAN Management Type VLAN  “ MACAddress “ Block cPU 1 2 3 +4 :5 :6 -7 :8 9 °10
» Quality of Service s . E
Static 10 00-00-00-00-00-00 No v
» Spanning Tree <
Static 100 00-00-00-00-00-00 Yes
» MAC Address Table >
> Configuration Static 109 00-00-00-00-00-00 No v
> Information Dynamic 1 00-00-5E-00-01-04 No v
» Multicast < Dynamic 1 00-00-5E-00-01-07 No v
» DHCP <
Dynamic 1 00-07-4D-22-7C-24 No v
» Security <
Dynamic 1 00-07-E9-B2-4B-F0 No v
» Access Control 3
Dynamic 1 00-08-E3-FF-FC-28 No v
» SNMP <
» Event Notification ¢ Dynamic 1 00-0C-29-38-CB-C9 No v
» Diagnostics < Dynamic 1 00-0C-29-4B-CA-4F No v
» Maintenance < 2.3 4 s 14 Next

Figure 9-2: MAC Table Information
Parameter descriptions:
Show x entries: At the dropdown, select how many lines to display per page (10, 25, 60, 100, or 500).
Type: Indicates whether the entry is a Static or a Dynamic entry, or 802.1x, DMS.
VLAN: The VLAN ID of the entry.
MAC address: The MAC address of the entry.
Block: Whether the mac address is blocked or not.

Port Members: The ports that are members of the entry.

Auto-refresh Refresh I Clear \
Buttons [ H_J

Auto-refresh: Check to refresh the page automatically every 3 seconds.
Refresh: Click to manually refresh the page. immediately

Clear: Click to clear the page.

Previous: Updates the system log entries, turn to the previous page.
Next: Updates the system log entries, turn to the next page.
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@ Note: 00-40-C7-73-01-29 : your switch MAC address (for IPv4)

33-33-00-00-00-01 : Destination MAC (for IPv6 Router Advertisement) (reference IPv6 RA.JPG)
33-33-00-00-00-02 : Destination MAC (for IPv6 Router Solicitation) (reference IPv6 RS.JPG)
33-33-FF-73-01-29 : Destination MAC (for IPv6 Neighbor Solicitation) (reference IPv6 DAD.JPG)
33-33-FF-A8-01-01: your switch MAC address (for IPv6 global IP)

FF-FF-FF-FF-FF-FF: for Broadcast.
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Chapter 10 - Multicast b Mulicast

» |GMP Snooping <

10-1 IGMP Snooping e

» MVR ¢

<

IGMP Snooping is used to establish the multicast groups to forward the multicast packet » Multicast Filtering Profile <
to the member ports, and, in nature, avoids wasting the bandwidth while IP multicast packets are running

over the network. This is because a switch that does not support IGMP or IGMP Snooping cannot tell a
multicast packet from a broadcast packet, so it can only treat them all as a broadcast packet. Without

IGMP Snooping, a multicast packet forwarding function is plain and nothing is different from a broadcast
packet.

The switch supports IGMP Snooping functions of query, report and leave, a type of packet exchanged
between IP Multicast Router/Switch and IP Multicast Host, can update the information of the Multicast
table when a member (port) joins or leaves an IP Multicast Destination Address. With this function, once a
switch receives an IP multicast packet, it will forward the packet to the members who joined in a specified
IP multicast group before.

The packets will be discarded by the IGMP Snooping if the user transmits multicast packets to the
multicast group that had not been built up in advance. IGMP mode enables the switch to issue IGMP
function that you enable IGMP proxy or snooping on the switch, which connects to a router closer to the
root of the tree. This interface is the upstream interface. The router on the upstream interface should be
running IGMP.

10-1.1 Basic Configuration

This webpage lets you set the basic IGMP snooping on the switch, which connects to a router closer to the
root of the tree. This interface is the upstream interface. The router on the upstream interface should be
running IGMP.

Web Interface
To configure IGMP Snooping parameters in the web UL

Click Multicast, IGMP Snooping, and Basic Configuration.

Enable or disable which Global configuration.

Select the port you want to become a Router Port or enable/ disable the Fast Leave function.
Scroll to set the Throttling and Profile.

Click the Apply button to save the settings.

o v A w N

To cancel the setting, click the Reset button to revert to previously saved values.

33717 Rev. ) https://www.transition.com Page 130 of 304



https://www.transition.com/

Transition Networks SMXTAT2SA Web User Guide

TRANSITION ® = === ;| = woest (7 Y] H @ G
N\ NETWORKS
SMETAT2SA IGMP Snooping Conﬁguration @Home - Multicast - IGMP Snooping - Basic Configuration
Switch DMS
Global Configuration

} System <
» Port Management < Snooping Enabled ﬂj
» PoE Management <

Unregistered IPMCv4 Flooding Enabled [

-

VLAN Management

IGMP 55M Range 232.0.0.0
» Quality of Service <
» Spanning Tree < Proxy Enabled [
» MAC Address Table <
S . Port Related Configuration
Port Router Port Fast Leave Throttling Profile
1 Ij I:‘ unlimited W - v
2 @ D v [ ]
» Groups Infermation
> IGMP SFM Information 3 @ E‘ unlimited -V
MLD Snooping <
- 4 ] O unlimited ¥ v
» MVR <
» Multicast Filtering Profile < B D |:| unlimited W - v
<
» DHCP 6 D |:| unlimited % -V
» Security <
T D |:| unlimited % -
» Access Control <
» SNMP < 8 O O nlimited v
Ev Mati #i <
} Event Motification g O ] nlimited v e
» Diagnostics <
10 [l [} unlimited -
» Maintenance <
| Apply || Reset |

Figure 10-1.1: IGMP Snooping Configuration
Parameter descriptions:

Global Configuration
Snooping Enabled: Enable the Global IGMP Snooping.

Unregistered IPMCv4 Flooding enabled: Enable unregistered IPMCv4 traffic flooding. Unregistered
IPMCv4 traffic is also called "unknown multicast”. After selected, the unregistered multicast stream will be
forwarded like normal packets. Once you un-selected it, an unregistered multicast stream will be
discarded.

IGMP SSM Range: SSM (Source-Specific Multicast) Range lets the SSM-aware hosts and routers run the
SSM service model for the groups in the address range. Format: (IP address/ sub mask).

Per IETF RFC 4607, IP version 4 (IPv4) addresses in the 232/8 (232.0.0.0 t0232.255.255.255) range are
designated as source-specific multicast (SSM) destination addresses and are reserved for use by source-
specific applications and protocols. For IP version 6 (IPv6), the address prefix FF3x::/32 is reserved for
source-specific multicast use.

Proxy Enabled: Enable IGMP Proxy. This feature can be used to avoid forwarding unnecessary join and
leave messages to the router side.
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Port Related Configuration
Port: It shows the physical Port index of switch.

Router Port: Specify which ports act as router ports. A router port is a port on the Ethernet switch that
leads towards the Layer 3 multicast device or IGMP querier. If an aggregation member port is selected as a
router port, the whole aggregation will act as a router port.

Fast Leave: Enable the fast leave on the port.
Throttling: Enable to limit the number of multicast groups to which a switch port can belong.

Profile: You can select profile when you edit in Multicast Filtering Profile.

Buttons

Auto-refresh: Check to refresh the page automatically every 3 seconds.
Refresh: Click to manually refresh the page. immediately
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10-1.2 VLAN Configuration

This page lets you set the VLAN parameters integrated with the IGMP Snooping function. Each page
shows up to 99 entries from the VLAN table, default being 20, selected through the "entries per page"
input field. When first visited, the web page will show the first 20 entries from the beginning of the VLAN
Table. The first displayed will be the one with the lowest VLAN ID found in the VLAN Table. The "VLAN"
input fields allow the user to select the starting point in the VLAN Table.

Web Interface

To configure the IGMP Snooping VLAN Configuration in the web interface:
Click Multicast, IGMP Snooping, and VLAN Configuration.

Click the Add New IGMP VLAN button to add a new row to the table.
3. Click the Apply button to save the settings.

N

4. To cancel the setting, click the Reset button to revert to previously saved values.

TR TR R —
TRANSITION E| E = ] oot Y] QG
Na—" NETWORKS
SMBTAT2SA IGMP Snooping Vlan Configuration Home - Mulicast - [GMP Snooping - Vlan Canfiguration
Switch DMS

VLAN  Snooping IGMP

b System Delete 1D Enabled Querier  Compatibility RV Ql{sec) QRI(0.1 sec) LLQI{0.1 sec) URI(sec)

» Port Management

(] 1000

IGMP-Auta ~ 2 125

» PoE Management

125

3
<

] 2000 (

2
» VLAN Management *
¥

& &

» Quality of Service

125

3
<

| 3000

» Spanning Tree

P MAC Address Table

» Multicast

» IGMP Snoonine

Figure 10-1.2: IGMP Snooping VLAN Configuration

Parameter descriptions:

Start from Vlan: Click to refresh the displayed table starting from the "VLAN" input fields.

Delete: Check to delete the entry. The designated entry will be deleted during the next save.

VLAN ID: Displays the VLAN ID (VID) of the entry.

Snooping Enabled: Enable the per-VLAN IGMP Snooping. Only up to 32 VLANs can be selected. .

IGMP Querier: Enable to join IGMP Querier election in the VLAN. Disable to act as an IGMP Non-Querier.

Compatibility: Compatibility is maintained by hosts and routers taking appropriate Compatibility

actions depending on the versions of IGMP operating on hosts and routers within a
network. The allowed selections are IGMP-Auto, Forced IGMPv1, Forced IGMPv2, Forced

IGMP-Auto

IGMPv3. The default is IGMP-Auto. Forced IGMPv1
Forced IGMPw2

IGMP v1 is specified in RFC-1112; it was the first widely-deployed version and the first |_forced IGMPv3___|
version to become an Internet Standard.

IGMP v2, specified in RFC-2236, added the ability for a host to signal desire to leave a multicast group.
IGMP v3, specified in RFC 3376, adds support for "source filtering”, that is, the ability for a system to
report interest in receiving packets *only* from specific source addresses, or from *all but* specific source
addresses, sent to a particular multicast address.

Rv: Robustness Variable. The Robustness Variable allows tuning for the expected packet loss on a network.
The allowed range is 1 to 255; default RV value is 2.
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QI(sec): Query Interval. The Query Interval is the interval between General Queries sent by the Querier.
The allowed range is 1 to 31744 seconds; default query interval is 125 seconds.

QRI(0.1 sec): Query Response Interval. The Max Response Time used to calculate the Max Resp Code
inserted into the periodic General Queries. The allowed range is 0 to 31744 in tenths of seconds; default
query response interval is 100 in tenths of seconds (10 seconds).

LLQI (0.1 sec): Last Member Query Interval. The Last Member Query Time is the time value represented
by the Last Member Query Interval, multiplied by the Last Member Query Count.

The allowed range is 0 to 31744 in tenths of seconds; the default last member query interval is 10 in
tenths of seconds (1 second).

URI(sec): Unsolicited Report Interval. The Unsolicited Report Interval is the time between repetitions of a
host's initial report of membership in a group. The allowed range is 0 to 31744 seconds; the default
unsolicited report interval is 1 second.

Buttons
Add New IGMP VLAN : Click to add a new IMCP VLAN entry to the table.
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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10-1.3 Status

After you complete the IGMP Snooping configuration, you can view the IGMP Snooping Status. This page
displays the IGMP Snooping detail status.

Web Interface

To display the IGMP Snooping status in the web interface:

1. Click Multicast, IGMP Snooping, and Status.

2. To auto-refresh the information, set “Auto-refresh” to On.

3. Click “Refresh” to refresh the IGMP Snooping Status.

TRANSITION ® =( === : &= °c
L" NETWORKS
SMBTAT25A IGMP Snooping Status @Home - Multicast - IGMPSnaoping - Status
Switch DMS —
Auto-refresh | Refresh |
b System &
» Port Management < Statistics
» PoE Management & VLAN = Querier Host Querier  Queries Queries V1 Reports V2 Reports V3 Reports V2 Leaves
» VLAN Management < ID Version Version = Status Transmitted = Received Received Received Received Received
¥ Quality of Service < 1000 w3 v3 IDLE 0 0 0 0 0 0
} Spanning Tree < 3000 w3 w3 ACTIVE 4] 0 0 1] 0 0
» MAC Address Table <

v Router Port

b Multicast
»
Port Status
1
> 2
3 Static
4 Static
op <
» MVR < 5 Static
* Multicast Filtering Profile < &
» DHCP < 7
» Security < 2
» Access Control < o
» SNMP <
10
» Fuent Notification <

Figure 10-1.3: IGMP Snooping Status

Parameter descriptions:

Statistics

VLAN ID: The VLAN ID of the entry.

Querier Version: Working Querier Version currently.
Host Version: Working Host Version currently.

Querier Status: Shows the Querier status is "ACTIVE" or "IDLE". "DISABLE" denotes the specific interface is
administratively disabled.

Queries Transmitted: The number of Transmitted Queries.

Queries Received: The number of Received Queries.
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V1 Reports Received: The number of Received V1 Reports.
V2 Reports Received: The number of Received V2 Reports.
V3 Reports Received: The number of Received V3 Reports.

V2 Leaves Received: The number of Received V2 Leaves.

Router Port: Displays which ports act as router ports. A router port is a port on the Ethernet switch that
leads towards the Layer 3 multicast device or IGMP querier. Static denotes the specific port is configured
to be a router port. Dynamic denotes the specific port is learnt to be a router port. Both denote the
specific port is configured or learnt to be a router port.

Port: Switch port number.

Status: Indicate whether specific port is a router port or not.

Auto-refresh ‘ Refresh ‘

Buttons

Auto-refresh: Check to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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10-1.4 Group Information

After you complete setting the IGMP Snooping function, you can view the IGMP Snooping Group
Information. Entries in the IGMP Group Table are shown on this page. The IGMP Group Table is sorted first
by VLAN ID, and then by group. When the end is reached the text "No more entries" is shown in the
displayed table.

Group Member behavior: in order to be compatible with older version routers, IGMPv3 hosts must
operate in version 1 and version 2 compatibility modes. IGMPv3 hosts MUST keep state per local interface
regarding the compatibility mode of each attached network. A host's compatibility mode is determined
from the Host Compatibility Mode variable which can be in one of three states: IGMPv1, IGMPv2 or
IGMPv3. This variable is kept per interface and depends on the version of General Queries heard on that
interface as well as the older querier present timers for the interface.

Web Interface

To display the IGMP Snooping Group Information in the web interface:

1. Click Multicast, IGMP Snooping, and Groups Information.

2. Specify how many entries to show in one page.

3. To auto-refresh the information click the “Auto-refresh” button.

4. Click "Refresh” to refresh an entry of the IGMP Snooping Groups Information.
5. Click Previous or Next to change pages.

N "

TRANSITION ® =| == s Y
N\ NETWORKS
SM8TAT2S5A IGMP Snooping Groups Information @Home - Multicsst - IGMP Snaoping - Groups Information
Switch DMS
Auto-refresh | Refrash |

b System <
» Port Management < Show | i w entries Search:
» PoE Managemeant < Port Members

-

VLAN Management VLAN ID * Group 1 2 3 4 5 [ 7 8 9 10

» Quality of Service &

AR No data available in table
» Spanning Tree <
b MAC Address Table <

b Multicast

(P TT N S

Figure 10-1.4: IGMP Snooping Groups Information

Parameter descriptions:
Navigating the IGMP Group Table

Each page shows up to 99 entries from the IGMP Group table, default being 20, selected through the
"entries per page" input field. When first visited, the web page shows the first 20 entries from the
beginning of the IGMP Group Table. The "Start from VLAN", and "group" input fields let you select the
starting point in the IGMP Group Table.

Search: You can search for the information that you want to see.

Show entries: You can choose how many items you want to view.

VLAN ID: VLAN ID of the group.

Groups: Group address of the group displayed.
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Port Members: Ports under this group.

Buttons Auto-refresh ‘ Refresh ‘

Auto-refresh : Check this box to refresh the page automatically every
3 seconds.

Refresh : Click to manually refresh the page immediately.
Next : Updates the system log entries, turn to the next page.

Previous : Updates the system log entries, turn to the previous page.
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10-1.5 IGMP SFM Information

Entries in the IGMP SFM Information Table are shown on this page. The IGMP SFM (Source-Filtered
Multicast) Information Table also contains the SSM (Source-Specific Multicast) information. This table is
sorted first by VLAN ID, then by group, and then by Port. Different source addresses belong to the same
group are treated as single entry.

Web Interface

To display the IGMP SFM Information in the web interface:

1. Click Multicast, IGMP Snooping, and IGMP SFM Information.

2. To auto-refresh the information select “Auto-refresh”.

3. Click "Refresh” to refresh an entry of the IGMP Snooping Groups Information.
4

Click Previous/Next to change page.

TRANSITION ® =| 2% : = HN oG
N\ NETWORKS
SM8TAT2SA IGMP SFM Information @Home - Multicast - IGMP Snooping - 1GMP SFM Infarmation
Switch DMS —
Auto-refresh | Refrash |
» System <
» Port Manasement < Show | i w entries Search:
» PoE Management . VLAN ID 4 Group Port Mode Source Address Type
(AN Manaoe <
> LAY M e No data available in table
» Quality of Service <
» Spanning Tree <

T S [ I £

Figure 10-1.5: IGMP SFM Information
Navigating the IGMP SFM Information Table

Each page shows up to 99 entries from the IGMP SFM Information table, default being 20, selected
through the "entries per page" input field. When first visited, the web page will show the first 20 entries
from the beginning of the IGMP SFM Information Table.

The "Start from VLAN", and "group" input fields allow the user to select the starting point in the IGMP SFM
Information Table. Clicking the Next button will update the displayed table starting from that or the
closest next IGMP SFM Information Table match. In addition, the two input fields will - upon a Previous
button click - assume the value of the first displayed entry, allowing for continuous refresh with the same
start address.

Parameter descriptions:

Search : You can search for the information that you want to view.
Show entries : You can choose how many items you want to show.
VLAN ID : VLAN ID of the group.

Group : Group address of the group displayed.

Port : Switch port number.

Mode : Indicates the filtering mode maintained per (VLAN ID, port number, Group Address) basis. It can
be either Include or Exclude.
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Source Address : IP Address of the source. Currently, system limits the total number of IP source
addresses for filtering to be 128.

Type : Indicates the Type. It can be either Allow or Deny.

Buttons Auto-refresh ‘ Refresh |

Auto-refresh : Check this box to refresh the page automatically every 3 seconds.
Refresh : Click to manually refresh the page immediately.
Previous : Updates the system log entries, turn to the previous page.

Next : Updates the system log entries, turn to the next page.
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10-2 MLD Snooping

Curiously enough, a network node that acts as a source of IPv6 multicast traffic is only an indirect
participant in MLD snooping - it just provides multicast traffic, and MLD doesn't interact with it. (Note,
however, that in an application like desktop conferencing a network node may act as both a source and an
MLD host; but MLD interacts with that node only in its role as an MLD host.)

A source node creates multicast traffic by sending packets to a multicast address. In IPv6, addresses with
the first eight bits set (that is, “FF” as the first two characters of the address) are multicast addresses, and
any node that listens to such an address will receive the traffic sent to that address. Application software
running on the source and destination systems cooperates to determine what multicast address to use.
(Note that this is a function of the application software, not of MLD.)

When MLD snooping is enabled on a VLAN, the switch acts to minimize unnecessary multicast traffic. If
the switch receives multicast traffic destined for a given multicast address, it forwards that traffic only to
ports on the VLAN that have MLD hosts for that address. It drops that traffic for ports on the VLAN that
have no MLD hosts.

MLD snooping enablad
Listener
(MLD hiost)
] [
— L[ — [ ]
[ =

[ Jj— ;
Switch

Source \
= A

[ |:| Listener
[ | (MLD host)

Figure 10-2: MLD Snooping enabled
10-2.1 Basic Configuration

This section let you configure the MLD Snooping basic configuration and the parameters.
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Web Interface
To configure MLD Snooping in the web UL

1. Click Multicast, MLD Snooping, and Basic Configuration.
2. Select "on" to enable Snooping globally and configure the parameters.
3. Select the port to join Router Port and Fast Leave.
4. Scroll to the Throttling mode dropdown and select unlimited or 1 to 10.
5. Click the Apply button to save the settings.
6. To cancel the settings, click the Reset button to revert to previously saved values.
TRARSTION ol FF
TRANSITION ® =| =% ; m=== _ _ oo
NETWORKS: 3 10
SMBTAT2SA MLD SnOOping COnﬁgUratiDn @ Home - Multicast ~ MLD Snooping - Basic Configurstion
Switch DMS
Global Configuration
» System <
» Port Management < Snooping Enabled ﬂ)
» PoE Management < i .
Unregistered IPMCvé Flooding
» VLAN Management < Enabled
» Quality of Service < MLD SSM Range Fraee /| e
» Spanning Tree <
Proxy Enabled
» MAC Address Table <
» Multicast e . .
e Port Related Configuration
» IGMP Snooping <
#» MLD Snooping ~ Port Router Port Fast Leave Throttling Profile
Basic Configuratio
Lo e 1 (] (] unlimited W - v
» Vlan Configuration
» Status 2 2 v v
» Groups Information
3 D unlimited % - oW
> MLD 5FM Information
» MVR < 4 l:l unlimited % - v
® Multicast Filtering Profile <
3 6 w w
» DHCP &
b Security < 6 O OJ unlimited % - v
» Access Control < 7 Ol ] unlimited - v
» SNMP &
8 D D unlimited % LW
» Event Notification <
» Diagnostics < g O ] unlimited % Low
» Maintenance & 10 ] O unlimited - v

Figure 10-2.1: MLD Snooping Basic Configuration
Parameter descriptions:

Global Configuration

Snooping Enabled: Enable the Global MLD Snooping.
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Unregistered IPMCv6 Flooding Enabled: Enable unregistered IPMCv6 traffic flooding.
Flooding control takes effect only when MLD Snooping is enabled. When MLD Snooping is disabled, then
unregistered IPMCv6 traffic flooding is always active in spite of this setting.

MLD SSM Range: SSM (Source-Specific Multicast) Range allows the SSM-aware hosts and routers run the
SSM service model for the groups in the address (using IPv6 Address) range.

Proxy Enabled: Enable MLD Proxy. This feature can be used to avoid forwarding unnecessary join and
leave messages to the router side.

Port Related Configuration

Router Port: Specify which ports act as router ports. A router port is a port on the Ethernet switch that
leads towards the Layer 3 multicast device or MLD querier. If an aggregation member port is selected as a
router port, the whole aggregation will act as a router port.

Fast Leave: Check the box to enable Fast Leave on the port.
Throttling: Enable to limit the number of multicast groups to which a switch port can belong.

Profile: You can select profile when you edit in Multicast Filtering Profile.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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10-2.2 VLAN Configuration

When MLD snooping is enabled on a VLAN, the switch acts to minimize unnecessary multicast traffic. If
the switch receives multicast traffic destined for a given multicast address, it forwards that traffic only to
ports on the VLAN that have MLD hosts for that address. It drops that traffic for ports on the VLAN that
have no MLD hosts

Web Interface

To configure MLD Snooping VLAN Configuration in the web UL

1. Click Multicast, MLD Snooping and VLAN Configuration.
2. Click the Add New MLD VLAN button.
3. Specify the VLAN ID with entries per page.

» Spanning Tree

TRANSITION =“ E ” o
V NETWORKS
SMBTAT2SA MLD Snooping Vlan Configuration @Homs - Multicast - MLDSnooping - Wian Configuration
Switch DMS
Snooping MLD
¥ System ¢ Delete VLANID Enabled  Querier Compatibility RV Ql(sec) QRI(0.1 sec) LLQI(0.1 sec) URI(sec)
» Port Management < _ _
‘ Delete ‘ (] O MLD-Auto ~ 2 125
» PoE Management < —
» VIANManagement < | Delete | 0 0 moe v | 2 12
» Quality of Service < ‘7_‘7” ‘ 0 0 e
. Delete. L
<

» MAC Address Table

» Mu

» IGMP Snooping <

Figure 10-2.2: MLD Snooping VLAN Configuration

Parameter descriptions:

Delete: Check to delete the entry. The designated entry will be deleted during the next save.

VLAN ID: It displays the VLAN ID of the entry.

Snooping Enabled: Enable the per-VLAN IGMP Snooping. Up to 32 VLANs can be selected.

MLD Querier: Enable to join IGMP Querier election in the VLAN. Disable to act as an IGMP Non-Querier.

Compatibility: Compatibility is maintained by hosts and routers taking appropriate actions
depending on the versions of IGMP operating on hosts and routers within a network. The
allowed selections are MLD-Auto, Forced MLD v1, Forced MLD v2. The default
compatibility value is MLD-Auto. WL

Forced MLDv1
Forced MLDv2

Compatibility

RV: Robustness Variable. The Robustness Variable allows tuning for the expected packet
loss on a network. The allowed range is 1 to 255; the default robustness variable value is 2.

QI(sec): Query Interval. The Query Interval is the interval between General Queries sent by the Querier.
The allowed range is 1 to 31744 seconds; the default query interval is 125 seconds.

QRI(0.1sec): Query Response Interval. The Max Response Time used to calculate the Max Resp Code
inserted into the periodic General Queries. The allowed range is 0 to 31744 in tenths of seconds; default
query response interval is 100 in tenths of seconds (10 seconds).
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LLQI (LMQI for IGMP): Last Member Query Interval. The Last Member Query Time is the time value
represented by the Last Member Query Interval, multiplied by the Last Member Query Count. The allowed
range is 0 to 31744 in tenths of seconds; default last member query interval is 10 in tenths of seconds (1
second).

URI(sec): Unsolicited Report Interval. The Unsolicited Report Interval is the time between repetitions of a
host's initial report of membership in a group. The allowed range is 0 to 31744 seconds; the default
unsolicited report interval is 1 second.

Buttons
Add New MLD VLAN : Click to add a new instance to the table for configuration.
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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10-2.3 Status

This page lets you view MLD Snooping Status and detail information.

Web Interface

To display MLD Snooping Status in the web UL
1. Click Multicast, MLD Snooping, and Status.

2. To automatically refresh the information select “on” at "Auto-refresh”.

SMXTAT2SA Web User Guide

3. Click "Refresh” to refresh an entry of the MLD Snooping Status Information.

o
TeansITIoN

SMBTAT2S5A
Switch DMS

-

System

-

Port Management

-

PoE Management

-

VLAN Management

-

Quality of Service

-

Spanning Tree

» MAC Address Table

> Groups Infermation

> MLD SFM Information
» MVR
» Multicast Filtering Profile

» DHCP

-

Security

<

'é‘j

(

MLD Snooping Status

Auto-refresh | Refresh |

Statistics

VLAN  Querier Host Querier
D Version Version Status

Router Port

Port
1

2

[

w

10

Queries Queries V1 Reports
Transmitted Received Received
Status
Static
Static
Static

Figure 10-2.3: MLD Snooping Status

Parameter descriptions:

VLAN ID: The VLAN ID of the entry.

Querier Version: Working Querier Version currently.

Host Version: Working Host Version currently.

Auto-logout H 9 C.

@Home - Mulficast - MLD Snooping - Ststus
V2 Reports V1 Leaves
Received Received

Querier Status : Show the Querier status is "ACTIVE" or "IDLE". "DISABLE" denotes the specific interface is
administratively disabled.

Queries Transmitted: The number of Transmitted Queries.

Queries Received: The number of Received Queries.

V1 Reports Received: The number of Received V1 Reports.

V2 Reports Received: The number of Received V2 Reports.

V1 Leaves Received: The number of Received V1 Leaves.
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Router Port: Display which ports act as router ports. A router port is a port on the Ethernet switch that
leads towards the Layer 3 multicast device or MLD querier.

Static denotes the specific port is configured to be a router port.
Dynamic denotes the specific port is learnt to be a router port.
Both denote the specific port is configured or learnt to be a router port.

Port: Switch port number.

Status: Indicate whether specific port is a router port or not.

Buttons Auto-refresh | Refresh |

Auto-refresh: Check to on to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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10-2.4 Groups Information

This page lets you set MLD Snooping Groups Information. The "Start from VLAN", and "group” input fields
allow the user to select the starting point in the MLD Group Table.

Each page shows up to 99 entries from the MLD Group table, default being 20, selected through the
"entries per page" input field. When first visited, the web page will show the first 20 entries from the
beginning of the MLD Group Table.

Web Interface

To display MLD Snooping Group information in the web UL

1. Click Multicast, MLD Snooping, and Group Information.

2. To auto-refresh the information select “on” at “Auto-refresh”.

3. Click “Refresh” to refresh an entry of the MLD Snooping Group Information.

TRANSITION ® =| === : = H oG
N NETWORKS
SM8TAT25A MLD Snooping Groups Information @Home - Multicast = MLD Snoaping - Groups Information
Switch DMS —
Auto-refresh | Refresh ‘
» System <
D B e < Show| 1w entries Search:
» PoE Management < Port Members
(LAN Manage <
L UL BT VLAN ID “ Group 1 2 3 4 5 6 7 8 9 10
» Quality of Service <
£ I No data available in table
» Spanning Tree <
» MAC Address Table <

> Multicast v
Figure 10-2.4: MLD Snooping Groups Information

Parameter descriptions:

VLAN ID: VLAN ID of the group.

Groups: Group address of the group displayed.

Port Members: Ports under this group.

Show entries: Choose how many items you want to view per page.

Buttons Auto-refresh ‘ Refresh ‘

Auto-refresh: Check to refresh the page automatically every 3
seconds.

Refresh: Click to manually refresh the page immediately.
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10-2.5 MLD SFM Information

Entries in the MLD SFM Information Table are shown on this page. The MLD SFM (Source-Filtered
Multicast) Information Table also contains the SSM (Source-Specific Multicast) information. This table is
sorted first by VLAN ID, then by group, and then by Port. Different source addresses that belong to the
same group are treated as single entry.

Web Interface
To display MLD SFM Information in the web UL

1. Click Multicast, MLD Snooping, and MLD SFM Information.
2. To auto-refresh the information click Auto-refresh “On".
3. Click “Refresh” to refresh an entry of the MLD SFM Information.

TRANSITION =| == : &2 MO G
N NETWORKS
SMBTAT25A MLD SFM Information @Home - Multicast - MLD Snooping - MLD SFM Information
Switch DMS —
Auto-refresh | Refresh |
b System <
» Port Management < S}"owentries search:
» PoE Management x VLAN ID “ Group Port Mode Source Address Type

» VLAN Management Mo data available in table

» Quality of Service

» Spanning Tree

Figure 10-2.5: MLD SFM Information

Parameter descriptions:

VLAN ID: VLAN ID of the group.

Group: Group address of the group displayed.
Port: Switch port number.

Mode: Indicates the filtering mode maintained per (VLAN ID, port number, Group Address) basis.
It can be either Include or Exclude.

Source Address: The IP Address of the source. Currently, the system limits the total number of IP source
addresses for filtering to be 128.

Type: Indicates the Type. It can be either Allow or Deny.

Show entries: You can choose how many items you want to display.

Buttons Auto-refresh ‘ Refresh ‘

Auto-refresh: Check to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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10.3 Multicast Filtering Profile

The ICMP (Internet Control Message Protocol) generates error response, diagnostic, or routing messages. ICMP
messages generally contain information about routing difficulties or simple exchanges such as time-stamp or echo
transactions.

IGMP Snooping is used to establish the multicast groups to forward the multicast packet to the member ports. It
avoids wasting the bandwidth when IP multicast packets are running over the network.

A switch that does not support IGMP or IGMP Snooping cannot tell the multicast packet from the broadcast packet,
so it can only treat them all as broadcast packets. Without IGMP Snooping, the multicast packet forwarding
function is inactive and all packets are treated as broadcast packets.

A switch that supports IGMP Snooping can query, report, and leave a packet exchanged between an IP Multicast
Router/Switch and an IP Multicast Host, and can update the information of the Multicast table when a member
(port) joins or leaves an IP Multicast Destination Address. With this function, once a switch receives an IP multicast
packet, it will forward the packet to the members who joined in a specified IP multicast group previously.

The packets will be discarded by IGMP Snooping if the user transmits multicast packets to the multicast group that
was not built up in advance. IGMP mode enables the switch to issue IGMP function that you enable IGMP proxy or
snooping on the switch, which connects to a router closer to the root of the tree. This interface is the upstream
interface. The router on the upstream interface should be running IGMP.

10.3-1 Switch > Multicast > Multicast Filtering Profile > Filtering Profile Table

The IPMC profile is used to deploy the access control on IP multicast streams. You can create a maximum of 64
Profiles and a maximum 128 corresponding rules for each at the Multicast Filtering Profile Configuration table.

Click the Add New Profile button to display the configurable parameters.

TRANSITION ® = =% : = Y
N NETWORKS
SMETAT2SA Multicast Filtering Profile Configuration — @Hems - Mutiesst - Muicsst FiseringProfile - Fitering Prefila Tasle
Switch DMS
Multicast Filtering Profile Mode Enabled W
b System <
» Port Management 5 . i )
Filtering Profile Table Setting
» PoE Management <
b VLAN Management < Delete Profile Name Profile Description Rule |
» Quality of Service < I} 3 44 | Ed |
} Spanning Tree <
» MAC Address Table 5 | Add New Profile |
¥ Multicast ’ | Annhi || Reset |

W IGMP Shannine ‘e

Parameter descriptions:

Multicast Filtering Profile Mode: Enable/Disable the Global IPMC Profile. The system starts to do filtering based on
profile settings only when the global profile mode is enabled. Select to Disable or Enable globally. The default is
Disabled.

Filtering Profile Table Setting

Delete: Click to delete the entry. The designated entry will be deleted during the next apply.

Profile Name: The name used for indexing the profile table. Each entry has the unique name which is composed of
at maximum 16 alphabetic and numeric characters. Enter a name for the new IPMC profile. Avoid spaces between
characters.
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Profile Description: Enter a description of the new IPMC profile. Additional description, which is composed of at
maximum 64 alphabetic and numeric characters, about the profile. No blank or space characters are permitted as
part of description. Use "_" or "-" to separate the description sentence.

Rule: When the profile is created, click the edit button to enter the rule setting page of the designated profile.
Summary about the designated profile will be shown by clicking the view button. You can manage or inspect the
rules of the designated profile by using these buttons:

o List the rules associated with the designated profile.
o Adjust the rules associated with the designated profile.

Enter the parameters and click the Apply button, then click the Edit button, then click the Add Last Rule button to
display the MC Filtering Profile Rule Configuration Rule Settings table (In Precedence Order).

Buttons:

Add New Profile: Click to add new profile. Specify the name and configure the new entry.
Delete: Check to delete the entry. The designated entry will be deleted during the next save.
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.

After you add a new profile and click Apply, the Multicast Filtering Profile Configuration page displays:

..-ﬁ I
TRANSITION \ =| awenss s - ©c
N NETWORKS
SM16TAT2SA Multicast Fi[teﬂng Profile Conﬁgurat]on @Home - Multicast - Multicast Filtering Profile - Filtering Profile Table
Switch DMS
Multicast Filtering Profile Mode Ensbled ¥
P System
» Port Management S . . .
Filtering Profile Table Setting
» PoE Management &
» VLAN Management < Delete Profile Name Profile Description Rule
» Quality of Service < O ) 44 | Edit |
» Spanning Tree <
» MAC Address Table <
» Multicast e
#» IGMP Snooping <
» MLD Snooping <
» MVR <
» Multicast Filtering Profile ~

> Filtering Profile Table

At the Multicast Filtering Profile [4] Rule Settings page click the Edit button in the Rule column of the table to
display the Multicast Filtering Profile Rule Configuration table:
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Switch DMS
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b System 4
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» MAC Address Table <

» Multicast
-

The IPMC profile is used to deploy the access control on IP multicast streams. It is allowed to create at maximum 64
Profiles with at maximum 128 corresponding rules for each.

Parameter descriptions:

Profile Name: The name of the designated profile to be associated. This field is not editable.

Entry Name: The name used in specifying the address range used for this rule. Only the existing profile address
entries will be chosen in the selected box. This field is not allowed to be selected as none ("-") while the Rule
Settings Table is committed.

Address Range: The corresponding address range of the selected profile entry. This field is not editable and will be
adjusted automatically according to the selected profile entry.

Action: Select the learning action upon receiving the Join/Report frame that has the group address matches the
address range of the rule.

Permit. Group address matches the range specified in the rule will be learned.

Deny. Group address matches the range specified in the rule will be dropped.

Log: Select the logging preference upon receiving the Join/Report frame that has the group address matches the
address range of the rule.

Enable: Corresponding information of the group address, that matches the range specified in the rule, will be
logged.

Disable: Corresponding information of the group address, that matches the range specified in the rule, will
not be logged.
Buttons

Add Last Rule: Click to add a new rule in the end of the specific profile's rule list. Specify the address entry and
configure the new entry. Click "Apply".

Delete: Check to delete the entry. The designated entry will be deleted during the next save.
Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.

Back to Filtering Profile Table: Click to return to previous page with no changes.
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10.3-1 Switch > Multicast > Multicast Filtering Profile > Filtering Address Entry

This page provides address range settings used in Multicast Filtering profile. The address entry is used to specify
the address range that will be associated with Multicast Filtering Profile. You can create up to 128 address entries
in the system.

TRANSITION® =[ =% : = S

N NETWORKS
SMBTAT2SA Multicast Filtering Profile Address Configuration @Home - Multicast - Multicsst Filtering Profile - Filtering Address Entry
Switch DMS
Multicast Filtering Profile Table Setting
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» PoE Management < | Delete
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» Quality of Service < | Add New Address (Range) Entry
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Multicast Filtering Profile Table Setting parameters:

Delete: Click to delete the entry. The designated entry will be deleted during the next apply.

Entry Name: The name used for indexing the address entry table.
Each entry has the unique name which is composed of at maximum 16 alphabetic and numeric characters.

Start Address: The starting IPv4/IPv6 Multicast Group Address that will be used as an address range.

End Address: The ending IPv4/IPv6 Multicast Group Address that will be used as an address range.

Buttons

Add New Address (Range) Entry: Click to add a new address range. Specify the name and configure the addresses.
Click "Apply".

Delete: Check to delete the entry. The designated entry will be deleted during the next save.
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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10.4 MVR

Multi VLAN Registration allows switches to automatically discover some of the
VLAN information that would otherwise need to be manually configured. The
MVR feature enables multicast traffic forwarding on the Multicast VLAN. In a
multicast television application, a PC or a television with a set-top box can
receive the multicast stream.

SMXTAT2SA Web User Guide

®» MVR

N
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asic Configuration
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s MY

& BT

Channel Groups

! SFM Information

Multiple set-top boxes or PCs can be connected to one subscriber port, which is a switch port configured as an
MVR receiver port. When a subscriber selects a channel, the set-top box or PC sends an IGMP join message to
Switch A to join the appropriate multicast. Uplink ports that send and receive multicast data to and from the

multicast VLAN are called MVR source ports.

10.4-1 Switch > MVR > Basic Configuration:

VLAN Interface Setting (Role [l:Inactive / S:Source / R:Receiver])
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Parameter descriptions:

Global Setting
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Profile
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MVR Mode: Select on or off. The default is off. Enable/Disable the Global MVR. The Unregistered Flooding control
depends on the current configuration in IGMP/MLD Snooping. It is suggested to enable Unregistered Flooding

control when the MVR group table is full.

VLAN Interface Setting (Role [l:Inactive / S:Source / R:Receiver])

MVR VID: Enter the new VLAN ID for this new MVR VLAN. Caution: MVR source ports are not recommended to be
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overlapped with management VLAN ports.

MVR Name: Enter a name for this new MVR VLAN. MVR Name is an optional attribute to indicate the name of the
specific MVR VLAN. Maximum length of the MVR VLAN Name string is 32. MVR VLAN Name can only contain
alphabets or numbers. MVR VLAN name can be edited for the existing MVR VLAN entries or it can be added to the
new entries.

IGMP Address: e.g., 192.168.1.40. Define the IPv4 address as source address used in IP header for IGMP control
frames. The default IGMP address is not set (0.0.0.0). When the IGMP address is not set, system uses IPv4
management address of the IP interface associated with this VLAN. When the IPv4 management address is not set,
system uses the first available IPv4 management address. Otherwise, system uses a pre-defined value. By default,
this value will be 192.0.2.1.

Mode: At the dropdown select Dynamic or Compatible. The default is Dynamic. Specify the MVR mode of
operation. In Dynamic mode, MVR allows dynamic MVR membership reports on source ports. In Compatible mode,
MVR membership reports are forbidden on source ports. The default is Dynamic mode.

Tagging: At the dropdown select Tagged or Untagged. The default is Tagged. Specify whether the traversed
IGMP/MLD control frames will be sent as Untagged or Tagged with MVR VID.

Priority: Enter O - 7. Specify how the traversed IGMP/MLD control frames will be sent in prioritized manner. The
default Priority is 0.

LLQI: Define the maximum time to wait for IGMP/MLD report memberships on a receiver port before removing the
port from multicast group membership. The value is in units of tenths of a seconds. The range is 0 - 31744. The
default LLQI is 5 tenths or one-half second.

Interface Channel Profile: At the dropdown select an existing Profile name. When the MVR VLAN is created, select
the profile to expand the corresponding multicast channel settings for the specific MVR VLAN. The file established
on Filtering Profile Table.

Port: The logical port for the settings.

Port Role: For each port choose a Role; each click displays the next role (I = Inactive, S = Source role, and R =
Receiver role). Configure an MVR port of the designated MVR VLAN as one of the following roles.

Inactive: The designated port does not participate MVR operations.

Source: Configure uplink ports that receive and send multicast data as source ports. Subscribers cannot be
directly connected to source ports.

Receiver. Configure a port as a receiver port if it is a subscriber port and should only receive multicast data. It
does not receive data unless it becomes a member of the multicast group by issuing IGMP/MLD messages.

Caution: MVR source ports are not recommended to be overlapped with management VLAN ports. Select the port
role by clicking the Role symbol to switch the setting. | indicates Inactive; S indicates Source; R indicates Receiver.
The default Role is Inactive.

Immediate Leave Setting

Port: The logical port for the settings.

Immediate Leave: Enable the fast leave on the port.

Buttons

Add New MVR VLAN: Click to add a new MVR VLAN entry to the table. Specify MVR VID, MVR Name, IGMP
Address, Mode, Tagging, Priority, LLQI, Interface Channel Profile. Click "Apply".

Delete: Check to delete the entry. The designated entry will be deleted during the next save.

Apply: Click to save changes.
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10.4-2 Switch > MVR > Statistics

This page displays the MVR detail Statistics that display after you have configured MVR on the switch.
It provides detailed MVR Statistics Information.

TRANSITIDN = T ] Auto-logout H e C.
\-—' NETWORKS
SMBTAT2SA MVR Statistics @iome - Multicast - VR - Statistics
Switch DMS
Auto-refresh | Refresh |
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MVR Statistics parameters:

VLAN ID: Displays the Multicast VID (VLAN ID).

IGMP/MLD Queries Received: The number of Received Queries for IGMP and MLD, respectively (e.g., x/y).
IGMP/MLD Queries Transmitted: The number of Transmitted Queries for IGMP and MLD, respectively (e.g., x/y).
IGMPv1 Joins Received: The number of Received IGMPv1 Joins (e.g., 1 Join received).

IGMPv2/MLDv1 Reports Received: The number of Received IGMPv2 Join's and MLDv1 Reports, respectively (e.g.,
x/Y).

IGMPv3/MLDv2 Reports Received: The number of Received IGMPv3 Join's and MLDv2 Report's, respectively.(e.g.,
x/y).

IGMPv2/MLDv1 Leaves Received: The number of Received IGMPv2 Leave's and MLDv1 Dones, respectively (e.g.,
x/y).

Buttons

Auto-Refresh: Check this box to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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10.4-3 Switch > MVR > Group Information

This page displays MVR Groups detail information on the switch. Entries in the MVR Group Table are shown on this
page. The MVR Group Table is sorted first by VLAN ID, and then by group.

Each page shows entries from the MVR Group table, default being 10, selected through the "entries per page"
input field. When first visited, the web page will show the first 10 entries from the beginning of the MVR Channels
(Groups) Information Table.

The "Search" input fields let you select the starting point in the MVR Channels (Groups) Information Table. It will
update the displayed table starting from that or the closest next MVR Channels (Groups) Information Table match.
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MVR Groups Information parameters:
VLAN ID: Displays the VID (VLAN ID) of the group.
Group: Displays the Group ID of the group displayed.

Port Members: Indicates which ports are members (the Ports under this group).

Buttons

Show entries: You can choose how many items you want to show up.
Search: You can search for the information that you want to see.
Auto-refresh: Check to refresh the page automatically every 3 seconds.
Refresh: Click to manually refresh the page immediately.

Previous: Updates the system log entries, turn to the previous page.

Next: Updates the system log entries, turn to the next page.
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10.4-4 Switch > MVR > SFM Information

The MVR SFM (Source-Filtered Multicast) Information Table also contains the SSM (Source-Specific
Multicast) information. This table is sorted first by VLAN ID, then by group, and then by Port. Different
source addresses belong to the same group are treated as single entry.

Each page shows up to 99 entries from the MVR SFM Information table, default being 10, selected
through the "entries per page" input field. When first visited, the web page will show the first 10 entries
from the beginning of the MVR SFM Information Table.

The "Search" input fields lets you select the starting point in the MVR SFM Information Table. It will
update the displayed table starting from that or the closest next MVR SFM Information Table match.

TRANSITION Vo TR [ ] Auto-logout [OFF v | o C.

N NETWORKS:
SM8TAT2SA MVR SFM Information @Home - Multiczst - MVR - MVRSFM Information
Switch DMS
Auto-refresh | Refresh |

» System <
o T e < Show| 1~ entries Search:
» PoE Management k. VLAN ID L Group Port Mode Source Address Type Hardware Filter/Switch

/LAN Manage <
D LA B No data available in table
» Quality of Service <
» Spanning Tree <

L T I¥ T €

MVR SFM Information parameters:

VLAN ID: Displays the VID (VLAN ID) of the group.
Group: Displays the Group address of the group displayed.
Port: Indicates which ports are members.

Mode: Displays the filtering mode maintained per (VLAN ID, port number, Group Address) basis. It can
be either Include or Exclude.

Source Address: Displays the IP Address of the source. Currently, system limits the total number of IP
source addresses for filtering to be 128. When there is not any source filtering address, the text "None"
is shown in the Source Address field.

Type: Displays the type (either Allow or Deny).

Hardware Filter/Switch: Indicates whether data plane destined to the specific group address from the
source IPv4/IPv6 address could be handled by the chip.

Buttons

Show entries: You can choose how many items you want to show up.
Search: You can search for the information that you want to see.
Auto-refresh: Check to refresh the page automatically every 3 seconds.
Refresh: Click to manually refresh the page immediately.

Previous: Updates the system log entries, turn to the previous page.

Next: Updates the system log entries, turn to the next page.

33717 Rev.J https://www.transition.com Page 158 of 304



https://www.transition.com/

Transition Networks SMXTAT2SA Web User Guide

Chapter 11 - DHCP

This section lets you view and configure various DHCP parameters of the switch.
See also Appendix B — DHCP Per Port on page 288.

11-1 Snooping

» Statistics
11-1.1 Configuration » Relay
DHCP Snooping is used to block intruder on the untrusted ports of the switch device -

when it tries to intervene by injecting a bogus DHCP reply packet to a legitimate
conversation between the DHCP client and server.

This page lets you configure the DHCP Snooping parameters of the switch.
DHCP Snooping can prevent attackers from adding their own DHCP servers to the network.

Web Interface

To configure DHCP snooping in the web interface:

1. Click DHCP, Snooping, and Configuration.

2. Select “on” or "off" at the Snooping Mode selector.
3. Select "Trusted” or “Untrusted” for each port.
4

Click Apply.
TRANSITION = TnmkSTE — Auto-logout H 0 C’
N NETWORKS:
SMETAT2SA DHCP Snooping Configuration #8Home - DHCF - Snoaping ~ Configuretion
Switch DMS
Snooping Mode ﬂ)
¥ System
» Port Management &
Port Mode Configuration
» PoE Management <
» VLAN Management < Port Mode
» Quality of Service < 1 Trusted W

¥ Spanning Tree

2 Trusted v
» MAC Address Table <
» Multicast & 3 Trusted W
» DHCP -
- ) 4 Trusted W
B Snooping
» Configuration 5 Trusted A
» Snooping Table
y g Trusted ~
k- <
7 Trusted v
> Serve
> ServerStatus 2 Trusted b
P Security <
Securnity 9 Trusted W
» Access Control &
10 Trusted v
» SNMP <
» Event Notification < —
| Apply || Reset |
» Diagnostics < — -

Figure 11-1.1: DHCP Snooping Configuration
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Parameter descriptions:

Snooping Mode : Indicates the DHCP snooping mode operation. Possible modes are:

on: Enable DHCP snooping mode operation. When DHCP snooping mode operation is enabled,
the DHCP request messages will be forwarded to trusted ports and only allow reply packets from
trusted ports.

off. Disable DHCP snooping mode operation.

Port Mode Configuration: Indicates the DHCP snooping port mode. Possible port modes are:
Trusted: Configures the port as trusted source of the DHCP messages.
Untrusted: Configures the port as untrusted source of the DHCP messages.

Buttons
Apply : Click to save changes.

Reset : Click to undo any changes made locally and revert to previously saved values.
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11-1.2 Snooping Table
This page displays the dynamic IP assigned information after DHCP Snooping mode is disabled. All DHCP

clients obtained the dynamic IP address from the DHCP server will be listed in this table except for local
VLAN interface IP addresses. Entries in the Dynamic DHCP Snooping Table are shown on this page.
Web Interface
To monitor the Dynamic DHCP Snooping Table in the web UL

1. Click DHCP, Snooping, and Snooping Table.

TRANSITIUN = Tl L] Auto-logout OFF - o C‘
N NETWORKS. I
SMBTAT2SA Dynamic DHCP Snooping Table @Home - DHCP - Snooping - Snooping Tble
Switch DMS
Auto-refresh | Refresh | E
» System <
» Port Management < Show| 10 Elentr‘les Search:
2 Rl ¢ MACAddress  * VLANID Port P Address IP Subnet Mask DHCP Server
> VLAN Management 00-16-6C-D4-DD-C2 1 6 10.0.4111 255.255.255.0 10.0.4.1
» Quality of Service <
.
» Spanning Tree <
» MAC Address Table &
» Multicast <
» DHCP =
® Snooping v
3 Confiouratinn

Figure 11-1.2: Dynamic DHCP Snooping Table
Parameter descriptions:
Show entries: You can choose how many items you want to show.
Search: You can search for the information that you want to see.
MAC Address: User MAC address of the entry.
VLAN ID: VLAN-ID in which the DHCP traffic is permitted.
Port: Switch Port Number for which the entries are displayed.
IP Address : User IP address of the entry.
IP Subnet Mask: User IP subnet mask of the entry.
DHCP Server: DHCP Server address of the entry.

Auto-refresh ‘ Refresh ‘
Buttons  —

Auto-refresh: Check to refresh the page automatically every 3 seconds.
Refresh: Click to manually refresh the page immediately.
Next: Updates the system log entries, turn to the next page.

Previous: Updates the system log entries, turn to the previous page.
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11-1.2 DHCP Detailed Statistics

This page provides statistics for DHCP snooping. Note that the normal forward per-port TX statistics are
not increased if the incoming DHCP packet is done by L3 forwarding mechanism. Also, a clear of the
statistics on a specific port may not take effect on global statistics since it gathers the different layer
overview.

Web Interface

To view detailed DHCP statistics via the web interface:
1. Click DHCP, Snooping, and Detailed Statistics.
2. Use the Port select box to select the desired port.

TRANSITION ® =[ =% ;| = o0
N NETWORKS
SM8TAT2SA DHCP Detail Statistics Port 1 @Home - DHCF - Snooping - Statistics
Switch DMS — —
Auto-refresh | Refresh || Clear | Part 1 b
» System <
» Port Management < Receive Packets Transmit Packets
» PoE Management < Rx Discover 0 Tx Discover 0
» VLAN Management < Rx Offer 0 Tx Offer 0
» Quality of Service & Rx Request 0 Tx Request 0
T < . .
D A TR Rx Decline 0 Tx Decline 0
» MAC Address Table <
Rx ACK 0 Tx ACK 0
b Multicast &
Rx NAK 0 Tx NAK Q
» DHCP -
Rx Release 0 Tx Release 0
Rx Inform 0 Tx Inform 0
Rx Lease Query 0 Tx Lease Query 0
Rx Lease Unassigned 0 Tx Lease Unassigned 0
<
Rx Lease Unknow 0 Tx Lease Unknow 0
Rx Lease Active 0 Tx Lease Active 0
» Security . Rx Discarded Checksum Error 0
ACCRES <
» Access Control Rx Discarded from Untrusted 0

b SNMP 4

Figure 11-1.2: Dynamic DHCP Snooping Table

Parameter descriptions:

Rx and Tx Discover: The number of discover (option 53 with value 1) packets received and transmitted.
Rx and Tx Offer: The number of offer (option 53 with value 2) packets received and transmitted.

Rx and Tx Request: The number of request (option 53 with value 3) packets received and transmitted.
Rx and Tx Decline: The number of decline (option 53 with value 4) packets received and transmitted.
Rx and Tx ACK: The number of ACK (option 53 with value 5) packets received and transmitted.

Rx and Tx NAK: The number of NAK (option 53 with value 6) packets received and transmitted.

Rx and Tx Release: The number of release (option 53 with value 7) packets received and transmitted.
Rx and Tx Inform: The number of inform (option 53 with value 8) packets received and transmitted.

Rx and Tx Lease Query: The number of lease query (option 53 with value 10) packets received and
transmitted.
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Rx and Tx Lease Unassigned: The number of lease unassigned (option 53 with value 11) packets received
and transmitted.

Rx and Tx Lease Unknown: The number of lease unknown (option 53 with value 12) packets received and
transmitted.

Rx and Tx Lease Active: The number of lease active (option 53 with value 13) packets received and
transmitted.

Rx Discarded checksum error: The number of discard packet that IP/UDP checksum is error.

Rx Discarded from Untrusted: The number of discarded packets that are coming from untrusted port.

Buttons

Port1 e
: & : Use the Port select box to select the port that you want to display the DHCP Detailed
Statistics.
Auto-refresh: Check to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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11-1.3 DHCP Relay Configuration

Navigate to the Switch > DHCP > Relay menu path to display the DHCP Relay Configuration table. Here
you can configure the DHCP Relay function.

A DHCP relay agent is used to forward and to transfer DHCP messages between the clients and the server
when they are not in the same subnet domain. It stores the incoming interface IP address in the GIADDR
field of the DHCP packet. The DHCP server can use the value of GIADDR field to determine the assigned
subnet. For such condition, please make sure the switch configuration of VLAN interface IP address and
PVID(Port VLAN ID) correctly.

TRANSITION ® =[ === : = e e
N\ NETWORKS
SMETAT2SA DHCP Relay Configuration @Homs - DHCP - Relay - Configurstion
Switch DMS
Relay Mode ﬂ:
b System
» Port Management < Relay Server 1234
’ P x o
of Management Relay Information Mode ﬂj
» VLAN Management <
b Quality of Service ¢ Relay Information Policy Replace W
» Spanning Tree < S
Apply (| Reset
» MAC Address Table < |_||_|
Parameters:

Relay Mode: Select on or off. The default is off. Indicates the DHCP relay mode operation. Possible
modes are:

On: Enable DHCP relay mode operation. When DHCP relay mode operation is enabled, the agent
forwards and transfers DHCP messages between the clients and the server when they are not in the
same subnet domain. And the DHCP broadcast message won't be flooded for security
considerations.

Off: Disable DHCP relay mode operation.
Relay Server: Enter the DHCP Relay server IP address.

Relay Information Mode: Select on or off. The default is off. Indicates the DHCP relay information mode
option operation. The option 82 circuit ID format as "[vlan_id][module_id][port_no]". The first four
characters represent the VLAN ID, the fifth and sixth characters are the module ID (always 0), and the last
two characters are the port number. For example, "00030108" means the DHCP message receive form
VLAN ID 3, switch ID 1, port No 8. And the option 82 remote ID value is equal the switch MAC address.
Possible modes are:

Enabled: Enable DHCP relay information mode operation. When DHCP relay information mode
operation is enabled, the agent inserts specific information (option 82) into a DHCP message when
forwarding to DHCP server and removes it from a DHCP message when transferring to DHCP client.
It only works when DHCP relay operation mode is enabled.

Disabled: Disable DHCP relay information mode operation.

Relay Information Policy: At the dropdown, select Replace, Keep, or Drop. Indicates the DHCP relay
information mode option operation. The option 82 circuit ID format as "[vlan_id][module_id][port_no]".
The first four characters represent the VLAN ID, the fifth and sixth characters are the module ID(in
standalone device it always equals 0, in stackable device it means switch ID), and the last two characters
are the port number. For example, "00030108" means the DHCP message receive form VLAN ID 3, switch
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ID 1, port No 8. And the option 82 remote ID value is equal the switch MAC address.
Possible modes are:

Replace: Replace the original relay information when a DHCP message that already contains it is
received.

Keep: Keep the original relay information when a DHCP message that already contains it is received.

Drop: Drop the package when a DHCP message that already contains relay information is received.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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11-1.3 DHCP Relay Configuration

Navigate to the Switch > DHCP > Relay > Relay Statistics menu path to display the DHCP Relay Statistics
table. This page provides statistics for DHCP relay.

TRANSITION ® =| == : = o
Naw" NETWORKS
SM8TAT2SA DHCP Relay Configuration @Home - DHCP - Relay - Configurstion
Switch DMS
Relay Mode ﬂj
b System <
» Port Management < Relay Server 1234
P P ¥ a <
oE Management Relay Information Mode ﬂ;
» VLAN Management &
» Quality of Service < Relay Information Policy Drop v

-

Spanning Tree <

» MAC Address Table < |F:_DE|

Server Statistics Parameters:

Transmit to Server: The number of packets that are relayed from client to server.

Transmit Error: The number of packets that resulted in error while being relayed from client to server.
Receive from Server: The number of packets received from server.

Receive Missing Agent Option: The number of packets received without agent information options.
Receive Missing Circuit ID: The number of packets received with the Circuit ID option missing.

Receive Missing Remote ID: The number of packets received with the Remote ID option missing.

Client Statistics Parameters:

Transmit to Client: The number of relayed packets from server to client.

Transmit Error: The number of packets that resulted in error while being sent to servers.

Receive from Client: The number of received packets from server.

Receive Agent Option: The number of received packets with relay agent information option.

Replace Agent Option: The number of packets which were replaced with relay agent information option.
Keep Agent Option: The number of packets whose relay agent information was retained.

Drop Agent Option: The number of packets that were dropped which were received with relay agent
information.

Buttons
Auto-refresh: Check to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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11-1.3 DHCP Server

Navigate to the Switch > DHCP > Server menu path to display the DHCP Server Configuration table. Here
you can add and configure new DHCP servers. Click the Add Interface button to start.

This page lets you enable or disable DHCP servers per system and per VLAN and configure Start IP and
End IP addresses. A DHCP server will allocate these IP addresses to the DHCP client and deliver
configuration parameters to the DHCP client.

TRANSITION * =| =% & Autologout [oFE_ ) 0 G
\-—* NETWORKS

SMBTAT2SA DHCP Server Configuration daHoms - DHCP - Senver
Switch DMS

Interfaces

System
Port Management < Delete VLAN  Mode Start 1P End IP Leasetime  Subnet mask Default router DNS server
PoE Management S | Delete | 1 Ensbled W
VLAN Management <

Quality of Service < ‘ Add Interface |

Spanning Tree <

A A Adeamn Takla <

Parameters:
Delete: Check to delete the entry. It will be deleted during the next save.

VLAN: Enter the VLAN ID (VID) for this instance. Configure the VLAN in which DHCP server is enabled or
disabled. Allowed VLAN are in the range 1 — 4095.

Mode: Indicates the operation mode per VLAN. Possible modes are: Enable: Enable DHCP server per
VLAN. Disable: Disable DHCP server per VLAN. The default is Disabled.

Start IP: Enter the starting IP address for the range. The Start IP must be smaller than or equal to the End
IP.

End IP: Enter the ending IP address for the range.

Lease time: Enter a valid DHCP lease time of the DHCP Server. Value range between 1 and 8640000 hours.
Subnet mask: Enter the Subnet mask.

Default router: Enter the default router IP address.

DNS server: Enter the destination IP network or host address of this route.

Subnet Mask: Configure subnet mask of the DHCP address.

Buttons
Add Interface: Click the button to create and configure an instance.
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
Messages:

This field is required.
ERROR: Not Found
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11-1.3 DHCP Server Status

Navigate to the Switch > DHCP > Server Status menu path to display the current DHCP Server Status.

TRANSITION — Tuen [ ] Auto-logout OFF  ~ o C*
N NETWORKS.
SM8TAT2SA DHCP Server Status @ Home - DHCP - Server Status 3
Switch DMS —
Auto-refresh | Refresh |
P System <
» Port Management & Interfaces
» PoE Management ¢ VLAN Type Start IP End IP Lease time Subnet mask  Default router DNS server
<
» WL e 1 Static 192.168.1.1 192.168.1.10 999999 255.255.255.0 192.168.1.40  192.168.1.40
» Quality of Service <
Parameters:

VLAN: The VLAN ID of the entry.

Type: Indicates the operation type per VLAN. Possible types are: Static and DMS.
Start IP and End IP: Display the Start IP and the End IP.

Lease time: Displays lease time of the pool.

Subnet mask: Displays subnet mask of the DHCP address.

Default router: Displays the destination IP network or host address of this route.

DNS server: Displays DNS server.
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Chapter 12 - Security

» Security
This section lets you configure switch Security settings. You can use the Security features Lz
to restrict input to an interface by limiting and identifying MAC addresses. » |EEE 802.1X

» |P Source Guard

12-1 Management » ARP Inspection
12-1.1 Account » Port Security
This page provides an overview of the current users. Currently the only way to login as » RADIUS
another user on the web server is to close and reopen the browser. » TACACS+
Web Interface

To add a new User via the Web UL
1. Click Security, Management, and Account.
2. Click the Add New User button to display the Add User webpage.
3. Specify the User Name, Password (twice) and Privilege Level parameters.
4

Click Apply.
‘-ﬂ TRENSITIEN
— = Auto-logo s
TRANSITION © = __ G
METWORKS
SM8TAT25A Add User @iHome - Security  Manegement - Astount
Switch DMS
User Settings
P System <
» Port Management g User Name
E M a {
» PoE Management password
» VLAN Management <
L. ) Confirm Password
» Quality of Service <
» Spanning Tree < Privilege Level 0w

» MAC Address Table <

-

Multicast

-~
I
]

a
T
i

3
T

Figure 12-1.1: Account Configuration — Add User

Parameter descriptions:
User Name: The name identifying the user. This is also a link to Add/Edit User webpage.

Password: Type the password. The allowed string length is 0 — 255 characters, and the allowed content is
the ASCII characters from 32 to 126.

Password (again): Type the password again. You must type the same password again in the field.

Privilege Level: The privilege level of the user. The allowed range is 0 to 15. If the privilege level value is
15, it can access all groups, i.e. that is granted the fully control of the device. But others value must refer to
each group privilege level. User's privilege should be same or greater than the group privilege level to
have the access of that group. By default, most groups are at privilege level 5 and have read-only access
and privilege level 10 has the read-write access. The system maintenance (software upload, factory
defaults and etc.) need user privilege level 15. Generally, privilege level 15 can be used for an admin
account, privilege level 10 for a standard user account and privilege level 5 for a guest account.
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Apply: Click to save changes.
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Reset: Click to undo any changes made locally and revert to previously saved values.

Cancel: Click to undo any changes made locally and return to the Users.

Delete User: Delete the current user. This button is not available for new configurations (Add New User).

Edit a User

-
JeansITioN

SMB8TAT2SA-DC
Switch DMS

-

System

-

Port Management

-

PoE Management

» VLAN Management

-

Quality of Service

-

Spanning Tree

-

-

Multicast

» DHCP

-

Security
*» Management

> Account
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12-1.2 Privilege Level

The Security > Management > Privilege Level menu path displays the Privilege Level Configuration table.
Here you can assign Read-Only or Read-Write privilege levels for each of the major functions. This page
lets you set Group Name Privilege Levels from 0 to 15.

TRANSITION \ =| > a Aologou - S
N NETWORKS.:
SMBTAT2SA Privilege Le\relC{)nfiguration @ Home ~ Security ~ Management - Privilege Level
Switch DMS
Privilege Level
» System <
Group Name Read-Only Read-Write
» Port Management <
» PoE Management ¢ access-mgmt 5 0w 0w
» VLAN Management o account 15w 15 v
» Quality of Service <
acl 5 v m v
» Spanning Tree <
» MAC Address Table < arp-inspection 5 v W™
ulti <
» Multicast auth-method 5w 10w
» DHCP <
dhcp-relay 5 v m v
» Security h P v
%» Management v dhcp-server s v 0w
> Account
> Privilege Level dhep-snooping 5 v 0 v
> Auth Method
diagnostic 5 v m v
> Access Managemen
» dotlx 5 v 0 v
»
eee 5 A 10 W
®» AR
? event 5w W v

ir = ~ mn w

Parameter descriptions:

Group Name: The name identifying the privilege group. In most cases, a privilege level group consists of
a single module (e.g. LACP, STP or QoS), but a few of them contains more than one. The following
description defines these privilege level groups in detail: System: Contact, Name, Location, Timezone,
Daylight Saving Time, Log.

Privilege Levels: Every group has an authorization Privilege level for the following sub groups:
configuration read-only, configuration/execute read-write. User Privilege should be same or greater than
the authorization Privilege level to have the access to that group.

Read-Only: At the dropdown select a privilege level of 0-15 for any function (access-mgmt, account, arp-
inspection, etc.) that you want to change from the default value.

Read-Write: At the dropdown select a privilege level of 0-15 for any function (access-mgmt, account, arp-
inspection, etc.) that you want to change from the default value.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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12-1.3 Auth Method

The Security > Management > Auth Method menu path displays the Auth Method Configuration tables,
where you can configure an authentication method (none, local, or radius) for each client (telnet, ssh, http,
https). You can also configure a service port number for telnet, ssh, http, and https clients, and enable the
HTTPS Redirect function on this page. The page also provides the Command Authorization Method
Configuration table and the Accounting Method Configuration table.

TRANSITION — TRANSITI F ] Auto-logout H o C’
N NETWORKS.
SMBTAT2SA Auth Method Configuration ome - Security - Management -~ Auth iethod
Switch DMS
Authentication Method Configuration
¥ System <
» Port Management ¢ Client Methods Service Port
» PoE Management < telnet local W o v - v 23
» VLAN Management <
ssh local hd no hd no v 22
» Quality of Service <
» Spanning Tree ¢ http local v no v no ~ 80
» MAC Address Table N https local v no v no v 443
» Multicast <
» DHCP < Command Authorization Method Configuration
¥ Security M )
Client Methods Cmd Lvl Cfg Cmd Fallback
» Management v
> Account telnet no v 0 |:| \:|
> Privilege Level . o
ssh no v 0 [ [
> Auth Method
» Access Management
5 [EEEEAE Accounting Method Configuration
” Client Methods Cmd Lvl Exec
» AR
» telnet no v 0 O
» —
ssh no v 0 [
»
» Access Control < | Apply || Reset |

Section descriptions:

Authentication Method Configuration: The authentication section allows you to configure how a user is
authenticated when he logs into the switch via one of the management client interfaces. The table has
one row for each client type and several columns.

Command Authorization Method Configuration: The command authorization section allows you to
limit the CLI commands available to a user. The table has one row for each client type and several
columns.

Accounting Method Configuration: The accounting section allows you to configure command and exec
(login) accounting. The table has one row for each client type and several columns,
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Parameter descriptions:

Methods: Select an authentication method (none, local, radius, or tacacs) for each client (telnet, ssh, http,
https). In the Command Authorization Method Configuration table and the Accounting Method
Configuration table, select a Method for telnet or ssh only (none or tacacs). The Method can be set to one
of the following values:

no: Authentication is disabled and login is not possible.
local: Use the local user database on the switch for authentication.

radius: Use remote RADIUS server(s) for authentication. Remote Authentication Dial In User Service is a
networking protocol that provides centralized access, authorization and accounting management for
people or computers to connect and use a network service.

tacacs: Use remote TACACS+ server(s) for authentication. Terminal Access Controller Access Control
System Plus. It is a networking protocol which provides access control for routers, network access
servers and other networked computing devices via one or more centralized servers. TACACS+ provides
separate authentication, authorization and accounting services.

Methods that involve remote servers are timed out if the remote servers are offline. In this case, the next
method is tried. Each method is tried from left to right and continues until a method either approves or
rejects a user. If a remote server is used for ‘primary’ authentication, it is recommended to configure
secondary authentication as 'local'. This lets the management client login via the local user database if
none of the configured authentication servers are alive.

Service Port: Enter a service port number for telnet, ssh, http, and https clients as required.

Cmd Lvl: Authorize all commands with a privilege level higher than or equal to this level. Valid values are 0
- 15. Runs accounting for all commands at the specified privilege level. Specific command level that
should be authorized. Valid entries are 0 through 15.

Cfg Cmd: Check to also authorize configuration commands.
Fallback: Check the box to Enable the fallback mechanism.

Exec: Check the box to Enable exec (login) accounting. Runs accounting to determine if the user is allowed
to run an EXEC shell. This facility might return user profile information such as auto command information.

Method: Accounting Method can be set to one of the following values:
no : accounting is disabled and login is not possible.
tacacs : use a remote TACACS server for accounting.

Cmd Lvl: Runs accounting for all commands at the specified privilege level. Specific command level that
should be authorized. Valid entries are 0 through 15.

Exec: Runs accounting to determine if the user is allowed to run an EXEC shell. This facility might return
user profile information such as auto command information.

Note: Password encoding changed in FW v1.02.1409. You cannot login if downgrading the switch to older
firmware versions or loading an old config file in new firmware.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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12-1.4 Access Management

This section shows you how to configure access management table of the Switch including HTTP/HTTPS,
SNMP, and TELNET/SSH. You can manage the Switch over an Ethernet LAN or over the Internet.

Web Interface

To configure an Access Management Configuration in the web interface:
Click Security, Management, Access Management.

2. Select “on"” in the Mode of Access Management Configuration.
3. Click "Add New Entry".
4. Checked Access Management method (HTTP/HTTPS, SNMP, and TELNET/SSH) in the entry.
5. Click Apply.
TRANSITION ® =| "% : g S
N NETWORKS.
SM8TAT2SA Access Management Configuration @brome - Security - Management - Access Management
Switch DMS :
Mod .
» System < e ﬂ
» Port Management <
\ Mask
2 [PEE g Delete  VLANID IP Address Length  HTTP/HTTPS SNMP TELNET/SSH

» VLAN Management ¢ - - .
| Delete | 1 10.0.4.3 O O [
» Quality of Service <

» Spanning Tree <

» MAC Address Table &

» Multicast 5
Figure 12-1.2: Access Management Configuration
Parameter descriptions:

Mode: Indicates the access management mode operation. Possible modes are:
On: Enable access management mode operation.

Off: Disable access management mode operation.
VLAN ID: Indicates the VLAN ID for the access management entry.
Delete: Check to delete the entry. It will be deleted during the next save.
IP address: Enter the source IP address.
Mask Length: Enter the Mask Length (1-32).

HTTP/HTTPS: Indicates that the host can access the switch from HTTP/HTTPS interface if the host IP
address matches the IP address range provided in the entry.

SNMP: Indicates that the host can access the switch from SNMP interface if the host IP address matches
the IP address range provided in the entry.

TELNET/SSH: Indicates that the host can access the switch from TELNET/SSH interface if the host IP
address matches the IP address range provided in the entry.

Note: Firmware v1.01.1209 modified authentication method behavior for telnet/ssh/http/https.
The connection is now closed if configuring the first field of Method to "none".
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Note: Password encoding is changed in FW v1.02.1409. You cannot login if downgrading the switch to
older firmware versions or loading an old config file in new firmware.

Buttons
Add New Entry: Click to add a new access management entry.
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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12-2 IEEE 802.1X
12-2.1 Configuration

This page lets you configure 802.1X parameters of the switch. You can use 802.1X to connect users to a
variety of resources including Internet access, conference calls, printing documents on shared printers, or
logging on to the Internet.

Web Interface

To configure the IEEE 802.1X in the web interface:
1. Click Security, IEEE 802.1X, Configuration.

2. Select “on” in the Mode of IEEE 802.1X Configuration.

3. Checked Reauthentication Enabled.

4. Set Reauthentication Period (default is 3600 seconds).

5. Select Admin State and displays Port State.

6. Click the Apply button to save the settings.

7. To cancel the setting click the Reset button to revert to previously saved values.

JRANSITION™ =[ == :  wose o] e ] MO G
SMBTAT25A-DC 802.1X Configuration @roms - Securty - IZEEGSZIL - Confguraion

o

b Port Management | SystemiConfiguration

» PoE Management < | Mode a

¥ VLAN Management <

Reauthentication Enabled =]
¥ Quality of Service B
+ Spanning Tree < Reauthentication Period 3600 seconds
<
¥ MAC Address Table EAPOL Timeout s seconds
b Multicast <
RADIUS-Assigned VLAN Enabled
» DHCP < . o
» Security w Guest VLAN Enabled ]
» Management <
Guest VLAN 1D 1
» IEEE ~
> Configuratios Max. Reauth. Count
> Status
Allow Guest VLAN if EAPOL Seen O
» IP Source Guard <
» ARF Inspection <
» Fort Security . Port Configuration
curity
» RADILS © Port  Admin State RADIUS-Assigned VLAN Enabled Guest VLAN Enabled Port State Restart
» TACACS+ <
1 Force Authorized - O O Authorized [ ] I ]
» Access Control €
b SNMP < 2 Force Unauthorized |z| O =) Link Down [ Reauthenticate ] Reinitialize ]
b Event Notification <
3 Port-based B02.0X |Z| O =] Authorized [ Reauthenticate ] Reinitialize ]
} Diagnostics <
» Maintenance g 4 Single 802 3% |Z| O 2] Authorized [ Reauthenticate ] Reinitialize ]
5 Ml 802.1X |Z| O =) Link Down [ ] l ]
[ Farce Autharized |z| O O Authorized [ ] l ]
7 MAC-based Auth O O 0 Auth/0 Unauth [ Reauthenticate ] Reinitialize ]
B Farce Authorizad |z| (] (] Link Down [ ] I ]
9 Farce Authorized |z| O O Authorized [ ] l ]
10 Force Authorized |Z| O O Link Diown [ ] I ]

(r=s]

Figure 12-2.1: 802.1X Configuration
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Parameter descriptions:

System Configuration

Mode: Select on or off. Indicates if IEEE 802.1X is globally enabled or disabled on the switch. If globally
disabled, all ports are allowed forwarding of frames.

Reauthentication Enabled: If checked, successfully authenticated supplicants/clients are reauthenticated
after the interval specified by the Reauthentication Period. Reauthentication for 802.1X-enabled ports can
be used to detect if a new device is plugged into a switch port or if a supplicant is no longer attached.

For MAC-based ports, reauthentication is only useful if the RADIUS server configuration has changed. It
does not involve communication between the switch and the client, and therefore doesn't imply that a
client is still present on a port (see Aging Period below).

Reauthentication Period: Determines the period, in seconds, after which a connected client must be
reauthenticated. This is only active if the Reauthentication Enabled checkbox is checked. Valid values are in
the range 1 to 3600 seconds.

EAPOL Timeout: Determines the time for retransmission of Request Identity EAPOL frames. Valid values
are in the range 1 to 255 seconds. This has no effect for MAC-based ports.

RADIUS-Assigned VLAN Enabled : RADIUS-assigned VLAN provides a means to centrally control the
VLAN on which a successfully authenticated supplicant is placed on the switch. Incoming traffic will be
classified to and switched on the RADIUS-assigned VLAN. The RADIUS server must be configured to
transmit special RADIUS attributes to take advantage of this feature.

The "RADIUS-Assigned VLAN Enabled" checkbox provides a quick way to globally enable/disable RADIUS-
server assigned VLAN functionality. When checked, the individual ports' ditto setting determines whether
RADIUS-assigned VLAN is enabled on that port. When unchecked, RADIUS-server assigned VLAN is
disabled on all ports.

Guest VLAN Enabled: A Guest VLAN is a special VLAN - typically with limited network access - on which
802.1X-unaware clients are placed after a network administrator-defined timeout. The switch follows a set
of rules for entering and leaving the Guest VLAN as listed below.

The "Guest VLAN Enabled" checkbox provides a quick way to globally enable/disable Guest VLAN
functionality. When checked, the individual ports' ditto setting determines whether the port can be moved
into Guest VLAN. When unchecked, the ability to move to the Guest VLAN is disabled on all ports.

Guest VLAN ID: This is the value that a port's Port VLAN ID is set to if a port is moved into the Guest
VLAN. It is only changeable if the Guest VLAN option is globally enabled. Valid values are 1- 4094.

Max. Reauth. Count: The number of times the switch transmits an EAPOL Request Identity frame without
response before considering entering the Guest VLAN is adjusted with this setting. The value can only be
changed if the Guest VLAN option is globally enabled. Valid values are in the range [1; 255].

Allow Guest VLAN if EAPOL Seen: The switch remembers if an EAPOL frame has been received on the
port for the life-time of the port. Once the switch considers whether to enter the Guest VLAN, it will first
check if this option is enabled or disabled. If disabled (unchecked; default), the switch will only enter the
Guest VLAN if an EAPOL frame has not been received on the port for the life-time of the port. If enabled
(checked), the switch will consider entering the Guest VLAN even if an EAPOL frame has been received on
the port for the life-time of the port. The value can only be changed if the Guest VLAN option is

globally enabled.

33717 Rev. ) https://www.transition.com Page 177 of 304



https://www.transition.com/
http://192.168.1.1/help/help_nas.htm#AgingPeriod
http://192.168.1.206/help/help_nas.htm#guest_vlan_port
http://192.168.1.206/help/help_nas.htm#guest_vlan_glbl
http://192.168.1.206/help/help_nas.htm#guest_vlan_glbl

Transition Networks SMXTAT2SA Web User Guide

Port Configuration

Port: The port number for which the configuration below applies.

Admin State: If 802.1X is globally enabled, this selection controls the port's authentication mode.
These modes are available:

Force Authorized: In this mode, the switch will send one EAPOL Success frame when the port
link comes up, and any client on the port will be allowed network access without authentication.

Force Unauthorized: In this mode, the switch will send one EAPOL Failure frame when the port
link comes up, and any client on the port will be disallowed network access.

Port-based 802.1X: In the 802.1X-world, the user is called the supplicant, the switch is the
authenticator, and the RADIUS server is the authentication server. The authenticator acts as the
man-in-the-middle, forwarding requests and responses between the supplicant and the
authentication server. Frames sent between the supplicant and the switch are special 802.1X
frames, known as EAPOL (EAP Over LANs) frames. EAPOL frames encapsulate EAP PDUs
(RFC3748). Frames sent between the switch and the RADIUS server are RADIUS packets. RADIUS
packets also encapsulate EAP PDUs together with other attributes like the switch's IP address,
name, and the supplicant's port number on the switch. EAP is very flexible, in that it allows for
different authentication methods, like MD5-Challenge, PEAP, and TLS. The important thing is that
the authenticator (the switch) doesn't need to know which authentication method the supplicant
and the authentication server are using, or how many information exchange frames are needed
for a particular method. The switch simply encapsulates the EAP part of the frame into the
relevant type (EAPOL or RADIUS) and forwards it.

When authentication is complete, the RADIUS server sends a special packet containing a success
or failure indication. Besides forwarding this decision to the supplicant, the switch uses it to open
or block traffic on the switch port connected to the supplicant.

@ NoTE: Suppose two backend servers are enabled and that the server timeout is configured
to X seconds (using the AAA configuration page) and suppose that the first server in the list
is currently down (but not considered dead).

Now, if the supplicant retransmits EAPOL Start frames at a rate faster than X seconds, then it
will never get authenticated, because the switch will cancel on-going backend authentication
server requests whenever it receives a new EAPOL Start frame from the supplicant.

And since the server hasn't yet failed (because the X seconds haven't expired), the same
server will be contacted upon the next backend authentication server request from the
switch. This scenario will loop forever. Therefore, the server timeout should be smaller than
the supplicant's EAPOL Start frame retransmission rate.

Guest VLAN Enabled

When Guest VLAN is both globally enabled and enabled (checked) for a given port, the switch considers
moving the port into the Guest VLAN according to the rules outlined below.
This option is only available for EAPOL-based modes, i.e.:

° Port-based 802.1X
e Single 802.1X
° Multi 802.1X

For troubleshooting VLAN assignments, use the "Monitor>VLANs>VLAN Membership and VLAN Port"
pages. These pages show which modules have (temporarily) overridden the current Port VLAN
configuration.
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Guest VLAN Operation:

When a Guest VLAN enabled port's link comes up, the switch starts transmitting EAPOL Request Identity
frames. If the number of transmissions of such frames exceeds Max. Reauth. Count and no EAPOL frames
have been received in the meanwhile, the switch considers entering the Guest VLAN. The interval between
transmission of EAPOL Request Identity frames is configured with EAPOL Timeout. If Allow Guest VLAN if
EAPOL Seen is enabled, the port will now be placed in the Guest VLAN. If disabled, the switch will first
check its history to see if an EAPOL frame has previously been received on the port (this history is cleared
if the port link goes down or the port's Admin State is changed), and if not, the port will be placed in the
Guest VLAN. Otherwise it will not move to the Guest VLAN but continue transmitting EAPOL Request
Identity frames at the rate given by EAPOL Timeout.

Once in the Guest VLAN, the port is considered authenticated, and all attached clients on the port are
allowed access on this VLAN. The switch will not transmit an EAPOL Success frame when entering the
Guest VLAN.

While in the Guest VLAN, the switch monitors the link for EAPOL frames, and if one such frame is received,
the switch immediately takes the port out of the Guest VLAN and starts authenticating the supplicant
according to the port mode. If an EAPOL frame is received, the port will never be able to go back into the
Guest VLAN if the "Allow Guest VLAN if EAPOL Seen" is disabled.

Port State : The current state of the port. It can undertake one of the following values:
Globally Disabled: IEEE 802.1X is globally disabled.
Link Down: IEEE 802.1X is globally enabled, but there is no link on the port.

Authorized: The port is in Force Authorized or a single-supplicant mode and the supplicant is
authorized.

Unauthorized: The port is in Force Unauthorized or a single-supplicant mode and the
supplicant is not successfully authorized by the RADIUS server.

X Auth/Y Unauth: The port is in a multi-supplicant mode. Currently X clients are authorized
and Y are unauthorized.

Restart: Two buttons are available for each row. The buttons are only enabled when authentication is
globally enabled and the port's Admin State is in an EAPOL-based or MAC-based mode. Clicking these
buttons will not cause settings changed on the page to take effect.

Re-authenticate: Schedules a re-authentication whenever the quiet-period of the port runs out
(EAPOL-based authentication). For MAC-based authentication, re-authentication will be attempted
immediately. The button only has effect for successfully authenticated clients on the port and will
not cause the clients to get temporarily unauthorized.

Reinitialize: Forces a re-initialization of the clients on the port and thereby a re-authentication
immediately. The clients will transfer to the unauthorized state while the re-authentication is in
progress.

Buttons
Apply : Click to save changes.

Reset : Click to undo any changes made locally and revert to previously saved values.
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This page displays 802.1X status information for each switch port. The status includes Admin State, Port

State, Last Source, Last ID and Port VLAN ID.

Web Interface

To displays 802.1X Status in the web interface:

1. Click Security, IEEE 802.1X, Status.

Check "Auto-refresh” if desired.

2
3. Click "Refresh” to refresh the port detailed statistics.
4

Select which port that you want display 802.1X Statistics.
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Switch DMS

-

-

-
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VLAN Management

-
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» Multicast €
» DHCP €
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802.1X Status
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Port Admin State

1 Force Authorized
2 Force Unauthorized
3 Port-based 802.1X
4 Single 202.1X

5 Multi 802.1X
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7 MAC-Based Auth
8 Force Authorized
9 Force Authorized
10 Force Authorized

Port State Last Source
Authorized
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Unauthorized

Unauthorized

Link Down

Authorized

0 Auth/0 Unauth

Link Down

Authorized

Link Down

Figure 12-2.2: IEEE 802.1X Status

Parameter descriptions:

Port: The switch port number. Click to navigate to detailed 802.1X statistics for this port.

Auto-logout 60min

Last ID

H 0 ¢

@@ Home - Security - IEEEBD2.1X - Status

Port VLAN ID

Admin State: The port's current administrative state. Refer to 802.1X Admin State above for a description

of possible values.

Port State: The current state of the port. Refer to 802.1X Port State above for a description of the

individual states.

Last Source: The source MAC address carried in the most recently received EAPOL frame for EAPOL-based
authentication, and the most recently received frame from a new client for MAC-based authentication.

Last ID: The user name (supplicant identity) carried in the most recently received Response Identity EAPOL
frame for EAPOL-based authentication, and the source MAC address from the most recently received
frame from a new client for MAC-based authentication.

Port VLAN ID: The VLAN ID that 802.1X has put the port in. The field is blank, if the Port VLAN ID is not
overridden by 802.1X. If the VLAN ID is assigned by the RADIUS server, "(RADIUS-assigned)" is appended
to the VLAN ID. If the port is moved to the Guest VLAN, "(Guest)" is —

appended to the VLAN ID. Read more about Guest VLANs here.
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Buttons
Auto-refresh: Check to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.

Example: Click a linked Port number to display its individual port statistics:

YT —— . . *]

THANNE!‘I(!)QKNS = [ ] = - Auto-logout 80 min O & |

SMBTAT2SA-DC 802.1X Statistics Port 3 @eHome - Smcurity - IESEE0ZLN - Stens |
Switch DMS

Auto-refresh

b System

» PortManagement < Port State

> PoEManagement ¢ Admin State Port-based 802.1X
b M e Port State Authorized
+ Quality of Service £
¥ Spanning Tree < Port Counters
» MAC Address Table < ) )
Receive EAPOL Counters Transmit EAPOL Counters
» Multicast «
Total 0 Total 7
» DHCP <
} Security ~ Response ID 0 Response ID 7
# Management < Responses o Requests Q
% |EEE® w =
Start v] 3
» Configuration
> Erem Logoff 0
# IP Source Guard < Invalid Type V]
# ARF Inspect
et : Invalid Length o |
# Port Security <
» RADIUS p Receive Backend Server Transmit Backend Server |
Counters Counters
» TACACS+ L+
Access Challenges 0 Responses 0
» Access Control <
e a Other Requests 7
} Event Notification « Auth. Successes o
» Diagnostics < Auth. Failures 0
7 < .
» Maintenance Supplicant Info
MAC Address
VLAN ID 0
Version 1
Identity

Figure 12-2.2: 802.1X Statistics
Parameter descriptions:
Port State:
Port: You can select which port that you want display 802.1X Statistics.

Admin State: The port's current administrative state. Refer to 802.1X Admin State for a description of
possible values.

Port State: The current state of the port. Refer to 802.1X Port State for a description of the individual
states.

Port Counters: Displays Received and Transmitted EAPOL Counters, Received and Transmitted Backend
Server Counters, and Supplicant Info.
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Buttons: Auto-refresh | Refresh ” Clear | Port3 IZI

Auto-refresh: Check this box to refresh the page automatically every 3 seconds.
Refresh: : Click to manually refresh the page immediately.

Clear: Click to clear the counters for the selected port.

Port3

IEI Port select box: Use the dropdown to display the port for which you want to view statistics.
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12-3 Port Security
12-3.1 Configuration

This section shows you how to configure the Port Security settings of the Switch. You can use the Port
Security feature to restrict input to an interface by limiting and identifying MAC addresses.

Web Interface

To configure a Port Security Configuration in the web interface:
Click Security, Port Security, Configuration.
Select “Enabled” in the Mode of System Configuration.

Set Mode (Enabled or Disabled), MAC Limit, and Action (Trap, Shutdown, Trap & Shutdown) for
each port.

4.  Click the Apply button to save the settings.
5. To cancel the settings click the Reset button to restore previously saved values.

TRANSITION V| e TT T - Auto-logout 80 min v @ &
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~ o ; <
Dbty eie Port Mode MAC Limit Action State Re-open
» Spanning Tree &
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» MAC Address Table ¢ = EI = —
¥ Multicast N 2 abled IZ| 4 Trap |Z| Ready I ‘
¥ DHCP ¢
¥ Security o 3 eoled IZ| ¢ B |Z| Ready I ‘
* Ma ent
B ¢ 4 abled |z| 4 Trap & Shutdown |z| Ready I ‘
#» IEEE 802.1X L] —
# IP Source Guard < 5 nabled IZ| 4 A IZ| Ready I ‘
# ARF Inspection <
% Port iy . [ Disabled IZ| 4 N Disabled I I
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7 bled 4 N Ready I ‘
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» Access Control P 9 Disabled IZ| 4 None Disabled I ‘
» SNMP ‘ 10 sbled IZ| 4 None IZ| Ready I ‘
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» Diagnostics ¢ I :;ese:‘
» Maintenance &

Figure 12-3.1: Port Security Configuration
Parameter descriptions:

System Configuration

Mode: Indicates if Limit Control is globally enabled or disabled on the switch. If globally disabled, other
modules may still use the underlying functionality, but limit checks and corresponding actions are
disabled.
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Port Configuration

Port: The port number to which the configuration below applies.

Mode: Controls whether Limit Control is enabled on this port. Both this and the Global Mode must be set
to Enabled for Limit Control to be in effect. Notice that other modules may still use the underlying port
security features without enabling Limit Control on a given port.

MAC Limit: The maximum number of MAC addresses that can be secured on this port. This number
cannot exceed 1024. If the limit is exceeded, the corresponding action is taken. The switch is "born" with a
total number of MAC addresses from which all ports draw whenever a new MAC address is seen on a Port
Security-enabled port. Since all ports draw from the same pool, it may happen that a configured
maximum cannot be granted, if the remaining ports have already used all available MAC addresses.

Action: If Limit is reached, the switch can take one of the following actions:
None: Do not allow more than Limit MAC addresses on the port, but take no further action.

Trap: If Limit + 1 MAC addresses seen on the port, send an SNMP trap. If Aging is disabled, only one
SNMP trap will be sent, but with Aging enabled, new SNMP traps will be sent every time the limit
gets exceeded.

Shutdown: If Limit + 1 MAC addresses is seen on the port, shut down the port. This implies that all
secured MAC addresses will be removed from the port, and no new address will be learned. Even if
the link is physically disconnected and reconnected on the port (by disconnecting the cable), the
port will remain shut down. There are three ways to re-open the port:

1) Boot the switch,

2) Disable and re-enable Limit Control on the port or the switch,

3) Click the Reopen button.

Trap & Shutdown: If Limit + 1 MAC addresses is seen on the port, both the "Trap" and the
"Shutdown" actions described above will be taken.

State: This column shows the current state of the port as seen from the Limit Control's point of view. The
state takes one of four values:

Disabled: Limit Control is either globally disabled or disabled on the port.
Ready: The limit is not yet reached. This can be shown for all actions.

Limit Reached: Indicates that the limit is reached on this port. This state can only be shown if Action
is set to none or Trap.

Shutdown: Indicates that the port is shut down by the Limit Control module. This state can only be
shown if Action is set to Shut Down or Trap & Shutdown.

Re-open Button: If a port is shut down by this module, you may reopen it by clicking this button, which
will only be enabled if this is the case. For other methods, refer to shut down in the Action section.

@ NoTe: Clicking the Re-open button causes the page to be refreshed, so non-
committed changes will be lost.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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12-3.2 Status

This page shows the Port Security status. Port Security is a module with no direct configuration.
Configuration comes indirectly from other modules - the user modules. When a user module has enabled
port security on a port, the port is set-up for software-based learning. In this mode, frames from unknown
MAC addresses are passed on to the port security module, which in turn asks all user modules whether to
allow this new MAC address to forward or block it. For a MAC address to be set in the forwarding state, all
enabled user modules must unanimously agree on allowing the MAC address to forward. If only one
chooses to block it, it will be blocked until that user module decides otherwise. The status page is divided
into two sections - one with a legend of user modules and one with the actual port status.

Web Interface

To displays a Port Security Status in the web interface:

1. Click Security, Port Security, and Status.

2. Check "Auto-refresh” if desired.

3. Click “Refresh” to refresh the port detailed statistics.

4. Click the port number to see the status for this particular port.

— -
TRANSITIUN = e L] — Auto-logout  Gomin H e C.
N NETWORKS. s
- ort Securi atus @Home - Security - PortSecurity - Stetis
SM8TAT2SA-DC Port S Stat
Switch DMS —
Auto-refresh ‘ Refresh ‘
» System &
» Port Management & HortStati=
» PoE Management ¢ Port State Mac Count =
o <
» VLAN Management 1 Dicabled
¥ Quality of Service &
2 Ready 1]
¥ Spanning Tree &
3 Ready Q
» MAC Address Table &
b Multicast & # Ready 0
¥ DHCP < 5 Ready 1]
» [} Disabled
A <
7 Ready 1]
<
: ] Ready 1]
< 9 Disabled
T 10 Ready 0

Figure 12-3.2: Port Security Status

Parameter descriptions:

Port: The port number for which the status applies. Click the port number to see the status for this
particular port.

State: Shows the current state of the port. It can take one of four values:

Disabled: No user modules are currently using the Port Security service.
Ready: The Port Security service is in use by at least one user module and is awaiting frames from
unknown MAC addresses to arrive.
Limit Reach: The Port Security service is enabled by at least the Limit Control user module, and that
module has indicated that the limit is reached and no more MAC addresses should be taken in.
Shutdown: The Port Security service is enabled by at least the Limit Control user module, and that
module has indicated that the limit is exceeded. No MAC addresses can be learned on the port until
it is administratively re-opened on the Limit Control configuration Web-page.
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MAC Count (Current, Limit): The two columns indicate the number of currently learned MAC addresses

(forwarding as well as blocked) and the maximum number of MAC addresses that can be learned on the
port, respectively. If no user modules are enabled on the port, the Current column will show a dash (-).

Buttons Auto-refresh | Refresh ‘

Auto-refresh: Check to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.

Example: Port State = Limit Reach, MAC Count = 4 on Port # 5

Port Security Status @Home  securty  Ponsen:
Auto-refresh
Port Status

Port State Mac Count
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12-4 IP Source Guard

The IP Source Guard security feature restricts IP traffic on untrusted Layer 2 ports by filtering traffic based
on the DHCP snooping binding database or manually configured IP source bindings. This feature helps
prevent IP spoofing attacks.

12-4.1 Configuration

Navigate to Security > IP Source Guard > Configuration to configure IP Source Guard mode and port
mode settings and the max dynamic clients.

TRANSITION * =| =¥ T Aot logout MmO G
N NETWORKS.
SMETAT2SA IP Source Guard Configuration dHome - Security - IP Source Guard - Configuration
Switch DMS :
Mode u )
» System < i
» Port Management &
Port Mode Configuration
» PoE Management i
» VLAN Management < Port Mode Max Dynamic Clients
7 Qraligersanes ‘ 1 Disabled Unlimited v
» Spanning Tree <
2 Enabled W 1 ~
» MAC Address Table &
» Multicast < 3 Enabled + 2 v
<
» Security h
| » Management < 5 Enabled + Unlimited
‘ 6 Disabled W Unlimited v
T Disabled W Unlimited v
a8 Disabled W Unlimited v
¢ 9 Disabled + Unlimited v
“ 10 Disabled W Unlimited W
» TACACS+ ¢
‘ Apply H Reset ‘
» Access Control & LR | SR

Parameter descriptions:

Mode: Select the global mode (on or off). The default is off.

Port: A row for configuring each port.

Mode: Select the mode for each port (Enabled or Disabled). The default is Disabled.

Max Dynamic Clients: At the dropdown select 0, 1, 2 or Unlimited. The default is Unlimited.
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12-4.2 Static Table

Navigate to Security > IP Source Guard > Static Table to create new Static IP Source Guard entries.

ﬁ | JmasmE
.TRANSITION * = ] =

NETWORKS

SM8TAT2SA
Switch DMS
» System
» Port Management
» PoE Management
» VLAN Management

» Quality of Service

<

Static IP Source Guard Table

Delete Port IP Address

Parameter descriptions:

Add New Entry: Click the button to add a row for configuring.

Port: At the dropdown select the port to be configured.

IP Address: Enter the IP address for this new entry.

SMXTAT2SA Web User Guide

puto-ogout H O G
@& Home Security IP Source Guard Static Table

MAC Address

MAC Address: Enter the MAC address for this new entry (must be a valid unicast MAC address).

Apply: Click the Apply button when done.
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12-4.3 Dynamic Table

The Security > IP Source Guard > Dynamic Table displays data on existing entries. Entries in the Dynamic
IP Source Guard Table are shown on this page. The Dynamic IP Source Guard Table is sorted first by port,
then by IP address, and then by MAC address.

TRANSITION © =| *** - -

NETWORKS

SM8TAT2SA
Switch DMS
» System
» Port Management
» PoE Management
» VLAN Management
» Quality of Service

» Spanning Tree

Parameters:

<

<

Dynamic IP Source Guard Table

Auto-refresh ‘ Refresh |

Show| 1o« entries

Port “ |P Address

No data available in table

Port: Displays the configured port.

IP Address: Displays the IP address for the entry.

MAC Address: Displays the MAC address for the entry.

Previous: Click the button to display the previous set of entries.

Next: Click the button to display the next set of entries.
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Auto-logout [OFF_ +] H o C‘

@ Home - Security - IP Source Guard =~ Dynamic Table

Search:

MAC Address
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12-5 ARP Inspection

This webpage lets you configure ARP Inspection settings including Mode (on and off) and Port (Enabled

and Disabled).

12-5.1 Port Configuration

SMXTAT2SA Web User Guide

The Security > ARP Inspection > Port Configuration page displays the Port Mode Configuration table.

=
JRANSITION

SM8TAT2SA
Switch DMS

» System

» Port Management

» PoE Management

» VLAN Management

» Quality of Service

» Spanning Tree

» MAC Address Table

» Multicast
» DHCP

» Security

» Management

g

Parameters:

onfiguration

Configuration

TRANSITION ™
U

ARP Inspection Configuration

Mode

Port Mode Configuration

Port

1

2

Lo @)

Mode Check VLAN
O O

] O

[l (v

[ (v

[l [}

7] O

Mode: The global mode setting (on or off). The default is off.

Port: A row for each port to be configured.

Mode: Check the box if configured.

Check VLAN: Check the box if configured.

Log Type: Select None, Deny, Permit, or All. The default is None.

Apply: Click the button when done configuring.
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12-5.2  VLAN Configuration
The Security > ARP Inspection > VLAN Configuration page displays the VLAN Mode Configuration table.
Here you can specify ARP Inspection is enabled on which VLANS.

First, you must enable the port setting on Port mode configuration web page. Only when both Global
Mode and Port Mode on a given port are enabled, ARP Inspection is enabled on this given port.

Second, you can specify which VLAN will be inspected on VLAN mode configuration web page. The log
type also can be configured on per VLAN setting.

ﬁ ANSITION N .
TRANSITION * =| =" - - Auto-logout H 0 &
N NETWORKS

SMBTAT2SA VLAN Mode Configuration tome - Securlty - ARP Inspection - VLAN Configuration
Switch DMS
VLAN 1D Log Type
» System <
» Port Management < ! Deny v
» PoE Management < 10 Permit

VLAN Management <

Quality of Service E

Spanning Tree <

» MAC Address Table <

» Multicast <
Parameters:

Delete: Check to delete the entry. It will be deleted during the next save.
VLAN ID: The VID for this instance.
Log Type: Select None, Deny, Permit, or All. The default is None.

None: Log nothing.

Deny: Log denied entries.
Permit: Log permitted entries.
ALL: Log all entries.

Buttons
Add New Entry: Click the button to add a row for configuring.
Apply: Click the Apply button when done configuring.

Reset: Click to undo any changes made locally and revert to previously saved values.
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12-5.3 Static Table

This page describes lets you configure Static ARP Inspection Table parameters of the switch. You can use
the Static ARP Inspection Table configure to manage the ARP entries.

Navigate to the Security > ARP Inspection > Static Table menu path to display the Static ARP Inspection
Table:

ﬁ ANSITION . 1
TRANSITIDN = TRANSITION & - Auto-logout H o C*
NETWORKS .«
SMBTAT2SA Static ARP Inspection Table @eHoms - Security - ARP Inspection - Siafic Table
Switch DMS
Delete Port VLAN ID MAC Address IP Address
» System <
» Port Management < | Delete v 10 0C-22-33-44-55-56
» VLAN Management ¢
» Quality of Service « ‘ Add New Entry |
» Spanning Tree < ‘ ool H N
Appl teset
Parameters:

Port: Select the port being configured.
VLAN ID: The VID for this instance.

MAC Address: Enter the MAC address for the entry. Must be a valid unicast MAC address. Allowed Source
MAC address in ARP request packets.

IP Address: Enter the IP address for the entry; allowed Source IP address in ARP request packets.

Buttons

Add New Entry: Click the button to add a row for configuring a new VLAN to add to the ARP Inspection
VLAN table.

Apply: Click the button when done configuring to save changes.

Reset: : Click to undo any changes made locally and revert to previously saved values.
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12-5.4 Dynamic Table

SMXTAT2SA Web User Guide

Navigate to the Security > ARP Inspection > Dynamic Table menu path to display the Dynamic ARP
Inspection Table. Entries in the Dynamic ARP Inspection Table are shown on this page. The Dynamic ARP
Inspection Table contains up to 1024 entries, and is sorted first by port, then by VLAN ID, then by MAC

address, and then by IP address.

TRANSITION ' =| &% - -

N NETWORKS
SM8TAT2SA Dynamic ARP Inspection Table
Switch DMS -
Auto-refresh | Refresh |

» System <
» Port Management ¢ Show| 1w entries
» Pok Management < Port “ VLANID MAC Address
» VLAN Management ¢ No data available in table
» Quality of Service <
» Spanning Tree <
Parameters:

Auto-logout [OFF_ +] M o C’

@ Home - Security - ARP Inspection - Dynamic Table

Search:

IP Address

Search: Use the Search box to search for the information that you want to see.

Show entries: You can choose how many items you want to show.

Port: Switch Port Number for which the entries are displayed.

VLAN ID: The VID for this instance. The VLAN ID in which the ARP traffic is permitted.

MAC Address: User MAC address of the entry.
IP Address: User IP address of the entry.

Buttons:
Previous: Click the button to display the previous set of entries.

Next: Click the button to display the next set of entries.
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12-6 SNMP s

> Configuration
The Security > SNMP menu path lets you configure SNMP Communities, Groups, Views, and o SRS
Access and Trap Event Security. 7 Communites

12-6.1 Configuration

Security > SNMP > Configuration

This webpage lets you configure SNMP System on the switch. This function is used to configure

SNMP settings, community name, trap host and public traps as well as the throttle of SNMP. A SNMP
manager must pass the authentication by identifying both community names, then it can access the MIB
information of the target device. So, both parties must have the same community name. Once completing
the setting, click button, the setting takes effect.

TRANSITION N . -
TRANSITION \ =| = e - oG
\.——' NETWORKS. |
SMB8TAT2SA SNMP Configuration @Home - SNMP - Configuration
Switch DMS
Read Community public
» System <
2 Port[-\-‘anagement < Write Community private Enabled W
» PoE Management E
» VLAN Management < |-\_|| e |

SNMP Configuration Parameters:

Read Community: Indicates the community read access string to permit access to SNMP agent. The
allowed string length is 1-31 characters, and the allowed content is the ASCII characters from 33 to 126.
The field is applicable only when SNMP version is SNMPv1 or SNMPv2c. If SNMP version is SNMPv3, the
community string will be associated with SNMPv3 communities table. It provides more flexibility to
configure security name than a SNMPv1 or SNMPv2c community string. In addition to community string,
a particular range of source addresses can be used to restrict source subnet

Write Community: Indicates the community write access string to permit access to SNMP agent.

The allowed string length is 1-31 characters, and the allowed content is the ASCII characters 33 - 126.
The field is applicable only when SNMP version is SNMPv1 or SNMPv2c. If SNMP version is SNMPv3, the
community string will be associated with SNMPv3 communities table. It provides more flexibility to
configure security name than a SNMPv1 or SNMPv2c community string. In addition to community string,
a particular range of source addresses can be used to restrict source subnet. At the dropdown you can
select Enabled (default) or Disabled.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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12-6.2 SNMPv3

Security > SNMP > SNMPv3 > Communities

The function is used to configure SNMPv3 communities. The Community is unique. To create a new
community account, please check <Add New Entry> button, and enter the account information then
check the Apply button. You can create up to six Groups.

ST . -
TRANSITION © =| = _ 0 &
N NETWORKS.
SM8TAT2SA SNMPv3 Community Configuration @Home - SNMP - SNMPVE - Communities
Switch DMS
Delete Community Source IP Source Mask
» System €
» Port Management < U S-tom-1 0000 0
» PoE Management < |:I sec 0.0.0.0 0
» VLAN Management <
» Quality of Service < | Add New Entry
» Spanning Tree g | Apply || deset
Parameters:

Community: Enter the IP address for this new entry. Indicates the community access string to permit
access to SNMPv3 agent. The allowed string length is 1 - 32 characters, and the allowed content is ASCII
characters 33 - 126. The community string will be treated as security name and map a SNMPv1 or
SNMPv2c community string.

Source IP: Enter the IP address for this new entry. Indicates the SNMP access source address. A particular
range of source addresses can be used to restrict source subnet when combined with source mask.

Source Mask: Enter the Source Mask for this new entry. Indicates the SNMP access source address mask.

Buttons:
Add New Entry: Click to add a row to the table and configure the new instance.
Apply: Click to save changes when done configuring.

Reset: Click to undo any changes made locally and revert to previously saved values.
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Security > SNMP > SNMPv3 >Users

The function is used to configure SNMPv3 user. The Entry index key is User Name. To create a new User
Name account, click the Add New Entry button, and enter the user information then click the Apply
button. You can create up to six Users.

TRANSITIIN - N
TRANSITION \ =| == - uotogot - IS
N\ NETWCRKS.
SM8TAT2SA SNMPv3 User Configuration @Home -~ SNUP - SNMPYE - Users
Switch DMS
User Security Authentication Authentication Privacy
» System ¢ Delete MName  Level Protocol Password Protocol Privacy Password
» Port Management < _
O S-Usr-1  Auth,Priv MD5 DES
» PoE Management <
b VLAN Manzgement < O SnUsr-2  Auth, Priv MD5 AES
» Quality of Service <o Cxvev  Auth,Priv MD5 DES
» Spanning Tree <
e ] bob NoAuth, None Naone None None
» MAC Address Table < — NoPriv
» Multicast <
» DHCP <
» Security <
Parameters:

User Name: Enter a name for this new user entry. A string identifying the user name that this entry should
belong to. The allowed string length is 1 — 31 characters, and the allowed content is ASCII characters from
33 - 126.

Security Level: Select the desired combination of Privacy and Authentication. Security Level indicates the
security model that this entry should belong to. Possible security models are:

NoAuth, NoPriv: No authentication and no privacy.
Auth, NoPriv: Authentication and no privacy.
Auth, Priv. Authentication and privacy.

The value of security level cannot be modified if entry already exists. That means it must first be ensured
that the value is set correctly.

Authentication Protocol: If Authentication is configured, select a protocol; either: MD5 (uses the Merkle—
Damgard construction) or SHA (Secure Hash Algorithm). Note: the value of security level cannot be
modified if an entry already exists. That means you must first ensure that the value is set correctly.

The length of 'SHA Authentication Password' is restricted to 8 — 39 characters.

Authentication Password: If Authentication is configured, enter a password for authenticating. A string
identifying the authentication password phrase. For MD5 authentication protocol, the allowed string
length is 8 to 39. For SHA authentication protocol, the allowed string length is 8 to 39 characters.

The allowed content is ASCII characters 33 - 126.

Privacy Protocol: If Privacy is configured, select a protocol; either DES (Data Encryption Standard) or AES
(Advanced Encryption Standard). Indicates the privacy protocol that this entry should belong to. Possible
privacy protocols are:

DES: An optional flag to indicate that this user uses DES authentication protocol.

AES: An optional flag to indicate that this user uses AES authentication protocol.
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Privacy Password: If Privacy is configured, enter a password for privacy. A string identifying the privacy
password phrase. The allowed string length is 8 to 31, and the allowed content is ASCII characters 33-126.
The length of 'Privacy Password' is restricted to 8 — 31 characters.

Buttons:
Add New Entry: Click to add a row to the table and configure the new instance.
Apply: Click to save changes when done configuring.

Reset: Click to undo any changes made locally and revert to previously saved values.
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Security > SNMP > SNMPv3 > Groups

The function is used to configure SNMPv3 group. The Entry index key are Security Model and Security
Name. To create a new group account, check the Add New Group button, and enter the group
information then click the Apply button. You can create up to 12 SNMP Groups.

-

Aﬂ TRANSITIEN ™
TRANSITION = JRA l= — Auto-logout €0 min ~ 9 C» ‘
N NETWORKS
SM8TAT2SA-DC SNMPv3 Group Configuration @Home - SNMP - SNUPG - Groups |
Switch DMS
Delete Security Model User Name Group Name
P System <
» Port Management < | VIR | v EI EI
» PoE Management < | Tk | e E| E|
» VLAN Management < E—
» Quality of Service < |e—| e E|
» Spanning Tree <

Add New Entry |

» MAC Address Table <

Apply || Reset

-

Multicast (

Parameters:

Security Model: Select v1, v2¢, or usm (User-based Security Model). Indicates the security model that this
entry should belong to. Possible security models are:

v1: Reserved for SNMPv1.
v2c: Reserved for SNMPv2c.
usm: User-based Security Model (USM).

User Name: At the dropdown select an existing User Name to become a member of this new group.
A string identifying the security name that this entry should belong to. The allowed string length is 1 - 31,
characters and the allowed content is ASCII characters 33 - 126.

Group Name: Enter the name for the new Group. A string identifying the group name that this entry
should belong to. The allowed string length is 1 to 32 characters, and the allowed content is ASCII
characters 33 - 126.

Buttons:
Add New Entry: Click to add a row to the table and configure the new instance.
Apply: Click to save changes when done configuring.

Reset: Click to undo any changes made locally and revert to previously saved values.
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Security > SNMP > SNMPv3 > Views

The function is used to configure SNMPv3 view. The Entry index keys are OID Subtree and View Name.
To create a new view account, please check <Add new view> button, and enter the view information then
click the Apply button. Max View number: 12. The entry index keys are View Name and OID Subtree.

ﬁ TRANSITION ™ -
TRANSITIUN — ||| L T ] Auto-logout 60 min - o C»
N NETWORKS. i
SME8TAT2SA-DC SNMPv3 View Configu ration @Home ~ SNMP - SNMPV3 — Views £
Switch DMS
Delete View Name View Type OID Subtree
b Systemn <

» Port Management < | Delete | l:l included EI
| Delete | included E|

Add New Entry |

» PoE Management

» VLAN Management <

» Quality of Service <

» Spanning Tree

| Apply || Reset |

MEA/ A Tl s

Parameters:

View Name: Enter the name for this new View. A string identifying the view name that this entry should
belong to. The allowed string length is 1 to 31 characters, and the allowed content is ASCII characters
33-126.

View Type: Select included or excluded for this new View. Indicates the view type that this entry should
belong to. Possible view types are:

Included: An optional flag to indicate that this view subtree should be included.

Excluded: An optional flag to indicate that this view subtree should be excluded.

In general, if a view entry's view type is 'excluded’, there should be another view entry existing with view
type as 'included' and it's OID subtree should overstep the ‘excluded’ view entry.

OID Subtree: Enter an Object Identifier for this new View. The format is .OID1.0ID2.0ID3 ...
The allowed string content is digital number or asterisk (*). This is the OID defining the root of the subtree
to add to the named view. The allowed OID length is 1 to 128.

Buttons:
Add New Entry: Click to add a row to the table and configure the new instance.
Apply: Click to save changes when done configuring.

Reset: Click to undo any changes made locally and revert to previously saved values.
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Security > SNMP > SNMPv3 > Access

The function is used to configure SNMPv3 accesses. The Entry index key are Group Name, Security Model
and Security level. To create a new access account, click the Add New Entry button, enter the access
information, and then check the Apply button. You can create up to 12 accesses.

TRANSITION N - - 1
TRANSITION \ =| == - MO C
N\ NETWORKS )
SMBTAT2SA SNMPv3 Access Configuration @ome - SNUP - SNIMPYS - Access
Switch DMS
Delete Group Name  Security Model Security Level Read View Name Write View Name
» System <
. Grp-l ™ any W NoAuth, NoPriv - 4 -
» Port Management <
» PoE Management <

» VLAN Management <

» Quality of Service <

Parameters:

Group Name: Select the name of the existing Group. A string identifying the group name that this entry
should belong to. The allowed string length is 1 to 31 characters, and the allowed content is ASCII
characters 33 - 126.

Security Model: Select any, v1, v2¢, or usm for this instance. Indicates the security model that this entry
should belong to. Possible security models are:

Any: Any security model accepted(vl|v2c|usm).
v1: Reserved for SNMPv1.

v2c: Reserved for SNMPv2c.

usm: User-based Security Model (USM).

Security Level: Select the level of security to be applied. Indicates the security model that this entry
should belong to. Possible security models are:

NoAuth, NoPriv: No authentication and no privacy.
Auth, NoPriv: Authentication and no privacy.
Auth, Priv. Authentication and privacy.

Read View Name: Select None or an existing Read View Name at the dropdown. This is the name of the
MIB view defining the MIB objects for which this request may request the current values. The allowed
string length is 1 to 31 characters, and the allowed content is ASCII characters 33 - 126.

Write View Name: Select None or an existing Write View Name at the dropdown. This is the name of the
MIB view defining the MIB objects for which this request may potentially set new values. The allowed
string length is 1 to 31 characters, and the allowed content is ASCII characters 33 - 126.

Buttons

Add New Entry: Click to add a new instance. An empty row is added to the table, and the new instance
can be configured as needed.

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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Switch > Event Notification > SNMP Trap
This page displays the SNMP Trap Hosts Configuration table:

TRANSITION * Mita-doeot \FE
TRANSITION® = == - °c
VNETWORKS
SM8TAT2SA SNMP Trap Hosts Configuration @Homs - EventNotificstion ~ SNMP Trap
Switch DMS
Destination Destination Severity
b System S Delete No Name Mode Version Address Port Level
» Port Management < —
e [l 1 Bob TCP vac 192.168.1.30 182 Emerg
» PoE Management < -
[l 2 admin TCP  v2c 192.168.1.40 162 Alert
b VLAN Management &
] 2 B p 92.168.1.1( 62 W :
T e ¢ [ 3 nnn TC v2e 192.168.1.10 162 Warning
» Spanning Tree < O 4
» MAC Address Table < M 5
b Multicast & O ~
» DHCP ¢
» Security 3 | Apply “ Reset |

No: The index of the trap host entry.
Name: Indicates the community access string when sending SNMP trap packet.

Mode: Indicates the trap destination mode operation. Possible modes are:
Disabled: Disable SNMP mode operation.
UDP: Enable UDP SNMP mode operation.
TCP: Enable TCP SNMP mode operation.

Version: Indicates the SNMP trap supported version. Possible versions are: SNMP v2c: Set SNMP trap
supported version 2c.

Destination Address: Indicates the SNMP trap destination address.

Destination port: Indicates the SNMP trap destination port. SNMP Agent will send SNMP message via
this port, the port range is 1~65535.
Severity Level: Indicates what kind of message will send to trap server. Possible modes are:

Emerg: System is unusable.

Alert: Action must be taken immediately.

Crit: Critical conditions.

Error: Error conditions.

Warning: Warning conditions.

Notice: Normal but significant conditions.

Info: Information messages.

Debug: Debug-level messages

Buttons

Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.
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12-7 RADIUS
12-4.1 Configuration
Web Interface

To configure a RADIUS in the web interface:
1. Click Security, RADIUS, Configuration.

2. Set Timeout, Retransmit, Deadtime, Key, NAS-IP-Address, NAS IPv6-Address,NAS-Identifier.
3. Click "Add New Entry” to display the configurable parameters.
4. Set Global Configuration parameters.
5. Set Server Configuration parameters.
6. Click the Apply button to save the settings. To cancel the settings, click the Reset button.
T p— - =
TRANSITION =| = [ T 1 Auto-logout 60min Q c.
N NETWORKS. e |
SM8TAT2SA-DC RADIUS Server Configuration @Home - Security - RADIUS - Configuration
Switch DMS I
Global Configuration
» System
» Port Management < Timeout 5 seconds
» PoE Management € Retransmit . times
» VLAN Management <
Deadtime o minutes
» Quality of Service ©
» Spanning Tree € Key 3

L4

<
MAC Address Table NAS-IP-Address

» Multicast €

NAS-IPv6-Address
» DHCP e
P Security - NAS-Identifier

*» Management <

» |EEE802.1X < ) .
Server Configuration

* |P Source Guard <

3 ARP Inspection < Delete Hostname Auth Port Acct Port Timeout Retransmit Key
» Port Security <
: ‘ Delete | 1812 1213 3 3
» RADIUS v - g
> Configuration |7|
> Status
» TACACS+ < | Apply || Reset |

Figure 12-7.1: RADIUS Server Configuration

Global Configuration parameters: These setting are common for all of the RADIUS servers.

Timeout: Timeout is the number of seconds, in the range 1 to 1000, to wait for a reply from a RADIUS
server before retransmitting the request.

Retransmit: Retransmit is the number of times, in the range 1 to 1000, a RADIUS request is retransmitted
to a server that is not responding. If the server has not responded after the last retransmit it is considered
to be dead.

Deadtime: Deadtime, which can be set to a number 0 to 1440 minutes, is the period during which the
switch will not send new requests to a server that has failed to respond to a previous request. This will
stop the switch from continually trying to contact a server that it has already determined as dead. Setting
the Deadtime to a value greater than 0 (zero) will enable this feature, but only if more than one server has
been configured.
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Key: The secret key - up to 63 characters long - shared between the RADIUS server and the switch.

NAS-IP-Address: The IPv4 address to be used as attribute 4 in RADIUS Access-Request packets. If this
field is left blank, the IP address of the outgoing interface is used.

NAS-IPv6-Address: The IPv6 address to be used as attribute 95 in RADIUS Access-Request packets.
If this field is left blank, the IP address of the outgoing interface is used.

NAS-Identifier: The identifier - up to 255 characters long - to be used as attribute 32 in RADIUS Access-
Request packets. If this field is left blank, the NAS-Identifier is not included in the packet.

Server Configuration parameters: The table has one row for each RADIUS server and a number of
columns

Delete: To delete a RADIUS server entry, check this box. The entry will be deleted during the next Save.
Hostname: The IP address or hostname of the RADIUS server.

Auth Port : The UDP port to use on the RADIUS server for authentication. The officially assigned port
number for RADIUS Accounting is 1812). Note: by default, many access servers use port 1645 for
authentication requests.

Note: For Windows Server information on how to configure ports that Network Policy Server
(NPS) uses for Remote Authentication Dial-In User Service (RADIUS) authentication and
accounting traffic see https://docs.microsoft.com/en-us/windows-
server/networking/technologies/nps/nps-udp-ports-
configure#:~:text=The%20port%20values%200f%201812,and%201646%20for%20accounting%2

Orequests
Acct Port : The UDP port to use on the RADIUS server for accounting. The officially assigned port number

for RADIUS Accounting is 1813. Note: by default, many access servers use port 1646 for accounting
requests.

Timeout: This optional setting overrides the global timeout value. Leaving it blank will use the global
timeout value.

Retransmit: This optional setting overrides the global retransmit value. Leaving it blank will use the global
retransmit value.

Key: This optional setting overrides the global key. Leaving it blank will use the global key.

Buttons

Add New Entry: Click to add a new RADIUS server. An empty row is added to the table, and the RADIUS
server can be configured as needed. Up to 5 servers are supported. The Reset button can be used to undo
the addition of the new server.

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.

Messages:

The value of NAS-IP-Address must be a valid IP address in dotted decimal notation (x.y.z.w), where x, y, z,
and w are decimal number between 0 and 255.

The input value NAS-IPv6-Address (111111111) is not a valid IPv6 address.
Hostname must be a valid hostname, unicast IPv4, or unicast IPv6 address
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RADIUS Attributes

Value Description Data Type Reference

4 NAS-IP-Address ipvd4addr IETF RFC2865
32 NAS-Identifier text IETF RFC2865
95 NAS-IPv6-Address  ipv6addr IETF RFC3162

The RADIUS Accounting protocol provides a protocol for carrying accounting information between a
Network Access Server and a shared Accounting Server per IETF RFC 2866.

See the IANA Considerations for guidance regarding IANA registration of values related to RADIUS as
defined in IETF RFC2865.

See your RADIUS server documents for more information.
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12-7.2 Status

This section shows you an overview/detail of the RADIUS Authentication and Accounting servers' status to
ensure the function is workable.

Web Interface

To display a RADIUS Status in the web interface:
1. Click Security, RADIUS, and Status.
2. Select a Server line to display the detail statistics for a particular RADIUS server.

TRANSITION ® = = : =

Auto-logout H o C.

N NETWORKS..
SM8TAT2SA RADIUS Server Status @Home - Security - RADIUS - Status
Switch DMS
RADIUS Authentication Server Status
» System <
» Port Management < # IP Address Status
» PoE Management < 1 111111:1812 Ready
» VLAM Management E 2 10.0.5.55:577 Ready
» Quality of Service < 5 0.0.0.0:0 Disabled
3 i { <
Spanning Tree 4 0.0.0.0:0 Disabled
» MAC Address Table <
5 0.0.0.0:0 Disabled
» Multicast ‘
> DHCP ¢ RADIUS Accounting Server Status
» Security -
» Management . # IP Address Status
» |EEE 802.1X < 1 111111:1813 Ready
» IP Source Guard < 1
2 10.0.5.55:765 Ready
» ARP Inspection <
e 3 0.0.0.0:0 Disabled
» Port Security <
» RADIUS v 4 0.0.0.0:0 Disabled
> Configuration 5 0.0.0.0:0 Disabled
> Status

Figure 12-4.2: RADIUS Server Status

Parameter descriptions:

RADIUS Authentication Server Status

#: The RADIUS server number. Click to navigate to detailed statistics for this server (see below).

IP Address: The IP address and UDP port number (in <IP Address>:<UDP Port> notation) of this server.

State: The current state of the server. This field takes one of these values:

Disabled: The server is disabled.

Not Ready: The server is enabled, but IP communication is not yet up and running.

Ready: The server is enabled, IP communication is up and running, and the RADIUS module is ready
to accept access attempts.
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Dead (X seconds left) : Access attempts were made to this server, but it did not reply within the
configured timeout. The server has temporarily been disabled but will get re-enabled when the dead-
time expires. The number of seconds left before this occurs is displayed in parentheses. This state is
only reachable when more than one server is enabled.

RADIUS Accounting Server Status

#: The RADIUS server number. Click to navigate to detailed statistics for this server.
IP Address: The IP address and UDP port number (in <IP Address>:<UDP Port> notation) of this server.
State : The current state of the server. This field takes one of the following values:

Disabled: The server is disabled.

Not Ready: The server is enabled, but IP communication is not yet up and running.

Ready: The server is enabled, IP communication is up and running, and the RADIUS module is
ready to accept accounting attempts.

Dead (X seconds left): Accounting attempts were made to this server, but it did not reply within
the configured timeout. The server has temporarily been disabled but will get re-enabled when
the dead-time expires. The number of seconds left before this occurs is displayed in parentheses.
This state is only reachable when more than one server is enabled.
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Example: If you select Server#2 to display its RADIUS Statistics:

‘ﬁ TRENSITIN ™ . - ,
TRANSITION =| o i Auto-logout M G
N NETWORKS
SMETAT25A RADIUS Statistics @oroms - Seeucty o RADIUS - Stus
Switch DMS

Auto-refresh
» System <

b Port Management ¢ RADIUS Authentication Statistics for Server #2

b PoE Management ¢ Receive Packets Transmit Packets
VLAN M o <
7 ULAIN R Access Accepts 0 Access Requests 0
¥ Quality of Service < ) o
Access Rejects 0 Access Retransmissions 0
» Spanning Tree <
Access Challenges 0 Pending Requests 0
» MAC Address Table <
» Multicast ¢ Malformed Access Responses 0 Timeouts 0
» DHCP < Bad Authenticators 0
» v Unknown Types 0
<
Packets Dropped 0
<
. Other Info
¢ IP Address 10.0.5.55:577
‘ State Ready
Round-Trip Time 0ms

RADIUS Accounting Statistics for Server #2

» Access Control < Receive Packets Transmit Packets
» SMMP R Responses 0 Requests 0
S Em <
7 BRI IETTT Malformed Responses 0 Retransmissions 0
» Diagnostics < . .
Bad Authenticators 0 Pending Requests 0
» Maintenance <
Unknown Types 0 Timeouts 0
Packets Dropped 0
Other Info
1P Address 10.0.5.55:765
State Ready
Round-Trip Time 0ms

Figure 12-7.2: RADIUS Statistics
Parameter descriptions:
server #: You can select which server that you want display RADIUS.

RADIUS Authentication Statistics for Server #1: The statistics map closely to those specified in IETF
RFC4668 - RADIUS Authentication Client MIB. Use the server select box to switch between the backend
servers to show details for.

Access Accepts: The number of RADIUS Access-Accept packets (valid or invalid) received from the server.
Access Rejects: The number of RADIUS Access-Reject packets (valid or invalid) received from the server.

Access Challenges: The number of RADIUS Access-Challenge packets (valid or invalid) received from the
server.

Malformed Access Responses: The number of malformed RADIUS Access-Response packets received
from the server. Malformed packets include packets with an invalid length. Bad authenticators or Message
Authenticator attributes or unknown types are not included as malformed access responses.
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Bad Authenticators: The number of RADIUS Access-Response packets containing invalid authenticators
or Message Authenticator attributes received from the server.

Unknown Types: The number of RADIUS packets that were received with unknown types from the server
on the authentication port and dropped.

Packets Dropped: The number of RADIUS packets that were received from the server on the
authentication port and dropped for some other reason.

Access Requests: The number of RADIUS Access-Request packets sent to the server. This does not include
retransmissions.

Access Retransmissions: The number of RADIUS Access-Request packets retransmitted to the RADIUS
authentication server.

Pending Requests: The number of RADIUS Access-Request packets destined for the server that have not
yet timed out or received a response. This variable is incremented when an Access-Request is sent and
decremented due to receipt of an Access-Accept, Access-Reject, Access-Challenge, timeout, or
retransmission.

Timeouts: The number of authentication timeouts to the server. After a timeout, the client may retry to
the same server, send to a different server, or give up. A retry to the same server is counted as a
retransmit as well as a timeout. A send to a different server is counted as a Request as well as a timeout.

IP Address: IP address and UDP port for the authentication server in question.
State: Shows the state of the server. It takes one of the following values:

Disabled: The selected server is disabled.

Not Ready: The server is enabled, but IP communication is not yet up and running.

Ready: The server is enabled, IP communication is up and running, and the RADIUS module is
ready to accept access attempts.

Dead (X seconds left): Access attempts were made to this server, but it did not reply within the
configured timeout. The server has temporarily been disabled but will get re-enabled when the
dead-time expires. The number of seconds left before this occurs is displayed in parentheses.
This state is only reachable when more than one server is enabled.

Round-Trip Time: The time interval (measured in milliseconds) between the most recent Access-
Reply/Access-Challenge and the Access-Request that matched it from the RADIUS authentication server.
The granularity of this measurement is 100 ms. A value of 0 ms indicates that there hasn't been round-trip
communication with the server yet.

RADIUS Accounting Statistics for Server #x: The statistics map closely to those specified in RFC4670 -
RADIUS Accounting Client MIB. Use the server select box to switch between the backend servers to show
details for.

Responses: The number of RADIUS packets (valid or invalid) received from the server.

Malformed Responses: The number of malformed RADIUS packets received from the server. Malformed
packets include packets with an invalid length. Bad authenticators or unknown types are not included as
malformed access responses.

Bad Authenticators: The number of RADIUS packets containing invalid authenticators received from the
server.

Unknown Types: The number of RADIUS packets of unknown types that were received from the server on
the accounting port.

Packets Dropped: The number of RADIUS packets that were received from the server on the accounting
port and dropped for some other reason.
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Requests: The number of RADIUS packets sent to the server. This does not include retransmissions
Retransmissions: The number of RADIUS packets retransmitted to the RADIUS accounting server.

Pending Requests: The number of RADIUS packets destined for the server that have not yet timed out or
received a response. This variable is incremented when a Request is sent and decremented due to receipt
of a Response, timeout, or retransmission.

Timeouts: The number of accounting timeouts to the server. After a timeout, the client may retry to the
same server, send to a different server, or give up. A retry to the same server is counted as a retransmit as
well as a timeout. A send to a different server is counted as a Request as well as a timeout.

IP Address: IP address and UDP port for the accounting server in question.
State: Shows the state of the server. It takes one of the following values:
Disabled: The selected server is disabled.
Not Ready: The server is enabled, but IP communication is not yet up and running.

Ready: The server is enabled, IP communication is up and running, and the RADIUS module is
ready to accept accounting attempts.

Dead (X seconds left): Accounting attempts were made to this server, but it did not reply within
the configured timeout. The server has temporarily been disabled but will get re-enabled when
the dead-time expires. The number of seconds left before this occurs is displayed in parentheses.
This state is only reachable when more than one server is enabled.

Round-Trip Time: The time interval (measured in milliseconds) between the most recent Response and
the Request that matched it from the RADIUS accounting server. The granularity of this measurement is
100 ms. A value of 0 ms indicates that there hasn't been round-trip communication with the server yet.
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12.8 RMON Configuration > RMON Configuration
Navigate to the Switch >Security > RMON menu path to configure remote ' “:Mf'c'i
monitoring. Here you can configure and view RMON statistics, history, alarms, ..l--.ul
and events. Alarm
VEn
» RMONN Statue <

RMON Statistics Configuration
1. Navigate to Switch > SNMP > RMON Configuration > Statistics to display the RMON Statistics
Configuration table.
Click the Add New Entry button.
Enter the desired parameters.
Click the Apply button to save the webpage changes to running-config.

TRANSITION ® =| === : = H O G
N NETWORKS
SMBTAT2SA RMOQON Statistics Configuration @Home - SNMP - RMON Configuration - Ststistics
Switch DMS
Delete 1D Data Source
P System %
1.3.6.1.2.1.2.2.1.1. s
| ¥ PortManagement < O ! -
» PoE Management < Ol 2 1.3.6.1.2.1.2.2.1.1. s
» VLAN Managament <
| A = O 3 1.3.6.1.2.1.2.2.1.1, s
¥ Quality of Service <
]
» Spanning Tree < | Add New En |
[ ]
§ » MAC Address Table < | ||—|
Apply || Reset
» Multicast < -

Parameter descriptions:
Delete: Check the box to delete the table entry.
ID: Enter an ID for the instance.

Data Source: The port ID which you want to be monitored with RMON.

Buttons
Add New Entry: Click the button to add a new row for configuring.
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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RMON History Configuration

Navigate to Switch > SNMP > RMON Configuration > History to display the RMON History Configuration
page:

TRANSITION ® =| == : = Mo G
" NETWORKS
SMBTAT2SA RMON History Configuration @Home - SHMP - RMON Configuration - History
Switch DMS
Delete D Data Source Interval Buckets Buckets Granted
» System
| 1 1361212211 = 200 GO0 500
» Port Management < —
» PoE Management < | Delete | 1361212211, 1200 50

-

VLAN Management <

-

Quality of Service <

» Spanning Tree

Parameters:

Delete: Check the box to delete the table entry.

ID: Indicates the index of the entry. The valid range is 1 to 65535.

Data Source: Indicates the port ID which you want to be monitored with RMON.

Interval: Indicates the interval in seconds for sampling the history statistics data. The valid range is 1 to
3600. The default value is 1800 seconds.

Buckets: Indicates the maximum data entries associated this History control entry stored in RMON.

The valid range is 1 to 3600. The default value is 50. This is the RMON “buckets requested’ value - the
requested number of discrete time intervals over which data is to be saved in the part of the media-
specific table associated with this historyControlEntry. When this object is created or modified, the probe
should set historyControlBucketsGranted as closely to this object as is possible for the particular probe
implementation and available resources. The default is 50 buckets.

Buckets Granted: The number of data saved in the RMON. The number of discrete sampling intervals
over which data will be saved in the part of the media-specific table associated with this
historyControlEntry.

See the RMON RFC (IETF REC 2819) for details on the particular probe implementation and available
resources.
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RMON Alarm Configuration

Navigate to Switch > SNMP > RMON Configuration > Alarm to display the RMON Alarm Configuration
page:

| TRANSITION® =| === ; = woos ) M Q@ G
N NETWORKS
SMBTAT2SA RMON Alarm Configuration @Home - SNP - RMON Configuration - Alarm
Switch DMS
Delete 1D Interval variable Sample Type Value Startup Alarm Rising Rising Falling Falling
» System ¢ Threshold  Index Threshold  Index
Part Manage <
> PertManagzment _ 1361.2.12.2.1.
» PoE Management S U ! - 108 ° M Freingorralline v - N
» VLAN Management <
» Quality of Service < | Add New Entry ‘

» Spanning Tree < | Apply H Resat

Parameters:

ID: Indicates the index of Alarm control entry.

Interval: Indicates the interval in seconds for sampling and comparing the rising and falling threshold.
Variable: Indicates the particular variable to be sampled.

Sample Type: The method of sampling the selected variable and calculating the value to be compared
against the thresholds, possible sample types are:

Delta: Delta sampling subtracts the current sample value from the last sample taken and then compares
the difference to the threshold. Delta sampling is like a counter that records a value that is constantly
increasing. The difference between samples of the selected variable is used when comparing against the
thresholds.

Absolute: Absolute sampling compares the sample value directly to the threshold. Absolute sampling is
like a gauge that records values that go up or down. An actual value of the selected variable is used
when comparing against the thresholds.

Value: The value of the statistic during the last sampling period. (e.g., 72).

Startup Alarm: The alarm that may be sent when this entry is first set to valid (e.g., RisingOrFalling).
Rising Threshold: Rising threshold value.

Rising Index: Rising event index.

Falling Threshold: Falling threshold value.

Falling Index: Falling event index.

Buttons
Add New Entry : Click to add new entry.
Apply : Click to save changes.

Reset : Click to undo any changes made locally and revert to previously saved values.

33717 Rev.J https://www.transition.com Page 212 of 304



https://www.transition.com/

Transition Networks SMXTAT2SA Web User Guide

RMON Event Configuration

Navigate to Switch > SNMP > RMON Configuration > Event to display the RMON Event Configuration
page:

TRANSITION = Lt o Auto-logout -_C-== v H 9 C"
e NETWORKS
SMEBTAT2SA RMON Event Conﬁguration @Home - SKMP - RMON Configuration - Event
Switch DMS
Delete ID Description Type Community Event Last Time
» System <
[l 1 BobB logznd trap W trppil 0
» Port Management < -
» PoE Management < O 2 po snmptrap W sTrapl 0
» VLAN Management &
» Quality of Service < | Add New En |
» Spanning Tree < | Apply || Reset |
Parameters:

ID: Enter the index of the RMON event. The valid range is 1 to 65535. Each ID entry must be unique.
Desc: Indicates this event, the string length is 0 to 127. The default is a null string.

Type: Indicates the notification of the event, the valid types are:
none: No logging action is performed.
log: A syslog entry is added.
snmptrap: An SNMP trap event is sent.
logandtrap: A syslog entry is logged and an SNMP trap event is sent.

Community: Specify the community when a trap is sent; the string length is 0 to 127 characters. The
default is "public".

Event Last Time: Indicates the value of sysUpTime at the time this event entry last generated an event
(e.g., 33554560 or 33 days, 55 hours, 45 minutes, and 50 seconds).

Buttons
Add New Entry : Click to add new entry.
Apply : Click to save changes.

Reset : Click to undo any changes made locally and revert to previously saved values.
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12.9 RMON Status » RMON Status
Navigate to the Switch > SNMP > RMON Status menu path to view RMON el
statistics, history, alarms, and events. » History

» Alarm
RMON Statistics Status > Event

Navigate to Switch > SNMP > RMON Status > Statistics to display the RMON Statistics Status page:

TRANSITION ® = === : = oot 5] B © G

N NETWORKS
SMBTAT25A RMON Statistics Status @Home - SNMP - RMON Status - Seatistics
Switch DMS
Auto-refresh | Refresh |
» System <
» Port Management < Show | 1 w entries Search:
g

» PoE Management ‘ Data 128 256 512 1024

» VLAN Management < * Source CRC Under- Over- 64 65~ ~ ~ - -
ag!
1D (ifindex) Drop Octets Pkts Broadcast Multicast Errors size size Frag. Jabb. Coll. Bytes 127 255 511 1023 1588
» Quality of Service <
1 5 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

» Spanning Tree <

» MAC Address Table < 2 5 0 0 Q Q 0 0 0 0 Q 0 0 0 0 0 0 0 0

VMAC A

5 el < 3 6 0 0 0o 0 0 0 0 0 0 0 0o 0 0o 0o o0 o0 0

» DHCP ‘ Showing 1to 3 of 3 entries

» Security <
Parameters:

ID: Indicates the index of Statistics entry.

Data Source (ifIndex): The data source which you want to be monitored.

Drop: The total number of events in which packets were dropped by the probe due to lack of resources.
Octets: The total number of octets of data (including those in bad packets) received on the network.

Pkts: The total number of packets (including bad packets, broadcast packets, and multicast packets)
received.

Broad-cast: The total number of good packets received that were directed to the broadcast address.
Multi-cast: The total number of good packets received that were directed to a multicast address.

CRC Errors: The total number of packets received that had a length (excluding framing bits, but including
FCS octets) of between 64 and 1518 octets.

Under-size: The total number of packets received that were less than 64 octets.

Over-size: The total number of packets received that were longer than 1518 octets.

Frag.: The number of frames with a size is less than 64 octets received with invalid CRC.

Jabb.: The number of frames which size is larger than 64 octets received with invalid CRC.

Coll.: The best estimate of the total number of collisions on this Ethernet segment.

64 Bytes: The total number of packets (including bad packets) received that were 64 octets in length.

65~127: The total number of packets (including bad packets) received that were 65 to 127 octets in
length.

128~255: The total number of packets (including bad packets) received that were 128 to 255 octets long.
256~511: The total number of packets (including bad packets) received that were 256 to 511 octets long.
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512~1023: The total number of packets (including bad packets) received that were 512 to 1023 octets
long.

1024~1588: The total number of packets (including bad packets) received that were 1024 to 1588 octets
long.

Buttons

Auto-refresh : Check this box to refresh the page automatically every 3 seconds.
Refresh : Click to refresh the page immediately.

Previous : Updates the entries, turn to the previous page.

Next : Updates the entries, turn to the next page.
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RMON History Status
Navigate to Switch > SNMP > RMON Status > History to display the RMON History Status page:

TRANSITIUN = T i Auto-logout -_O== v H 9 C.
N NETWORKS
SMETAT2SA RMON History Status ghHome ~ SNMP - RMON Statws - History
Switch DMS —
Auto-refresh | Refresh |
» System <
» Port Management < Index ndexl W
» POE Management <
» VLAN Management < Show 1w |entries Search:
» Quality of Service N sample, CRC  Under- Over-
¥ Spanning Tree < Index Sample Start Drop Octets Pkts Broadcast Multicast Errors size size Frag. Jabb. Coll. utilization
MAC A < 2d
C REAIEEs TR 50 ‘ 0 700000 3500 70 105 3 0 0 70 g o
4:31:39(189099)
» Multicast 3
2d
» DHCP < 51 - .0 1320000 6800 132 188 L] Q 0 33 4] 16 0
5:01:35(1908598)
» Security <
. 2d - . - 5 . S
b Access Control < 52 5:31:30(192609) 0 180000 800 16 24 8 V] 1] 4 ] 2 0
b SNMP - o
2d
53 .0 260000 1300 26 39 13 Q0 0 g 0 3 Q0
6:01:35(1944098)
<
2d
¢ 54 _ . . |0 480000 2300 46 69 23 1] 0 11 0 5 1]
6:31:39(106299)
2d
55 0 1200000 S500 150 285 85 ] 0 a7 0 23 ]

7:01:39(198089)

> Alarm Showing 1 to 6 of 6 entries

Parameters:
Sample Index: Indicates the index of the data entry associated with the control entry

Sample Start: The total number of events in which packets were dropped by the probe due to lack of
resources.

Drops: The total number of events in which packets were dropped by the probe due to lack of resources.
Octets: The total number of octets of data (including those in bad packets) received on the network.

Pkts: The total number of packets (including bad packets, broadcast packets, and multicast packets)
received.

Broadcast: The total number of good packets received that were directed to the broadcast address.
Multicast: The total number of good packets received that were directed to a multicast address.

CRC Errors: The total number of packets received that had a length (excluding framing bits, but including
FCS octets) of between 64 and 1518 octets.

Undersize: The total number of packets received that were less than 64 octets.

Oversize: The total number of packets received that were longer than 1518 octets.

Frag.: The number of frames which size is less than 64 octets received with invalid CRC.
Jabb.: The number of frames which size is larger than 64 octets received with invalid CRC.

Coll.: The best estimate of the total number of collisions on this Ethernet segment.
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Utilization: The best estimate of the mean physical layer network utilization on this interface during this
sampling interval, in hundredths of a percent ((01% sampling interval).

Buttons

Auto-refresh : Check this box to refresh the page automatically every 3 seconds.
Refresh : Click to refresh the page immediately.

Previous : Updates the entries, turn to the previous page.

Next : Updates the entries, turn to the next page.

33717 Rev. ) https://www.transition.com Page 217 of 304



https://www.transition.com/

Transition Networks SMXTAT2SA Web User Guide

RMON Alarm Status
Navigate to Switch > SNMP > RMON Status > Alarm to display the RMON Alarm Status page:

TRANSITION * =| == = M OoC
\.—' NETWORKS
SM8TAT25A RMQON Alarm Status @Home - SNMP - RMON Status - Alsrm
Switch DMS —
Auto-refresh ‘ Refresh |
» System <
} Port Management < Show| 0+ entries Search:
» PoE Management N X sample Rising Rising Falling Falling
» VLAN Management < D Interval Variable Type Value Startup Alarm  Threshold Index Threshold Index
» Quality of Service < 1 30 1.3.6.1.2.1.2.2.1.10.8  Delta 0 RisingOrFalling 4 4 2 2
E— <
L S e Showing 1tc 1 of 1 entries
» MAC Address Table <
Parameters:

ID: Indicates the index of Alarm control entry.
Interval: Indicates the interval in seconds for sampling and comparing the rising and falling threshold.
Variable: Indicates the particular variable to be sampled.

Sample Type: The method of sampling the selected variable and calculating the value to be compared
against the thresholds. Possible sample types are:

Delta: Delta sampling subtracts the current sample value from the last sample taken and then compares
the difference to the threshold. Delta sampling is like a counter that records a value that is constantly
increasing. The difference between samples of the selected variable is used when comparing against the
thresholds.

Absolute: Absolute sampling compares the sample value directly to the threshold. Absolute sampling is
like a gauge that records values that go up or down. An actual value of the selected variable is used
when comparing against the thresholds.

Value: The value of the statistic during the last sampling period. (e.g., 72).

Startup Alarm: The alarm that may be sent when this entry is first set to valid (e.g., RisingOrFalling).
Rising Threshold: Rising threshold value.

Rising Index: Rising event index.

Falling Threshold: Falling threshold value.

Falling Index: Falling event index.

Buttons

Auto-refresh : Check this box to refresh the page automatically every 3 seconds.
Refresh : Click to refresh the page immediately.

Previous : Updates the entries, turn to the previous page.

Next : Updates the entries, turn to the next page.
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RMON Event Status
Navigate to Switch > SNMP > RMON Status > Event to display the RMON Event Status page:

TRANSITION = Lt = Auto-logout H o C"
Na" NETWORKS
SME8TAT2SA RMON Event Status @Homs - SNUP - RMON Status - Event
Switch DMS
Auto-refresh | Refresh |
» System <
» Port Management ¢ Show | 10« entries Search:
» PoE Management . Event Index “ LogIndex Log Time Log Description
/LAN Manage ¢
D LA No data available in table
» Quality of Service <
Showing 0 to 0 of 0 entries
» Spanning Tree <
Parameters:

Event Index: Indicates the index of the event entry.
Log Index: Indicates the index of the log entry.
Log Time: Indicates the time that the Event was logged.

Log Description: Indicates the Event description.

Buttons

Auto-refresh : Check this box to refresh the page automatically every 3 seconds.
Refresh : Click to refresh the page immediately.

Previous : Updates the entries, turn to the previous page.

Next : Updates the entries, turn to the next page.
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12.10 TACACS+ Configuration

Navigate to Switch >Security >TACACS+ > Configuration to display the TACACS+ Server Configuration
page. Here you can configure up to six TACACS+ servers.

TRANSITION ® =| ®*F : = o c
N NETWORKS:
SM8TAT2SA TACACS+ Server Configuration SHoms - Sscurity - TACACS+ - Confizurstion
Switch DMS
Global Configuration
» System <
» Port Management < Timeout 5 seconds
» PoE Management < Deadtime 5 minutes
» VLAN Management <
Key
» Quality of Service E
» Spanning Tree <

Server Configuration

MAC Address Table <

» Multicast < Delete Hostname Port Timeout Key
» DHCP ¢ ‘ Delete
» Security \’

» Management < | |

_— . Apply H Reset
» |IP Source Guard | ’

Global Configuration Parameters:

Timeout: The number of seconds, in the range 1 - 1000, to wait for a reply from a TACACS+ server before
it is considered to be dead.

Deadtime: Deadtime, which can be set to 0 - 1440 minutes, is the period during which the switch will not
send new requests to a server that has failed to respond to a previous request. This will stop the switch
from continually trying to contact a server that it has already determined as dead. Setting the Deadtime to
a value greater than 0 (zero) will enable this feature, but only if more than one server has been configured.

Key: The secret key - up to 63 characters long - shared between the TACACS+ server and the switch.

Server Configuration Parameters:

Delete : To delete a TACACS+ server entry, check this box. The entry will be deleted during the next Save.
Hostname: The IP address or hostname of the TACACS+ server.
Port: The TCP port to use for TACACS+ server for authentication.

Timeout: This optional setting overrides the global timeout value. Leaving it blank will use the global
timeout value.

Key: This optional setting overrides the global key. Leaving it blank will use the global key.
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Add New Entry: Click to add a new TACACS+ server. An empty row is added to the table, and the

TACACS+ server can be configured as needed. Up to 6 servers are supported.

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.

Example:

=
TRANSITION

NETWORKS:-

SM8TAT2SA

Switch DMS

» System

» Port Management

» PoE Management

» VLAN Management

» Quality of Service

» Spanning Tree

» MAC Address Table

» Multicast

» DHCP

» Security
» Management
» IE
»
» A

»

» RA
» TACACS+

> Configuration

» Access Control

Messages:

Authentication Error

TRANSITION ™
I

TACACS+ Server Configuration

Global Configuration

Timeout

Deadtime

Key

Server Configuration

Delete

Hostname

111111

TacSrvr2

TacSrvr3

Tacs3

admin

seconds

minutes

1845

1645

1645

HTTPD cache has no valid entry

Auto-logout o C*

@Home - Security - TACACS+ - Configuration

Timeout Key

60

Hostname must be a valid hostname, unicast IPv4, or unicast IPv6 address

Meaning: You entered an invalid Key or Hostname parameter.

admin

superuser

Recovery: 1. Click the Previous button to clear the error message. 2. Re-enter a valid Key or Hostname
parameter. 3. Continue operation.
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12.11 Access Control List

This page lets you configure Access Control List rules. An Access Control List (ACL) is a sequential list of
permit or deny conditions that apply to IP addresses, MAC addresses, or other more specific criteria. This
switch tests ingress packets against the conditions in an ACL one by one. A packet will be accepted as
soon as it matches a permit rule or dropped as soon as it matches a deny rule. If no rules match, the frame
is accepted. Other actions can also be invoked when a matching packet is found, including rate limiting,
copying matching packets to another port or to the system log, or shutting down a port. This page shows
the Access Control List (ACL), which is made up of the ACEs defined on this switch. Each row describes the
ACE that is defined. The maximum number of ACEs is 256 on each switch. Click on the lowest plus sign to
add a new ACE to the list. Reserved ACEs used for internal protocol and cannot be edited or deleted; the
order sequence cannot be changed the priority is highest.

Navigate to Switch >Access Control List > Access Control List to display the default Access Control List
Configuration page:

TRANSITIDN \ = JTRansTa [ 1 Auto-logout H o C’

N NETWORKS.
SM8TAT2SA Access Control List Configuration @Home - Access Control - Access Contral List
Switch DMS
Auto-refresh | Refresh || Clear H Remove All

» System <
» Port Management ¢ ACE Ingress Port Frame Type Action Metering Mirror Counter
» PoE Management < o

Click the ﬂ icon to add an ACE from the ACE Configuration page:

ACE Configuration / Frame Type: Any

ACE COﬂfIgU ratl@ﬂ #kHome - Access Control ~ Access Control List
Ingress Port All Action Permit v
Port1
Port 2 .
Port3 o Mirror Disabled »
Frame Type Any v Metering Disabled
Counter Disabled
| Apply || Reset || an —l|
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ACE Configuration / Frame Type: Ethernet Type

ACE Configuration @ Home - Access Control - Access Control List
Ingress Port All Action Deny v
Port1
Port2 )
Ports| . Mirror Enabled
Frame Type EthernetType T+ Metering Enabled v
Metering Bandwidth 1000000 Kbps
MAC Parameters
Counter Disabled
SMAC Filter Any v
DMAC Filter Any v VLAN Parameters
C-VLAN Tagged Any v
Ethernet Type Parameters
C-VLAN ID Filter Any B
Ethernet Type Filter -
C-VLAN Tag Priority Any v
S-VLAN Tagged Any v
S-VLAN ID Filter Any B
S-VLAN Tag Priority Any v
| Apply || Reset || Cancel ‘
ACE Configuration / Frame Type: IPv4
ACE Configuration @oms  Access Control - Access Cantral List
Ingress Port All Action Permit v
Port1
Port2 .
Port3 Mirror Disabled v
Frame Type IPva B Metering Disabled
Counter Disabled v

IP Parameters

IP Protocol Filter TCP Parameters

IP Fragment Any v Source Port Filter Any v
ToS Filter Any v Destination Port Filter Any v
SIP Filter Any v TCP FIN Any v
DIP Filter Any v TCP SYN Any v
TCP RST Ay v
TCP PSH tny v
TCP ACK Ay v
TCP URG tny v

‘. Apply H Reset H Cancel |

33717 Rev.J https://www.transition.com Page 223 of 304



https://www.transition.com/

Transition Networks SMXTAT2SA Web User Guide

ACE Configuration Parameters:.

ACE: Indicates the ACE ID.

Ingress Port: Select the ingress port of the ACE. Possible values are:

All: The ACE will match all ingress port.
Port. The ACE will match a specific ingress port.

Frame Type: Indicates the frame type of the ACE. Possible values are:
Any: The ACE will match any frame type.
Ethernet Type: The ACE will match Ethernet Type frames. Note that an Ethernet Type
based ACE will not get matched by IP and ARP frames.
IPv4: The ACE will match all IPv4 frames.

Action: Indicates the forwarding action of the ACE. Possible values are:

Permit: Frames matching the ACE may be forwarded and learned.
Deny: Frames matching the ACE are dropped.
Shutdown: Specify the port shut down operation of the ACE.

Metering: Enable or disable metering mode. The default value is "Disabled".

Metering Bandwidth: Enter an integer value between 16 and 1000000 Kbps.

Pvd

Any
Ethernet Type
1Pv4

Permit

Deny

Shutdown

Mirror: Specify the mirror operation of this port. Frames matching the ACE are mirrored to the destination
mirror port. The allowed values are: Enabled: Frames received on the port are mirrored. Disabled: Frames

received on the port are not mirrored. The default value is "Disabled".

Counter: The counter indicates the number of times the ACE was hit by a frame.

MAC Parameters

SMAC Filter: Specify the source MAC filter for this ACE. (Only displayed when the frame type is Ethernet
Type or ARP) Any: No SMAC filter is specified. (SMAC filter status is "don't-care".) Specific: If you want to
filter a specific source MAC address with this ACE, choose this value. A field for entering an SMAC value

displays.

SMAC Value: When "Specific" is selected for the SMAC filter, you can enter a specific source MAC address.
The legal format is "XX-XX-XX-XX-XX-XX" OF "XX.XX.XX.XX.XX.XX" OF "Xxxxxxxxxxxx" (X is a hexadecimal digit). A

frame that hits this ACE matches this SMAC value.

DMAC Filter: Specify the destination MAC filter for this ACE. Any: No DMAC filter is specified. (DMAC filter
status is "don't-care".) MC: Frame must be multicast. BC: Frame must be broadcast. UC: Frame must be
unicast. Specific: If you want to filter a specific destination MAC address with this ACE, choose this value. A

field for entering a DMAC value displays.

DMAC Value: When "Specific" is selected for the DMAC filter, you can enter a specific destination MAC
address. The legal format is "XX-XX-XX-XX-XX-XX" OF "XX.XX.XX.XX.XX.XX" OF "XXXXXXXXXxxX" (X is a hexadecimal

digit). A frame that hits this ACE matches this DMAC value.
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VLAN Parameters

802.1Q Tagged: Specify whether frames can hit the action according to the 802.1Q tagged. The allowed
values are: Any: Any value is allowed ("don't-care"). Enabled: Tagged frame only. Disabled: Untagged frame
only. The default value is "Any".

VLAN ID Filter: Specify the VLAN ID filter for this ACE. Any: No VLAN ID filter is specified. (VLAN ID filter
status is "don't-care".) Specific: If you want to filter a specific VLAN ID with this ACE, choose this value. A
field for entering a VLAN ID number displays.

VLAN ID: When "Specific" is selected for the VLAN ID filter, you can enter a specific VLAN ID number. The
valid range is 1 to 4094. A frame that hits this ACE matches this VLAN ID value.

Tag Priority: Specify the tag priority for this ACE. A frame that hits this ACE matches this tag priority. The
valid number range is 0 to 7. The value Any means that no tag priority is specified (tag priority is "don't-
care")

IPv4 Parameters

The IP parameters can be configured when Frame Type "IPv4" is selected.

IP Protocol Filter: Specify the IP protocol filter for this ACE. Any: No IP protocol filter is specified ("don't-
care"). ICMP: Select ICMP to filter IPv4 ICMP protocol frames. Extra fields for defining ICMP parameters
will appear. These fields are explained later in this section. UDP: Select UDP to filter IPv4 UDP protocol
frames. Extra fields for defining UDP parameters will appear. These fields are explained later in this section.
TCP: Select TCP to filter IPv4 TCP protocol frames. Extra fields for defining TCP parameters will display.
These fields are explained later in this section. Other: If you want to filter another specific IP protocol filter
with this ACE, choose this value. A field for entering an IP protocol filter displays.

IP Protocol Value: When "Specific" is selected for the IP protocol value, you can enter a specific value. The
valid range is 0 to 255. A frame that hits this ACE matches this IP protocol value.

IP TTL: Specify the Time-to-Live settings for this ACE. Zero: IPv4 frames with a Time-to-Live field greater
than zero must not be able to match this entry. Non-zero: IPv4 frames with a Time-to-Live field greater
than zero must be able to match this entry. Any: Any value is allowed ("don't-care").

IP Fragment: Specify the fragment offset settings for this ACE. This involves the settings for the More
Fragments (MF) bit and the Fragment Offset (FRAG OFFSET) field for an IPv4 frame. No: IPv4 frames where
the MF bit is set or the FRAG OFFSET field is greater than zero must not be able to match this entry. Yes:
IPv4 frames where the MF bit is set or the FRAG OFFSET field is greater than zero must be able to match
this entry. Any: Any value is allowed ("don't-care").

IP Option: Specify the options flag setting for this ACE. No: IPv4 frames where the options flag is set must
not be able to match this entry. Yes: IPv4 frames where the options flag is set must be able to match this
entry. Any: Any value is allowed ("don't-care").

SIP Filter: Specify the source IP filter for this ACE. Any: No source IP filter is specified. (Source IP filter is
"don't-care".) Host: Source IP filter is set to Host. Specify the source IP address in the SIP Address field that
appears. Network: Source IP filter is set to Network. Specify the source IP address and source IP mask in
the SIP Address and SIP Mask fields that appear.

SIP Address: When "Host" or "Network" is selected for the source IP filter, you can enter a specific SIP
address in dotted decimal notation.

SIP Mask: When "Network" is selected for the source IP filter, you can enter a specific SIP mask in dotted
decimal notation.

DIP Filter: Specify the destination IP filter for this ACE. Any: No destination IP filter is specified.
(Destination IP filter is "don't-care".) Host: Destination IP filter is set to Host. Specify the destination IP
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address in the DIP Address field that appears. Network: Destination IP filter is set to Network. Specify the
destination IP address and destination IP mask in the DIP Address and DIP Mask fields that appear.

DIP Address: When "Host" or "Network" is selected for the DIP Filter, you can enter a specific DIP address
in dotted decimal notation.

DIP Mask: When "Network" is selected for the DIP Filter, you can enter a specific DIP mask in dotted
decimal notation.

ICMP Parameters

ICMP Type Filter: Specify the ICMP filter for this ACE. Any: No ICMP filter is specified (ICMP filter status is
"don't-care"). Specific: If you want to filter a specific ICMP filter with this ACE, you can enter a specific
ICMP value. A field for entering an ICMP value appears.

ICMP Type Value: When "Specific" is selected for the ICMP filter, you can enter a specific ICMP value. The
allowed range is 0 to 255. A frame that hits this ACE matches this ICMP value.

ICMP Code Filter: Specify the ICMP code filter for this ACE. Any: No ICMP code filter is specified (ICMP
code filter status is "don't-care"). Specific: If you want to filter a specific ICMP code filter with this ACE, you
can enter a specific ICMP code value. A field for entering an ICMP code value appears.

ICMP Code Value: When "Specific" is selected for the ICMP code filter, you can enter a specific ICMP code
value. The allowed range is 0 to 255. A frame that hits this ACE matches this ICMP code value.

TCP Parameters

Source Port Filter: Specify the TCP/UDP source filter for this ACE. Any: No TCP/UDP source filter is
specified (TCP/UDP source filter status is "don't-care"). Specific: If you want to filter a specific TCP/UDP
source filter with this ACE, you can enter a specific TCP/UDP source value. A field for entering a TCP/UDP
source value appears. Range: If you want to filter a specific TCP/UDP source range filter with this ACE, you
can enter a specific TCP/UDP source range value. A field for entering a TCP/UDP source value appears.

Source Port No.: When "Specific” is selected for the TCP/UDP source filter, you can enter a specific
TCP/UDP source value. The allowed range is 0 to 65535. A frame that hits this ACE matches this TCP/UDP
source value.

Source Port Range: When "Range" is selected for the TCP/UDP source filter, you can enter a specific
TCP/UDP source range value. The allowed range is 0 to 65535. A frame that hits this ACE matches this
TCP/UDP source value.

Destination Port Filter: Specify the TCP/UDP destination filter for this ACE. Any: No TCP/UDP destination
filter is specified (TCP/UDP destination filter status is "don't-care"). Specific: If you want to filter a specific
TCP/UDP destination filter with this ACE, you can enter a specific TCP/UDP destination value. A field for
entering a TCP/UDP destination value appears. Range: If you want to filter a specific range TCP/UDP
destination filter with this ACE, you can enter a specific TCP/UDP destination range value. A field for
entering a TCP/UDP destination value displays.

Dest. Port No.: When "Specific" is selected for the TCP/UDP destination filter, you can enter a specific
TCP/UDP destination value. The allowed range is 0 to 65535. A frame that hits this ACE matches this
TCP/UDP destination value.

Destination Port Range: When "Range" is selected for the TCP/UDP destination filter, you can enter a
specific TCP/UDP destination range value. The allowed range is 0 to 65535. A frame that hits this ACE
matches this TCP/UDP destination value.

TCP FIN: One of several TCP flag names used only when filtering TCP (urg, ack, psh, rst, syn, and fin).
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Specify the TCP "No more data from sender” (FIN) value for this ACE. 0: TCP frames where the FIN field is
set must not be able to match this entry. I: TCP frames where the FIN field is set must be able to match
this entry. Any: Any value is allowed ("don't-care").

TCP SYN: One of several TCP flag names used only when filtering TCP (urg, ack, psh, rst, syn, and fin).
Specify the TCP "Synchronize sequence numbers" (SYN) value for this ACE. 0: TCP frames where the SYN
field is set must not be able to match this entry. 1: TCP frames where the SYN field is set must be able to
match this entry. Any: Any value is allowed ("don't-care").

TCP RST: One of several TCP flag names used only when filtering TCP (urg, ack, psh, rst, syn, and fin).
Specify the TCP "Reset the connection" (RST) value for this ACE. 0: TCP frames where the RST field is set
must not be able to match this entry. I: TCP frames where the RST field is set must be able to match this
entry. Any: Any value is allowed ("don't-care").

TCP PSH: One of several TCP flag names used only when filtering TCP (urg, ack, psh, rst, syn, and fin).
Specify the TCP "Push” function (PSH) value for this ACE. 0: TCP frames where the PSH field is set must not
be able to match this entry. 1: TCP frames where the PSH field is set must be able to match this entry. Any:
Any value is allowed ("don't-care").

TCP ACK: One of several TCP flag names used only when filtering TCP (urg, ack, psh, rst, syn, and fin).
Specify the TCP "Acknowledgment field significant” (ACK) value for this ACE. 0: TCP frames where the ACK
field is set must not be able to match this entry. 1: TCP frames where the ACK field is set must be able to
match this entry. Any: Any value is allowed ("don't-care").

TCP URG: One of several TCP flag names used only when filtering TCP (urg, ack, psh, rst, syn, and fin).
Specify the TCP "Urgent Pointer field significant” (URG) value for this ACE. 0: TCP frames where the URG
field is set must not be able to match this entry. 1: TCP frames where the URG field is set must be able to
match this entry. Any: Any value is allowed ("don't-care").

UDP Parameters

Source Port Filter: Specify the TCP/UDP source filter for this ACE. Any: No TCP/UDP source filter is
specified (TCP/UDP source filter status is "don't-care"). Specific: If you want to filter a specific TCP/UDP
source filter with this ACE, you can enter a specific TCP/UDP source value. A field for entering a TCP/UDP
source value appears. Range: If you want to filter a specific TCP/UDP source range filter with this ACE, you
can enter a specific TCP/UDP source range value. A field for entering a TCP/UDP source value appears.

Source Port No.: When "Specific” is selected for the TCP/UDP source filter, you can enter a specific
TCP/UDP source value. The allowed range is 0 to 65535. A frame that hits this ACE matches this TCP/UDP
source value.

Source Port Range: When "Range" is selected for the TCP/UDP source filter, you can enter a specific
TCP/UDP source range value. The allowed range is 0 to 65535. A frame that hits this ACE matches this
TCP/UDP source value.

Dest. Port Filter: When "Specific" is selected for the TCP/UDP destination filter, you can enter a specific
TCP/UDP destination value. The allowed range is 0 to 65535. A frame that hits this ACE matches this
TCP/UDP destination value.

Destination Port Range: When "Range" is selected for the TCP/UDP destination filter, you can enter a
specific TCP/UDP destination range value. The allowed range is 0 to 65535. A frame that hits this ACE
matches this TCP/UDP destination value.
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Ethernet Type Parameters
The Ethernet Type parameters can be configured when Frame Type "Ethernet Type" is selected.

EtherType Filter: Specify the Ethernet type filter for this ACE.
Any: No EtherType filter is specified (EtherType filter status is "don't-care").
Specific: If you want to filter a specific EtherType filter with this ACE, you can enter a specific
EtherType value. A field for entering a EtherType value appears.

Ethernet Type Value: When "Specific" is selected for the EtherType filter, you can enter a specific
EtherType value. The allowed range is 0x600 to OxFFFF but excluding 0x800(IPv4), 0x806(ARP) and
0x86DD(IPv6). A frame that hits this ACE matches this EtherType value.

Access Control List Configuration Example

‘I\ TRANSITION * o . - J
TRANSITION © =| == - I
N NETWORKS

SM8TAT2SA Access Control List Configuration @ Home - Access Cantrol + Access Cantrol Lt
Switch DMS
Auto-refresh | Refresh || Clear || Remove All
» System <
» Port Management ¢ ACE Ingress Port  Frame Type Action Metering Mirror Counter
» PoE Management < 1 Any Ethernet Type- Oxffff Permit = Disabled Disabled Disabled @&
» VLAN Management < 2 Any Any Permit = Disabled Disabled Disabled @&
» Quality of Service < 3 Any IPv4/TCP DIP:0.0.0.0/32  Permit 1000000 Kbps  Disabled 0 oK
» Spanning Tree < o
» MAC Address Tahle <

Control Icons

o Add ACE to end of list.

E" Edit ACE on this line.
e Delete ACE on this line.

Buttons

Auto-refresh : Check this box to automatically refresh the page every 3 seconds.
Refresh : Click to manually update webpage information immediately.
Clear : Click to clear the ACL configuration information.

Remove All : Click to remove all ACL entries from the table. At the confirmation prompt click OK to
proceed.
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12.12 Access Control Status

This page displays the Access Control status.

TRANSITION * =| =% : ==s==_ _ puto-logout (2 IS
N NETWORKS. ‘ i i i A
SM8TAT2SA Access Control Status @Home - Access Contral -~ Access Control Status
Switch DMS
Auto-refresh | Refresh |
» System <
» Port Management < ST
» PoE Management E Port State Re-open
» VLAN Management <
1 None ‘ |
» Quality of Service <
» Spanning Tree < 2 None ‘ |
M o < S
» MAC Address Table 3 None ‘ |
» Multicast <
» DHCP < 4 None ‘ |
» Security < 5 None ‘ |
» Access Control e E—
> Access Control List 6 None ‘ |
> Access Control Status -
7 None ‘ |
» SNMP <
» Event Notification < & None ‘ |
. . < -
» Diagnostics 9 None ‘ |
» Maintenance <
10 None ‘ |

Port: The port number of the access control status.

State: Shows the current state of the port. It can take one of two values:

None: The port is normally used.
Shutdown: The port is shut down by ACL rule.

Re-open button: Click to recover the shutdown port that triggered by ACL rule.

Buttons
Auto-refresh: Check this box to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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12.13 Switch > Event Notification
This menu path displays the SNMP Trap, Syslog, and Event Notification menu options.
12.13.1 Switch > Event Notification > SNMP Trap

Navigate to the Switch > Event Notification > SNMP Trap menu path to display the SNMP Trap Hosts
Configuration table. Here you can add and configure up to six SNMP Trap hosts.

TRANSITITN ™ .
= : [T T 71 Auto-logout
TRANSITION © = : — oG
NETWORKS «
SM8TAT2SA SNMP Trap Hosts Configuration dHoms - Event Notification ~ SNMP Trap
Switch DMS

Delete No Name Mode Version Destination Address Destination Port  Severity Level
» System <

O 1
» Port Management < -
» PoE Management < O 2
» VLAN Management E O 3
» Quality of Service < 0 4
» Spanning Tree <

O s
» MAC Address Table ¥
» Multicast g O ¢
» DHCP <

| Apply H Reset |
» Security <

Click a line to display its configurable parameters:

TRANSITION .
= e . [T 771 Auto-logout
TRANSITION \ = : = emnv] H @ G
N NETWORKS «
SMBTAT2SA Add SNMP Trap Host gk Home - Event Motification - SNMF Trap
Switch DMS
Trap Host Settings
P System 3
» Port Management < No 1
» PoE Management < Trap Mode Disabled v
» ! <
VLAN Management Trap Version vac
» Quality of Service E
Trap Community
» Spanning Tree <

» MAC Address Table < Trap Destination Address

» Multicast < Trap Destination Port 162
» DHCP &
Severity Level Emerg Vv
» Security E
» Access Control
| Apply || Reset || Cancel ‘
» SNMP
» Event Notification h
» SNMP Trap -
Parameters:

No: Displays the instance number for this line in the table.

Trap Name: Indicates the community access string when sending SNMP trap packet. This comes from the
Trap Community parameter (see below).
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Trap Mode: Indicates the SNMP mode operation. Possible modes are:
Disabled: Disable SNMP mode operation (default). R TE R
Disabled
UDP: Enable UDP SNMP mode operation. UDE
TCP: Enable TCP SNMP mode operation. [_TEP

Trap Version: The SNMP trap version. SNMP trap supports version 2c.

Trap Community: Enter the SNMP community name. This is the community access string when sending
SNMP trap packet. The allowed string length is 1-32 characters, and the allowed content is ASCII
characters 33 - 126. This becomes the "Name” parameter.

Trap Destination Address: Indicates the SNMP trap destination address.

Trap Destination Port: Indicates the SNMP trap destination port. SNMP Agent will send SNMP message
via this port, the port range is 1~65535.

Severity Level: At the dropdown select what level of message to send to trap server (Emerg, Alert, Crit,
Error, Warning, Notice, Info, or Debug.- Possible levels are:

Emerg: Emergency; System is unusable.

Alert: Action must be taken immediately. m
Crit: Critical conditions. I ———

Error. Error conditions.
Warning: Warning conditions. E;-i:
Notice:  Normal but significant conditions. Error
Info: Information messages. 'r‘f'ﬂr_"l'g
Debug: Debug-level messages. Ei; =
Debug

Buttons
Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.

Cancel: Click to cancel the page edits.
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Example

The screen below shows three SNMP Trap Hosts configured:

-

-

-

-

-

-

-

-

-

=
JRANSITION.

SM8TAT2SA
Switch
System
Port Management
PoE Management
VLAN Management
Quality of Service
Spanning Tree
MAC Address Table
Multicast

DHCP

T S P
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DMS

—

TRANSITION *

[T Y T1
LLL L |}

SNMP Trap Hosts Configuration

Delete

O 0Oo0ooo

| Apply

No
1
2

3

‘ Reset |

Name Mode

admin UDP v2c
Bob UDP v2C
admini TCP v2c

Version

Destination Address

192.168.1.30

192.168.1.40

192.168.1.10

https://www.transition.com
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Auto-logout H 0 C’

@eHome - Event Notificstion - SNMP Trap

Destination Port Severity Level

162 Emerg
162 Alert
162 Warning
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12.13.2 Switch > Event Notification > eMail

The Switch > Event Notification > eMail menu path displays the SMTP Configuration page. Configure
SMTP (Simple Mail Transfer Protocol) on this page. Simple Mail Transfer Protocol is the message-exchange
standard for the Internet.

The switch is to be configured as a client of SMTP while the server is a remote device that will receive
messages from the switch on which the alarm events occurred.

Web Interface

To configure SMTP via the web UL

1. Click Event Notification, Syslog, and eMail.
2. Specify the SMTP Configuration parameters.

3. Click Apply.

-ﬁ TRANSITION * aito-loso = L
TRANSITION ® = == - w7 V) M Q@ G
N\ NETWORKS

SMB8TAT2SA SMTP Configuration @Home - EventNotificstion - eMail
Switch DMS
Mail Server
b System <
» Port Management < User Name
» PoE Management password
» VLAN Management
Sender

-

-

-

Quality of Service
Spanning Tree

MAC Address Table

Return Path

Email Address 1

» Multicast
Email Address 2
» DHCP
b Security Email Address 3
Arress ¢
> Access Control Email Address 4
P SNMP <

Email Address 5

-

Event Notification

> SNMF Trap Email Address &

> eMail

Figure 12-13.1: SMTP Configuration page
Parameter descriptions:

Mail Server : The IP address or hostname of the mail server. IP address is expressed in dotted decimal
notation. This will be the device that sends out the email for you

User Name : Specify the username on the mail server.
Password : Specify the password of the user on the mail server.
Sender : Specify the sender name of the alarm mail.

Return Path : Specify the sender email address of the alarm mail. This address will be the "from" address
on the email message.

Email Address # : Specify the email address of the receiver.
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Buttons

Apply: Click to save changes.

SMXTAT2SA Web User Guide

Reset: Click to undo any changes made locally and revert to previously saved values.

Example:

4

-

-

-

2

TRANSITION ® = ===

\-—’ NETWORKS «

SME8TAT2SA
DMS

Switch

System
Port Management
PoE Management
VLAN Management
Quality of Service
Spanning Tree
MAC Address Table
Multicast
DHCP
Security
Access Control
SNMP
Event Notification
> SNMP Trap
> eMail
» Syslog

> Event Configuration
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[T 7 T 7 Auto-logout [OFF | | !
Ty - - - H o C‘
SMTP Conﬂgu ration #bHome - Event Netification - eMail

Mail Server myMailServer

User Name Bob

Password

Sender smetatZza

Return Path

Email Address 1
Email Address 2
Email Address 3
Email Address 4
Email Address 5

Email Address &

| Apply || Reset |

smetatl=a@i152.168.50.3
jeffsherman@ecomeast.nat

Jeffs@transition.com

mickeyabc@acl.com
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12.13.3 Switch > Event Notification > Syslog

The Switch > Event Notification > Syslog menu path provides the Syslog Configuration and View Log
menu options per IETF RFC 3164.

Syslog is a standard for logging program messages. It allows separation of the software that generates
messages from the system that stores them and the software that reports and analyzes them. It can be
used as a generalized informational, analysis and debugging messages. Syslog is supported by a wide
variety of devices and receivers across multiple platforms.

12.13.3.1 Syslog Configuration

Here you can enable System Logging and provide an IP Address for up to six Syslog servers.

Web Interface

To configure Syslog Configuration in the web interface:

4. Click Event Notification, Syslog, and Syslog Configuration.

5. At Mode, select "on” to enable Syslog globally.

6. Specify the syslog parameters including the IP Address of Syslog server and Port number.
7. Click Apply.

TRANSITION * " S -
TRANSITION \ =| == - puto-ogo 0 c
N NETWORKS.
SMSTATZSA Systerﬂ I_Og Conﬁgl.lration @& Home -~ Event Notification ~ Syslog = Syslog Configuration
Switch DMS :
Mode @ )
b System < !
» Port Management < Server 1 172.16.44.72
» PoE Management <
Server2
» VLAN Management <
» Quality of Service < Servers
» Spanning Tree & Server 4
» MAC Address Table <
Server 5
» Multicast E
» DHCP ¢ Server 6
» Security <
» Access Control < | APPY || eeet | -

Figure 12-13.3.1: System Log Configuration page
Parameter descriptions:

Mode: Select the server mode of operation. When the mode is “on” (enabled) syslog messages will be
sent out to the configured syslog server. The syslog protocol is based on UDP communication and
received on UDP port 514 and the syslog server will not send acknowledgments back to the sender since
UDP is a connectionless protocol and it does not provide acknowledgments. The syslog packet is always
sent out even if the syslog server does not exist. Possible modes are:

On: Enable server mode operation.

Off: Disable server mode operation.
Server 1 to 6: Indicates the IPv4 hosts address of syslog server. If the switch provides DNS, it also can be a
host name (FQDN).
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Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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12.13.3.2 View Log

This page displays the switch system log (Syslog) information.

Web Interface

To display the log configuration in the web interface:

1
2.

-

-

-

-

-

-

-

-

-

-

-

-

-

TRANSITION

N NETWORKS

SMETAT2SA
Switch DMS

System

Port Management
PoE Managemeant
VLAN Management
Quality of Service
Spanning Tree
MAC Address Table
Multicast

DHCP

Security

Access Control
SNMP

Event Notification

> SNMP Trap

Observe the log information.

Click Event Notification, Syslog, and View Log.

RARSITION

System Log Information

Show| 1 w entries

D Y Level

1 Warning
2 Info

3 Info

4 Warning
5 Info

] Warning
7 Info

& Info

w
5
=)

10 Info

Showing 1 to 10 of 10 entries

Time

2017-01-01 00:00:23

2017-01-0100:00:24

2017-01-01 00:00:26

2017-01-0100:00:28

2017-01-01 00:00:28

2017-01-01 00:00:28

2017-01-01 00:00:28

2017-01-0100:34:03

2020-06-17 17:45:48

2020-06-18 11:06:31

SMXTAT2SA Web User Guide

Auto-logout 9 C.

@Home - EventNotificstien - Syslog - Viaw Log

Search:

Message

Switch just made a warm boot.
Password of user 'admin’ was changad
Management IP address was changed
Linkup on port@

SFP module inserted on port &

Link up on port 10

SFP module inserted on port 10

Login passed for user 'admin' through HTTP from
1%2.168.93.5 and authenticated by local method

User 'admin’ saved running config as startup config

Login passed for user 'admin' through HTTP from
1%2.168.113.62 and authenticated by local method

Figure 12-13.3.2: System Log Information page

Parameter descriptions:

ID: The ID of the system log entry.

Level: the level of the system log entry. The following level types are supported:

Debug: debug level message.

Info: informational message.

Notice: normal, but significant, condition.

Warning: warning condition.

Error: error condition.

Crit: critical conditions.

Alert: action must be taken immediately.

Emerg: system is unusable.

Time: Displays the log record by device time; the time of the system log entry.

Message: Displays the log detail message; the message of the system log entry (e.g., LINK-UPDOWN).
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Search: Lets you search for the information that you want to view.

Show entries: Lets you choose how many items you want to view per page (i.e., 10, 25, 60, ALL).

Buttons

Refresh: Updates the system log entries, starting from the current entry ID.

Clear Logs: Clears all the system log entries and display “No data available in table".
Next: Updates the system log entries, turn to the next page.

Previous: Updates the system log entries, turn to the previous page.

System Log Message Examples

Warning LINK-UPDOWN: Interface GigabitEthernet 1/1, changed state to up.

Warning WARM-START: Switch just made a warm boot.

Info LOGIN: Login passed for user 'admin’

Info LOGOUT: User " logout

Warning SFP: Interface GigabitEthernet 1/17 rx power 0.00 exceeds Alarm-Low Limitation
Warning POE-PD-OFF: Port 3 PoE PD off

Warning LINK-UPDOWN: Interface GigabitEthernet 1/7, changed state to up.

Info SFP: Interface GigabitEthernet 1/17 rx power 0.00 exceeds Alarm-Low Limitation
Info LACP: LACP was enabled on port 2 with key 1

Alert MGMT-IP-CHANGE: Management IPv4 address of interface VLAN 1 was changed
Info SFP: SFP module inserted on port 9
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12.13.3 Event Configuration

The Event Notification > Event Configuration page displays the Event Configuration table. Here you can
view and configure severity levels, Syslog status, and Trap status for each Group Name.

TRANSITIDN = JRANSITIEN - Auto-logout o C’
N NETWORKS.
SMB8TAT2SA Event Configuration @ toms - Event Nofificstion - Event Configuration
Switch DMS
Group Name Severity Level Syslog Trap SMTP
» System <
. Inf v [w] N v
» Port Management < 802.1X ° vl U (v
» PoE Management < ACCESS-MGMT Infa v [wl O vl
» VLAN Management & o . .
ACL Infa v [w] J J
» Quality of Service &
» Spanning Tree ¢ AUTH-FAILED Waming v ] O 2]
» MAC Address Table < COLD-START Waming v = ) )
» Multicast < _ _ _
LACP Info v [ O J
» DHCP <
» Security ¢ LINK-UPDOWN Warning v [w) O O
< _ _ _
» Access Control LOGIN Info o ~ O O
» SNMP g - - —
LOGOUT Info v [w] ] [
» Event Notification h
» P TED LOOP-PROTECTION Info v ] 0 0
MAC-TABLE Info v [+ O O
7 LIS MAINTFNANCF Info [ M ([

Parameters:
Group Name: The name identifying the severity group.

Severity Level: Every group has a severity level. These levels are supported:

Emergency: System is unusable.

Alert: Action must be taken immediately.
Critical: Critical conditions.

Error: Error conditions.

Warning: Warning conditions.

Notice: Normal but significant conditions.

Information:  Information messages.

Debug: Debug-level messages.
Syslog: Check the checkbox to enable Syslog for this Group Name.
Trap: Check the checkbox to enable Syslog for this Group Name.
SMTP : Check the checkbox to enable SMTP email events for this Group Name.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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Chapter 13 - Diagnostics

» Diagnostics

This module provides basic system diagnostics to help you determine system health. > Ping
The diagnostics include Ping, Traceroute, Cable Diagnostics, and Mirroring. » Traceroute
. » Cable Diagnostic
13-1 Ping L=
» Mirroring

This page lets you issue ICMP PING packets to troubleshoot IPv4 or IPv6 connectivity issues.

Web Interface

To configure a PING in the web interface:
1. Click Diagnostics and Ping.
2. Specify IP Address, IP Version, Ping Length, and Ping Count.

3. Click Start.
TRANSITION® =[ =% : = e o
N NETWORKS: | .
SM8TAT2SA Ping @&Home - Diagnostics - Ping
Switch DMS
IP Address 0.0.0.0
b System ¢
» Port Management < IP Version Pv4 v
Y < .
» PoE Management Ping Length -
» VLAN Management &
Ping Count 5
» Quality of Service E & 7
» Spanning Tree E )
‘ Start ‘
» MAC Address Table < E—
» Multicast <
» DHCP E
b Chcuritug <

Figure 13-1: Ping Diagnostic page

Parameter descriptions:

IP Address: Enter the IP Address of the device that you want to ping.

B

VG

IP Version: Select the required IP Version (IPv4, IPv6, or Domain Name). omain Mame

[w]

Egress Interface: Specify an interface VLAN for sending ICMPv6 Echo packets.

Ping Length: The payload size of the ICMP packet. Values range from 1 - 1452 bytes.
Ping Count: The count of the ICMP packet. Values range from 1 time to 60 times.
Start: Click the “Start” button to start to ping the target IP address.

After you press Start, five ICMP packets are transmitted, and the sequence number and roundtrip time are
displayed upon reception of a reply. The page refreshes automatically until responses to all packets are
received, or until a timeout occurs.
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Successful Ping:

PING 192.
64 bytes
64 bytes
64 bytes
64 bytes
64 bytes

--- 192.168.1.

168.
from
from
from
from
from

1.77

192.
192.
192.
192.
192.

77 ping

(192.168.1.77): 56 data bytes
168.1.77: seq=0 ttl=64 time=0.
168.1.77: seq=1 ttl=64 time=0.
168.1.77: seq=2 ttl=64 time=0.
168.1.77: seq=3 ttl=64 time=0.
168.1.77: seq=4 ttl=64 time=0.

000
000
000
000
000

ms
ms
ms
ms
ms

statistics ---

5 packets transmitted, 5 packets received, 0% packet loss

round-trip min/avg/max =

Failed Ping:
PING 192.168.1.32 (192.168.1.32): 56 data bytes

Request t
Request t
Request t
Request t
Request t

--- 192.

imed
imed
imed
imed
imed

168.1.

out.
out.
out.
out.
out.

0.000/0.000/0.000 ms

32 ping statistics ---

5 packets transmitted, © packets received, 100% packet loss

Messages:
Please enter a valid IP v4 address.
Please enter a valid IP v6 address.
Please enter a valid domain name address.

Example:

TRANSITION ® =

v NETWORKS

SM8TAT2SA

Switch

» System

DMS

-

-

-

-

-

-

-

-

-

-

»

Port Management
PoE Management
VLAN Management
Quality of Service
Spanning Tree
MAC Address Table
Multicast
DHCP
Security
Access Control
SNMP
Event Notification
Diagnostics

> Ping

> Traceroute

> Cable Diagnostics
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3n_ﬂnr:‘r?‘ &
Ping
IP Address 10.0.4.3
< IP Version Pvd v
Ping Length 56
Ping Count 5

| Start |

PING 10.0.4.3 (10.0.4.3): 56 data bytes

« 64 bytes from 10.0.4.3: seq=0 {tl=64 time<1ms
< 64 bytes from 10.0.4.3: seq=1 ttl=64 time<ims

64 bytes from 10.0.4.3: seq=2 ttl=64 time<1ms
64 bytes from 10.0.4.3: seq=3 ttl=64 time<ims

¢ 64 bytes from 10.0.4.3: seq=4 ttl=64 time<ims

- 10.0.4.3 ping statistics -

Auto-logout H 9 C‘
@Home - Diagnostics - Ping

5 packets transmitted, 5 packets received, 0% packet loss

round-trip min/avg/max = 0.0/0.0/0.0 ms
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13-2 Traceroute
This page allows you to issue ICMP or UDP packets to diagnose network connectivity issues.
Web Interface

To configure a traceroute in the web UL

1. Click Diagnostics and Traceroute.

2. Specify IP Address, IP Version, IP Protocol, Wait Time, Maximum TTL, and Probe Count.
3. Click Start.

TRANSITION * =| == : s | oS M Q

N\ NETWORKS
SMSTAT2SA Tl‘aCEI‘OUtE @& Home Diagnostics - Traceroute
Switch DMS
IP Address 10.0.4.2

P System <
» Port Management < IP Version Pv4 v

Y <
» PoE Management IP Protocol I
» VLAN Management §

. . Wait Time 5
» Quality of Service <
» Spanning Tree < Maximum TTL 30
» MAC Address Table <

Probe Count 3
» Multicast <
p ] .

S e | Start |
P Security <
» Access Control <
> SNMP ¢ traceroute to 10.0.4.3 (10.0.4.3), 30 hops max, 38 byte packets
» Event Notification < 110.0.4.3 0.000 ms 0.000 ms 0.000 ms

-

Diagnostics
> Ping
> Traceroute

Figure 13-2: Traceroute page

Parameter descriptions:
IP Address: The destination IP Address.
IP Version: Select the IP Version (IPv4, IPv6, or Domain Name).
IP Protocol: The protocol (ICMP or UDP) packets to send.

Egress Interface: Specify an egress interface for sending traceroute packets. Only used in IPv6.

Wait Time: Set the time (in seconds) to wait for a response to a probe (default 5.0 sec). Values range from
1 to 60. The payload size of the ICMP packet. Values range from 2 bytes to 1452 bytes.

Maximum TTL: Specify the maximum number of hops (max time-to-live value) traceroute will probe.
Values range from 1 to 255. The default is 30.

Probe Count: Sets the number of probe packets per hop. Valid values are 1 - 10. The default is 3.
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Button

Start: Start traceroute to the IP address that you selected.

Message: traceroute: can't connect to remote host: Network is unreachable
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13-3 Cable Diagnostics

This section is used for running the Cable Diagnostics for copper ports. Press Start to run the diagnostics.
This will take approximately 5 seconds. If all ports are selected, this can take approximately 15 seconds.
When completed, the page refreshes automatically, and you can view the cable diagnostics results in the
cable status table. Note that this is only accurate for cables of length 7 -140 meters. The 10 and 100 Mbps
ports will be linked down while running; running on a 10 or 100 Mbps management port will cause the
switch to stop responding until it is complete.

The cable length reported could have a plus or minus 3 meter inaccuracy if the diagnostic port to be
checked is link down, and it could have a plus or minus 15 meter inaccuracy if the diagnostic port to be
checked is link up. Note that the port link up on 10M speed is not supported.

Web Interface

To run a Cable Diagnostic in the web UL
1. Click Diagnostics and Cable Diagnostics.
2. Se the Port that you want to check.

3. Click Start.
e — ]
TRANS""ON = | s ] Auto-logout [OFF  w 0 C’
N NETWORKS.
SM8TAT2SA Cable Diagnostics $EHome - Disgrostics -~ Ceble Disgnostics

Switch DMS

» System <

Cable Diagnostics Status

» Port Management <
» PoE Management N Port Link Status Test Result Length
P OVIANM J={ < L
VLAN Management 1 16 oK 0.00 (m)
» Quality of Service < o
2 Link Down Abnormal 0.00 (m)
» Spanning Tree <
» MAC Address Table <
» Multicast < 4 Link Down Abnormal 0.00 [m)
» DHCP < |2
b Security < 6
¥ Access Control < 7

SNMP <

» Event Notification <
Figure 13-3: Cable Diagnostics page
Parameter descriptions:

Port : At the dropdown, select he port number on which you want to run Cable Diagnostics.

Cable Diagnostics Status

Port: The Port number you are requesting Cable Diagnostics.

Link Status: Provides the current link speed of the port (e.g., 1G or Link Down).
Test Result: The status of the cable pair being diagnosed (e.g., OK or Abnormal)
Length: The length (in meters) of the cable pair.

Button
Start : Start cable diagnostics on the port that you selected. The message displays
momentarily.
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Message: The cable length reported could have a plus or minus 3 meter inaccuracy if the diagnostic port to

be checked is link down, and it could have a plus or minus 15 meter inaccuracy if the diagnostic port to be
checked is link up.

Meaning: informational message only, detailing the accuracy of the diagnostic in certain conditions.
Recovery: None; click the OK button and continue operation.
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13-4 Mirroring

You can mirror traffic from any source port to a target port for real-time analysis. You can then attach a
logic analyzer or RMON probe to the target port and study the traffic crossing the source portin a
completely unobtrusive manner.

Mirror Configuration is used to monitor the traffic of the network. For example, assume that Port A and
Port B are Monitoring Port and Monitored Port respectively; the traffic received by Port B will be copied to
Port A for monitoring.

Web Interface

To configure Mirror parameters in the web UL

1. Click Diagnostics and Mirroring.
2. At the Mode selection select on.
3. At the dropdown select the Monitor Destination Port.
4. Select Disabled, Enabled, TX Only, or RX only as the port mirror Mode for each port.
5. Click the Apply button to save the settings.
6. To cancel the setting click the Reset button to revert to previously saved values.
TRANSITION ® =| === - e
N\ NETWORKS
SM8TAT2SA Mirror Configuration @Home - Disgnostics - Mirroring
Switch DMS
Mode ﬁ)
» System
» Port Management < Monitor Destination Port Portl W
» PoE Management <
» VLAN Management < Monitor Source Port Configuration
Slity o F Saryi <
» Quality of Service Port Mode
» Spanning Tree <
1 Dizabled W
» MAC Address Table <
» Multicast 4 2 Rxonly b
» DHCP <, -
3 w only hd
» Security <
4 Enabled W
» Access Control <
S p
» Event Notification 5 Dicbled v
» Diagnostics h
> Ping i Dizabled W
> Tracerouts
& Dizabled W
> Cable Diagnostics
» Mirroring ] Disabled
» Maintenance < 10 Disabled
| Apply || Reset |

Figure 13-4: Mirror Configuration page
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Mirror Configuration:

Mode: Indicates the Mirror mode operation. Possible modes are:

on: Enable Mirror mode operation.
off: Disable Mirror mode operation.

Monitor Destination Port : Port to output the mirrored traffic. Also known as the mirror port. Frames
from ports that have either source (rx) or destination (tx) mirroring enabled are mirrored on this port.

Mirror Source Port Configuration:

Port: The logical port for the settings contained in the same row.
Mode: Select mirror mode:

Rx only: Frames received on this port are mirrored on the mirror port. Frames transmitted are not
mirrored.

Tx only: Frames transmitted on this port are mirrored on the mirror port. Frames received are not
mirrored.

Disabled: neither frames transmitted nor frames received are mirrored.

Enabled: Frames received and frames transmitted are mirrored on the mirror port.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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Chapter 14 - Maintenance > Maintenance

» Configuration
This chapter describes the switch Maintenance configuration tasks to enhance the > Savestartup-config
performance of local network including Save, Backup, Restore, Activate, Delete, Restart > Backup
Device, Factory Defaults, and Firmware upgrade and Firmware Selection. > Restore

> Activate
14-1 Configuration > Delete
The switch stores its configuration in a number of text files in CLI format. ? RS

The files are either virtual (RAM-based) or stored in flash on the switch.

» Firmware

There are three system files:

» Firmware Selection

¢ running-config: A virtual file that represents the currently active configuration on
the switch. This file is volatile. The config settings must be different than the default settings.

e startup-config: The startup configuration for the switch, read at boot time.

o default-config: A read-only file with vendor-specific configuration. This file is read when the system
is restored to default settings.

It is also possible to store up to two other files and apply them to running-config, thereby switching

configuration.

14-1.1 Save running-config

This will copy the running-config to startup-config, thereby ensuring that the currently active
configuration will be used at the next reboot.

Web Interface
To save running configuration in the web interface:
1. Click Maintenance, Configuration, Save startup-config.

2. Click Save Configuration.

"ﬂ TRARSITION * ol FE
JRANSITION ® =| == - woos G Y] H Q@ G
NETWORKS
SMBTAT2SA Save Running Configuration to startup-config @Homs - Maintenance - Configuration - Save startup-conig
Switch DMS
» System < Flease note:
» Port Management < The generation of the configuration file may be time consuming, depending on the amount of non-default
configuration.
» PoE Management <
» WLAN Management <
| Save Configurati |
» Quality of Service <
Figure 14-1.1: Save Running Config to startup-config
Button

Save Configuration: Click to save configuration; the running configuration will be written to flash
memory for system boot up to load this startup configuration file. When done, the message “startup-
config saved successfully.” displays. Note: The generation of the configuration file may be time consuming,
depending on the amount of non-default configuration.
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Sample running-config file in WordPad:

SMXTAT2SA Web User Guide

-
E,‘, | & = | running-config - WordPad

i Home View
= Cut _ =
D Courier New |11 < A A

Copy

Paste Bfg*xzxzpvév |_

o

Clipboard Font Paragraph Insert

-1---|---g---|‘--1‘--|‘--2---|---3---|---4---|

vlan 1

spanning-tree

trap 1 v2c 192.168.33.25 6 public
event group ACCESS-MGMT trap enable
event group ACL trap enable

event group ARP-INSPECTICN trap enable
event group AUTH-FAILED trap enable
event group COLD-START trap enable
event group DHCF trap enable

event group DHCP-SNCCPING trap enable
event group DOT1X trap enable

event group IP-SCOURCE-GUARD trap enable
event group LACP trap enable

event group LINEK-UPDOWN trap enable
event group LOGIN trap enable

event group LOGOUT trap enable

event group LOCP-PRCTECTICN trap enable
event group MAC-TAELE trap enable
event group MAINTENANCE trap enable
event group MGMT-IP-CHENGE trap enable
event group PORT trap enable

event group PORT-SECURITY trap enable
event group RMON trap enable

event group SFP trap enable

event group SPANNING-TREE trap enable
event group SYSTEM trap enable

event group USER trap enable

event group WARM-START trap enable

1

interface GigabitEthernet 1/1

no spanning-tree edge

1

interface GigabitEthernet 1/2

no spanning-tree edge
1

interfarae GimahitFrhernat 1

T @

Picture FPaint Dateand Insert
= drawing  time object

ERRRREREF CRRRRRRE X

|1.Lserna_me admin privilege 15 password encrypted YWRtaW4=
|

&3 Find
E’,’a'0 Replace
Select all
Editing

»

m

100% (
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14-1.2 Backup Configuration

This webpage lets you export the Switch Configuration for maintenance needs. Any current configuration
files will be exported as text format.

If the file system is full (i.e., contains the three system files mentioned above plus two other files), it is not
possible to create new files, but an existing file must be overwritten or another deleted first.
Web Interface
To download configuration in the web interface:
1. Click Maintenance, Configuration, and Backup.
2. Select running-config, default-config, or startup-config for backup.

3. Click the Backup button. At the prompt select Open or Save or View Download.

‘ﬂ TRARSITION * et EE
TRANSITION ® = == - 0 G
N\ NETWORKS
SMBTAT2SA Backup Configuration File @toms - Mainnzncs - Confisurstion - Backup
Switch DMS . o
Select configuration file for backup.
b System S Please note: running-config may take a while to prepare for download.
» Port Management <
= File Name
» PoE Management <
O O D R ¢ () running-config
» Quality of Service < (C)  default-config
» Spanning Tree < () startup-confiz
» MAC Address Table <
» Multicast < | |

Figure 14-1.2: Backup Configuration

Parameter descriptions:

running-config: A virtual file that represents the currently active configuration on the switch. This file is
volatile. The config settings must be different than the default settings.

default-config: A read-only file with vendor-specific configuration. This file is read when the system is
restored to default settings.

startup-config: The startup configuration for the switch, read at boot time.

Buttons

Backup : Click the “Backup” button then the switch will start to download the configuration from flash
memory to the PC or Server. Note: running-config may take a while to prepare for download.

Note: At firmware v1.01.1201, the Backup config file name will automatically include the device's IP
address and date.
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Example:

A sample startup-config page is shown below:

SMXTAT2SA Web User Guide

username admin privilege 15 password encrypted sha

Bce976e5b5410415bde508bd4deel3dfbl67a%c873£fcd4bb8aBlf6f2ab448a918

exec—timeout autologout 0

I

vlan 1

I

ipme profile 4

description 44

ipme mode

ip dhecp snooping

ip dhcp relay

ip helper-address 1.2.3.4

ip dhcp relay information option
ip dhcp relay information policy drop
access—list ace 1

access—list ace 2 frame-type etype
access—list ace 3 frame-type ipvé

ip igmp snooping

ipve mld host-proxy

ipvé mld snooping

mvr vlan 1 name 4

mvr vlan 1 igmp-address 0.0.0.0

mvr vlan 1 mode dynamic

mvr vlan 1 frame tagged tagged

mvr vlan 1 frame priority 0

mvr vlan 1 last-member—-qguery—interval 5
mvr vlan 1 channel 4

radius-server key encrypted

2937FRS640CFDAFBST650CD3DS26AF4F4CBE44ED20138405B8A8E6EBSASS8A5DECIESD282513B27D5

1B79529C8RAR3CA32B36B5B59F6YBES287345E57C041B430
attribute 4 1%2.168.1.111
attribute 32 11111111

radius—-server
radius—-server
radius—server
key encrypted
spanning-tree
spanning-tree
spanning-tree
spanning—-tree
spanning-tree
spanning—tree
spanning-trees

BFDR4650D3169D38%88SE6A0CC23655D

name 00-CO-F2-45-LAB-14 revision 1
1 vlan 2,5,20-40

2 wlan 100-200
max-hops 11

max—age 10
forward-time 11
spanning—-tree m=t 0 priority 36864
spanning-tree mst 1 pricority 28672

poe management mode class—consumption
poe auto—check

dm=s service-mode enabled priority high

mst
mst
mst
mst
mst
mst

event group B02.1X smtp enable

| + | startup-config_10.0.4 - WordPad o o e S
 c— i e —
Home View L2l
£ Cut o o - Erzasa Find
D " Courier New 11 ~||A A = v :5' Bl élﬁ n
Copy ) b 33 Replace
B 7 U ghe . 3*|# - A-| |=|= = =||55 | Fidure Paint Dateand Insett | ...
: — | - +~ drawing time object | iLli Selectall
Clipboard Fant Paragraph Insert Editing
S T T o - T o T o . T 5o s
9 1 1 1 2 1 3 1 4 1 5 1 (5] 1 7 LS
-

host 111111 auth-port 1812 acct-port 1813 timecut 5 retransmit 3

m

100% (=)
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14-1.3 Restore Configuration

It is possible to import a file from the web browser to all the files on the switch, except default-config,
which is read-only. Select the source file to restore, and select the destination file on the target.

Web Interface

To restore a configuration via the web interface:
1. Click Maintenance, Configuration, and Restore.
2. Browse to and select a Source File.
3. Click the Restore button.

TRANSITION * =| = : > R
N NETWORKS: )
SM8TAT2SA Restore Configuration ftome - Msintensncs - Configuration - Restors
Switch DMS
Source File | Choose File |No file chosen
P System < -

Port Management Destination File

» PoE Management E
File Name Parameters
» VLAN Management
> Quality of Service < (O running-config @ Replace () Merge
» Spanning Tree < () startup-config

TBERa s EbE ‘ () Create new file

Multicast <

DHCP < |

Figure 14-1.3: Restore Configuration
There are three destination file name selections:

running-config: A virtual file that represents the currently active configuration on the switch. This file is
volatile. You can select "Replace” the existing file, or “Merge” the existing running-config file with the new
file. If the destination is running-config, the file will be applied to the switch configuration.

This can be done in two ways:

Replace: The current configuration is fully replaced with the configuration specified in the source file.
Merge: The source file configuration is merged into running-config.

startup-config: The startup configuration for the switch, read at boot time.

Create new file: A read-only file with vendor-specific configuration. This file is read when the system is
restored to default settings.

Buttons
Browse: Click the browse button to search for the configuration text file and filename.

Restore: Click the "Restore” button then the running web management PC will start to upload the
configuration from the location PC configuration into the managed switch.

Message: The config file is uploaded successfully.
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14-1.4 Activate config

It is possible to activate any of the configuration files present on the switch, except for running-config

which represents the currently active configuration.

Web Interface
To activate configuration in the web interface:
1. Click Maintenance, Configuration, and Activate Configuration.

2. Select the File Name to be activated.

3. Click the Activate Configuration File button. This will initiate the process of completely replacing the

existing configuration with that of the selected file.

TRANSITION® = ®** : = oG

N NETWORKS.
SM8TAT2SA Activate Configuration @Home - Msintenance - Confizurstion - Activate

Switch DMS
» System ¢ Activate File Name
» Port Management & @ startup-config
» PoE Management <
» VLAN Management <

Activate Configuration File

» Omnalitv nf Servire <

Figure 14-1.4: Activate Configuration

Parameter descriptions:

Activate: Select the radio button to activate the selected file.

Buttons

Activate Configuration File: Click the button then the selected file will be activated and will become this

switch's running configuration.
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14-1.5 Delete config

It is possible to delete any of the writable files stored in flash, including startup-config. If this is done and
the switch is rebooted without a prior save operation, this effectively resets the switch to its default
configuration.
Web Interface
To delete configuration in the web interface:

1. Click Maintenance, Configuration, Delete config.

2. Click Delete Select.

TRANSITIDN o 2 "7 Auto-logout = 9 c’

N NETWORKS:
SMSTATz SA Delete COﬂfIgU l'aJ[IOI"I @kHome - Maintenance -~ Configuration - Delete
Switch DMS
» System < Delete File Name
» Port Management <
Delete Configuration File |

» PoE Management <

Figure 14-1.5: Delete Configuration

Parameter descriptions:

Delete: Select the file that you want to be deleted.

Buttons

Delete Configuration File: Click the button then the selected file will be deleted.
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14-2 Restart Device

This webpage lets you restart switch for any maintenance needs. Any configuration files or scripts that you
saved in the switch should still be available afterwards.

Web Interface

To configure a Device Restart in the web interface:
1. Click Maintenance and Restart Device.
2. Check or uncheck the Always-On PoE option checkbox.

3. Click Yes.
TRANSITION \ =| >*F : = puologot S I
N NETWORKS:«
S M STATZ SA Re Sta I'T DE‘VI ce @ Home - Maintenance - Restart Device
Switch DMS
» System < Are you sure you want to perform a Restart?
» Port Management <
» PoE Management <[] Always On PoE

» VLAN Management < |T| |]_|

Figure 14-2: Restart Device

Parameter descriptions:

Restart Device: You can restart the switch on this page. After restart, the switch will boot normally.

Buttons

Always-0On PoE: Check for the switch to maintain power to PDs during device restart. Note that the
name "Non-stop PoE" changed to "Always-On PoE" at FW v1.03.1501.

Yes: Click to restart the device.

No: Click to undo any restart action and return to the System Configuration page without restarting the
configuration.
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14-3 Restore Factory Defaults

This webpage lets you reset the Switch configuration to Factory Defaults. Any configuration files or
scripts are restored to factory default values.

Web Interface

To reset the switch configuration to its Factory default settings in the web interface:
1. Click Maintenance and Factory Defaults.

2. Check the box if you want to keep the current IP configuration.

3. Click Yes.
TRANSITION ® =| =% : = Moo
N NETWORKS.
SMB8TAT2SA Restore Configuration to Factory Default @Homs - Msintanancs - Factory Defaults
Switch DMS
» System < Are you sure to restore configuration to factory default ?
» Port Management <
» PoE Management * (] Keep IP Configuration

» VLAN Management <

(]

Figure 14-3: Restore Config to Factory Defaults
Buttons

Keep IP Configuration: Check if you want to keep the current IP address configuration after the restore is
completed. At FW v1.02.1474 the Gateway IP address is also kept when restoring the switch to its factory
defaults with the Keep IP Configuration checkbox checked.

Yes: Click the button to reset the configuration to Factory Defaults.

No: Click to undo any restore action and return to the System Configuration page without restoring the
configuration.
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14-4 Firmware

This webpage lets you upgrade and select Firmware. The Switch can be enhanced with value-added
functions by installing firmware upgrades. Note: Password encoding changed in FW v1.02.1409. You
cannot login if downgrading the switch to older firmware versions or loading an old config file in new
firmware.

15-4.1 Firmware Upgrade

This page facilitates an update of the firmware controlling the switch.

Web Interface

To configure a Firmware Upgrade Configuration in the web interface:
1. Click Maintenance, Firmware, and Firmware Upgrade.
2. Browse to and select the file to upgrade the switch to (e.g., SM16TAT2SA _Transition_201702024.tgz).

3. Click the Upload button. Continue operation when the message “Firmware upgrade in progress
Completed!" displays.

TRANSITION R TN F Auto-logout = 9 C’
N NETWORKS: )
SMBTATZSA F|nT|Wa re Upgrade #eHome - Maintenance - Firmware - Firmware Upgrade
Switch DMS
Firmware File | Choose File | No file chosen
» System < -
» Port Management <[] Atways On PoE
» PoE Management g | Upload |

Figure 14-4.1 Software Upload page
Parameter descriptions:

Always-On PoE: Always On PoE (soft reboot) allows a warm reboot of the switch without affecting the
PoE output to the PD, providing continuous power even during firmware upgrade. Note that the name
"Non-stop PoE" changed to "Always-On PoE" at FW v1.03.1501.

Buttons:

Choose File: Click the button to search for the Firmware filename.

@ Note: This page facilitates an update of the firmware controlling the switch. A Software Upload will
update the managed switch to the software image at the specified location. After the software image is
uploaded, a page announces that the firmware update is initiated. After about a minute, the firmware is
updated and the switch restarts.

A WARNING: While the firmware is being updated, Web access appears to be defunct. The front
LED flashes Green/Off with a frequency of 10 Hz while the firmware update is in progress. Do not restart
or power off the device at this time or the switch may fail to function afterwards.
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TRANSITION '
= e . FTTT1 Auto-logout
TRANSITION \ = . BEEEmm or v M @ G
N NETWORKS .
SMETAT2SA Firmware Upgrade @& Home ~ Maintenance - Firmware = Firmware Upgrade
Switch DMS
Firmware File Choose File |SM&TAT2S.. ..tar.gz.imgs
» System <
|

» Port Management < [#] Always On PoE
» PoE Management * Upload
Messages:

Message: Error : The firmware is already update.
Meaning: You are trying to upgrade to the current (existing) firmware version.
Recovery: Verify that you are upgrading to the latest version.

Message: The firmware update was successful.
Meaning: The software was successfully updated.
Recovery: None required.

Message: Firmware upgrade in progress  Waiting, please stand by...

Waiting, please stand by...

Meaning: While the firmware is being updated, do not restart or power off the switch or it may fail to
function afterwards.
Recovery: None. Wait for the upgrade to complete.

Message: Error : The firmware image is invalid. Please use a correct firmware image.

Meaning: You tried to upload an invalid firmware file.

Recovery: Check the file format and location. Make sure the firmware filename prefix matches your
specific switch model (e.g., sm16tat2sa).

Message. Firmware upgrade in progress

The uploaded firmware image is being transferred to flash.
The system will restart after the update.

Until then, do not reset or power off the device!

Waiting, please stand by...
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14-4.1 Firmware Selection

This page lets you activate an alternate firmware image. This page provides information about the active
and alternate (backup) firmware images in the device and allows you to activate the alternate image.
The web page displays two tables with information about the active and alternate firmware images.

Note: Password encoding changed in FW v1.02.1409. You cannot login if downgrading the switch to
older firmware versions or loading an old config file in new firmware.

1. Navigate to > Maintenance > Firmware > Firmware Selection to display the Firmware Selection page.
2. Verify the Active Image and Alternate Image information.
3. Check or uncheck the Always On PoE checkbox.
4. Click the Activate Alternate Image button to swap the firmware versions.

TRANSITION ® = =% : ==== _ GRS

N NETWORKS
SMETAT2SA Firmwa e Selection @Home - Mazintznance - Firmware = Firmwars Selection
Switch DMS
Active Image

P System <
» Port Management < Partition primary
» PoE Management < Version v1.04.0020
b VLAN Management < Date 2021-04-21 17:56:19 UTC
» Quality of Service <
» Spanning Tree < Alternate Image
» MAC Address Table ¢ Partition secondary
» Multicast <

Iulticas Version v1.03.1490
» DHCP <

Date 2020-07-28 22:34:42 UTC

» Security <
» Access Control ¢ [Jawsyzonroe
» SNMP i | Activate Alternate Image || Cancel
Parameters:

Active Image

Partition: Indicates whether “primary” or “secondary” flash partition will provide the firmware upgrade
image.

Version: The active firmware version (e.g., v1.04.0020).

Date: The active firmware build date (e.g., 2021-04-21 22:34:42 UTC).

Alternate Image

Partition: e.g., “secondary” firmware image.

Version: The alternate firmware version (e.g., v1.04.0001).

Date: The alternate firmware build date (e.g., 2020-10-08 10:23:11 UTC).
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Buttons:

Always On PoE: Always On PoE (soft reboot) allows a warm reboot of the switch without affecting the
PoE output to the PD, providing continuous power even during firmware upgrade. Note that the name
"Non-stop PoE" changed to "Always-On PoE" at FW v1.03.1501.

Activate Alternate Image: Click the button to activate the Alternate Firmware image.

Cancel: Click to cancel the page edits.
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Chapter 15 - DMS (Device Management System)

The Transition Networks DMS (Device Management System) is an intelligent SM8TAT2SA-DC
management tool embedded in the switch to intuitively help IT/TS in reducing support

: Switch DMS
time, cost, and effort.

> DMS Mode
In the SMXTAT2SA main menu pane on the left, navigate to the DMS tab to display the » Graphical Monitoring

main DMS features: DMS Mode, Graphical Monitoring, Management, and Maintenance. > Topology View

> Floor View

DMS features include: > MapView

e DMS automatically discovers and displays all devices connected to the switch using | + wanagement
standard networking protocols such as LLDP, UPnP, ONVIF, etc. > Device List

e DMS supports up to 256 devices within four subnets. : T'ja"_:'apl’Key )

e DMS operates via an intuitive web GUI to allow you to: > Fo!]rtner:s:c
o Power down the IP cameras, NVRs, or any PoE devices. 7 refetonter

o Remotely identify the exact cable break location.

o Detect abnormal traffic issues on IP cameras/NVR.

o Monitor devices' status (e.g., link up, PoE power, traffic, etc.).

o Configure VLAN/QoS intuitively for better solution quality/reliability.

When you click the DMS tab, the default (startup) DMS webpage (DMS > Graphical Monitoring >
Topology View) displays:

T Twsmar dhrm in -
TRANS[TION = .= — Auto-logout | 10 min o c-
Na—" NETWORKS
SMB8TAT2SA-DC Topology View #@Home - Graphicsl Monitoring - Topology View
Switch DMS s
> DMS Mode + {:C}:}
» Graphical Monitoring ¥ = KA
> Topology View N
> Floor View 192.168.1.99
> MapView ? Port: 1 {0.001MB) =|
» Management E
» Maintenance @
SMBTAT2SADC . 192.188.1.100

192.188.1.77 | g [ 9 | Por7

192.188.0.90
7 | Port 9 (876.925Mb)
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15-1 DMS Mode - DMS Controller Switch
You can configure DMS mode and monitor device numbers/ DMS Controller Switch IP.
e DMS is controlled by the DMS Controller switch, as specified by DMS Mode selection.

e The DMS Controller Switch is in charge of syncing DMS information in order to manage Topology
View, Floor View, and trap event / data polling / DHCP server assignment.

DMS Controller : Managed Devices .» i ,_lp to 256 devices within 4 subnets
Switch 1 .
1 the device 13 a Switch
* Locate In 3 secure 1 ’
L0« e In a secur
I , 1 (= - - , e
Y DMS : , J the device is a PC
dropdown select
3 . I
High Priority
i : - p»>  the device is an IP Camera
! .
: }: ,E the device is an |P Phone.
[am=s ]
]
' ¥ - : A
1 &= the device is an AP
1 .
H vl -
1 =3 the device is a Router
1
| Q- 2 P device detectad by DMS, but device type not recognized
: (“unknown” device type)

DMS Controller Switch and Managed Devices
Note:

1. If there are more than two Switches set as High-priority or no High-priority mode switch, the Switch
with the longer system uptime will be the DMS Controller switch. If two switches have same up time,
the switch with the smaller MAC address will be assigned as the DMS Controller Switch.

2. You can set two switches to High Priority for Controller Switch redundancy.

3. The DMS Controller Switch should be put in a secure location such as a server room, with
access/authority limited to IT staff.

4. The DMS Controller Switch is the center of IP / Event management to operate the DMS:

a. When enabled DHCP Server mode in DMS network, the DMS Controller switch is responsible for
assigning IP address for all devices.

b. The DMS Controller Switch will Collect, Poll, and Sync DMS information, and act as the Event
Notification control center to manage all device information.
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15-2 DMS Mode
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1. Click DMS > DMS Mode to display the DMS Information page.
2. At the DMS Mode dropdown select Enabled or Disabled.

3. Click the Apply button. The DMS Information page updates.

TRANSITION

N NETWORKS

SMETAT2SA-DC
Switch DMS
> DMS Mode
» Graphical Monitoring
» Management

»  Maintenance

<

=
JRANSTION

l= — Auto-logout 10min - H o C.

Information

DMS Mode
DMS Priority

Total Devices
On-line Devices
Off-line Devices

Controller IP

@@Home - DMS Mode

Enabled |z|
High |z|

4
3
1

192.168.1.97

DMS Mode Information parameters

DMS Mode: At the dropdown select Enabled or Disabled. The default is Enabled.

DMS Priority: At the dropdown select High, Mid, Low, or Non.

High ¥
High: Choose "High" to make this switch the DMS Controller switch (Master switch). C high
Mid: Makes this switch a middle priority. Mid
Low: Makes this switch a low priority (default). 'r“j

WOn

Non: This switch will never become the Controller switch (Master switch).

Total Devices: Displays the Total / On-line/ Off-line Devices count in the DMS network (read only).

On-line Devices: Displays the total number of discovered devices that are currently on line (e.g., 3).

Off-line Devices: Displays the total number of discovered devices that are currently off line (e.g., 1).

Controller IP: Displays the active DMS Controller Switch’s IP Address (read only).

DMS Mode Buttons

Apply: Click to save changes.
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15-3 Graphical Monitoring
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Navigate to the DMS > Graphical Monitoring menu path to view the options of DMS Graphical
Monitoring Topology View, Floor View, and Map View.

15-3.1 Topology View

Navigate to the DMS > Graphical Monitoring > Topology View menu path. Note that FW v1.02.1327 adds
automatic logout when the screen is idle for over 10 minutes on the DMS Topology View page.

Click the {é} button to display the right pane menu tabs (Device, Group, and Config).

TRANSITION =| == | szsz..|
N NETWORKS: - e i s sl b
SM8TAT2SA Topology View
Switch DMS
> DMS Mode +
» Graph -

> Topols

> Floor
> MapView
» Management 8
b Maintenance <
e
) rezrmasiy
Non-Pos
Fort 1 (0 gt
SMETAT2SA
192168554
PoEOW
24P aXA
B =1

Nen-PeE
Potg-Pot 2

ot 4P 25

oo
@Home - Graphical Monitorig - Topology View
Device Group Config
{":} (an -] @ [sve -
”
s la |
E— L — ¢S -
) 92 e anne N ST
FOEOW L PoE24W B =
Port 9P 25 Pert 2 (LO0TME)
?
s
SisPMICaDzIEeL
e o~
PoEOW
Port 10~ For 17 5
=}
s
SISPMIOIB4LRTL
=g 2t
PoE0W o
Port 11-Fon 2
=
SISPMIOGR2-LRT
E=p) 21 3
PoEOW
Port 12- Port: 7 &) o
00z t584
SEPHLse L o

The Topology View icons and controls are shown below.

Zoom in or zoom out

i . Show/ hide
display area . Specified DMS Controller Switch Device/Graup/Config
Show / hide tabs Save Configuration
the menu Click to display a port's detailed statistics Help
\ . Log Out
TR :
TRANSTION
SM16TAT2S5A Topology View Biroe - Graphical Mantoring - Topology View Click té sort. filter. ot
| S i N .
Switch DMS ] e configure basic settings
> DMS Mode 3 - EE = {e.g., VLAN, Qas).
» Graphical Monitoring ? fal -
- - - Show:all f show graphic-only
2
- Click to select the set of
=7? information to be displayed
b Management ¢ (MAC, IP, PoE power, etc.).
» Maintenance < ?B

Click anywhere and drag to move the
display area up/down/left/right
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Click to-zoom in'on-an
individual device

A Black device icon indicates device is operating normally. Click a device
icon to show its device consale

A Red device icon indicates the device is operating abnormally.

A Red circled device number shows the number of alarm notifications for
the device,

A Red circled question mark indicates an unknown type detected; you can
select its type from a pre-defined list,
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Topology View Icons / Controls

Click anywhere and drag to move the display area up /down/ left /right.

Click “+” or “-” to zoom in or zoom out the display area.

A Black device icon indicates device is operating normally. Click a device

2.1E5.70.14 icon to show its device console.
Fort: 1 (0.005ME)
"ssmr;}ﬁ$j=:
| 192188177 A Red device icon indicates the device is operating abnormally.
Port 1-Part 7
@l SOEENIC-1
I;li Zarzrl FO A Red circled device number shows the number of alarm notifications for
T 1e2aEaTDA the device.
Part: 1 (100588

=

Click this icon to select the set of information to be displayed (MAC, IP, PoE
power, etc.).

Config

Click this icon to sort, filter, or configure basic settings (e.g., VLAN, QoS).

Device Categories and Sta

tuses

=B

The device is a Switch.

| ]
.\\.. ../.

The device is a General switch.

s

The device is a PC.

g

The device is an IP Cam.

The device is an IP Phone.

=
-

The device is a Wireless Access Point (WAP).

The device is a Router.
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§ ™ # ’

Z —@— | The device is an LED Light.
= Black icon: Device link up. You can select a function and check for issues.
QH Red icon: Device link down. You can diagnose the link status.

Icon with number: indicates some event has occurred (e.g. Device Off-line, IP
|:|H Duplicate, etc.) on the IP device; you can click on the device icon to check
- events in Notification.

40GEMICA

|;|a Genaml PC A Red circled device number shows the number of alarm notifications for the
: 192.168.70.14 device.

Fort 1 (10088

Icon with question mark: Unknown Device; the IP device is detected by DMS,
? but the device type can't be recognized which will be classified as an
* unknown device type.

?m Icon with question mark and red N:indicates the device is unknown and id
not connected.

40GEMNIC-
|;|ﬁ Genars| PO A Black device icon indicates device is operating normally. Click device icon
" 192.1E8.70.14 to show its device console.

Part: 1 (1.000ME)

o SIEPM1040-354-LRT-C

| 192188177 A Red device icon indicates the device is operating abnormally.
Part 1-Part 7
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DMS Topology View parameters Al

All
SWITCH
PC

Device tab parameters

IP Camera

Devices dropdown: Select the device type (All, SWITCH, PC, IP Camera, IP Phone, AP,

IP Phone

Others, or Off Line). ap
Others
Snapshot icon: Use the ﬁ icon to capture the displayed topology view. Off ine
File format: Select the graphics file type (SVG, PNG, or PDF). SS\:E ]
PNG :|
PDF
Search box: Use the Q | to search for a device by typing IP/MAC
address or Model/Device name.
Group tab parameters Device Group Config
Vlan ID: Enter a VLAN ID (VID) for the new group (1-4095). e |-«
|New Group |E]

Name: Enter a name for the new group.

Vlam ID
Traffic Priority: At the dropdown select Default or 0 (Low) — I I

7 (ngh) Name

Traffic Pricrity | Default [~]
OUI 1: Enter an Organizationally Unique Identifier. oult | |

oulZ | |

OUI 2: Enter a second Organizationally Unique Identifier.

oul 2 | |

OUI 3: Enter a third Organizationally Unique Identifier.

Apply: Click when done entering the new group data. —
Delete: Click to close the new group configuration dialog.
Device Group Config
Total Device 2
Config tab parameters Controller IP 192.168.1.77
Total Device: Displays the total number of devices discovered. EdP ey lF
Controller IP: The control device IP address in the format 0.0.0.0. orersener Disabied ]

P Range |_S|'ng|e Subnet '_|

DHCP Server IP: The IP address of the configured DHCP Server;

otherwise --- if no DHCP Server is configured. Apply
DHCP Server: At the dropdown select Enabled or Disabled.
. . Device Group Config
The default is Disabled.
Total Device 2
IP Range: The range type (Single Subnet or Multiple Subnet). Controller IP 102168177
If you select Multiple Subnet, selection fields display for Range 1 - Range 4. pkce serverip
Apply: Click the button to make the changes. orer semer [Enabled [
Range 1 0.0.0.0 H0.0.0.0
Range 2 0.0.0.0 H0.0.0.0
Range 3 0.0.0.0 H0.0.0.0
Range 4 0.0.0.,0 H0.0.0.0
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Device data

Click a device in the Topology View to display its discovered data:

TRANSITION =| === | 2 |
= -
" NETWORKS
SM8TAT2SA Topology View
Switch DMS
> DMS Mode + SM24DPAXA X
ng SWITCH
L e—
e
SM24DPAXA -
fap Vi 00-0-2-7c-57-01
» Management g 192.168.85.2
> Maintenance 3
MAP PoE Supply Non-PoE
e
Nonpos
ot () T
SMBTAT2SA Lagin Upgrade Find Switch Diagr
12185554 (g
Fosow
SM24DP4AXA —
12E5252 |l = 162

Device data parameters

Device Type: e.g., SWITCH, PC, IP Camera, IP Phone, AP (Access Point).
Device Type is displayed automatically. If an unknown type is detected, you
can still select its type from a pre-defined list. An IP device recognized as a
DMS Control switch supports "Upgrade" and "Find Switch" functions.

An IP device recognized as a PoE device supports "Upgrade" and "Reboot"

functions.
An IP device recognized as an IP Camera via the ONVIF protocol will support
the "Streaming" function.

Device Name: e.g., SM16TAT2SA. Create your own Device Name or alias for
easy management such as "IF_Lobby Cam1".

Model Name: e.g., SM16TAT2SA.

Mac Address: e.g., 00-40-c7-1c-cb-6e; displayed automatically by DMS.
IP Address: e.g,, 192.168.1.77; displayed automatically by DMS.

Http port: e.g., port 80

PoE Used: e.g., 2 Watts; displayed automatically by DMS.

PoE Supply: e.g., PoE or non-PoE.

Login icon: Click to display the login window.

Upgrade icon: Click to display a window in which you can enter a Tftp Server
IP address and the name of a firmware file to upgrade to.

Find Switch icon: Click to flash the device LEDs for 15 seconds to help find
the device. Click OK to clear the message.

Parent Node / Undo Parent: click to toggle between switching the selected
device with its parent node device and back.
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Login

Dashboard

TV-1P320-PI X

[General IP Camera ‘ ':\

TV-1P320-PI

d§-eb-97-ce-08-26
192.168.90.100
50

2w

2 O

Diagnostics ~ PoE Reboot

Notification Monitor

SM24DP4XA x

SWITCH

SM24DP4xA

SM24DP4XA

00-c0-f2-Te-57-01

192.165.85.2

E |

2

Diagnostics

Notification

Mon-PoE

I, Q

—_l

Upgrade Find Switch
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PoE Config icon: Click to display a window in which you can enable or disable PoE Auto Checking globally
and enable or disable POE Mode on a port-by-port basis.

PoE Reboot: Click to re-boot PoE. 192.168.1.99 X

|Unknown Device [~]

PoE Supply and PoE Used: displayed automatically by DMS.

Dashboard icon: Click to display the dashboard.

Notification icon: Click to display an editable message area. aeaddress - 00-1D-11-b2-bd-4b
P Address 192.168.1.99

ort 80
Unknown Device parameters

PoE Used MNon-PoE
. . 192.168.1.99
[ ) Port3(001M)
You can click on an unknown device ( -~ ) to display its Diagnostics
dlscovereq data (sge descriptions above)..If an gnknown type is detected,
you can still select its type from a pre-defined list. Nofification Manitor

PoE Auto Checking “AutoFill” Feature

When you enable Auto Power Reset (PoE Auto Checking) in DMS, the IP addresses of the connected
devices are automatically filled in the Auto Power Reset configuration page.

1. Configure the “PoE Auto Checking” parameter at Switch > PoE Management > PoE Auto Checking.
The “Failure Action” parameter can be set to “Reboot Remote PD” or “Nothing”.
2. Configure PoE parameters at DMS > Graphical Monitoring > Topology View. Left click on the switch

icon to display its device configuration popup. Click the PoE Config ( P===="z ) icon to display the PoE
Auto Checking pane:

TR
TRANSITION

NETWORKS.

I&Eu_smﬁn‘ - Auto-logout H o C‘

SMBTAT2SA Topology View @Home - Graphical Moritoring - Topology View
Switch DMS

- 1

SMSTAT2SA x

Port PoE Mode i
2 \@| ? Port 8 (0.001Mi)

s Eme T
: e —
: e —
6
7
&

o 2 N T~
? Port: 6 (0.001Mb) ‘:EQ/‘F’

‘Aan

> DMS Mode

Monitoring

» Management <

» Maintenance s

\:':Enab\a M| 1006158
s 7)) ~somie
|Disable |

SMETAT2SA

10043 | EEEED -

10.04.220
? ) Port 11 @001ME)

10.0.4.240

{7 ) Port 12 (0001MD)
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15-3.3 DMS Firmware Upgrade Procedure
1. Navigate to the DMS > Graphical Monitoring > Topology View or Floor View menu path.

2. Click the @ button to display the right pane menu tabs (Entry and Config).

3. Connect all switches and make sure DMS is working.
- Set all switches with different IP addresses and in the same IP segment.

- Make sure gateway IP address is configured.

4. Enable the TFTP server and set the correct image path.

¥ Tfpde4 by Ph. Jounin — O ><
| Current Directory  |EEERTRE FVE] ~ Browse
Serverinterfaces  [192.168.6.130 Realtek PCle GBE Fan_~ Show Dir

Thp Server | Thp Client | DHCP server  Log viewer |

< >
Clear Copy
About | Settings | Help

5. Click switch's icon, then click the "Upgrade” button in the Dashboard.

TRANSITION® =[ = : mss=__ ” it H 9 G
N NETWORKS. ) i e Ml
SMBTAT2SA Topology View @iHame - Graphical aritoring - TapolosyView
Switch DMS
) 2\ Port 6(0.001Mb) Davice Group Config
> DMS Mod +
ode SMBTAT2SA x '{é} i N @Ee
> ical M ing v - R ;
Ew aphical Monitoring Device Type SWITCH KA ‘Q |
© T s 3 DeviceName  [SMBTAT2SA ¢ N n
b GIEsAL Model Name ~ SMBTAT2SA 1004 155 E] ==
N View [Port: & (0.001Mb) 00-c0-f2-45-ab-14
> Map View Mac Address  00-c0-2-49-ab-14 - !
» Management < P Address 10043 5
? ) weax
» Maintenance < Http port 80 R
PoE Supply ow ?
SMETAT2SA SM24TETZDRA B0 1ss ? ) woais
= 00-0d-b3-50-b7-74
10043 1004 ¢ @ 9 |Port: 9 (0.001Mb)
Port 1-Port Login Upgrade | FindSwith  PoE Config
? ) seass
00-0d-b3-50-b7-75
£A
Dashboard Nofification s
? 10.0.4.221
1004220 00-0d-b3-50-b5-c0
? ) Port 11 (0.001Mb) 5
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6. Enter the Tftp Server IP address and FW image name (e.g., SM8TAT2SA_v1.04.0001_CM_202008022.tar.gz).

TRA SITIDN EH e H Auto-togout T S
" NETWORKS . ks
SM8TAT2SA Topology View @ome - Grashic Topelogytiew
Switch DMS 5
- Port 6 (0.001MR) Device Group Config
> DMS Mode + SMaTAT2SA x D¢ @ Flabs [
» Graphical Monitoring -
- Tip Server IP - [TE2.166.1.60] ] File - [SMBTATZSA_vi.04.0001_CM_2020080 7 |
> Topalogy N -
. oo
> Floor\ Name P Version Status = fam f;‘g‘;‘}s"
> Map View v SMETAT2SA 10043 v1.04.0001 — 0o facisaiid
» Management < 7
» Maintenance < R ————
;
?) oass
SMETATZ&C 00-0d-b3-50-b7-74
002 (g -
? ) moass
SontbasabrTs
:
? ) e
00-0d-b3-50-b3-c0
:
? ) 00420
moEEe
Ar ?7 ) 1004220
e e
M " n
7. Click "Apply” to start the FW upgrade.
8. Observe the upgrade status until completion.
& > O | 1921686136/t0pology htm = &
TRANSITION ®  =| =7 H e
N\ NETWORKS -
SM8TAT2SA Topology View @Home - Graphical Monitoring - Topology View
Switch DMS
> DMS Mode SMBTAT2SA x {é):}
» Graphical Monitoring| 140 o.rver 1p - [192168. 6130 | File - [SMBTAT2SA_Transition_201702025 gz KA
> Topology View ¢ N
> Floor View Name P Version Status
> Map View SMSTAT2SA 192.168.6.136 v1.00.798 2017-01-0101:53
Starting, please wait...
» Management v SMSTAT2SA 192.168.6.135 v1.00.798 B Thpd64 by Ph. Jounin — o X

» Maintenance

Current Directory

C:\lemp\2017030 Browse
Serverinterfaces [132.168.6.130 Realtek PCle GBE Fan v | Show Dit

Titp Server | Thp Client | DHCP server Log viewer

Connection received from 192.168.6.135 on port 26524 [02/03 13:42:59.784]

Read request for fils <SMBTAT2SA_Transiion_201 702025.tgz>. Mode octet [nz/oa 13.4259.7
Connection received from 192.168.5.136 on port 17186 [02/03 13:42:53.799]

Flead request for fils <SMBTAT2SA_Transiion_201702025.tgz>. Mode octet [02/03 134253 €
Using local port 51268 [02/03 13:4259.833]

Using local port 51269 [02/03 13:42:59.833]

& SMBTAT25A
File size : 10521483
120861 Bytes/sec

8460288 Byt

File size : 10521489
6351934 Bytes sent 119456 Bytes/sec
[ANEEEERERRREREEEER
< >
Clear | Copy
About | Settings | Help |

Message: Error : Firmware download fail displays if the TFTP Server IP address or the FW image name
entered is incorrect.
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15-3.4 Floor View

Navigate to the DMS > Graphical Monitoring > Floor View menu path. After you have added a Floor
Image at DMS > Maintenance > Floor Image, the Floor View lets you:

e Drag and drop (anchor) devices onto Floor Maps
e Find device location instantly

e Store up to 10 Maps per Switch

e IP Surveillance/VoIP/WiFi applications

e Other features same as Topology View

~t,
Click the {'J‘:Jj button to display the right pane menu tabs (Entry and Config).

an e .
UV N s s 10 G
SMBTAT2SA-DC Floor View @Home - Graphical Manicoring - Fioor View
Switch DMS - P o
7 o ode j ‘ I 1st Eloor ‘ {é} [ [ @ By [
» Graphical Monitoring v - K 7| [FoorPlanistFloor (192.168.1.77) [-)

> Topology View

JE— 4

> Floor

[a |

> MapView

~

» Management

» Maintenance €

DMS Floor View parameters Al

All

Device tab parameters SWITCH

PC
Devices dropdown: Select the device type (All, SWITCH, PC, IP Camera, IP Phone, AP, Others, or i: ::“‘e“
Off Line).

AP
Others

Snapshot icon: Use the m icon to capture the displayed topology view. off Line

File format: Select the graphics file type (SVG, PNG, or PDF).

Search box: Use the Q | to search for a device by typing IP/MAC PG
address or Model/Device name.
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Config tab parameters Tz Config

Total Devics 2
Total Device: Displays the total number of devices discovered. e PR
. . DHCP Server P
Controller IP: The control device IP address in the format 0.0.0.0.
DHCP Server Pisablea ]
IP Range: The range type (Single Subnet or Multiple Subnet). IP Range [Single Subnet ___|~]
DHCP Server IP: Select Enabled or Disabled. Lo
DHCP Server: Select Single Subnet or Multiple Subnet.
Apply: Click the button to save the selections.
Example: Drag and drop the devices to the desired locations:
TRANSITION ® = =% : ssss.. o g Mo G
\—’ NETWORKS« 910
SMBTAT2SA Floor View @ome -~ Graphical Monitoring - Floor View
Switch DMS
R Device Config
> DMS Mode H ::Qt} [al [~] [sve -]
’) fgi::;éi:jnitorirg - ; . ‘ >< |FloorPlanFirstFloor (10.0.4.3) "]
> FloorView ‘Qf JETRTETTY - |
00-12-25-11-F4-3 *
> Map View
3
o enssement SHIPPING ) e o
» Maintenance < “
? 10047
00-c0-f2-01-9¢-b2
u  Suesoe
- SM24TET2DPA
=T
DOCK 2
= o
00-c0-F2-4¢-3d-T2
N e ?7) wee
14
? 1004240
02-21-12-ee-00-01
5 AXIS Camara .
i’- ::;512;.105;:‘.: k11 - ACCCEEADFEZA °

sc-ce-Be-ad-fa-2a
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15-3.5 Map View
Navigate to the DMS > Graphical Monitoring > Floor View menu path. The Map View lets you:

¢ Anchor devices onto Google Maps

¢ Find devices instantly from Map

¢ Search on-Line by Company/Address
¢ Run outdoor IP Cam/WiFi applications
¢ Other features same as Topology View

Click the {:é} button to display the right pane menu tabs (Device and Config).

Tuma . } . . el
TRANSITION ™ = == ;|  =z=c..] oo 5T M @ G
N\ NETWORKS i
SMBTAT2SA-DC Map View @Home - Graphicsl Monftoring - Map View
Switch DMS
Device Config
> DMS Mode Google B
» Graphical Monitoring This page can't load Google Maps correctly. |
> Topology View Do you own this website? SMaTAT28ADC
: TAT2SADC

> Floor View
> Map View

» Management @ 152102100
000810402020

» Maintenance S
152

18109
00-1b-11-b2-6d-4b

192168080
scecgeadfas

| 102.168.1.77 wants to:

If the message "192.168.1.77 wants to know your location” displays,
click the Allow button. !

Q  Know your location

Allow Block

DMS Map View parameters
Device tab:

Devices dropdown: Select the device type (All, SWITCH, PC, IP Camera, IP Phone, AP, Others, or Off Line).

Search box: Use the Q | to search for a device by typing IP/MAC address or
Model/Device name.

Config tab parameters:

. . . Entry Config
Total Device: Displays the total number of devices discovered. Total Device ,
Controller IP: The control device IP address in the format 0.0.0.0. . i
Singie subnet ]

IP Range: The range type (Single Subnet or Multiple Subnet).

‘\ Apply |

Apply: Click the button to save the selections.
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Satellite View: From DMS > Graphical Monitoring > Map View you can click Satellite to replace the Map

View with a satellite view:

TR
Uil
SM8TAT2SA
Switch DMS

> DMS Mode

» Graphical Monitoring
> Topology View

> Floor View

> Map View

» Management <

» Maintenance <

TwsmE

Map View
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@Home - Graphical Monitoring - Map View

H e ¢

Config

[

/<J/““‘*‘°” =
g / N e

SMETAT2SA
SMETAT2SA
192.168.90.6

192.168.90.1
00-08-e3--1c-28

Axis211
192.168.90.82
00-20-8¢-7d-81-02

192.168.90.52
00-c0-f2-00-25-dc
SM16TAT20PA
SMI6TAT20PA
169.254.225.32
00-c0-f2-46-87-38
General PC
LAPB3BAD
192.168.90.200
14-91-82-fo-3b-20

M3025
192.168.90.101

()
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15-4 Management
Navigate to the DMS > Management menu path to view the Device List and Map API Key webpages.

15-4.1 Device List

Navigate to DMS > Management > Device List to show all devices and information detected by DMS.

TRANSITION > =[ =7 : = MO G
N NETWORKS.
SMBTAT2SA Device List Sitome - Mansgament - Davice List
Switch DMS —— ——
Auto-refresh ‘ Refresh || Edit ‘
> DMS Mode —
v Graphical Monitoring < Show 10 w entries Search:
» Management N [[J Remove Status Device Type * Model Name Device Name MAC IP Address
> Device Lisi
> Map AP r.; Online IP Camera 00-18-85-11-F4-F9 10.0.4.101
S [VERIERERED < Online IP Camera 00-18-85-17-5B-23 10.0.4.100
Online IP Camera AXIS Camera AXIS M3106-LVE Mk || - ACCCBEADF82A AC-CC-8E-AD-F82A  192.168.0.90
Online Others 00-00-5E-00-01-04 10.0.4.1
Online Others 00-0D-B9-50-B7-74 10.0.4.155
Online Others 00-0D-B9-50-B7-75 10.0.4.155
Online Others 00-0D-B9-50-B9-CO 10.0.4.221
Online Others 00-0D-B9-52-02-A9 10.0.4.210
Online Others 00-0D-B9-56-91-E1 10.0.4.220
[} @ Offline  Others 00-C0-F2-01-9C-B2 10.0.4.7
Showing 1 to 10 of 15 entries 2 Next

(Avely |

DMS > Management > Device List parameters

Remove: Check the box to delete the table entry at the next Apply. Only Offline devices can be removed
from the DMS Device List.

Status: e.g., Online or Offline.

Device Type: e.g., SWITCH or Others.

Model Name: e.g.,, SM8TAT2SA or SM16TAT2SA or SM24TAT2SA.

Device Name: e.g.,, SM8TAT2SA or SM16TAT2SA or SM24TAT2SA.

MAC: e.g., 00-40-C7-1C-CB-6E.

IP Address: e.g., 192.168.1.77.

Http Port: Click the Edit icon to edit the Http Port number (added at FW v1.02.1327).
User Name: Click the Edit icon to edit the User Name (added at FW v1.02.1327).
Password: Click the Edit icon to edit the Password (added at FW v1.02.1327).

Buttons

Auto-refresh: Select on to automatically refresh the page every 3 seconds. The default is off.
Refresh: Click the button to refresh the page immediately.
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Edit: Click the button to display the table in editable form. Click the Edit icon to edit the Device Name,
Http Port, User Name, and Password. This function can also be configured in the Dashboard of Topology
view. There is no HTTP connection function for Unknown Device and PC type devices, so the Ul doesn't

provide "Edit HTTP port" function for configuring it. See below.

Show xx entries: At the dropdown select how many entries to show per page (10, 25, 60, or All).

Search: Enter key word(s) to search for on the page.

Remove: Only Offline devices provide "Remove" function to remove from DMS device list.

Previous: Click to display the previous set of entries (if any exist).
Next: Click to display the next set of entries (if any exist).

Apply: Click to save changes.

You can click the Edit button to show additional fields for editing:

TRANSITION =[ =% ;& H

" NETWORKS
SMBTAT2SA Device List
Switch DMS ————
Auto-refresh | Refresh || Edit |
> DMS Mode —
» Graphical Monitoring ¢ Show| 1 v|entries
> Ma [CEE [J Remove Status = Device Type* ModelName Device Name MAC
> Map AP ;; Online IP Camera 00-18-85-11-F4-F9
» Maintenance ¢ Online IP Camera 00-18-85-17-58-23
Online |P Camera AXIS Camera AXIS M3106-LVE Mk 11 - ACCCaI AC-CC-BE-AD-Fa-2A
Online  Others 00-00-5E-00-01-04
Online  Others 00-0D-B9-50-B7-74
Online  Others 00-0D-B9-50-B7-75
Online  Others 00-0D-B9-50-B3-Co
Online  Others 00-0D-B9-52-02-A9
Online Others 00-0D-B9-56-91-E1
O @®Ofiline  Others 00-C0-F2-01-9C-B2
Showing 1 to 10 of 15 entries
‘ Apply ‘
Additional Parameter descriptions:
Device Name: Enter the desired name for this device.
Http Port: Edit the HTTP port number for this device.
User Name: Edit the Username for this device.
Password: Edit the Password for this device.
33717 Rev. ) https://www.transition.com
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Search:
IP Address Http Port  User Name Password
10.0.4.101 20 admin e
10.0.4.100 20 admin e
192.168.0.90 80 admin e
10.04.1
10.0.4.155
10.0.4.155
10.0.4.221
10.0.4.210
10.0.4.220

10.0.4.7

2 Next
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15-4.2 MAP API Key

Navigate to DMS > Management > Map APl Key menu path to display the Google Map API Key
Configuration page. You need a valid API key and a Google Cloud Platform billing account to access
Google core products. If not, DMS Map View will not be able to load Google Map correctly.

Visit the Google website below and follow the directions to get an API key:
https://developers.google.com/maps/documentation/directions/get-api-key

To configure the DMS Management API Key via the web Ul:
1. Click DMS, Management, Map API Key.
2. Specify the Google Map API Key.
3. Click Apply to save the settings.

\ TREKSITION e -
TRANSITIUN =/ = R Auto-logout 9 G
N NETWORKS
SMETAT25A GOOgIE Map API Key Configuration @Homs - Management - Map API Ky
Switch DMS

Key AlzaSyDgDiSaFUGEPImOypm ZAISxNdH2-31 VTV
> DMS Mode

» Graphical Monitoring < | _____ |

b Management h

Devae
Levice LiIst

Parameter descriptions

Key: Specify the Google API Key. To use the Google Maps Embed API, you must register your app project
on the Google APl Console and get a Google APl key which you can add to your app or website.

Buttons

Apply: Click to save changes.
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15-4 Maintenance > Floor Image

Navigate to DMS > Maintenance > Floor Image to display the Floor Image Maintenance page:

TRANSITION N | e & Auto-logout H 0 ¢
N NETWORKS. .
SMBTAT2SA Floor Image Maintenance @rome - Maintensnce - Floorimaze
Switch DMS
Maximum: 30 files Used: 0 file(s) Free: 30 file(s)
> DMS Mode
» Graphical Monitoring ¢ Add Floor Image: | Choose File | No file chosen
» Management <
Name
» Maintenance
> Floor Image |
> Traffic Monitor i
Select No. File Name Image

No information found

| Delete |

Parameter descriptions

Maximum: x files: By default this field displays "Maximum: 10 files". With each switch added and
discovered, the maximum value increases by 10. For example, if only two switches are connected to each
other, the maximum number of files will increase from 10 to 20 (on both switches). But once the
connection is removed and after an approximate 1 minute wait, the maximum number of files will restore
to 10.

The maximum number of images displayed is additive. When the switch is stand alone with no
connections to other DMS switches, the number displayed is 10. As other DMS switches are added, the
field is incremented by 10 for each one.

Used: x file(s): The number of files that have already been uploaded.

Free: x file(s): The number of files that can be uploaded before reaching the maximum number of images.
Add Floor Image: Click Choose File and browse to and select a File Name to add.

Add: Click to add the selected file.

Select: Displays the selected image name.

No.: Displays the instance number.

File Name: Displays the selected file name.
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Image: Displays the selected image. Image added (FloorPlanFirstFloor):

ﬁ TRANSITION ™
TRANSITION * =| ** -
N NETWORKS:
SMBTAT2SA Floor Image Maintenance
Switch DMS
Maximum: 30 files Used: 1 file(s) Free: 29 file(s)
> DMS Mode

» Graphical Monitoring <

Add Floor Image: | Choose File |No file chosen

SMXTAT2SA Web User Guide

Auto-logout H e C’

@Home - Maintensnce = Floor Image

T Floor

» Management <
Name
» Maintenance h
> Floor Image -
B | Add |
> Traffic Monitor —_—
Select No. File Name Image
._‘T-_ o
EHIPRING i |
O 1 FloorPlanFirstFloor (10.0.4.3) #
—
| Delete

Message: 192.168.1.77 says: Insufficient Space. Only x files available.
Meaning: The file is too large or no file exists.

Recovery: Click the OK button to clear the message and choose a new File Name to add.

Message: Special Characters are not allowed in Name.

Meaning: The Floor Image filename has special characters (dash, space,
allowed.

numbers, etc.) which are not

Recovery: Click the OK button to clear the message and choose a File Name with no special characters.
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15-5 Maintenance > Traffic Monitor

DMS supports traffic monitoring of each port and keeps a one-week record that can be used to compare
and analyze through visual charts. The page displays two different graphs for a selected device.

Procedure

1. Click DMS > Maintenance > Traffic Monitor.
2. Select the parameters to display.

3. Select the device to monitor.

Traffic Monitor froo— i
g Dusvbrw Link
ATLIE u S
3 == poiist ol
. L]
o 1
=
L1 I F -
) L] ] I
. - -
-1 -
o 2
L b | o ol e
SEN r
-

] ¥ ! § F n o 3 4 1 " [-] 1 i = 4 = A C = =@ P

ELFS SRR .
|
|
|
L
T
L [0
HEwo
MENa
L L |
L k|
=My
L3 P | Vi
S T S B S B N S R S S & M % M W% i 4 % @ h & @ e

Parameter descriptions:

0 Total Rx Tx

Total / Rx / Tx: Select the set of data to be displayed.

< 2011/01/04 @& oay wesk

< yy/mm/dd >: Select the date of data displayed.
Day / Week: Select a day’s worth of data or a week’s worth of data to be displayed.
Device List: Displays the set of discovered devices.

Throughput: Vertical axis shows throughput (e.g., 0 M — 18000 M or 0 M-1200 M). The unit of measure
is Mbps.

Port: Horizontal axis shows the switch port numbers.
Time (Hour): Horizontal axis shows the time elapsed in hours (0-23).

The graph’s vertical axis shows throughput and the unit of measure is Mbps.
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Message: Traffic Monitor feature is only available on master controller. Current master controller IP Address:
192.168.90.52.

Traffic Monitor feature is only available on master controller.
Current master controller IP Address:192 168.90 52

-
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15-6 DMS Troubleshooting

Problem: The switch lists itself as the only device in Topology View of DMS.
Problem: In DMS, the Local image shows the IP address of another switch.

Description: The switch is listed as only device in DMS Topology View in DMS; all devices are listed in
DMS device list. This is usually because the switch's gateway is not configured appropriately.

Resolution: An IP Route must be configured manually. For example, a switch IP address of 192.168.1.77
should have the following IP route configured: ip route 0.0.0.0 0.0.0.0 192.168.1.x. Without the IP route
configured, you may be unable to view all devices on the network in DMS.

1. Go to DMS > Management > DMS Mode to check if the controller IP is correct.
2. Verify that the gateway of this switch is correctly configured.
3. Verify that all connected devices are displayed in DMS Topology View.

Problem: DMS Connectivity diagnostics fails to ICMP reachable device.

Description: DMS displays a device which is reachable via ICMP ping as failing the connection status in
diagnostics. Cable status displays as OK.

Resolution: Contact Transition Networks Technical Support. See Contact Us below.

Problem: DMS will discover the device type, name and model of some cameras and hosts but others are
displayed as Unknown.

Description: When a device is detected by DMS, the device’s information (such as type, model
name...etc.) can be recognized via LLDP (e.g. Switch), UPnP (e.g. AP), ONVIF (e.g. IP cam), NBNS (e.g. PC)
packets if the device supports these protocols. So if the device display as Unknown, that means this
device do not issue above mentioned protocol for DMS to recognize.

Resolution: You can manually assign and configure the device type and name for the unknown devices.
See the Topology View > Dashboard or the Topology View section.

Message: This page can’t load Google Maps correctly.

Recovery:

1. Click the OK button to clear the message.

2. Navigate to DMS > Management > Map API Key.

3. See “15-4.2 MAP APl Key” on page 241.

4. Click the linked text “Do you own this website?” to display the Google API Key and Billing Errors
Troubleshooting page.

5. For help on finding error messages, see the section on checking errors in your browser.

6. See the Google Maps Platform FAQ for more information.

Problem: The switch cannot discover / display devices in DMS mode.
Solution: 1. Make sure DMS Mode = Enabled and DMS Priority = High. 2. Refresh the web browser page.
3. Update web browser cache. 4. Open a new web browser window.
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Issue: |E Tab fix for Chrome-Firefox - DMS Topology view issue.

Description: In order to log into a camera on a switch with PoE+ or PoE++ from the DMS Topology View
window from a browser other than Internet Explorer, you must have an “IE Tab” extension installed.
This is needed for both Chrome and Firefox. IE Tab is an extension for the Google Chrome and Mozilla
Firefox web browsers that lets you view pages using the Internet Explorer layout engine.

Recovery:

Google Chrome: https://chrome.google.com/webstore/detail/ie-
tab/hehijbfgiekmijfkfipbkbammijbdenadd?hl=en-US

Firefox: https://addons.mozilla.org/en-US/firefox/addon/open-in-internet-explorer/

16-7 For More DMS Information

See the online DMS Video.
See the online DMS Overview.
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Appendix A - Troubleshooting

Refer to the SMXTAT2SA Install Guide for Install Troubleshooting, Warranty, Support, and Compliance
information.

General Troubleshooting Procedure

Many problems are caused by the following situations. Check for these items first when you start
troubleshooting:

1. Verify the install procedures were performed correctly. See the SMXTAT2SA Install Guide.

2. Check if the SMXTAT2SA POWER LED is Off:
e Check connections between the switch, the power cord and the wall outlet.
e Contact your dealer for assistance.

3. Check if the SMXTAT2SA Link LED is Off:

e Verify that the switch and attached device are powered on.

e Be sure the cable is plugged into the switch and corresponding device.

e |[f the switch is installed in a rack, check the connections to the punch-down block and patch
panel.

e Verify that the proper cable type is used and its length does not exceed specified limits.

e Check the adapter on the attached device and cable connections for possible defects. Replace
the defective adapter or cable if necessary.

4. Make sure all devices connected to the SMXTAT2SA are configured to auto negotiate or are configured
to connect at half duplex (all hubs are configured this way, for example).

5. Check the cabling:
e Look for faulty or loose cables.
e Look for non-standard and miswired cables.

6. Make sure you have a valid network topology:
e Check for improper Network Topologies.
e Make sure that your network topology contains no data path loops.

7. Check the port configuration.

o Make sure ports have not been put into a “blocking” state by Spanning Tree, GVRP, or LACP. The
normal operation of the Spanning Tree, GVRP, and LACP features may put the port in a blocking
state.

e Verify that the port has not been configured as disabled via software.

8. Make sure connected devices (e.g., SFPs, switches, hubs) are cabled, powered, and operating properly.
9. If possible, try switching modes (i.e., from Web Ul to CLI, or vice versa).

10. Verify the specific function that failed (e.g., port config, PoE or VLAN management, QoS, Spanning
Tree). Refer to the specific function's user manual page and online Help for details. Verify that the
function you are trying to perform is supported by your particular switch model.

11. Run the tests in the Diagnostic tab of the Web Ul. Verify that the interface is assigned to the correct
VLAN. Use the Layer 2 traceroute. Check for spanning-tree problems such as BPDU floods or flapping
mac address. Try a ping to broadcast IP address of subnet from your L3 device (Gateway).

12. Record any related error messages, conditions, and configurations for your Tech Support Specialist to
consider. See below.

13. Contact Transition Networks Tech Support. See Contact Us below.
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Record Device and System Information

After performing the troubleshooting procedures, and before calling or emailing Technical Support,
please record as much information as possible in order to help the Transition Networks Tech Support
Specialist.

1. Select the SMXTAT2SA Switch > System > System Information menu path to gather the information
below or as requested by the TN Support Specialist.

2. Record Model:

Hardware Version: Firmware Version:

PoE Firmware Version: S/N:

3. LED Status:

4. Additional information for your Tech Support Specialist. See the “Troubleshooting” section above.

Your Transition Networks service contract number:

A description of the failure:

A description of any action(s) already taken to resolve the problem (e.g., change mode, reboot, etc.):

The serial and revision numbers of all involved Transition Networks products in the network:

A description of your network environment (layout, cable type, etc.):

Network load and frame size at the time of trouble (if known):

The device history (i.e., have you returned the device before, is this a recurring problem, etc.):

Previous Return Material Authorization (RMA) numbers:
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You can get Model, P/N, and S/N information from the Box label and the Device label:

16TAT :
MODEL SM 2SA This device complies with Part 15
of the FCC Rules

Managed Switch, 16-port Glgabit PoE+,

2-port 100/1000 SFP

Model: SM16TAT2SA FC
. LI
e nopvssseno | INUNIEIINVAN AN mmnn i C€
S/N: C021319BR2100002 S/N: CO21118BR2100002 ‘ﬁ c E f—

Made in Taiwan

MADE IN TAIWAN

Serial Label on Box Serial Label on Device

Contact Us

Transition Networks Inc.

10900 Red Circle Drive, Minnetonka, MN 55343

Telephone: +1-952-941-7600 / Toll Free: 800-526-9267 / Fax: 952-941-2322

E-Mail: customerservice@transition.com / techsupport@transition.com
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Appendix B — DHCP Per Port

You can configure DHCP Per Port via the CLI and Web UL The DHCP Per Port factory default mode is
Disabled. See the CL/ Reference for CLI mode operation.

Configure DHCP Per Port via the Web Ul

The switch’s DHCP server assigns IP addresses. Clients get IP addresses in sequence and the switch assigns
IP addresses on a per-port basis starting from the configured IP range. For example, if the IP address
range is configured as 192.168.10.20 - 192.168.10.37 with one DHCP device connected to port 1, the
client will always get IP address 192.168.10.20, then port 3 is always distributed IP address 192.168.10.22,
even if port 2 is an empty port (because port 2 is always distributed IP address 192.168.10.21).

The switch does not allow a DHCP per Port pool to include the switch’s address.
IP address assigned range and VLAN 1 should stay in the same subnet mask.

The configurable IP address range is allowed to configure over 18 IP addresses, but the switch always
assigns one IP address per port connecting device.

The DHCP Per Port function is only supported on VLAN 1.

When the DHCP Per Port function is enabled, the switch software will automatically create the related
DHCP pool named "DHCP_Per _Port".

Once the DHCP Per Port function is enabled on one switch, IPv4 DHCP client at VLAN1 mode (DMS DHCP
mode), DHCP server mode are all limited to be enabled at the same time (an error message displays if
attempted).

If the DHCP server pool has been configured, once you enable the DHCP Per Port function, then that
DHCP server pool configuration will be overwritten.

Only for VLAN 1, clients issued DHCP packets will not be broadcast/forwarded to other ports. DHCP
packets in others VLANs will be broadcast/forwarded to others ports.

The DHCP Per Port function allows the switch to connect only one DHCP client device.

DHCP-Per-Port is configured entirely on the Switch > Configuration > System > IP page, IP Interfaces
window.

The feature is enabled here and an IP range (pool) is entered. The “automatic” results of this action can be
displayed in:

¢ Switch > Configuration > System > DHCP > Server > Mode (Global Mode - Enabled, VLAN Mode -
VLAN 1 created)

¢ Switch > Configuration > System > DHCP > Excluded (Excluded range created based on range
entered)

¢ Switch > Configuration > System > DHCP > Pool (Pool "DHCP_Per_Port” created based on range
entered)

Actual DHCP operation is monitored as normal under System > Monitor > DHCP.

The DHCP Per Port pages and parameters are described below.
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DHCP Per Port Mode Configuration

The DHCP Per Port function lets you assign an IP address based on the switch port the device is
connected to. This will speed up installation of IP cameras, as the cameras can be configured after they are
on the network. The DHCP Per Port assignment lets you know which IP was assigned to which camera.

Note: to prevent IP conflict, each switch can be allocated a different IP range.

To configure DHCP Per Port via the Web UL navigate to the System > IP Address > Advanced IP
Settings menu path.

4-\ R .
TRANSITION ® =| wesns szas H oG
N NETWORKS
SM16TAT2SA Advanced IP Settings @roms - System [P Address - Advanced P Settings
Switch DMS
DNS Server No DNS server v
IP Interfaces
DHCP Per Port
Mode Disabled ¥
1P
> System Time
» LLDP ¢
> UPnP DHCPv4 IPv4 IPVE
» Port Management < Current Mask Mask
_ ¢ Delete  VLAN  Enable Fallback Lease Address Length Address Length
» PoE Management
» VLAN Management < O 1 O
» Quality of Service <
| Add Interface |
» Spanning Tree < Shm————
b MAC Address Table < Link-Local Address binding interface VLANL T
» Multicast <
» DHCP < IP Routes
b Security S
Delete Network Mask Length Gateway Next Hop VLAN
» Access Control <
O 0.0.0.0 0 192.168.1.254 0
» SNMP S
» Event Notification < | 4d Rov ‘
» Diagnostics < |—||—
Apply
» Maintenance < — -

Parameter descriptions: The DHCP Per Port parameters and buttons are described below.

DHCP Per Port Mode: at the dropdown select Enable or Disable the DHCP Per Port function globally.
The default is Disabled.

IP: enter the IPv4 IP address range to be used when the DHCP Per Port function is enabled (e.g.,
192.168.10.20 - 192.168.10.37). The DHCP Per Port IP range must be within the interface subnet. Note
that DHCP Per Port with IPv6 is not supported at this time. The DHCP Per Port IP range must equal the
switch port number excluding uplink ports (16).

Apply: Click to save changes to the entries. If the entries are valid, the webpage message “Update
success!" displays. Click the OK button to clear the message. If any entries are invalid, an error message
displays. Click the OK button to clear the message and enter valid values, then click the Apply button
again.

Reset: Click to undo any changes made locally and revert to previously saved values.
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When DHCP Per Port is enabled at Configuration > System > IP, the checkbox and selection in the DHCP
Server Mode Configuration section becomes grayed out (cannot be selected):

To monitor DHCP Per Port status, navigate to the System > IP Address > Status menu path.

TRANSITION \N — T 7 Auto-logout (=) e
N NETWORKS.
SMETAT2SA IP Status #Fome - Symtem - [P Address - Stats
Switch DMS
Auto-refresh
» System v
» System Information IP Interfaces
» |P Address
Interface * Type Address Status
Advanced IP Settings
7 SRR 0silo Link 00-00-00-00-00-00 UP LOOPBACK RUNNING MTU:16436 Metric:1
. 0s:lo P4 127.0.0.1/8
» System Time
» LLDP ¢ 0s:lo IPvE :1/128
v Wl VLAN1 Link 00-C0-F2-49-AB-14 UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1
» Port Management <
ortianagemen VLANL IPv4 10.0.4.3/24 Manual
» PoE Management <
VLAMT IPvE feB0m2c0:f2fffed9:ab14/84 Link Local Address
» VLAN Management s
» Quality of Service S
_ . IP Routes
» Spanning Tree <
» MAC Address Table <
Network * Gateway Status Interface
» Multicast <
0.0.0.0/0 10.0.4.1 UP GATEWAY VLAN1
» DHCP <
» Security < 0.0.0.0/0 0.0.0.0 up VLAN1
» Access Control < 10.0.4.0/24 0.0.0.0 upP VLAN1
» SMMP ‘ 127.0.0.0/24 0.0.0.0 up 0S:lo
» EventNotification 169.254.0.0/16 0.0.0.0 uP VLANI
» Diagnostics S .
ulf128 uP 0s:lo
» Maintenance <
feg0: /64 upP VLAN1
feR0:2c0:f2ff-fedB:ab14/128 up 0S:lo
ffoo::/e upP VLAN1
Neighbour Cache
IP Address * Link Address
amnnan AN ARAAN AN EA AN AT DA -

Message: Interface xx not using DHCP

Meaning: The Interface being configured does not have DHCP enabled and configured.

Recovery: 1. Click the OK button to clear the webpage message. 2. Enable and configure DHCP for the
interface being configured. See "DHCP Server Mode Configuration” on page 290.

i N
Message from webpage &J

! . Interface 10 not using DHCP
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Message: The value of 'DNS Server’ must be a valid IP address in dotted decimal notation ('x.y.zw’).
Meaning: You entered an invalid IP address for the DNS Server being configured.

Recovery: 1. Click the OK button to clear the webpage message. 2. Enter a valid IP address in the format
x.y.zw per the on-screen restrictions. See “DHCP Server Mode Configuration” on page 290.

r y
Message from webpage &J

The value of 'DMNS Server' must be a valid IP address in dotted decimal
l % notation (xy.zw').

The following restrictions apply:
1) %, y, z, and w must be decimal numbers between 0 and 255,
2) x must not be 0 unless also y, z, and w are 0,
37 % must not be 127, and
4) x must not be greater than 223.

Message: ‘DHCP Interface VLAN ID’ must be an integer value between 1 and 4095.
Meaning: You entered an invalid VLAN ID for the DHCP Interface.

Recovery: 1. Click the OK button to clear the webpage message. 2. Enter a valid VLAN ID for the DHCP
Interface (1-4095). See “DHCP Server Mode Configuration” on page 290.

Message from webpage &J

l L 'DHCP Interface VLAN ID' must be an integer value between 1 and 4035
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Glossary of Terms

Note that mention of a term below does not imply that the feature described is necessarily supported.

A

ACE

An ACE (Access Control Entry) describes access permission associated with a particular ACE ID.

There are three ACE frame types (Ethernet Type, ARP, and IPv4) and two ACE actions (permit and deny).
The ACE also contains many detailed, different parameter options that are available for individual
application.

ACL

An ACL (Access Control List) is the list table of ACEs, containing access control entries that specify
individual users or groups permitted or denied to specific traffic objects, such as a process or a program.

Each accessible traffic object contains an identifier to its ACL. The privileges determine whether there are
specific traffic object access rights.

ACL implementations can be quite complex, for example, when the ACEs are prioritized for the various
situation. In networking, the ACL refers to a list of service ports or network services that are available on a
host or server, each with a list of hosts or servers permitted or denied to use the service. ACL can
generally be configured to control inbound traffic, and in this context, they are similar to firewalls.

There are 3 web-pages associated with the manual ACL configuration:

ACL > Access Control List: The web page shows the ACEs in a prioritized way, highest (top) to lowest
(bottom). Default the table is empty. An ingress frame will only get a hit on one ACE even though
there are more matching ACEs. The first matching ACE will take action (permit/deny) on that frame
and a counter associated with that ACE is incremented. An ACE can be associated with a Policy, 1
ingress port, or any ingress port (the whole switch). If an ACE Policy is created then that Policy can be
associated with a group of ports under the "Ports" web-page. There are number of parameters that
can be configured with an ACE. Read the Web page help text to get further information for each of
them. The maximum number of ACEs is 64.

ACL > Ports: The ACL Ports configuration is used to assign a Policy ID to an ingress port. This is
useful to group ports to obey the same traffic rules. Traffic Policy is created under the "Access
Control List" - page. You can you also set up specific traffic properties (Action / Rate Limiter / Port
copy, etc.) for each ingress port. They will though only apply if the frame gets past the ACE matching
without getting matched. In that case a counter associated with that port is incremented. See the
Web page help text for each specific port property.

ACL > Rate Limiters: Under this page you can configure the rate limiters. There can be 15 different
rate limiters, each ranging from 1-1024K packets per seconds. Under "Ports" and "Access Control
List" web-pages you can assign a Rate Limiter ID to the ACE(s) or ingress port(s).

AES

The AES (Advanced Encryption Standard) encryption key protocol is applied in 802.1i standard to improve
WLAN security. It is an encryption standard by the U.S. government, which will replace DES and 3DES. AES
has a fixed block size of 128 bits and a key size of 128, 192, or 256 bits.

Aggregation

Using multiple ports in parallel to increase the link speed beyond the limits of a port and to increase the
redundancy for higher availability. (Also Port Aggregation, Link Aggregation).
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ARP

ARP (Address Resolution Protocol) is a protocol that is used to convert an IP address into a physical
address, such as an Ethernet address. ARP allows a host to communicate with other hosts when only the
Internet address of its neighbors is known. Before using IP, the host sends a broadcast ARP request
containing the Internet address of the desired destination system.

ARP Inspection

ARP Inspection is a secure feature. Several types of attacks can be launched against a host or devices
connected to Layer 2 networks by "poisoning" the ARP caches. This feature is used to block such attacks.
Only valid ARP requests and responses can go through the switch device.

Auto-Negotiation

Auto-negotiation is the process where two different devices establish the mode of operation and the
speed settings that can be shared by those devices for a link.

D

DEI

DEI (Drop Eligible Indicator) is a 1-bit field in the VLAN tag.
DES

DES ( Data Encryption Standard) provides a complete description of a mathematical algorithm for
encrypting (enciphering) and decrypting (deciphering) binary coded information. Encrypting data
converts it to an unintelligible form called cipher. Decrypting cipher converts the data back to its original
form called plaintext. The algorithm described in this standard specifies both enciphering and deciphering
operations which are based on a binary number called a key.

DHCP

The DHCP (Dynamic Host Configuration Protocol) is used for assigning dynamic IP addresses to devices
on a network. DHCP used by networked computers (clients) to obtain IP addresses and other parameters
such as the default gateway, subnet mask, and IP addresses of DNS servers from a DHCP server. The DHCP
server ensures that all IP addresses are unique, for example, no IP address is assigned to a second client
while the first client's assignment is valid (its lease has not expired). Therefore, IP address pool
management is done by the server and not by a human network administrator.

Dynamic addressing simplifies network administration because the software keeps track of IP addresses
rather than requiring an administrator to manage the task. This means that a new computer can be added
to a network without the hassle of manually assigning it a unique IP address.

DHCP Relay

DHCP Relay is used to forward and to transfer DHCP messages between the clients and the server when
they are not on the same subnet domain. The DHCP option 82 enables a DHCP relay agent to insert
specific information into a DHCP request packets when forwarding client DHCP packets to a DHCP server
and remove the specific information from a DHCP reply packets when forwarding server DHCP packets to
a DHCP client. The DHCP server can use this information to implement IP address or other assignment
policies. Specifically the option works by setting two suboptions: Circuit ID (option 1) and Remote ID
(option2). The Circuit ID sub-option is supposed to include information specific to which circuit the
request came in on. The Remote ID sub-option was designed to carry information relating to the remote
host end of the circuit.

The definition of Circuit ID in the switch is 4 bytes in length and the format is "vlan_id" "module_id"
"port_no". The parameter of "vlan_id" is the first two bytes represent the VLAN ID. The parameter of
"module_id" is the third byte for the module ID (in standalone switch it always equals 0). The parameter of
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"port_no" is the fourth byte and it means the port number. The Remote ID is 6 bytes in length, and the
value is equal the DHCP relay agents MAC address.

DHCP Snooping

DHCP Snooping is used to block intruder on the untrusted ports of the switch device when it tries to
intervene by injecting a bogus DHCP reply packet to a legitimate conversation between the DHCP client
and server.

DNS

DNS (Domain Name System) stores and associates many types of information with domain names. Most
importantly, DNS translates human-friendly domain names and computer hostnames into computer-
friendly IP addresses. For example, the domain name www.example.com might translate to 192.168.0.1.

DoS

In a DoS (Denial of Service) attack, an attacker attempts to prevent legitimate users from accessing
information or services. By targeting at network sites or network connection, an attacker may be able to
prevent network users from accessing email, web sites, online accounts (banking, etc.), or other services
that rely on the affected computer.

Dotted Decimal Notation

Dotted Decimal Notation refers to a method of writing IP addresses using decimal numbers and dots as
separators between octets. An IPv4 dotted decimal address has the form x.y.z.w, where x, y, z, and w are
decimal numbers between 0 and 255.

DSCP

DSCP (Differentiated Services Code Point)is a field in the header of IP packets for packet classification
purposes.

E

EEE

EEE is an abbreviation for Energy Efficient Ethernet defined in IEEE 802.3az.
Ethernet Type

Ethernet Type, or EtherType, is a field in the Ethernet MAC header, defined by the Ethernet networking
standard. It is used to indicate which protocol is being transported in an Ethernet frame.

F
FTP

FTP is an acronym for File Transfer Protocol. It is a transfer protocol that uses the Transmission Control
Protocol (TCP) and provides file writing and reading. It also provides directory service and security
features.

Fast Leave

Multicast snooping Fast Leave processing allows the switch to remove an interface from the forwarding-
table entry without first sending out group specific queries to the interface. The VLAN interface is pruned
from the multicast tree for the multicast group specified in the original leave message. Fast-leave
processing ensures optimal bandwidth management for all hosts on a switched network, even when
multiple multicast groups are in use simultaneously. This processing applies to IGMP and MLD.
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H
HTTP

HTTP (Hypertext Transfer Protocol) is a protocol that used to transfer or convey information on the World
Wide Web (WWW). HTTP defines how messages are formatted and transmitted, and what actions Web
servers and browsers should take in response to various commands. The other main standard that
controls how the World Wide Web works is HTML, which covers how Web pages are formatted and
displayed. Any Web server machine contains, in addition to the Web page files it can serve, an HTTP
daemon, a program that is designed to wait for HTTP requests and handle them when they arrive. The
Web browser is an HTTP client, sending requests to server machines. An HTTP client initiates a request by
establishing a Transmission Control Protocol (TCP) connection to a particular port on a remote host (port
80 by default). An HTTP server listening on that port waits for the client to send a request message.

HTTPS

HTTPS (Hypertext Transfer Protocol over Secure Socket Layer) is used to indicate a secure HTTP
connection. HTTPS provide authentication and encrypted communication and is widely used on the World
Wide Web for security-sensitive communication such as payment transactions and corporate logons.
HTTPS is really just the use of Netscape's Secure Socket Layer (SSL) as a sub layer under its regular HTTP
application layering. (HTTPS uses port 443 instead of HTTP port 80 in its interactions with the lower layer,
TCP/IP) SSL uses a 40-bit key size for the RC4 stream encryption algorithm, which is considered an
adequate degree of encryption for commercial exchange.

I
ICMP

ICMP (Internet Control Message Protocol) is a protocol that generated the error response, diagnostic or
routing purposes. ICMP messages generally contain information about routing difficulties or simple
exchanges such as time-stamp or echo transactions.

IEEE 802.1X

IEEE 802.1X is an IEEE standard for port-based Network Access Control. It provides authentication to
devices attached to a LAN port, establishing a point-to-point connection or preventing access from that
port if authentication fails. With 802.1X, access to all switch ports can be centrally controlled from a server,
which means that authorized users can use the same credentials for authentication from any point within
the network.

IGMP

IGMP (Internet Group Management Protocol) is a communications protocol used to manage the
membership of Internet Protocol multicast groups. IGMP is used by IP hosts and adjacent multicast
routers to establish multicast group memberships. It is an integral part of the IP multicast specification,
like ICMP for unicast connections. IGMP can be used for online video and gaming, and allows more
efficient use of resources when supporting these uses.

IGMP Querier
A router sends IGMP Query messages onto a particular link. This router is called the Querier.
IMAP

IMAP (Internet Message Access Protocol) is a protocol for email clients to retrieve email messages from a
mail server. IMAP is the protocol that IMAP clients use to communicate with the servers, and SMTP is the
protocol used to transport mail to an IMAP server. The current version of the Internet Message Access
Protocol is IMAPA4. It is similar to Post Office Protocol version 3 (POP3), but offers additional and more
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complex features. For example, the IMAP4 protocol leaves your email messages on the server rather than
downloading them to your computer. If you wish to remove your messages from the server, you must use
your mail client to generate local folders, copy messages to your local hard drive, and then delete and
expunge the messages from the server.

IP

IP (Internet Protocol) is a protocol used for communicating data across an internet network. IP is a "best
effort" system, which means that no packet of information sent over is assured to reach its destination in
the same condition it was sent. Each device connected to a Local Area Network (LAN) or Wide Area
Network (WAN) is given an Internet Protocol address, and this IP address is used to identify the device
uniquely among all other devices connected to the extended network. The current version of the Internet
protocol is IPv4, which has 32-bits Internet Protocol addresses allowing for in excess of four billion unique
addresses. This number is reduced drastically by the practice of webmasters taking addresses in large
blocks, the bulk of which remain unused. There is a rather substantial movement to adopt a new version
of the Internet Protocol, IPv6, which would have 128-bits Internet Protocol addresses. This number can be
represented roughly by a three with thirty-nine zeroes after it. However, IPv4 is still the protocol of choice
for most of the Internet.

IPMC
IPMC is an acronym for IP Multicast.
IP Source Guard

IP Source Guard is a secure feature used to restrict IP traffic on DHCP snooping untrusted ports by
filtering traffic based on the DHCP Snooping Table or manually configured IP Source Bindings. It helps
prevent IP spoofing attacks when a host tries to spoof and use the IP address of another host.

L
LACP

LACP is an IEEE 802.3ad standard protocol. The Link Aggregation Control Protocol allows bundling several
physical ports together to form a single logical port.

Lightly Managed Switch (AKA, Smart Switch)

This Ethernet switch category offers certain levels of Management, QoS, Security, etc. with somewhat
"lighter” capabilities and scalability than the Managed switches. This makes Lightly Managed switches a
cost-effective alternative to Managed switches. Lightly Managed switches fit well at the edge of a large
network; Managed Switches are better suited in the core. Lightly Managed switches are also used in
infrastructures with smaller deployments, or for generally less complex networks.

The capabilities available for the Lightly Managed switch category vary, but most have a browser-based
Management interface, often with CLI and/or SNMP. Lightly Managed switches let you segment a network
into workgroups by creating VLANSs, but with fewer VLANs and nodes than with a Managed switch. Lightly
Managed switches offer some levels of security, such as 802.1x endpoint authentication, and/or a limited
set of Access Control Lists (ACLs). Lightly Managed switches support basic QoS (Quality Of Service) that
lets you prioritize users and applications per 802.1q/TOS/DSCP.

Transition Networks' SMXTAT2SA switches are included in this Lightly Managed Switch (Smart Switch)
category.

LLC

The IEEE 802.2 Logical Link Control (LLC) protocol provides a link mechanism for upper layer protocols. It
is the upper sub-layer of the Data Link Layer and provides multiplexing mechanisms that make it possible
for several network protocols (IP, IPX) to coexist within a multipoint network. LLC header consists of 1 byte
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DSAP (Destination Service Access Point), 1 byte SSAP (Source Service Access Point), 1 or 2 bytes Control
field followed by LLC information.

LLDP

LLDP is an IEEE 802.1ab standard protocol. The Link Layer Discovery Protocol (LLDP) specified in this
standard allows stations attached to an IEEE 802 LAN to advertise, to other stations attached to the same
IEEE 802 LAN, the major capabilities provided by the system incorporating that station, the management
address or addresses of the entity or entities that provide management of those capabilities, and the
identification of the stations point of attachment to the IEEE 802 LAN required by those management
entity or entities. The information distributed via this protocol is stored by its recipients in a standard
Management Information Base (MIB), making it possible for the information to be accessed by a Network
Management System (NMS) using a management protocol such as the Simple Network Management
Protocol (SNMP).

LLDP-MED

LLDP-MED is an extension of IEEE 802.1ab and is defined by the telecommunication industry association
(TIA-1057). LLDP-MED provides Auto-discovery of LAN policies enabling plug and play networking, device
location discovery to allow VoIP Enhanced 911 services; extended and automated power management of
PoE end points.

M
MAC Table

Switching of frames is based upon the DMAC address contained in the frame. The switch builds up a table
that maps MAC addresses to switch ports for knowing which ports the frames should go to (based upon
the DMAC address in the frame ). This table contains both static and dynamic entries.

The static entries are configured by the network administrator if the administrator wants to do a fixed
mapping between the DMAC address and switch ports.

The frames also contain a MAC address (SMAC address), which shows the MAC address of the equipment
sending the frame. The SMAC address is used by the switch to automatically update the MAC table with
these dynamic MAC addresses. Dynamic entries are removed from the MAC table if no frame with the
corresponding SMAC address have been seen after a configurable age time.

MD5

MD5 (Message-Digest algorithm 5) is a message digest algorithm, used cryptographic hash function with
a 128-bit hash value. It was designed by Ron Rivest in 1991. MD5 is officially defined in RFC 1321 - The
MD5 Message-Digest Algorithm.

Metering

Metering is a service model that an Internet service provider (ISP) uses to track bandwidth usage and then
charges high traffic customers accordingly. Typically, a customer will select a service package with a flat
rate up to a specified limit and then pays additional fees beyond that limit (e.g., per gigabyte of data
downloaded). AKA, bandwidth metering, Internet metering.
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Mirroring

For debugging network problems or monitoring network traffic, the switch system can be configured to
mirror frames from multiple ports to a mirror port. (In this context, mirroring a frame is the same as
copying the frame.) Both incoming (source) and outgoing (destination) frames can be mirrored to the
mirror port.

MLD

MLD (Multicast Listener Discovery) for IPv6 is used by IPv6 routers to discover multicast listeners on a
directly attached link, much as IGMP is used in IPv4. The protocol is embedded in ICMPv6 instead of using
a separate protocol.

MVR

Multicast VLAN Registration is a protocol for Layer 2 (IP)-networks that lets multicast-traffic from a source
VLAN be shared with subscriber-VLANs. The main reason to use MVR is to save bandwidth by preventing
duplicate multicast streams being sent in the core network; instead stream(s) are received on the
MVRVLAN and forwarded to the VLANs where hosts have requested them (Wikipedia).

N
NAS

NAS (Network Access Server) is meant to act as a gateway to guard access to a protected source.

A client connects to the NAS, and the NAS connects to another resource asking whether the client's
supplied credentials are valid. Based on the answer, the NAS then allows or disallows access to the
protected resource. An example of a NAS implementation is IEEE 802.1X.

NBNS

(NetBIOS Name Service); often called WINS on Windows systems. The NBNS is part of the NetBIOS-over-
TCP protocol suite. NBNS serves a purpose similar to DNS (translate human-readable names to IP
addresses).

NetBIOS

NetBIOS (Network Basic Input/Output System) is a program that allows applications on separate
computers to communicate within a Local Area Network (LAN), and it is not supported on a Wide Area
Network (WAN). The NetBIOS giving each computer in the network both a NetBIOS name and an IP
address corresponding to a different host name, provides the session and transport services described in
the Open Systems Interconnection (OSI) model.

NFS

NFS ( Network File System) allows hosts to mount partitions on a remote system and use them as though
they are local file systems. NFS allows the system administrator to store resources in a central location on
the network, providing authorized users continuous access to them, which means NFS supports sharing of
files, printers, and other resources as persistent storage over a computer network.

NTP

NTP (Network Time Protocol) is a network protocol for synchronizing the clocks of computer systems. NTP
uses UDP (datagram) as transport layer.
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(0
ONVIF

(originally an acronym for Open Network Video Interface Forum) ONVIF is a global and open industry
forum with the goal of facilitating the development and use of a global open standard for the interface of
physical IP-based security products (i.e., to create a standard for how IP products in video surveillance and
other physical security areas can communicate with each other).

Optional TLVs

An LLDP frame contains multiple TLVs For some TLVs it is configurable if the switch shall include the TLV in
the LLDP frame. These TLVs are known as optional TLVs. If an optional TLVs is disabled the corresponding
information is not included in the LLDP frame.

oul

OULl is the organizationally unique identifier. An OUI address is a globally unique identifier assigned to a
vendor by IEEE. You can determine which vendor a device belongs to according to the OUI address which
forms the first 24 bits of a MAC address.

P

PCP

PCP (Priority Code Point) is a 3-bit field storing the priority level for the 802.1Q frame. It is also known as
User Priority.

PD

PD is an acronym for Powered Device. In a PoE> system the power is delivered from a PSE ( power
sourcing equipment ) to a remote device. The remote device is called a PD.

PHY

PHY is an abbreviation for Physical Interface Transceiver and is the device that implement the Ethernet
physical layer (IEEE-802.3).

PING

Ping is a program that sends a series of packets over a network or the Internet to a specific computer in
order to generate a response from that computer. The other computer responds with an acknowledgment
that it received the packets. Ping was created to verify whether a specific computer on a network or the
Internet exists and is connected. ping uses Internet Control Message Protocol (ICMP) packets. The PING
Request is the packet from the origin computer, and the PING Reply is the packet response from the
target.

PoE

PoE (Power over Ethernet) is used to transmit electrical power, to remote devices over standard Ethernet
cable. It could for example be used for powering IP telephones, wireless LAN access points and other
equipment, where it would be difficult or expensive to connect the equipment to main power supply.

Policer

A policer can limit the bandwidth of received frames. It is located in front of the ingress queue.
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POP3

POP3 (Post Office Protocol version 3) is a protocol for email clients to retrieve email messages from a mail
server. POP3 is designed to delete mail on the server as soon as the user has downloaded it. However,
some implementations allow users or an administrator to specify that mail be saved for some period of
time. POP can be thought of as a "store-and-forward" service. An alternative protocol is Internet Message
Access Protocol (IMAP). IMAP provides the user with more capabilities for retaining e-mail on the server
and for organizing it in folders on the server. IMAP can be thought of as a remote file server. POP and
IMAP deal with the receiving of e-mail and are not to be confused with the Simple Mail Transfer Protocol
(SMTP). You send e-mail with SMTP, and a mail handler receives it on your recipient's behalf. Then the mail
is read using POP or IMAP. IMAP4 and POP3 are the two most prevalent Internet standard protocols for e-
mail retrieval. Virtually all modern e-mail clients and servers support both.

Private VLAN

In a private VLAN, communication between ports in that private VLAN is not permitted. A VLAN can be
configured as a private VLAN.

Q
QCE

QCE (QoS Control Entry) describes QoS class associated with a particular QCE ID. There are six QCE frame
types: Ethernet Type, VLAN, UDP/TCP Port, DSCP, TOS, and Tag Priority. Frames can be classified by one of
4 different QoS classes: "Low", "Normal", "Medium", and "High" for individual application.

QCL

QCL (QoS Control List) is the list table of QCEs, containing QoS control entries that classify to a specific
QoS class on specific traffic objects. Each accessible traffic object contains an identifier to its QCL. The
privileges determine specific traffic object to specific QoS class.

QoS

QoS (Quiality of Service) is a method to guarantee a bandwidth relationship between individual
applications or protocols. A communications network transports a multitude of applications and data,
including high-quality video and delay-sensitive data such as real-time voice. Networks must provide
secure, predictable, measurable, and sometimes guaranteed services. Achieving the required QoS
becomes the secret to a successful end-to-end business solution. Therefore, QoS is the set of techniques
to manage network resources.

R
RARP

RARP (Reverse Address Resolution Protocol) is a protocol that is used to obtain an IP address for a given
hardware address, such as an Ethernet address. RARP is the complement of ARP.

RADIUS

RADIUS is an acronym for Remote Authentication Dial In User Service. It is a networking protocol that
provides centralized access, authorization and accounting management for

people or computers to connect and use a network service.
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RSTP

In 1998, the IEEE with document 802.1w introduced an evolution of STP: the Rapid Spanning Tree Protocol,
which provides for faster spanning tree convergence after a topology change. Standard IEEE 802.1D-2004
now incorporates RSTP and obsoletes STP, while at the same time being backwards compatible with STP.

S
SHA

SHA (Secure Hash Algorithm) was designed by the National Security Agency (NSA) and published by the
NIST as a U.S. Federal Information Processing Standard. Hash algorithms compute a fixed-length digital
representation (known as a message digest) of an input data sequence (the message) of any length.

Shaper
A shaper can limit the bandwidth of transmitted frames. It is located after the ingress queues.
Smart Switch (AKA, Lightly Managed Switch)

This category of switches offers certain levels of Management, QoS, Security, etc. with somewhat “lighter”
capabilities and scalability than the Managed switches. This makes them a cost-effective alternative to
Managed switches. Smart switches fit well at the edge of a large network; Managed Switches are better
suited in the core. Smart switches are also used in infrastructures with smaller deployments, or for
generally less complex networks.

The capabilities available for the Smart switch category vary, but most have a browser-based Management
interface, often with CLI and/or SNMP. Smart switches let you segment a network into workgroups by
creating VLANSs, but with fewer VLANs and nodes than with a Managed switch. Smart switches offer some
levels of security, such as 802.1x endpoint authentication, and/or a limited set of Access Control Lists
(ACLs). Smart switches support basic QoS (Quality Of Service) that lets you prioritize users and
applications per 802.1g/TOS/DSCP.

Transition Networks' SMXTAT2SA switches are included in this Smart Switch (Lightly Managed Switch)
category.

SMTP

SMTP (Simple Mail Transfer Protocol) is a text-based protocol that uses the Transmission Control Protocol
(TCP) and provides a mail service modeled on the FTP file transfer service. SMTP transfers mail messages
between systems and notifications regarding incoming mail.

SNAP

The Sub Network Access Protocol (SNAP) is a mechanism for multiplexing, on networks using IEEE 802.2
LLC, more protocols than can be distinguished by the 8-bit 802.2 Service Access Point (SAP) fields. SNAP
supports identifying protocols by Ethernet type field values; it also supports vendor private protocol
identifier.

SNMP

SNMP (Simple Network Management Protocol) is part of the Transmission Control Protocol/Internet
Protocol (TCP/IP) protocol for network management. SNMP allow diverse network objects to participate in
a network management architecture. It enables network management systems to learn network problems
by receiving traps or change notices from network devices implementing SNMP.

SNTP

SNTP (Simple Network Time Protocol) is a network protocol for synchronizing the clocks of computer
systems. SNTP uses UDP (datagrams) as transport layer.
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SSID

Service Set Identifier is a name used to identify the particular 802.11 wireless LANs to which a user wants
to attach. A client device will receive broadcast messages from all access points within range advertising
their SSIDs, and can choose one to connect to based on pre-configuration, or by displaying a list of SSIDs
in range and asking the user to select one (Wikipedia).

SSH

SSH (Secure Shell) is a network protocol that allows data to be exchanged using a secure channel between
two networked devices. The encryption used by SSH provides confidentiality and integrity of data over an
insecure network. The goal of SSH was to replace the earlier rlogin, TELNET and rsh protocols, which did
not provide strong authentication or guarantee confidentiality (Wikipedia).

STP

Spanning Tree Protocol is an OSI layer-2 protocol which ensures a loop free topology for any bridged LAN.
The original STP protocol is now obsolete by RSTP.

T
TACACS +

TACACS+ (Terminal Access Controller Access Control System Plus) is a networking protocol which provides
access control for routers, network access servers and other networked computing devices via one or
more centralized servers. TACACS+ provides separate authentication, authorization and accounting
services.

Tag Priority
Tag Priority is a 3-bit field storing the priority level for the 802.1Q frame.
TCP

TCP (Transmission Control Protocol) is a communications protocol that uses the Internet Protocol (IP) to
exchange the messages between computers. The TCP protocol guarantees reliable and in-order delivery
of data from sender to receiver and distinguishes data for multiple connections by concurrent applications
(for example, Web server and e-mail server) running on the same host. The applications on networked
hosts can use TCP to create connections to one another. It is known as a connection-oriented protocol,
which means that a connection is established and maintained until such time as the message or messages
to be exchanged by the application programs at each end have been exchanged. TCP is responsible for
ensuring that a message is divided into the packets that IP manages and for reassembling the packets
back into the complete message at the other end. Common network applications that use TCP include the
World Wide Web (WWW), e-mail, and File Transfer Protocol (FTP).

TELNET (or Telnet or telnet)

TELNET (TELetype NETwork) is a terminal emulation protocol that uses the Transmission Control Protocol
(TCP) and provides a virtual connection between TELNET server and TELNET client.

TFTP

TFTP (Trivial File Transfer Protocol) is a transfer protocol that uses the User Datagram Protocol (UDP) and
provides file writing and reading, but it does not provide directory service and security features.
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U
uDP

UDP (User Datagram Protocol) is a communications protocol that uses the Internet Protocol (IP) to
exchange the messages between computers. UDP is an alternative to the Transmission Control Protocol
(TCP) that uses the Internet Protocol (IP). Unlike TCP, UDP does not provide the service of dividing a
message into packet datagrams, and UDP doesn't provide reassembling and sequencing of the packets.
This means that the application program that uses UDP must be able to make sure that the entire
message has arrived and is in the right order. Network applications that want to save processing time
because they have very small data units to exchange may prefer UDP to TCP. UDP provides two services
not provided by the IP layer. It provides port numbers to help distinguish different user requests and,
optionally, a checksum capability to verify that the data arrived intact. Common network applications that
use UDP include the Domain Name System (DNS), streaming media applications such as IPTV, Voice over
IP (VoIP), and Trivial File Transfer Protocol (TFTP).

User Priority

User Priority is a 3-bit field storing the priority level for the 802.1Q frame. It is also known as PCP.

4
VLAN

A Virtual LAN is method to restrict communication between switch ports. VLANs can be used for the
following applications:

VLAN unaware switching: This is the default configuration. All ports are VLAN unaware with Port VLAN ID
1 and members of VLAN 1. This means that MAC addresses are learned in VLAN 1, and the switch does
not remove or insert VLAN tags.

VLAN aware switching: This is based on the IEEE 802.1Q standard. All ports are VLAN aware. Ports
connected to VLAN aware switches are members of multiple VLANs and transmit tagged frames. Other
ports are members of one VLAN, set up with this Port VLAN ID, and transmit untagged frames.

Provider switching: This is also known as Q-in-Q switching. Ports connected to subscribers are VLAN
unaware, members of one VLAN, and set up with this unique Port VLAN ID. Ports connected to the service
provider are VLAN aware, members of multiple VLANSs, and set up to tag all frames. Untagged frames
received on a subscriber port are forwarded to the provider port with a single VLAN tag. Tagged frames
received on a subscriber port are forwarded to the provider port with a double VLAN tag.

VLAN ID
A VLAN ID is a 12-bit field specifying the VLAN to which the frame belongs.
Voice VLAN

Voice VLAN is VLAN configured specially for voice traffic. By adding the ports with voice devices attached
to voice VLAN, we can perform QoS-related configuration for voice data, ensuring the transmission
priority of voice traffic and voice quality.
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